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Acasă > Turul ActivInspire > Explorați ActivInspire Studio

Explorați ActivInspire Studio
Ce vedeți când rulați ActivInspire prima dată depinde de faptul dacă aveți ActivInspire Professional sau Personal.

Unde este posibil, vă arătăm ambele variante în acest tur ilustrat.

Panoul de control (Dashboard) 

Fereastra ActivInspire

Instrumentele Principale 

Navigatoarele ActivInspire 

Vizualizare flipchart

Administrare flipcharturi multiple 

Crearea pe computer

Prezentarea la tablă

Colaborarea la tablă

Instrumente de explorare

Cele mai frecvent folosite instrumente
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Welcome to ActivInspire
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Acasă > Bun venit la ActivInspire

Bun venit la ActivInspire
ActivInspire este noul soft pentru predare și învățare de la Promethean, 
pentru calculatoare și table interactive

Cu ActivInspire puteți:

• Preda la fel ca pe tabla
clasică, varia viteza prezentării
și livra sesiuni practice de
instruire
• Scrie și desena, apoi șterge,
la fel cum faci pe tabla clasică
• Salva paginile ca un
document de tip flipchart și să
le folosiți apoi și pentru
predarea la altă materie sau
altă clasă
• Adăuga imagini, video-uri și
sunete în paginile flipchart ale
lecției
• Structura rapid conținutul
lecției și timpul, ca să se
încadreze în planul lecției
• Adăuga text, de exemplu din
Microsoft Word sau direct de
pe Internet. ActivInspire îți
poate chiar recunoaște scrisul
și transforma în text.
• Folosi un sistem de răspuns
din partea elevilor – puneți
elevilor întrebări sau afișați
întrebări pregătite anterior în
flipcharturi. Elevii pot vota sau
scrie răspunsul pe dispozitivele
ActiVote și ActivExpression și
rezultatele pot fi afișate în
diferite formate
• Adapta rapid flipcharturile în
funcție de răspunsurile elevilor
sau în concordanță cu
programa
• Folosi instrumente simple,
dar eficiente, pentru a stimula
gândirea și a capta atenția
elevilor



A tour of ActivInspire
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Acasă > Turul ActivInspire

Turul ActivInspire
Această secțiune este pentru utilizatori noi și utilizatori uzuali ai softurilor Activstudio și Activprimary. Conține câteva subiecte 
introductive și vă face un tur al ActivInspire Studio și ActivInspire Primary:

O aplicație, două produse

Despre flipcharturi

Explorați ActivInspire Studio 

Explorați ActivInspire Primary
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Dashboard
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Panou de control

Panoul de control (Dashboard)
Când rulați ActivInspire, după 
alegerea preferințelor inițiale, 
primul lucru pe care îl vedeți este 
panoul de control (Dashboard).

Panoul de control conține scurtături 
către flipcharturi și instrumente 
folositoare, pentru a economisi 
timp.

Panoul de control va rămâne 
deschis până îl închideți.

Dacă debifați căsuța “Afișează panoul de control la deschidere” (Show the dashboard window on startup), panoul 
de control nu se va deschide automat data următoare când rulați ActivInspire.
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ActivInspire window
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Fereastra ActivInspire

Fereastra ActivInspire
Când rulați ActivInspire, fereastra ActivInspire se va deschide în spatele panoului de control. 

Aspectul acestei ferestre depinde de mai multe lucruri:

• Preferințele la pornire

• Dacă folosiți ActivInspire Professional sau Personal

• Dacă ați personalizat una din componentele ferestrei

Aici introducem componentele principale ale ferestrei ActivInspire pentru ActivInspire Professional și ActivInpire Personal.

ActivInspire Professional
Imaginea de mai jos este o reproducere a ferestrei ActivInspire Professional. Lista din stânga denumește fiecare componentă 
numerotată:

1

2 Navigator (Browser)

3 Bara de meniu

4 Numele flipchartului

5 Detalii pentru redimensionare

6 Pagina flipchart

7 Coș de gunoi

Înapoi sus

ActivInspire Personal
Imaginea de mai jos este o reproducere a ferestrei ActivInspire Personal. 

ActivInspire Personal nu vă oferă aceeași gamă de 
instrumente și Navigatoare ca ActivInspire 
Professional. De exemplu, nu include instrumentele 
Forme și Navigatorul de acțiuni.

Instrumentele principale
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ActivInspire window
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Forme 

Navigatorul de acțiuni

Înapoi sus

Sfat
Căutați pictogramele mici din partea de sus a Navigatoarelor (Browsers), Meniurilor și Seturilor de Instrumente. 
Ele vă permit să personalizați rapid comportamentul unei componente:

 Opțiunile 
Instrumentelor 

 Rulați

Fixare Instrumente 

Selectați dintr-un meniu drop-down unde să fie afișat elementul și cât din el să fie vizibil.

Un comutator prin care înfășurați elementul, ca să ocupe mai puțin loc sau pentru a-l desfășura 
din nou.

Un comutator prin care fixați elementul. Acest lucru împiedică ascunderea automată a acestuia 
sau mutarea accidentală.

Pentru a muta un element, apăsați în zona bleumarin din partea de sus, trageți-l și plasați-l unde doriți.  

Următoarea dată când deschideți ActivInspire, vă păstra preferințele dumneavoastră. 

Înapoi sus



Demo Acasă > Turul ActivInspire > Explorați ActivInspire Studio  > Instrumentele Principale

Instrumentele Principale 
Meniul cu Instrumentele Principale se deschide pe ecran când porniți ActivInspire. Când porniți 
ActivInspire pentru prima dată, setul de instrumente va conține cele mai populare instrumente.

Elementele din Setul din Instrumente Principal sunt doar o selecție din multele instrumente disponibile. 
Puteți accesa o gamă largă de instrumente din Meniul de Instrumente. Următoarea dată când veți 
deschide ActivInspire, își va aminti unde ați plasat setul de instrumente ultima dată și elementele 
componente.

Preferințe
Puteți păstra setul de instrumente implicit, elimina instrumente sau înlocui unele sau toate cu alte 
instrumente. Vă puteți defini preferințele într-un profil și să le salvați când sunteți mulțumit.
Puteți crea câte profiluri aveți nevoie și să comutați rapid între ele cu pictograma Schimbați profilul.

Pentru detalii despre cum să personalizați profilurile, vedeți Personalizarea profilurilor.

Înapoi sus 
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ActivInspire's Browsers
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire

Navigatoarele ActivInspire
Această secțiune este o introducere în navigatoarele ActivInspire.

Ce este un navigator?
Un flipchart poate avea multe pagini și elemente, fiecare cu o gamă de caracteristici și proprietăți.

ActivInspire face lucrul cu aceste caracteristici și proprietăți simplu, furnizând un Navigator (Browser) pentru fiecare zonă importantă. 

Prin intermediul Navigatoarelor puteți vedea:
• Ce este deja inclus în flipchart

• Ce altceva ați putea adăuga sau optimiza

• Cum să faceți aceste lucruri

Utilizați browserele pentru a construi, rafina și îmbunătăți rapid flipcharturile dvs. și ale celorlalți.

Fiecare browser:

• Este structurat pentru a vă oferi informații clare și detaliate despre zona în care navigați.

• Are propriul         meniu pop-up și / sau set de pictograme pentru a vă ajuta să lucrați eficient cu flipchartul.

În plus, puteți mări sau micșora Navigatorul și puteți ajusta nivelul de detalii pe care să îl vizualizați pentru a se 

potrivi nevoilor dvs.

Ce Navigatoare există?
Sunt 7 navigatoare în ActivInspire:

Navigator de pagini  

Navigator de resurse 

Navigator de obiecte 

Navigator de notițe 

Navigator de proprietăți 

Navigator de acțiuni

Navigator de vot 
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Viewing a flipchart
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Vizualizare flipchart

Vizualizare flipchart
Când deschideți un flipchart, Navigatorul de pagini afișează miniaturile paginilor din flipchart și în zona de lucru din fereastra 
ActivInspire se afișează prima pagină a flipchartului.

Aici descriem cinci moduri facile de a vizualiza un flipchart:

Vizualizați câte o pagină

Previzualizați mai multe pagini odată 

Creșteți și scădeți dimensiunea paginii 

Măriți și micșorați

Explorați flipchartul

Vizualizați câte o pagină
Două moduri de a vizualiza câte o pagină pe rând:

• Faceți clic pe pictogramele        Pagina următoare și         Pagina anterioară. 

• Din Meniul Vizualizare, selectați Pagina următoare sau Pagina anterioară.

Când apăsați pe pictograma         Pagina următoare în ultima pagina unui flipchart, inserați automat o 
nouă pagină în flipchart.

  


Previzualizați mai multe pagini odată
Puteți mări sau micșora dimensiunea miniaturilor pe care le vedeți în Navigatorul de Pagini. Cu cât miniaturile sunt mai mici, cu 
atât mai mult pagini puteți previzualiza simultan.

Două moduri de a previzualiza mai multe pagini:

• Apăsați și trageți marginea Navigatorului de Pagini sau utilizați glisorul din partea dreaptă jos a Navigatorului de Pagini pentru 
a modifica dimensiunea miniaturilor.
• Trageți glisorul din marginea din dreapta sus a Navigatorului de pagini în jos sau în sus pentru a derula printre miniaturile 
paginilor din flipchart. Apoi apăsați pe miniatura paginii pe care doriți să o vedeți.

Exemplu

Imaginea de mai jos arată toate 
paginile din flipchartul deschis ca 
miniaturi în Navigatorul de Pagini. 
Puteți vedea, atât în Navigator, cât 
și în spațiul de lucru, că ultima 
pagină este pagina curenta.
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Viewing a flipchart
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Înapoi sus

Creșteți și scădeți dimensiunea paginii

În mod implicit, ActivInspire este setat pentru a încadra întreaga pagină flipchart în 
fereastra ActivInspire. Această opțiune este denumită „Best Fit”. Puteți schimba ușor 
acest lucru din meniul drop-down din colțul din dreapta sus al ferestrei.

Apăsați pe pictograma săgeată în jos, apoi selectați o opțiune care să se potrivească 
nevoilor dvs. Dacă nu puteți vedea pictograma săgeată în jos, faceți clic pe pictograma 
>>.

Faceți cunoștință cu opțiunea Global (World)!
Dacă selectați o opțiune de vizualizare mai mică de 100%, dimensiunea paginii flipchart 
va fi proporțional redusă în fereastra ActivInspire.

Aceasta deschide o zonă în jurul paginii flipchart numită World. Puteți folosi World ca o 
hartă, pentru a poziționa temporar obiecte în afara limitei paginii flipchart, pentru utilizare 
ulterioară. Aceste obiecte pot rămâne apoi ascunse atunci când pagina este încadrată 
cu opțiunea Best Fit. De exemplu, lucruri pe care nu doriți să le faceți vizibile elevilor dvs. 
sau elemente pe care doriți să le dezvăluiți într-un anumit moment al lecției.



Viewing a flipchart
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Măriți și micșorați

Puteți utiliza opțiunea           Page Zoom pentru a mări sau micșora ceea ce vedeți pe flipchart. Page Zoom nu schimbă flipchartul, ci 
influențează doar modul de vizualizare a flipchartului.

Măriți

1. Din Meniul Vizualizare selectați Page Zoom

2. Apăsați pe pagină și așteptați un moment. Efectul de mărire începe și continuă până când eliberați ActivPen sau butonul mouse-ului.

Page Zoom este acum în Setul de Instrumente Rapide.

Micșorați

Cu Page Zoom selectat:

1. Faceți clic dreapta pe pagină.
2. Țineți apăsat butonul.

Dacă faceți dublu-clic pe pagină în timp ce Page Zoom este selectat, scalarea paginii revine la Best Fit.

Explorați flipchartul
Când ați mărit un flipchart până în punctul în care pagina flipchart este mai mare decât fereastra ActivInspire, nu puteți nu mai 
vedeți pagină flipchart completă. 

În această situație puteți explora pagina două moduri: 

• Utilizați barele glisante verticală și orizontală care apar în 
jurul paginii 

• Utilizați Page Zoom. Atunci când este selectat acest 
instrument, în timp ce mișcați cursorul peste pagină, o 
pictogramă mânuță este afișată. Dacă faceți clic acum pe 
pagina și trageți, puteți naviga în jurul paginii pentru a 
vizualiza alte zone. Rețineți că acest comportament se 
aplică și atunci când micșorați pagina. 

Înapoi sus



Managing multiple flipcharts
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Administrare flipcharturi multiple
De fiecare dată când deschideți sau creați un alt flipchart, apare o nouă filă în bara de documente. Puteți lucra cu un număr 
nelimitat de flipcharturi în același timp. 

Pentru a trece de la un flipchart la altul, apăsați pe fila document (Document 
Tab) a flipchartului în care doriți să lucrați. Aceasta devine flipchartul curent. 

Numele flipchartului apare cu caractere îngroșare în fila sa de documente. 
Pentru a închide flipchartul, faceți clic pe X.

javascript:void(0);


Authoring at your computer
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Crearea pe computer

Când lucrați la computer, aveți nevoie de acces rapid la o serie de instrumente pentru pregătirea lecțiilor.

Cel mai rapid mod de a realiza acest lucru este să treceți la profilul Creație (Authoring) furnizat împreună cu ActivInspire:

Apăsați pe          Schimbați profilul și selectați profilul de creație (Authoring) din lista drop-down.

Alternativ, puteți experimenta combinațiile preferate de instrumente și setări, apoi le puteți salva într-un profil.

Pentru mai multe informații despre crearea și lucrul cu profiluri, consultați Personalizarea profilurilor.
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Presenting at the board
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Prezentarea la tablă

Prezentarea la tablă
Când prezentați la tablă, aveți nevoie de acces rapid la o serie de instrumente de prezentare. Puteți să maximizați spațiul disponibil și 
să minimizați distragerile.
Iată câteva modalități de a realiza acest lucru:

• Setați afișajul la modul Ecran Complet (F5).

• Ascundeți meniurile.

• Fixați Setul de Instrumente Principale.

• Adăugați în setul de instrumente instrumentele pe care intenționați să le utilizați, înainte de lecție.

• Eliminați toate instrumentele de care știți că nu aveți nevoie din setul de instrumente.

• Activați elemente interactive, cum ar fi acțiuni sau legături.

• Ascundeți obiectele de acțiune.

• Deschideți Pagina sau Navigatorul de resurse.

• Afișați Coșul de gunoi.

Experimentați cu combinațiile dvs. preferate de instrumente și setări, apoi salvați-le într-un profil.

Alternativ, apăsați pe             Schimbați profilul și selectați profilul La Tablă (At The Board) din lista drop-down.

Pentru mai multe informații despre:

• Prezentarea la tablă, vedeți  Lucrul la tablă.

• Crearea și lucrul cu profiluri, vedeți Personalizarea profilurilor.
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Collaborating at the board
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Colaborarea la tablă

Colaborarea la tablă
Există multe modalități prin care vă puteți încuraja elevii să colaboreze la tablă. De obicei, asta înseamnă că aceștia trebuie să 
folosească pe rând instrumentul ActivPen (stiloul).

ActivInspire face un pas înainte în colaborare, permițând ca două persoane să lucreze 
interactiv pe același flipchart. Numim acest mod de lucru modul Utilizator Dual (Dual 
User), deoarece fiecare colaborator își folosește propriul Set de Instrumente 
ActivInspire și propriul ActivPen pentru a lucra pe ActivBoard.

• Numai profesorul poate activa modul Dual User.
• Pornirea modului Dual User activează Dual Toolbox, care conține o selecție din 
instrumentele disponibile în Instrumentele Principale
• Persoana care folosește Dual Box poate lucra numai pe pagina flipchart curentă.
• Doar utilizatorul Instrumentelor Principale are acces complet la toate funcțiile 
ActivInspire.
• Dual Toolbox rămâne sub controlul persoanei care folosește Instrumentele 
Principale.
• Accesul la Dual Toolbox poate fi revocat oricând din Instrumentele Principale.

Aveți nevoie de ActivInspire Professional pentru a folosi modul Dual User.

Sfaturi pentru a colabora în modul Dual User
Am adunat câteva sfaturi pentru a vă stimula creativitatea atunci când lucrați în modul Dual User.

Două ActivPen sunt mai bune decât unul

Încurajați elevii să lucreze la același obiectiv. Asigurați-vă că elevii comunică și împărtășesc permanent informații. Aceasta ar putea 
însemna asamblarea unui puzzle sau lucrul în echipă pentru a răspunde la întrebări de pe ActivBoard.

Schimbați rolurile

Schimbați rolurile la jumătatea activității, astfel încât un elev să nu fie prins într-o zonă pe care nu o cunoaște bine.

Profesorul supraveghează

Profesorul are control asupra Instrumentelor Principale, adnotând munca elevilor pe măsură ce ies la ActivBoard, pentru a ajuta la 
creșterea încrederii elevilor.

Un nou spațiu de lucru

Modul Dual User creează un spațiu în care doi elevi pot lucra, împreună sau individual, la ActivBoard, făcând ActivBoard un spațiu de 
lucru în sine.

Lucru constructiv în perechi

Formați o pereche dintre un elev mai puternic și unul mai slab. Elevul mai puternic îl învață pe cel mai slab. Elevul mai slab îi întărește 
cunoștințele elevului mai puternic.

Prezentări comune

Încurajați elevii să creeze prezentări în perechi, astfel încât să poată discuta despre ce rol să îndeplinească și cum pot lucra împreună 
la ActivBoard.

Încurajarea creativității

Două grupuri își pot scrie acum ideile pe ActivBoard în același timp. Văzând ideile celuilalt grup, elevii se pot inspira reciproc, ajutând 
la dezvoltarea creativității.
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Roluri

Oferiți elevilor roluri diferite de îndeplinit la ActivBoard, astfel încât aceștia să poată vedea rezultatele unei echipe eficiente. De 
exemplu, un elev ar putea fi responsabil de text, în timp ce celălalt este responsabil de imagini.

Puncte de vedere diferite

Două puncte de vedere pot fi afișate și discutate simultan la ActivBoard. Elevii pot identifica apoi unde există idei care coincid sau se 
contrazic.

Încurajați gândirea corectă

Clasa citește instrucțiuni pentru doi elevi care lucrează spate în spate, pentru a vedea dacă ambii elevi înțeleg instrucțiunile în același 
fel.

Pentru mai multe detalii, vedeți Lucrul în modul Dual User.



Exploring tools
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Instrumente de explorare
ActivInspire include multe instrumente care vă ajută să creați lecții interactive pentru a captiva elevii și a le crește interesul în timp ce 
lucrează la tablă.
Setul de Instrumente Principale conține cele mai populare instrumente și multe instrumente disponibile din Meniul de Instrumente 
(Tools Menu).
Aici descriem doar câteva dintre instrumentele distractive pentru explorare:

Înregistrare sunet 
(Sound Recorder)

Acest instrument vă permite să captați sunetul într-un fișier pentru a fi inclus în flipchart. De 
exemplu, puteți să creați clipuri sonore și să le conectați la cuvinte pentru a îmbunătăți pronunția 
elevilor sau să captați sunetul în timp ce realizați o înregistrare pe ecran cu Screen Recorder.

Înregistrare ecran 
(Screen Recorder)

Panglică cu mesaje 
(Tickertape)

Ceas (Clock)

Cameră
(Camera)

Deschideți flipchart 
(Open Flipchart)

Dezvăluitorul
(Revealer)

Utilizator Dual
(Dual User)

Acest instrument vă permite să înregistrați orice se întâmplă pe ecran într-un fișier video (.AVI), pe 
care îl puteți păstra în flipchart sau salva într-un dosar de resurse și reda de câte ori este necesar.

Un instrument de prezentare care vă permite să creați un mesaj care se unduiește ca o panglică 
peste partea de sus a tablei. O puteți opri, porni și modifica oricând.

Un ceas ce poate fi folosit în timpul unei lecții, de exemplu, pentru a-i învăța pe elevi timpul sau 
pentru a-l folosi ca temporizator sau cronometru pentru diverse activități.

Acest instrument vă permite să realizați o captură cu ceea ce este pe ecran și să o plasați în 
flipchart, clipboard sau în fișierele Resursele mele (My Resources) sau Resurse partajate (Shared 
folder). O gamă de opțiuni vă permite să adaptați dimensiunea și forma capturii de ecran la nevoile 
dvs.

O comandă rapidă către Deschideți flipchart (Open flipchart), pe care o puteți utiliza pentru a 
naviga și a deschide flipcharturi.

Un instrument distractiv pentru ascunderea și dezvăluirea zonelor din pagina flipchart! Excelent 
pentru jocuri de ghicit și pentru stimularea interesului.

Un instrument pentru colaborarea la tablă. Acesta activează un al doilea set de instrumente care 
poate fi utilizată de un elev pentru a scrie, desena, selecta, umple și conecta obiecte de pe tablă.

Instrumentele își păstrează setările. Când schimbați instrumentele, fiecare păstrează ultima dvs. alegere. De 
exemplu, Stiloul (Pen) și Evidențiatorul (Highlighter) își păstrează setările de culoare și grosime. 
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Cel mai frecvent folosite instrumente

Cel mai frecvent folosite instrumente
În timp ce lucrați cu ActivInspire, bara de comenzi rapide cu instrumente din dreapta casetei de Instrumente Principale se umple 
treptat cu pictograme. ActivInspire plasează automat instrumentele dvs. cele mai des utilizate acolo, astfel încât acestea să fie 
ușor accesibile.

În imaginea din dreapta, bara de comenzi rapide cu instrumente include unele dintre 
instrumentele descrise în subiectul anterior.

Pentru a vedea descrierea unui instrument, faceți clic pe link:

Adnotări (Annotate Over Desktop)

Înregistrare ecran (Screen Recorder)

Înregistrare sunet (Sound Recorder)

Dezvăluitorul (Revealer)

Mărire și micșorare pagină (Page Zoom)

Cameră
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Acasă > Turul ActivInspire > O aplicație, două produse

O aplicație, două produse
La generațiile anterioare de software Promethean trebuia să alegeți între software-ul Activstudio și Activprimary. Vestea bună este că 
acest lucru nu mai este valabil în cazul ActivInspire. 

Pentru un început rapid cu ActivInspire, vă alegeți aspectul preferat atunci când rulați aplicația pentru prima dată. ActivInspire vă 
adaptează instrumentele și aspectul ecranului în funcție de alegerea dvs. Indiferent de opțiunea pe care o alegeți, beneficiați de 
caracteristicile puternice ActivInspire.

Opțiunile dvs. sunt:

• Promethean Activstudio 
• Promethean Activprimary 
• Alte aplicații, cum ar fi Powerpoint® 

Odată ce este în funcțiune, puteți personaliza ActivInspire și mai mult, apoi puteți salva toate preferințele dvs. într-un profil pentru 
utilizare viitoare. Pentru mai multe informații, vedeți Personalizarea profilurilor.

În acest document de ajutor, îți arătăm cum să lucrezi cu ActivInspire Studio și ActivInspire Primary.
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Acasă > Turul ActivInspire > Despre flipcharturi

Despre flipcharturi
Un flipchart este spațiul mare de lucru dreptunghiular din fereastra ActivInspire, unde creați lecții.

Câteva informații despre flipcharturi:

• Când lansați ActivInspire, se deschide un flipchart gol, unde puteți începe crearea lecției
• Flipcharturile pot include o gamă largă de obiecte, forme și caracteristici interactive, inclusiv sunete, animații și acțiuni.
• Puteți lucra cu cât de multe flipcharturi doriți în același timp.
• Fiecare flipchart se deschide în propria filă din fereastra ActivInspire.
• Puteți naviga rapid printre flipcharturi folosind filele documentului.
• Un flipchart poate conține câte pagini doriți.
• De asemenea, puteți crea flipcharturi pentru desktop, unde puteți adnota fie direct pe desktop, fie pe o captură a
desktopului.
• Flipcharturile create cu ActivInspire au extensia de fișier .flipchart.
• Puteți converti orice flipchart creat cu versiuni anterioare ale software-ului Promethean (versiunea 2.0 și ulterioare)
la noul format de fișier.

Puteți deschide flipcharturi create cu ActivPrimary și ActivStudio în ActivInspire. Odată ce salvați aceste flipcharturi în 
ActivInspire, nu le puteți deschide în ActivPrimary sau ActivStudio.
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Explorați ActivInspire Primary
Ce vedeți când rulați ActivInspire Primary prima dată depinde de faptul dacă aveți ActivInspire Professional sau Personal. Unde este 
posibil, vă arătăm ambele variante în acest tur ilustrat.

Panoul de control (Dashboard)

Fereastra ActivInspire

Instrumentele Principale

Instrumente de scris

Navigatoarele ActivInspire 

Vizualizare flipchart

Administrare flipcharturi multiple

Crearea pe computer

Prezentarea la tablă

Colaborarea la tablă

Instrumente de explorare

Cele mai frecvent folosite instrumente
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Acasă > Mai multe despre ActivInspire > Personalizarea profilurilor

Personalizarea profilurilor
ActivInspire are o gamă atent gândită de meniuri, setări și moduri de lucru implicite, care vă oferă rezultate consecvente de fiecare 
dată când lucrați cu flipcharturi.

Cu toate acestea, ceea ce obțineți poate să nu fie exact ceea v-ați dorit. Dacă ați mai folosit înainte un software creativ, este posibil 
să fiți familiarizați cu schimbarea setărilor și opțiunilor pentru a se potrivi nevoilor dumneavoastră. În ActivInspire numim acest lucru 
crearea unui profil.

Vedeți mai multe în:

Despre profiluri

Crearea și comutarea profiluri
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Acasă > Turul ActivInspire > Exporați ActivInspire Studio > ActivInspire's Browsers > Page Browser

Navigatorul de Pagini
Acest navigator vă ajută să puneți rapid baza unui flipchart.

Folosiți Navigatorul de Pagini pentru:

• Vizualizarea întregului flipchart ca miniaturi de pagină
• Navigarea printre paginile flipchartului
• Setarea fundalului și grilelor pentru pagini
• Organizarea paginilor din flipchart folosind drag & drop (trageți și plasați) sau comenzile Decupează (Cut), Copiază (Copy), 
Șterge (Delete) și Duplică (Duplicate)

Exemple

Imaginea din dreapta prezintă un flipchart cu mai multe 
pagini.
Navigatorul de Pagini este deschis și arată miniaturi ale 
primelor două pagini din flipchart.         Pictograma Meniu 
Popup din miniatură indică că aceasta este pagina 
curentă. Asta înseamnă că puteți selecta un element sau 
zonă din pagină și să lucrați.
Pentru a afișa o altă pagină, apăsați pe miniatură.
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire > Navigatorul de Resurse

Navigatorul de Resurse
Acest navigator vă ajută să vizualizați, navigați și utilizați facil resursele furnizate de ActivInspire pentru a vă crea flipcharturile. 
Biblioteca de Resurse conține o gamă largă de jocuri și activități, adnotări, evaluări, fundaluri, hărți conceptuale, imagini, forme, 
sunete și alte elemente prea numeroase pentru a fi enumerate. 

Puteți îmbogăți cu ușurință biblioteca cu resursele proprii și ale altor persoane și puteți adăuga pachete de resurse de pe website-ul 
Promethean Planet www.prometheanplanet.com sau de la partenerii noștri.

Utilizați Navigatorul de Resurse pentru: 

• Navigare rapidă și vizualizare a tuturor resurselor dintr-un anumit folder, de exemplu Resursele Mele, Resurse Partajate sau 
altele locații din memorie sau în rețea. 
• Afișarea miniaturilor și numelor de fișiere ale resurselor selectate din navigator.
• Inserarea resurselor, cum ar fi șabloane de pagini, pagini de activitate și pagini de întrebări din navigator în flipchart, prin drag 
& drop.
• Inserarea propriilor creații dintr-o pagină flipchart într-un folder din Biblioteca de Resurse, prin drag & drop. 
• Schimbarea transparenței unei resurse în flipchart. 
• Crearea rapidă a mai multor copii ale unei resurse într-un flipchart, cu ajutorul Rubberstamp.

Exemplu

Implicit, Navigatorul de Resurse deschide fișierul Shared Resources. Toate resursele ActivInspire sunt organizate pe categorii 
și stocate în fișiere denumite clar.

Imaginea din dreapta prezintă câteva dintre resursele din fișierul Shared Resources.

Apăsați pe pictogramele de sus pentru a căuta resurse în următoarele locuri:

• Resursele Mele (My Resources)
• Resurse Partajate (Shared Resources)
• Alt fișier cu resurse
• Alt fișier din computer
• Promethean Planet

Secțiunea din partea de sus a Navigatorului arată fișierele. 
Meniul Popup vă permite să importați și exportați Pachete de Resurse.

           Funcția de import este disponibilă doar din Meniul Popup a folderului principal.
Secțiunea din partea de jos arată miniaturile resurselor din acel fișier și denumirile lor.

De acolo puteți:

• Schimba dimensiunea și aspectul miniaturilor resurselor.
• Insera resurse din Biblioteca de Resurse în flipchart.
• Șterge resurse din Biblioteca de Resurse.

Zona dintre cele două secțiuni arată numărul de elemente din fișierul selectat.
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Conține, de asemenea, două instrumente folositoare 
pentru copierea și modificarea resurselor:

    Modificați transparența (Toggle Transparency) vă permite 
să faceți transparent fundalul unei imagini atunci când o trageți în 
pagină.

   Multiplică (Rubberstamp) vă permite să inserați rapid mai 
multe copii ale unei resurse în flipchart

Înapoi sus
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Home > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire > Navigatorul de Obiecte

Navigatorul de Obiecte
O introducere despre obiecte și Navigatorul de Obiecte:

Despre obiecte

Despre straturi și suprapunere

Vizualizare obiecte

Lucrul cu obiecte 

Examplu

Despre obiecte
În ActivInspire, tot ce adăugați într-un flipchart este un obiect de un fel sau altul. De exemplu, dacă scrieți ceva cu          Stiloul (Pen), 
desenați o formă, adăugați o imagine sau o legătură spre un fișier audio, oricare dintre aceste elemente sunt obiecte. Puteți adăuga 
multe tipuri diferite de obiecte într-un flipchart. Navigatorul de Obiecte vă ajută să urmăriți numărul și tipul de obiecte din flipchart și să 
luați cu ușurință obiecte dintr-un flipchart creat de altcineva.

Despre suprapunerea obiectelor
Navigatorul de Obiecte arată detalii despre obiectele de pe pagina curentă. Deși o pagină este un plan drept, o pagină flipchart are de 
fapt 4 straturi! Acestea sunt ca niște foi transparente care conțin anumite tipuri de obiecte, asta dacă nu mutați obiecte de pe un strat 
pe celălalt. Într-un layer puteți suprapune obiecte.

Implicit:

Conține...

Adnotări: tot ce desenezi cu          Stiloul,          Evidențiatorul sau          Cerneala Magică, 
un instrument secret despre care vom vorbi mai târziu

Imagini, forme și obiecte text.

Acest strat...

Superior (Top)

De mijloc (Middle)

Inferior (Bottom)

Fundal (Background)

Tot ceea ce desenezi cu           Conectorul, dar puteți plasa și alte obiecte pe acest 
strat, cu drag & drop.

Fundaluri, grile și culoarea paginii.

Selectați obiectele listate în Navigatorul de Obiecte pentru a le putea insera în primele trei straturi din navigator, dar nu în stratul de 
fundal. Acest lucru influențează direct stratificarea lor pe pagina flipchart. Straturile sunt complet separate unul de celălalt. Cu alte 
cuvinte, puteți înlocui fundalul fără a vă afecta imaginile sau adnotările. Sau puteți adnota peste fotografii și fundal fără a afecta alte 
straturi.

Pentru mai multe detalii, vedeți Folosirea straturilor și suprapunerii.

Vizualizare obiecte
Utilizați Navigatorul de Obiecte pentru a vizualiza rapid:

• Ordinea de afișare a obiectelor și ce obiecte se află în straturile superior, de mijloc și inferior ale 

unei pagini.

• Care obiecte sunt grupate împreună. Acest lucru vă permite să lucrați la toate în același timp.

• Dacă o pagină conține obiecte ascunse.
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• Dacă o pagină conține obiecte care sunt blocate astfel încât să nu poată fi mutate.

Lucrul cu obiecte
Utilizați Navigatorul de Obiecte ca să

• Mutați obiecte dintr-un strat în altul, cu drag& drop
• Grupați, suprapuneți și reordonați obiecte.
• Afișați sau ascundeți obiecte.
• Blocați sau deblocați obiectele selectate, de exemplu, dacă planificați o activitate cu elevii în care doar anumite 
obiecte pot fi mutate, iar altele trebuie să rămână fixe.

Înapoi sus

Exemplu

Imaginea din dreapta prezintă detalii despre 
obiectele din pagina curentă a flipchartului. 
Puteți vedea în Navigator că toate 
obiectele sunt identificate prin:

• Pictograma instrumentului prin 
care au fost create
• Numele lor.  

Navigatorul arată clar ce obiecte sunt pe 
fiecare strat: 

Există opt obiecte în stratul superior. 
Acestea sunt adnotările 
scrise cu stiloul 

Există patru obiecte în stratul de mijloc:
 
Textul creat cu Instrumentul de Text

Remarcați lacătul        de lângă obiectul Text din Navigator. Aceasta indică faptul că obiectul a fost fixat. Lacătul este un 
comutator care permite blocarea și deblocarea rapidă a obiectelor.

Triunghiul și pătratele create cu Instrumentul Forme        sunt implicit în stratul de mijloc. Remarcați pictograma cu ochiul tăiat 
lângă obiectul din Navigator. Acest lucru indică faptul că triunghiul este un obiect ascuns. După cum puteți vedea pe pagina 
flipchart, triunghiul nu este vizibil. Pictograma ochi este un comutator care permite afișarea și ascunderea rapidă a obiectelor.

Există un singur obiect în stratul inferior, un pătrat creat cu Instrumentul Forme. În Navigatorul de Obiecte, am tras acest obiect 
în jos din stratul de mijloc, unde a fost creat.

Fundalul galben al paginii  se află în propriul strat. Am inserat acest fundal cu Navigatorul de Pagini.

Înapoi sus
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire > Navigatorul de Notițe

Navigatorul de Notițe
Acest Navigator vă ajută să faceți flipchartul și mai ușor de utilizat, permițându-vă să creați, vizualizați și editați notițe despre 
flipcharturi. Puteți folosi aceste notițe în ce fel doriți. Veți învăța din experiență că notițele pot face diferența între o lecție neinspirată și 
una care decurge minunat. Vă încurajăm să folosiți Navigatorul de Notițe la potențial maxim pentru a îmbunătăți experiența de predare 
cu ActivInspire.

Folosiți Navigatorul de Notițe ca să:
• Adăugați propriile notițe și comentarii la un flipchart, făcându-l mai ușor de partajat și refolosit.

• Dacă folosiți un flipchart creat de altcineva:

o Vizualizați notițele și comentariile altor profesori despre flipchart și adăugați propriile notițe unde este adecvat.
o Vizualizați notițe de la autori despre cum să le folosiți mai bine flipcharturile și adăugați propriile notițe unde este 
adecvat.

Exemplu

Imaginea din dreapta prezintă Navigatorul de Notițe. Puteți 
introduce notițele ca text simplu sau puteți deschide 
Instrumentele de Formatare (Format Toolbar) și formata textul.

ActivInspire afișează pictograma           Notițele Paginii (Page 
Notes) în Bara de Meniu dacă pagina curentă conține notițe.

Puteți adăuga notițe la fiecare pagină a unui flipchart și le 
puteți printa, fie odată cu paginile flipchartului, fie separat.
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire > Navigatorul de Proprietăți

Navigatorul de Proprietăți
Acest Navigator vă ajută să vizualizați rapid proprietățile unui obiect. Este un instrument puternic pentru a adăuga facil 
interactivitate lecțiilor.

Folosiți acest Navigator pentru a:

• Afișa toate proprietățile unui obiect. Glisați bara verticală a Navigatorului în sus și în jos pentru a vizualiza întreaga gamă de 
proprietăți disponibile.
• Vizualiza și modifica poziția și modul de afișare a unui obiect schimbându-i setările din Navigatorul de Proprietăți. Desigur, 
puteți controla în continuare poziția unui obiect cu drag & drop și îl puteți edita pentru a-i schimba culoarea.
• Adaugă caracteristici interactive la flipchart și controlați cum pot fi utilizate.
• Adăuga etichete vizibile permanent la obiecte sau etichete care apar doar când treceți cu cursorul mouse-ului peste obiect
• Controla comportamentul unui obiect prin definirea unor reguli numite restricții, care influențează mutarea acestuia. Această 
opțiune este folositoare, de exemplu, dacă doriți să creați propriul joc pe ecran.
• Toate proprietățile sunt clasificate clar ca sa puteți selecta proprietățile în funcție de tip.

Exemplu

Imaginea din dreapta prezintă câteva 
dintre proprietățile pătratului roșu, 
obiectul selectat. Puteți vedea numele 
obiectului și câteva detalii despre 
poziția pe pagină. Puteți vedea de 
asemenea că pătratul este în stratul 
de mijloc. 

Pe pagina flipchart, puteți vedea de 
asemenea Punctele pentru 
Redimensionare care înconjoară 
obiectul. Acestea indică că puteți 
muta obiectul sau îl puteți 
redimensiona. Rândul de pictograme 
pătrate care apar de-a lungul 
obiectului reprezintă Meniul de 
Editare al Obiectului pentru a putea 
lucra cu obiectul. 
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire's Browsers > Navigatorul de Acțiuni

Navigatorul de Acțiuni
Acest Navigator vă ajută să asociați rapid un obiect cu o acțiune. Acest lucru înseamnă că atunci când obiectul este selectat, acțiunea 
asociată cu acesta va avea loc. De exemplu, o panglică va apărea afișând un mesaj sau se va auzi un fișier audio sau va începe un 
vot pe flipchart. Toate acțiunile sunt clar clasificate, ca să puteți selecta acțiunile după tip. Puteți seta oricâte acțiuni în flipchart pentru 
a face lecția cât de variată și interactivă doriți. 

Folosiți Navigatorul de Acțiuni ca să:

• Aplicați o comandă de acțiune unui obiect, de exemplu,           Aruncarea Zarurilor (Dice Roller), pentru ca până la 5 
zaruri să fie aruncate atunci când cineva selectează un anumit obiect pe tablă.
• Aplicați unui obiect o acțiune pentru pagină, de exemplu, pentru a trece la pagina următoare.
• Aplicați unui obiect o acțiune pentru obiect, de exemplu, pentru a modifica dimensiunea, poziția sau transparența unui 
obiect.
• Aplicați unui obiect o acțiune media sau document, de exemplu, pentru a insera o legătură către un fișier sau un website.
• Aplicați unui obiect o acțiune de votare, de exemplu pentru a porni sau opri un Vot pe Flipchart.
• Eliminați o acțiune care nu mai este necesară.
• Previzualizați o acțiune pentru a verifica dacă se comportă cum vă doriți

Exemplu

Imaginea din dreapta prezintă Navigatorul 
de Acțiuni. Am asociat         Aruncătorul 
de Zaruri cu pătratul albastru. Știm că o 
acțiune este asociată cu acest obiect 
pentru că atunci când trecem cursorul 
peste obiect apare o pictogramă de 
Previzualizare.

Când apăsați pe pătrat, fereastra popup a 
Aruncătorului de Zaruri se deschide și 
zarurile se învârt.

Puteți:

• Alege numărul de zaruri.
• Crește sau scădea viteza.
• Arunca zarurile de câte ori doriți.
• Trimite numărul de aruncări pe 
flipchartul curent.

Aruncați zarurile!
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Aveți nevoie de ActivInspire Professional pentru a folosi Navigatorul de Acțiuni.

Înapoi sus

Aruncați zarurile!
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Acasă > Turul ActivInspire > Explorați ActivInspire Studio > Navigatoarele ActivInspire > Navigatorul de Votare

Navigatorul de Votare
Acest navigator vă ajută să administrați toate aspectele înregistrării dispozitivelor ActivSlate, ActiVote și ActivExpression, să 
porniți sesiuni de vot, dar și să le înregistrați, stocați și căutați rezultatele unei astfel de sesiuni. 

Folosiți Navigatorul de Votare ca să:

• Înregistrați dispozitivele ActivSlate, ActiVote și ActivExpression.
• Repartizați elevii pe dispozitive.
• Comutați între votul anonim sau cu nume.
• Selectați între dispozitivele ActiVote sau ActivExpression pentru o sesiune de vot.
• Setați, suspendați sau schimbați timpul permis pentru răspunsuri.
• Porniți și opriți votul.
• Afișați sau ascundeți mesajul Votați Acum (Vote Now)
• Căutați rezultate ale sesiunilor de vot și să le exportați într-o foaie de calcul Microsoft Excel.

Pentru detalii despre înregistrarea dispozitivelor și folosirea lor în sesiunile de vot, 
vedeți Folosirea Sistemelor de Răspuns pentru Elevi.
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă

Lucrul la tablă
În această secțiune descriem cum puteți profita la maximum de Instrumentele de Prezentare ActivInspire în timp ce lucrați la tablă

Verificare prealabilă

Adnotări pe Desktop

Utilizare Instrumente Desktop 

Utilizare Cameră

Utilizare Ceas

Utilizare Recunoaștere scris de mână 

Utilizare Recunoaștere Formă 

Utilizare Cerneală Magică

Utilizare Panglică cu mesaje

Lucrul în modul Utilizator Dual 

Utilizare tastatura pentru ecran 

Utilizare Reflector

Utilizare Blocare Acces

Utilizare Instrumente Matematice
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Acasă > Mai multe despreo ActivInspire > Lucrul la tablă> Lucrul în modul Utilizator Dual

Lucrul în modul Utilizator Dual
Această secțiune explică modul Utilizator Dual și interactivitatea oferită de această caracteristică:

Conceptul

Pedagogia

Ce aveți nevoie

Cum funcționează

Truse de instrumente suplimentare ActivInspire Primary

Reguli de interactivitate

Dezactivare mod Utilizator Dual

Conținut pentru modul Utilizator Dual

Conceptul
Tehnologia Promethean sprijină interacțiunea adevărată dintre mai mulți utilizatori și operațiuni multiple care se desfășoară în același 
timp. Aceasta duce ideea de multi-utilizator la un nou nivel. Utilizatorii individuali sunt diferențiați în sistemul Promethean și, pe lângă 
funcțiile oricărui alt tip de suprafață de tip touch, știe și cine este profesorul și cine sunt elevii.

Pedagogia
Abordarea Promethean oferă un model de tablă interactivă total nou, care deschide o nouă lume de ușurință în administrare și 
oportunități pedagogice de predare și învățare avansate.

Beneficiile în momentul folosirii de doi sau mai mulți utilizatori:

• Nu este tehnic – la fel de ușor ca doi oameni care desenează pe o foaie mare de hârtie.
• Le permite elevilor să lucreze în același timp pe ecran și în aceeași aplicație (special dezvoltată) – la toate celelalte 
sisteme utilizatorii trebuie să facă cu rândul.
• Utilizatorii pot colabora pentru a rezolva probleme și puzzle-uri.
• Utilizatorii pot concura în timp real.
• Permite folosirea în echipe.
• Crește productivitatea la tablă.
• Profesorii pot lucra cu un elev oferindu-i ajutor și sfaturi și pot explora idei fără să schimbe stiloul sau rolurile

Ce aveți nevoie
Pentru a activa modul Utilizator Dual trebuie să vă asigurați că îndepliniți următoarele condiții hardware și software:

• ActivBoard v3 sau ActivBoard v2 actualizat (care conține firmware ActivBoard v2.3 sau mai nou)
• Dual User ActivPens (Stilou Profesor și Stilou Elev)
• Dual User activat de ActivDriver
• ActivInspire

Pentru mai multe informații despre cerințele hardware și software, contactați Quartz Matrix.

Cum funcționează
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Funcționalitatea Utilizator Dual a ActivInspire este disponibilă atunci când softul detectează o tablă ActivBoard cu Utilizator Dual 
conectată la computer. Dacă nu nu se întâmplă acest lucru, funcționalitatea Utilizator Dual nu este disponibilă cu ActivInspire.

Această secțiune este scrisă cu presupunerea că modul Utilizator Dual este disponibil.

Modul Utilizator Dual este conceput în jurul conceptelor de Stilou Profesor și Stilou Elev: 

Stilou Profesor

Stilou Elev

Implicit, când modul Utilizator Dual nu este disponibil, atât Stiloul Profesorului, cât și Stiloul Elevului se comportă ca simple 
intrări standard ActivPens și le puteți folosi pe oricare dintre ele, dar pe rând.

Cu oricare dintre stilouri puteți activa funcționalitățile Utilizator Dual, după cum urmează:

• Din Meniul Principal, selectați Tools > Dual User

Când Dual User este activat, este afișat un al doilea set de instrumente, pentru elev:

Instrumente Elev (ActivInspire 
Studio)

Instrumente Elev (ActivInspire 
Primary)

Când este activat modul Utilizator Dual:

• Stiloul Elevului poate fi folosit doar pentru anumite acțiuni:

•  Poziționarea setului de Instrumente Elev.
•  Selectarea și folosirea instrumentelor din Instrumente Elev pe pagina flipchart.
•  Interacționarea cu conținutul de pe pagina flipchart.
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• Stiloul Profesorului va putea controla în continuare funcționalitățile ActivInspire, cu excepția că nu poate fi folosit pentru a 
interacționa cu Instrumentele Elevului.

• Mouse-ul computerului nu poate interacționa cu materialul flipchart sau Instrumentele Elevului, dar poate controla în continuare 
celelalte aspecte ActivInspire.

Setul de Instrumente 
pentru Elev oferă 
următoarele 
instrumente....

Cu acestea elevul poate să...

Selectați 
Mută și redimensionează obiecte de pe pagină.

Stilou
Facă adnotări pe pagină.

Evidențiator
Evidențieze zone de pe pagină.

Umplere 
Umple obiecte de pe pagină.

Formă Adauge forme pe pagină.

Conector Conecteze obiecte de pe pagina.

Recunoaștere 
Scris de Mână Adauge obiecte de text identificate pe pagină.

Adauge forme identificate pe pagină.

Aceste instrumente se comportă la fel ca instrumentele standard pentru intrarea cu un singur stilou.

Pentru detalii, vedeți secțiunile individuale despre aceste instrumente în acest document de ajutor.

Este important să înțelegeți că orice activitate realizată cu Stiloul Elevului poate apărea pe pagină independent sau 
simultan cu activitatea realizată cu Stiloul Profesorului.

Prin urmare, aceasta oferă numeroase tipuri de activități de colaborare, inclusiv

• Profesorul și elevul scriu împreună.
• Profesorul scrie și elevul evidențiază anumite cuvinte.
• Profesorul scrie, iar elevul selectează și mută obiecte.
• Profesorul și elevul mută, redimensionează, rotesc, inserează obiecte.

Toate acțiunile și proprietățile obiectelor din pagină, cum ar fi containerele și restricțiile, se aplică atât Stiloului 
Profesorului, cât și Stiloului Elevului.

Truse de instrumente suplimentare ActivInspire Primary

Recunoaștere Formă
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Modul Utilizator Dual din interfața ActivInspire Primary oferă câteva seturi de instrumente suplimentare.

Când este selectat          Stilou cu Stiloul Elevului, Trusa Stiloul Elevului este afișată în zona Truse, permițându-i elevului să 
selecteze stilouri, evidențiatoare și culori:

Când este selectat Instrumentul de Umplere cu Stiloul Elevului, Trusa de Umplere pentru Elev este afișată în zona de Truse, 
permițându-i elevului să selecteze culoarea de Umplere:

Aceste truse vor apărea alături de celelalte truse utilizate în acel moment de Stiloul Profesorului. 

Reguli de interactivitate
Când lucrați în modul Utilizator Dual, ActivInspire impune următoarele reguli de interactivitate:

• Stiloul Profesorului nu poate selecta Instrumentele Elevului. Stiloul Elevului nu poate selecta Instrumentele Profesorului.
• Nicio fereastră Inspire sau de dialog (de exemplu, cele pentru Ceas sau Aruncarea Zarurilor) nu pot fi accesate cu Stiloul 
Elevului.
• Când selectați un obiect din pagină (sau obiecte) cu unul dintre stilouri și sunt afișate opțiunile de editare, aceste obiecte nu 
mai pot fi accesate de celălalt stilou. Această regulă este valabilă până ce opțiunile de editare sunt închise, prin orice mijloace. 
Cu alte cuvinte, fiecare stilou poate defini selecția independentă de opțiuni de editare, care sunt inaccesibile celuilalt stilou. 
• Dacă un stilou interacționează cu un obiect de pe pagină, de exemplu, primul stilou ține un obiect, al doilea stilou nu poate 
interacționa cu acest obiect până ce primul stilou nu eliberează obiectul.
• Instrumentul Forme             al Elevului nu afișează Instrumentele Elevului. Setul de Instrumente pentru Forme trebuie să fie 
afișat de Instrumentul Forme al Profesorului, de unde și Stiloul Elevului și al Profesorului pot selecta forme din Setul de 
Instrumente pentru Forme. Amândouă stilourile vor folosi întotdeauna ultima formă utilizată de fiecare stilou.
• Când Stiloul Elevului folosește Instrumentul Recunoaștere Scris de Mână, niciun cuvânt alternativ nu este 
furnizat odată ce cuvântul este recunoscut (spre deosebire de Stiloul Profesor).
• Dacă se scrie cu ambele stilouri, ordinea de suprapunere a adnotărilor este definită de ordinea evenimentelor de scriere. Prin 
urmare, dacă Stiloul 2 este in procesul de desenare a unei adnotări, Stiloul 1 poate mereu să deseneze pe deasupra acestei 
adnotări (și invers).
• Dacă sunt afișase pe pagină două Instrumente Matematice (de exemplu riglă, compas, raportor), fiecare stilou poate 
interacționa cu propriul instrument matematic.
• Când folosiți ActivInspire, pozițiile truselor Elevului sau Profesorului depind de pozițiile Seturilor de Instrumente ale Elevului și 
Profesorului. Dacă Instrumentele Profesorului sunt la dreapta Instrumentelor Elevului, atunci trusele corespunzătoare vor 
apărea în aceeași ordine.

Dezactivare mod Utilizator Dual
Când modul Utilizator Dual este activat, puteți folosi Stiloul Profesorului sau mouse-ul computerului pentru a opri modul Utilizator 
Dual, după cum urmează:

Din Meniul Principal, selectați Tools > Dual User. Odată ce Utilizator Dual este oprit, amândouă stilourile revin la funcțiile standard, 
adică folosirea unui singur stilou o dată (condiția implicită).
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Conținut pentru modul Utilizator Dual
Pe toate paginile se poate lucra în modul dual, individual sau secvențial. Utilizatori multiplii nu va fi o condiție prealabilă pentru 
utilizarea paginilor, totuși, paginile utilizate în acest mod vor fi cele mai eficiente datorită naturii învățării colaborative și beneficiilor sale.

Criteriile pentru șabloanele multi-utilizator sunt următoarele

• Șabloane de activități pe care elevii le pot folosi ca punct central pentru colectarea informațiilor, schimbul de idei și discuții.
• Șabloane de activități în care elevii pot lucra împreună pentru a opera sau interacționa cu elementele paginii pentru a construi 
și a consolida cunoștințele.
• Șabloane de activități care promovează abilități de gândire de ordin superior, încurajând elevii să se gândească la concepte în 
moduri mai avansate sau mai complexe (de la nivelurile de bază ale gândirii la niveluri mai complexe de analiză, sinteză și 
evaluare).
• Șabloane de activități care permit finalizarea în sincron a activităților identice sau similare - cu sau fără un element competitiv, 
conform preferințelor profesorului.
• Șabloane de activități care permit exerciții comune de creativitate.
• Șabloane de activități care servesc la îmbunătățirea înțelegerii atunci când sunt utilizate ca parte centrală a învățării - pentru a 
încuraja implicarea și interacțiunea elevului cu conceptele, dar și unul cu celălalt, și nu neapărat interacțiunea cu instrumentele 
(interacțiune tehnică versus conceptuală).
• Activități care utilizează tehnica „Spate-în-Spate” în sarcini de colaborare sau competitive

Există o mulțime de șabloane de pagini pentru utilizatori multipli și activități cu mai mulți utilizatori care se găsesc 
în subfolderele din Librăria de Resurse Partajate (Shared Resources):

Shared Resources > ActivInspire
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Acasă > Referințe > Instrumente > Înregistrare Sunet

Înregistrare Sunet (Sound Recorder)

Ce? Vă permite să capturați o înregistrare audio (discurs sau/și muzică) într-un fișier, 
folosind funcțiile de înregistrare ale computerului.

Unde? • Main Menu > Tools > More Tools > Sound Recorder

• Instrumentele Desktop (Desktop Tools)

Comandă rapidă? CTRL+Shift+R (WindowsTM & LinuxTM)

Cmd+Shift+R (Mac®)

Cum? În Setul de Instrumente Înregistrare Sunet, apăsați pe pictograma roșie Record 
pentru a începe înregistrarea sunetului. Puteți folosi opțiunile Pause sau Stop în 
orice moment.

Pentru a înregistra un discurs, trebuie să vă asigurați că aveți un microfon 
corespunzător conectat la sistem. Pentru mai multe informații, vedeți fișierele Ajutor 
pentru Sistemul de Operare.

Ce puteți personaliza? Adăugare în Flipchart 
(Add To Flipchart)

Adaugă o pictogramă de sunet în pagina flipchart când se 
termină înregistrarea. Apăsați pe pictogramă, cu opțiunea 
Enable Actions activată, pentru a reda înregistrarea.

Salvează în computer 
(Save To Disk)

Când apăsați pe pictograma Record, ActivInspire vă 
solicită să specificați un nume pentru fișier și locația în 
care se va salva, înainte de a începe înregistrarea.

Ambele (both) Ambele opțiuni de mai sus.

Cum puteți personaliza? Settings > Recordings > Sound Recordings

Mai multe informații...
Mai multe descpre ActivInspire> Lucrul cu obiecte > Inserare referințe 

multimedia > Setări > Înregistrări
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Acasă > Referințe> Instrumente> Înregistrare Ecran

Înregistrare Ecran (Screen Recorder)

Ce?? Înregistrarea acțiunilor de pe un flipchart, desktop flipchart, desktop sau altă 
aplicație, salvarea lor ca fișiere .avi, apoi redarea lor ca animații.

Unde? • Main Menu > Tools > More Tools > Screen Recorder

• Instrumentele Desktop (Desktop Tools)

Cum? Apăsați pe butonul roșu Record și scrieți un nume pentru fișier. Alternativ, selectați 
inițial formatul video și compresia audio, apoi începeți înregistrarea. Apăsați pe 
butonul negru Stop pentru a opri înregistrarea. 

Ce puteți personaliza? În Meniul Înregistrare Ecran (Screen Recorder Menu):

Compresie Video 
(Video Compression)

Pentru a economisi spațiu de stocare, alegeți unul dintre 
programele de compresare video compatibile instalate pe 
computer.

Format Audio 
(Audio Format)

Alegeți mono sau stereo și calitatea înregistrării. Cu cât 
sunt mai mulți kilobiți pe secundă, cu atât este mai bună 
calitatea sunetului și fișierul este mai mare.

În secțiunea Recordings din Settings:

Rata de captură a 
cadrelor (Capture 
Frame Rate)

Implicit = 5

Rata de captură a cadrelor pe secundă (1-10).
Cu cât sunt mai multe cadre, cu atât calitatea video este 
mai bună și fișierul este mai mare.

Înregistrare audio
(Record audio)

Implicit. Dacă aveți echipament audio corespunzător, 
se va înregistra atât video, cât și audio.

Înregistrare doar video.

Captură rapidă 
Quick capture)

Selectați când înregistrați activități în care mișcați 
cursorul de multe ori peste zone statice mari. De 
exemplu, un demo de soft.

 Implicit.

Captură cursor 
mouse (Capture 
mouse pointer)

Implicit. Înregistrați mișcările cursorului în video.

Nu înregistrați mișcările cursorului.

Captură ferestre 
stratificate 
(Capture layered 
windows)

 Ferestrele stratificate sunt folosite de aplicații pentru a 
crea ferestre translucide. De exemplu, imaginea 
translucidă care apare când mutați o pictogramă cu drag 
& drop pe desktop. 

Selectați când înregistrați din aplicații care folosesc 
ferestre stratificate
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Cursorul poate clipi în timpul înregistrării, dar 
acest efect nu va apărea în videoclip.

Implicit.

Dezactivare creștere 
viteză hardware în 
timpul înregistrării 
(Disable hardware 
acceleration during 
recording)

 Implicit.

 Viteza hardware îmbunătățește performanța graficii 3D 
de pe computer, dar poate afecta performanța 
Înregistrării Ecranului.

Selectați ca să dezactivați creșterea vitezei la începutul 
înregistrării și restabiliți la finalizarea înregistrării.

Ascundere set de 
instrumente de 
înregistrare în timpul 
înregistrării (Hide 
screen
recorder toolbox
whilst recording)

Ascundeți setul de instrumente de Înregistrare 
Ecran la începutul fiecărei înregistrări noi.

 Când setul este ascuns, înregistrarea poate fi

           oprită apăsând pe pictograma Înregistrare Ecran 
(Screen Recorder).

 Implicit. Înregistrare Ecran este afișat în timpul 
înregistrării, astfel că puteți opri, pune pauză sau 
reporni înregistrarea.

Unde se pot personaliza? • Meniul Înregistrare Ecran (Screen Recorder Menu)

• Edit Profiles > Settings> Recordings

Mai multe informații... Mai multe despre ActiveInspire > Lucrul cu obiecte > Inserare multimedia
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Acasă > Referințe > Instrumente > Panglică cu mesaje

Panglică cu mesaje

Ce? Vă permite să creați și afișați mesaje text care se derulează pe ecran peste 
prezentare. Panglicile pot fi create, editate, salvate ca fișiere și refolosite.

Unde? •Tool Menu > More Tools > Tickertape

•Instrumentele Desktop (Desktop Tools)

Comandă rapidă? CTRL+Shift+T (WindowsTM & LinuxTM)

Cmd+Shift+T (Mac®)

Cum? Când selectați acest instrument, un nou mesaj, implicit, se derulează pe display. 
Puteți folosi fereastra “Tickertape Edit” pentru a introduce mesajul și a-i schimba 
proprietățile. Folosiți Tickertape File Menu pentru a salva și încărca panglici.

Ce pot personaliza? Proprietățile panglicii, cum ar fi culoarea și viteza.

Unde pot să o personalizez? Fereastra “Tickertape Edit”

Mai multe informații Mai multe despre ActivInspire > Lucrul cu obiecte > Utilizare Panglică cu mesaje
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Acasă > Referințe > Instrumente > Ceas

Ceas(Clock)

Ce? Ceasul clasei, activități și competiții contra timp.

Unde? • Tools > More Tools > Clock

• Instrumentele Desktop (Desktop Tools)

Comenzi rapide? Reflector Cirular (vezi descrierea de mai jos):

CTRL+Shift+U (WindowsTM & LinuxTM)

Cmd+Shift+U (Mac®)

Cum? Setați afișajul, alegeți numărătoare sau numărătoare inversă, după cum doriți:

Ce pot personaliza? Afișează ceas analog

Afișează ceas digital

Afișează atât ceas analog, cât și digital

Comutator. Pune pauză sau repornește ceasul.

Deschide fereastra de dialog 
“Clock Counter” (Numărătoare)

• Interval numărătoare/ numărătoare inversă
• Repetare numărătoare/ numărătoare inversă
• Resetare
• Redare sunet la expirarea timpului
• Efectuare acțiune la expirarea timpului

Unde pot să personalizez? • Caseta Ceas (Clock Box)

• Edit Profiles > Settings> Clock Tool

Mai multe informații...
Utilizare Ceas

Setări > Instrumente

Lucrul cu acțiuni

Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Camera

Cameră (Camera)

Ce? Faceți o captură de pe ecran – aceasta poate fi o imagine de pe un website sau flipchart, 
de exemplu.

Unde? • Tools > Clock

• Instrumentele Desktop (Desktop Tools)

Comandă rapidă? Captură Zonală (vezi descrierea de mai jos): 

CTRL+Shift+K (WindowsTM & LinuxTM)

Cmd+Shift+K (Mac®)

Cum? Alegeți tipul de captură din meniul dropdown, apoi alegeți destinația pentru captură din 
Camera Snapshot Box (Caseta Captură Cameră).

Captură Zonală 
(Area Snapshot)

O casetă evidențiată este afișată. Apăsați în interiorul 
casetei și glisați ca să o mutați – schimbați dimensiunile 
glisând marginile. Pentru ajustarea fină, utilizați comenzile 
de poziție din Caseta Instantaneu Cameră.

Captură între două 
puncte (Point to 
Point Snapshot)

Apăsați și trageți, trasând linii drepte pentru a contura o 
zonă cu marginile evidențiate pe ecranul gri. Zona de 
captură nu poate fi mutată sau modificată – dacă greșiți, 
doar închideți “Caseta Captură Cameră” și încercați din 
nou. Camera este activată când conturul este complet.

Captură fără formă 
(Freehand Snapshot)

Apăsați și trageți, desenând cu mâna liberă, pentru a 
contura o zonă cu marginile evidențiate pe ecranul gri. 
Zona de captură nu poate fi mutată sau modificată – dacă 
greșiți, doar închideți “Caseta Captură Cameră” și încercați 
din nou.

Captură de fereastră Capturați ferestre de dialog sau fereastra ActivInspire.

Captură ecran complet Capturați întregul ecran.

Alegeți destinația:

Pagina Curentă 

Pagină Nouă O pagină nouă, care este inserată după pagina curentă.

Clipboard

Resursele Mele 
My Resources sau Shared Resources.

Resurse Partajate 
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Mai multe 
informații

Utilizarea camerei
Lucrul cu acțiuni
Acțiuni > Acțiuni de comandă
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Acasă > Referințe> Instrumente > Dezvăluitor

Dezvăluitor

Ce? Dezvăluirea selectivă a anumitor părți din pagina flipchart.

Unde? Tools > Revealer

Comandă rapidă? CTRL+R (WindowsTM & LinuxTM)

Cmd+R (Mac®)

Cum? Dezvăluitorul este un comutator. Dezvăluiți obiectele ascunse apăsând și glisând 
jaluzeaua de sus, de jos, de la stânga sau de la dreapta.

Ce pot personaliza? Culoarea jaluzelei de dezvăluire
Viteza animației (1 la 20 secunde) – pentru utilizare cu ActivRemote

Unde pot să o personalizez? Edit profiles > Effects > Reveal Tool

Mai multe informații...
Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Dezvăluitorul

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Utilizator Dual

Utilizator dual 

Ce? Lucrul colaborativ cu două ActivPens pe ActivBoard versiunea 3 sau ActivBoard 
versiunea 2 actualizată.

Unde? Tools > Dual User

Cum? Porniți modul Utilizator Dual, apoi doi colaboratori pot scrie și lucra simultan pe tablă, 
folosind un Stilou Profesor și Stilou Elev.

Mai multe 
informații...

Lucrul în utlizator dual
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Acasă > Referințe > Instrumente > Stilou

Stilou (Pen)

Ce? Desenare sau scriere adnotări pe tablă

Unde? • Tools > Pen

• Instrumentele Principale (Main Toolbox)

• Instrumentele Duale (Dual Toolbox)

Comandă rapidă? CTRL+P (WindowsTM & LinuxTM)

Cmd+P (Mac®)

Cum? Desenați sau scrieți încet, încercați să aveți un stil cursiv în scriere pentru a 
evita crearea mai multor adnotări mici.

Unde pot personaliza? Setați culoarea și grosimea din Instrumentele Principale (Main Toolbox) 
(ActivInspire Studio) sau din Caseta Stilou (Pen Tray) (ActivInspire Primary).

Mai multe informații
Primii pași cu ActivInspire > Scrierea pe flipchart

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Evidențiator

Evidențiator (Highlighter) 

Ce? Sublinierea unor zone de pe flipchart cu culoare translucidă.

Unde? • Tools > Highlight

• Instrumentele Principale (Main Toolbox) (ActivInspire Studio)

• Caseta Stilou (Pen Tray) (ActivInspire Primary)

• Instrumentele Duale (Dual Toolbox)

• Caseta Stilou Duală (Dual Pen Tray) (ActivInspire Primary)

Comandă rapidă? CTRL+H (WindowsTM and LinuxTM)

Cmd+H (Mac®)

Cum? Trageți cursorul peste zona pe care doriți să o evidențiați.

Unde pot personaliza? Setați culoarea și grosimea din Instrumentele Principale (Main Toolbox) 
(ActivInspire Studio) sau din Caseta Stilou (Pen Tray) (ActivInspire Primary).

 More info...
Primii pași cu ActivInspire > Scrierea pe flipchart

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Desktop Annotate

Adnotări Desktop (Desktop Annotate)

Ce? Scrierea adnotărilor pe dektopul computerului cu Stiloul 
sau Evidențiatorul

Interacționarea cu alte aplicații de pe desktop cu Selectare

Unde? Tools > Desktop Annotate

Comandă rapidă? CTRL+Shift+A (WindowsTM & LinuxTM)

Cmd+Shift+A (Mac®)

Cum? Desktopul computerului devine fundalul paginii flipchart. Setul de Instrumente 
Principale rămâne deschis, ca să puteți selecta instrumente și să salvați sau renunțați 
la modificări pe flipchartul desktop.
Puteți căuta în computer, deschide aplicații și folosi instrumentele ActivInspire pentru 
a crea și modifica adnotări și alte obiecte. Obiectele pe care le creați în flipchart sunt 
o suprapunere peste desktop, nu vor rămâne pe desktop când închideți flipchartul 
desktop.

Dacă salvați flipchartul, acesta nu va include o imagine a desktopului.

Mai multe informații?
Mai multe despre ActivInspire > Lucrul la tablă > Adnotarea pe desktop

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instumente > Mărire și micșorare pagină 

Mărire și micșorare pagină (Page Zoom)

Ce? Mărirea sau micșorarea paginii curente.

Unde? View > Page Zoom

Comandă rapidă? CTRL+Shift+Z (WindowsTM & LinuxTM)

Cmd+Shift+Z (Mac®)

Cum? Clic pe pagină, apăsați și mențineți pentru mărire, clic dreapta pe 
pagină, apăsați și mențineți pentru micșorare.

Mai multe informații...

Turul ActivInspire > Explorați ActivInspire Studio > Vizualizare flipchart

Turul ActivInspire > Explorați ActivInspire Primary > Vizualizare flipchart

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Panou de control

Panoul de control (Dashboard)
Când deschideți 
ActivInspire, după 
alegerea 
preferințelor inițiale, 
primul lucru pe care 
îl vedeți este Panoul 
de Control.

Panoul de Control 
conține scurtături 
spre flipcharturi și 
instrumente 
folositoare pentru 
economisirea 
timpului.

Panoul de Control 
va rămâne deschis 
până îl închideți.

Dacă debifați căsuța “Afișează panoul de control la deschidere” (Show the dashboard window on startup), panoul 
de control nu se va deschide automat data următoare când rulați ActivInspire.
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Fereastra ActivInspire

Fereastra ActivInspire
Când rulați ActivInspire, fereastra ActivInspire se va deschide în spatele panoului de control. 
Aspectul acestei ferestre depinde de mai multe lucruri:

• Preferințele la pornire
• Dacă folosiți ActivInspire Professional sau Personal
• Dacă ați personalizat una din componentele ferestrei

Aici introducem componentele principale ale ferestrei ActivInspire pentru ActivInspire Professional.

ActivInspire Professional
Imaginea de mai jos este o reproducere a ferestrei ActivInspire Professional. Lista din stânga denumește fiecare componentă 
numerotată:

1

2

3

4

5

6

7

8

9

Instrumentele principale

Coș de gunoi

Caseta Stilou

Navigator de pagină

Navigator de Obiecte

Bara de meniu

Numele flipchartului

Meniul contextual

Indicator de pagină

Detalii pentru redimensionare

Pagina flipchart

10

11

Inapoi sus

ActivInspire Personal
ActivInspire Personal nu vă oferă aceeași gamă de instrumente și Navigatoare ca ActivInspire Professional. De exemplu, nu include 

instrumentele            Forme și           Navigatorul de acțiuni.
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ActivInspire window
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Sfat
Căutați pictogramele mici din partea de sus a Navigatoarelor (Browsers), Meniurilor și Seturilor de Instrumente. Ele vă permit să 
personalizați rapid comportamentul unei componente:

Opțiunile Instrumente

Rulați

Fixați Instrumentele

Selectați dintr-un meniu drop-down unde să fie afișat elementul și cât din el să fie vizibil.

Un comutator prin care înfășurați elementul, ca să ocupe mai puțin loc sau pentru a-l 
desfășura din nou.

Un comutator prin care fixați elementul. Acest lucru împiedică ascunderea automată a acestuia 
sau mutarea accidentală.

Pentru a muta un element, apăsați în zona galbenă din partea de sus, trageți-l și plasați-l unde doriți. 

Următoarea dată când deschideți ActivInspire, vă păstra preferințele dumneavoastră. 

Înapoi sus



Main Toolbox
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Instrumentele Principale

Instrumentele Principale
Meniul cu Instrumentele Principale se deschide pe ecran când porniți ActivInspire. Când porniți ActivInspire pentru prima dată, setul de instrumente va conține cele mai populare 
instrumente.
Elementele din Setul din Instrumente Principal sunt doar o selecție din multele instrumente disponibile. Puteți accesa o gamă largă de instrumente din Meniul de Instrumente. Următoarea 
dată când veți deschide ActivInspire, își va aminti unde ați plasat setul de instrumente ultima dată și elementele componente.

ActivInspire
Professional

ActivInspire
Personal

Instrumente

Meniu Principal Schimbați profilul Ștergeți

Pagina anterioară Pagina următoare Resetare pagină

Start/Stop Vot Flipchart Sondaj rapid Anulați

Selectați Instrumente Refaceți

Stilou Umplere Editați butoanele 
definite de utilizator

Forme Conector

Inserați media din fișier Text

Aveți nevoie de ActivInspire Professional dacă doriți să creați propriile forme cu Instrumentul Forme

Preferințe
Puteți păstra setul de instrumente implicit, elimina instrumente sau înlocui unele sau toate cu alte instrumente. Vă puteți defini 
preferințele într-un profil și să le salvați când sunteți mulțumit.
Puteți crea câte profiluri aveți nevoie și să comutați rapid între ele cu pictograma             Schimbați profilul. Pentru detalii despre 
cum să personalizați profilurile, vedeți Personalizarea profilurilor.

Înapoi sus
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Pen Tray

Caseta Stilou (Pen Tray)
Caseta Stilou se deschide în partea de jos a ecranului când apăsați pe           Stilou. Conține instrumentele de bază de care 
aveți nevoie pentru a scrie pe tablă și a face modificări și corecturi rapide. Imaginea de mai jos prezintă Caseta Stilou. Lista din 
stânga denumește fiecare componentă numerotată:

1

2

3

4

5

Evidențiatoare

Stilouri

Radiere

Paleta de culori

Spații pentru culori personalizate
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Acasă >Turul ActivInspire > Explorați ActivInspire Primary > Navigatorul ActivInspire

Navigatoarele ActivInspire
Această secțiune introduce navigatoarele ActivInspire.

Ce este un navigator?
Un flipchart poate avea multe pagini și elemente, fiecare cu o gamă de caracteristici și proprietăți.

ActivInspire face lucrul cu aceste caracteristici și proprietăți simplu, furnizând un Navigator (Browser) pentru fiecare zonă importantă. 

Prin intermediul Navigatoarelor puteți vedea:

• Ce este deja inclus în flipchart
• Ce altceva ați putea adăuga sau optimiza
• Cum să faceți aceste lucruri

Utilizați navigatoarele pentru a construi, rafina și îmbunătăți rapid flipcharturile dvs. și ale celorlalți.Fiecare browser:

• Este structurat pentru a vă oferi informații clare și detaliate despre zona în care navigați.

• Are propriul        meniu pop-up și / sau set de pictograme pentru a vă ajuta să lucrați eficient cu flipchartul.

În plus, puteți mări sau micșora Navigatorul și puteți ajusta nivelul de detalii pe care să îl vizualizați pentru a se potrivi nevoilor dvs.

Ce Navigatoare există?
Sunt 7 navigatoare:

Navigator de pagini

Navigatorde resurse

Navigator de obiecte

Navigator de notițe

Navigator de proprietăți

Navigator de acțiuni

Navigator de vot
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Viewing a flipchart
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Acasă > Turul ActivInspire > Explorati ActivInspire Primary > Vizualizare flipchart

Vizualizare flipchart
Descriem cinci moduri facile de a vizualiza un flipchart:

• Vizualizați câte o pagină

• Previzualizați mai multe pagini odată

• Creșteți și scădeți dimensiunea paginii

• Măriți și micșorați

• Explorați flipchartul

Vizualizați câte o pagină
Două moduri de a vizualiza câte o pagină pe rând:

• Faceți clic pe pictogramele           Pagina următoare și           Pagina anterioară

• Din Meniul Vizualizare, selectați Pagina următoare sau Pagina anterioară.

Când apăsați pe pictograma           Pagina următoare în ultima pagina unui flipchart, inserați automat o 
nouă pagină în flipchart.

  


Previzualizați mai multe pagini odată

Din Instrumentele Principale, 
deschideți Navigatorul de Pagini.

Previzualizați miniaturile paginilor și apăsați pe 
triunghiurile negre de pe rola de film pentru a 
vizualiza celelalte miniaturi. Pentru a afișa o 
pagină în fereastra ActivInpire, apăsați pe 
miniatura ei.

Creșteți și scădeți dimensiunea paginii

În mod implicit, ActivInspire este setat pentru a încadra întreaga pagină flipchart în fereastra ActivInspire. Această opțiune este 
denumită „Best Fit”. Puteți schimba ușor acest lucru din meniul drop-down din colțul din dreapta sus 
al ferestrei.

Apăsați pe triunghiurile mici albe, apoi selectați o opțiune care să se potrivească nevoilor dvs.

Faceți cunoștință cu opțiunea Global (World)!

Dacă selectați o opțiune de vizualizare mai mică de 100%, dimensiunea paginii flipchart va fi proporțional redusă în fereastra 
ActivInspire.
Aceasta deschide o zonă în jurul paginii flipchart numită World. Puteți folosi World ca o mapă, pentru a poziționa temporar 
obiecte în afara limitei paginii flipchart, pentru utilizare ulterioară. Aceste obiecte pot rămâne apoi ascunse atunci când pagina 
este încadrată cu opțiunea Best Fit. De exemplu, lucruri pe care nu doriți să le faceți vizibile elevilor dvs. sau elemente pe care 
doriți să le dezvăluiți într-un anumit moment al lecției.
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Viewing a flipchart
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Măriți și micșorați

Puteți utiliza opțiunea            Page Zoom pentru a mări sau micșora ceea ce vedeți pe flipchart. Page Zoom nu schimbă flipchartul, 
ci influențează doar modul de vizualizare a flipchartului.

Măriți

1. Din Meniul Vizualizare selectați         Page Zoom

2 .Apăsați pe pagină și așteptați un moment. Efectul de mărire începe și continuă până când eliberați ActivPen sau butonul
mouse-ului.

Page Zoom este acum în Setul de Instrumente Rapide.

Micșorați

Cu Page Zoom selectat:

1. Faceți clic dreapta pe pagină.
2.Țineți apăsat butonul.

Dacă faceți dublu-clic pe pagină în timp ce Page Zoom este selectat, scalarea paginii revine la Best Fit.

Explorați flipchartul
Când ați mărit un flipchart până în punctul în care pagina flipchart este mai mare decât fereastra ActivInspire, nu puteți nu mai 
vedeți pagină flipchart completă. 

În această situație puteți explora pagina două moduri: 

• Utilizați barele glisante verticală și orizontală care
apar în jurul paginii

• Utilizați Page Zoom. Atunci când este selectat acest
instrument, în timp ce mișcați cursorul peste pagină, o
pictogramă mânuță este afișată. Dacă faceți clic acum
pe pagina și trageți, puteți naviga în jurul paginii pentru
a vizualiza alte zone. Rețineți că acest comportament
se aplică și atunci când micșorați pagina.



Viewing a flipchart
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Managing multiple flipcharts
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Administrare flipcharturi multiple

Administrare flipcharturi multiple
De fiecare dată când deschideți sau creați un alt flipchart, apare o nouă filă în bara de documente. Puteți lucra cu un număr 
nelimitat de flipcharturi în același timp. 

Pentru a trece de la un flipchart la altul, apăsați pe fila document (Document 
Tab) a flipchartului în care doriți să lucrați. Aceasta devine flipchartul curent.

Flipchartul curent este evidențiat cu galben în fila sa de documente. Pentru a 
închide flipchartul, faceți clic pe X.
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Acasă > Turul ActivInspire  > Explorați ActivInspire Primary> Crearea pe computer

Crearea pe computer
Când lucrați la computer, aveți nevoie de acces rapid la o serie de instrumente pentru pregătirea lecțiilor.

Cel mai rapid mod de a realiza acest lucru este să treceți la profilul Creație (Authoring) furnizat împreună cu ActivInspire:

Apăsați pe              Schimbați profilul și selectați profilul de creație (Authoring) din lista drop-down.

Alternativ, puteți experimenta combinațiile preferate de instrumente și setări, apoi le puteți salva într-un profil.

Pentru mai multe informații despre crearea și lucrul cu profiluri, consultați Perzonalizarea profilurilor.
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Acasă  > Turul ActivInspire > Explorați ActivInspire Primary > > Cel mai frecvent folosite instrumente

Cel mai frecvent folosite instrumente
În timp ce lucrați cu ActivInspire, bara de comenzi rapide cu instrumente din dreapta casetei de Instrumente Principale se umple 
treptat cu pictograme. ActivInspire plasează automat instrumentele dvs. cele mai des utilizate acolo, astfel încât acestea să fie 
ușor accesibile.

În imaginea din dreapta, bara de comenzi rapide cu instrumente include 
unele dintre instrumentele descrise în subiectul anterior.

Pentru a vedea descrierea unui instrument, faceți clic pe link:

Ceas (Ceas)

Camera

Deschideți flipchart (Open Flipchart)

Dezvăluitorul (Revealer)

Modul dual (Dual Mode)

Înregistrare sunet (Sound Recorder)

Panglică cu mesaje (Tickertape)
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Acasă > Mai multe despre ActivInspire

Mai multe despre ActivInspire
Această secțiune conține informații detaliate despre cum să lucrați cu ActivInspire:

Lucrul cu resurse

Lucrul cu obiecte

Realizarea flipcharturilor

Personalizarea profilurilor

Lucrul la tablă

Importul și exportul fișierelor
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Acasă > Mai multe despre ActivInspire > Personalizarea profilurilor > Despre profiluriDespre profiluri

Aici analizăm profilurile în detaliu:

Ce este un profil?

Ce puteți personaliza într-un profil?

Ce profiluri sunt incluse în ActivInspire?

Ce este un profil?
ActivInspire poate fi adaptat pentru a se potrivi diferitelor tehnici de predare. 

Indiferent dacă aveți nevoie de o mulțime de instrumente pe tablă sau doar de mult spațiu - ActivInspire se potrivește tuturor stilurilor 
de predare. Când porniți ActivInspire, sunt afișate elemente, de exemplu instrumente, în funcție de profilul selectat.

Dacă ați folosit alte aplicații pentru computer, este posibil să fiți familiarizați cu opțiunile și preferințele. ActivInspire creează un profil 
pe baza modului în care utilizați instrumentele.

De exemplu, când rulați în Navigator, ActivInspire adaugă o notă în profil. Data următoare când lansați ActivInspire, meniurile, 
instrumentele și alte elemente vor arăta și se vor comporta exact așa cum le-ați lăsat. 

Puteți continua să lucrați cu acest profil sau puteți selecta Editare > Profiluri (Edit > Profiles) pentru a crea și a salva unul sau mai 
multe profiluri proprii. Puteți crea profiluri diferite pentru circumstanțe diferite și să vă salvați preferințele în câte profiluri doriți. Puteți 
utiliza apoi profilurile dvs. de pe alt computer. Alți profesori își pot folosi profilurile de pe computerul dvs., apoi puteți reveni la profilul 
dvs. atunci când au terminat. 

Profilurile dvs. personale sunt stocate în folderul Profilurile mele (My Profiles).

Ce puteți personaliza într-un profil?
Profilurile sunt o modalitate excelentă de a personaliza ActivInspire pentru a se potrivi nevoilor de predare. Puteți personaliza 
aproape totul în ActivInspire și să vă salvați preferințele în unul sau mai multe profiluri. Ca să îți eficientizăm munca, am grupat 
opțiunile în 4 categorii principale. Fiecare categorie este reprezentată de o filă diferită în caseta de dialog Edit Profiles.

Vă permite să...

Alegeți poziția, vizibilitatea și comportamentul elementelor, cum ar fi Instrumentele Principale, 
Barele de meniu și Filele cu documente.

Personalizați Instrumentele Principale și butoanele de marcare și redimensionare, adăugând sau 
eliminând elemente, în funcție de nevoi.

Vă creați propriile comenzi rapide, astfel încât atunci când apăsați unul dintre butoane, 
ActivInspire:

• Inserează o tastare specială.

• Afișează textul pe care l-ați asociat anterior cu un buton.

• Deschide un fișier sau lansează un program

Această categorie

Aspect (Layout)

Comenzi (Commands)

Butoane personalizate 

Settings Personalizați modul în care lucrați cu Sistemul de Răspuns din partea Elevilor, 
instrumentele matematice, multimedia și multe altele.

Ce profiluri sunt incluse în ActivInspire?
ActivInspire include 5 profiluri. Numele lor indică scopul acestora. Le puteți folosi așa cum sunt sau le puteți personaliza pentru 
a se potrivi nevoilor de predare:
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La tablă 
(At the Board)

Creare 
(Authoring)

Limbi străine 
(Languages)

Matematică
(Mathematics)

Media

Prezintă un ecran ordonat, în care fereastra ActivInspire este setată pe modul Best Fit, Navigatorul este 
ascuns, Coșul de Gunoi este vizibil, Setul de Instrumente Rapide este ascuns și setul de Instrumente 
Principale conține câteva instrumente de prezentare la tablă, precum și butoanele pentru Navigatoarele 
de Pagini și de Resurse.

Vă pune la dispoziție instrumentele de creare pentru dezvoltarea rapidă a lecțiilor. Se deschide cu 
Navigatorul de Pagini deschis și fixat și include Paleta de Culori extinsă în Instrumentele Principale, 
precum și Setul de Instrumente Rapide. 

Prezintă un ecran ordonat, în care fereastra ActivInspire este setată pe modul Best Fit, Navigatorul este 
ascuns, Coșul de Gunoi este vizibil, Setul de Instrumente Rapide este ascuns și setul de Instrumente 
Principale conține instrumente suplimentare pentru predarea limbilor străine, cum ar fi Tastatura pe 
ecran, Recunoaștere text, Panglică cu mesaje și Corector ortografic.

Prezintă un ecran ordonat, în care fereastra ActivInspire este setată pe modul Best Fit, Navigatorul este 
ascuns, Coșul de Gunoi este vizibil, Setul de Instrumente Rapide este ascuns și setul de Instrumente 
Principale conține instrumente suplimentare de matematică, cum ar fi Rigla, Raportor și XY Origin.

Prezintă un ecran ordonat, în care fereastra ActivInspire este setată pe modul Best Fit, Navigatorul este 
ascuns, Coșul de Gunoi este vizibil, Setul de Instrumente Rapide este ascuns și setul de Instrumente 
Principale conține instrumente media suplimentare, cum ar fi Înregistrare Sunet, Înregistrare Ecran, 
Cameră și Inserați Media din Fișier.

Înapoi sus
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Acasă > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea 
profilurilor

Crearea și comutarea profilurilor
Aici vă arătăm cum să creați, personalizați și comutați profilurile:

Creați un profil

Alegerea aspectului

Alegerea instrumentelor

Definirea butoanelor

Alegerea setărilor aplicațiilor

Comutarea profilurilor
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Acasă > Mai multe despre ActivInspire > Lucrul cu obiecte > Folosirea straturilor și a suprapunerii

Folosirea straturilor și a suprapunerii 
Aici vă arătăm cum să folosiți straturile și suprapunerea obiectelor:

Mai multe despre straturi

Mutarea unui obiect în alt strat

Suprapunerea obiectelor

Mai multe despre straturi
Poate vă amintiți că toate obiectele sunt plasate implicit pe anumite straturi și că puteți muta obiecte de pe un strat pe altul.

Stratul superior

Stratul de mijloc

Stratul inferior

Stratul de fundal

Implicit, acest strat conține toate obiectele de adnotare care sunt făcute cu instrumentele Stilou, 
Evidențiator și Cerneală Magică. Astfel de obiecte sunt afișate deasupra oricăror alte obiecte 
plasate pe straturile inferioare.

• Culoarea de fundal a paginii
• Imaginea de fundal (opțional)
• Grilă (opțional)

În plus, puteți așeza orice alte obiecte pe stratul de fundal, iar acestea vor deveni blocate pe fundal 
și vor apărea dedesubtul tuturor obiectelor de pe celelalte straturi. 
Dacă stratul de fundal conține o imagine de fundal, modul în care imaginea se încadrează pe pagină 
este dictat de proprietatea Background Fit. Pentru detalii, vedeți Referințe > Proprietăți > Diverse 
proprietăți (Reference > Properties >  Miscellaneous properties)

Straturile sunt complet separate unul de celălalt. Cu alte cuvinte, puteți înlocui fundalul fără a influența imaginile sau adnotările de 
pe celelalte straturi. Sau puteți face adnotări peste fotografii și fundal fără a influența alte straturi.

Mutarea unui obiect în alt strat
1. Clic dreapta pe obiect

   2. Din Meniul Popup selectați Recorder >         To Top Layer (Stratul superior) >         To Middle Layer (Stratul de 
mijloc) sau          To Bottom Layer (Stratul inferior). Acest lucru vă permite să acoperiți, de exemplu, un obiect de adnotare 
cu un obiect de imagine.

Adnotările Cerneala Magică (Magic Ink) vor ascunde orice obiect (sau părți din obiecte) din stratul superior peste 
care trece Cerneala Magică (inclusiv adnotări și imagini), permițându-vă să vedeți prin straturile de dedesubt.

Folosiți Instrumentul Ștergeți corespunzător pentru a îndepărta obiecte in fiecare strat.

Implicit, acest strat conține imagini, forme și obiecte text.
Adnotările recunoscute sunt convertite automat în obiecte de text și plasate în stratul de mijloc.
Aceste obiecte sunt afișate în spatele (sau dedesubtul) oricărui obiect plasat pe stratul superior, 
dar sunt afișate deasupra (sau peste) oricărui alt obiect plasat în stratul inferior.

Inițial gol, stratul inferior poate conține conectori sau orice obiect care este plasat fizic pe el. 
Pentru detalii, vedeți secțiunea Mutarea unui obiect în alt strat de mai jos.

Stratul de fundal este alcătuit din 3 elemente:
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Suprapunerea obiectelor
Tuturor obiectelor le este alocată o poziție în stivă în funcție de ordinea în care sunt adăugate pe pagină. Fiecare obiect succesiv este 
plasat deasupra celui precedent în propriul strat. Gândiți-vă la aceasta ca la un pachet de cărți de joc, de unde trebuie să scoateți o 
carte și să o așezați deasupra pentru a o vizualiza complet. Cel mai recent obiect plasat pe o pagină este deasupra stivei.

Cardurile din exemplul din dreapta au fost adăugate în ordinea următoare:

• Albastru 1
• Galben 2
• Roșu 3

Se aplică următoarele reguli:

• Cardul albastru se va afișa sub cardurile galben și roșu.
• Cardul galben se va afișa peste cardul albastru, dar sub cel roșu.
• Cardul roșu se va afișa deasupra cardurilor galben și albastru.

Aceste reguli se aplică în fiecare strat. Nu doar că există o ordine de 
suprapunere a straturilor, dar trebuie să luați în considerare și ordinea de 
suprapunere din fiecare strat.

Schimbarea ordinii de suprapunere

Puteți schimba ordinea de suprapunere, trimițând un obiect în alt loc în stivă.

Ordinea cardurilor din exemplul din dreapta s-a schimbat. Roșu 3 este acum 
în partea de jos a stivei.

Aici vă prezentăm două metode prin care puteți schimba ordinea de 
suprapunere:

O mutare pe rând

1. Selectați obiectul..

2. Din Context Menu selectați Send Backwards (Dedesubt) 
sau Send Forward (Deasupra). Obiectul se mută cu un 
pas deasupra sau dedesubt în ordinea de suprapunere.

3. Repetați dacă este necesar..

Mutare totală

1. Selectați obiectul.
2. Din Meniul de Editare (Edit Menu), selectați Reorder > Bring to Front

sau Send to Back. Această opțiune va muta obiectul deasupra sau
dedesubtul stivei

Puteți selecta, de asemenea, mai multe obiecte deodată și să le trimiteți deasupra sau dedesubt. Fiecare obiect își va menține 
poziția de suprapunere în relația cu celelalte obiecte.
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Acasă > Folosirea Sistemelor de Răspuns pentru Elevi

Folosirea Sistemelor de Răspuns pentru Elevi
Această secțiune cuprinde informații despre Sistemul de Răspuns pentru Elevi (Learner Response System):

Prezentare generală

Înregistrarea dispozitivelor

Alocarea elevilor pe dispozitive

Întrebări pregătite - Folosirea Expertului în Întrebări

Întrebări și sondaje rapide
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Verificarea prealabilă

Verificarea prealabilă
Lucrul cu un flipchart la tablă este diferit de lucrul cu el pe computer. Fonturile, obiectele și culorile care arată excelent pe ecranul computerului, pot 
să nu funcționeze chiar atât de bine pe tablă.
Îți recomandăm să testezi flipchartul pe tablă înainte de a-l folosi pentru predare în fața elevilor. Acum este momentul pentru ultimele modificări:

Întrebați-vă... Sugestii Mai multe informații

Obiectivele de 
învățare sunt clare?

Enunțați obiectivele de învățare la început și
revizuiți-le la sfârșitul orei.
Includeți obiective de învățare în fiecare pagină:

• Folosiți o panglică cu mesaje și lăsați-o să ruleze
pe tot parcursul lecției
• Așezați-le în partea de sus a fiecărei pagini,
probabil în stratul inferior, sau blocați-le, ca să nu
poată fi mutate sau șterse din greșeală.

Utilizarea Panglică cu mesaje

Realizarea flipcharturilor interactive > 
Crearea containerelor

Realizarea flipcharturilor interactive > 
Crearea restricțiilor

Lucrul cu obiecte > Folosirea straturilor și 
a suprapunerii

Este structurată clar 
fiecare pagină 
flipchart?

Dacă o pagină pare prea aglomerată, încercați să 
împărțiți conținutul în două pagini.

Este tot textul 
lizibil?

Asigurați-vă că textul are o dimensiune de cel puțin 16.

Dacă este necesar, schimbați fontul, dimensiunea 
fontului sau culoarea textului pentru mai multă claritate.

Primii pași cu ActivInspire > Adăugarea și formatarea 
textului

Există suficient 
contrast de culoare?

Luați în considerare schimbarea culorilor textului și a 
obiectelor pentru mai mult contrast și impact.

Lucrul cu obiecte > Schimbarea proprietăților 
obiectelor

Dacă folosiți acțiuni, 
acestea funcționează 
corect?

Verificați ca acțiunile să fie activate și că fiecare 
obiect a fost asociat cu acțiunea corectă.

Realizarea flipcharturilor interactive > Lucrul cu acțiuni

Se afișează corect 
toate imaginile pe 
tablă?

Este posibil să trebuiască să le redimensionați 
pentru un efect optim.

Lucrul cu obiecte > Schimbarea proprietăților 
obiectelor

Funcționează toate
trimiterile?

Dacă ați adăugat legături, asigurați-vă că le puteți 
accesa. Dacă aveți nevoie de acces la Internet, asigurați-
vă că v-ați conectat la rețea. 

Lucrul cu obiecte > Adăugare și eliminare legăturilor

Sunt accesibile 
toate obiectele și 
butoanele?

Pentru a putea să lucrați la tablă, și dvs. și elevii, 
asigurați-vă că tot ce aveți nevoie să accesați în timpul 
lecției se află în treimea inferioară a flipchartului.

Ați ales un profil de 
predare pentru 
acest flipchart?

Poate doriți să folosiți unul dintre profilurile incluse în 
ActivInspire sau doriți să creați un profil adaptat unei 
anumite lecții sau grup de elevi.

Personalizarea profilurilor

Aveți intenția de a 
folosi acest flipchart 
pentru lucrul 
colaborativ în modul 
Utilizator Dual?

Dacă răspunsul este „Da”, asigurați-vă că sarcinile de 
lucru pe care le setați pentru elevi pot fi îndeplinite cu 
instrumentele disponibile în Instrumentele Duale.

Lucrul în modul Utilizator Dual

Trebuie să limitați Luați în considerare folosirea funcției Blocare Acces Utilizare Blocare Access
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accesul la una dintre 
funcțiile ActivInspire 
când elevii lucrează 
la tablă?

(Teacher Lock) pentru a menține elevii 
atenți la activitatea curentă.

Pentru sfaturi experte legate de cele mai bune practici de predare în ActivClassroom, vezi secțiunea de Dezvoltare Profesională 
(Professional Development) de pe Promethean Planet.

http://www.prometheanplanet.com/
http://www.prometheanplanet.com/
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Adnotări pe Desktop

Adnotări pe Desktop
Folosiți butonul de Adnotări pe Desktop (Desktop Annotate) când doriți să folosiți instrumentele ActivInspire, cum ar fi Stiloul, 
Evidențiatorul sau Radiera, pe desktop sau orice aplicație aveți deschisă pe desktop. Când faceți adnotări pe desktop, veți crea un 
flipchart desktop, care poate fi salvat pentru utilizări viitoare.

Folosiți această funcție în lecțiile cu:

• Website-uri

• Aplicații software

Faceți adnotări pe desktop

1. Din Meniul de Instrumente, selectați Desktop Annotate. 
Desktopul este afișat între Navigatorul ActivInspire și
Setul de Instrumente Principale, așa cum puteți vedea
în imaginea din dreapta.

2. Apăsați pe butonul Desktop Annotate din setul de instrumente 
pentru a restabili elementele ascunse anterior. Bara de Meniu arată că 
un nou flipchart a fost creat, cu numele “desktop flipchart”. Flipchartul 
desktop este transparent.

Puteți face adnotări pe desktop și să livrați o lecție bazată pe 
conținut de tip website sau aplicație software.

Când selectați cursorul și apăsați pe desktop, puteți:

• Începe și să folosiți aplicațiile desktop.
• Selecta obiecte din aplicații sau website-uri și să le
copiați. Din clipboard le puteți pune în flipcharturi.

Afișați structura stratificată
Deschideți Navigatorul de Obiecte ca să vedeți 
structura straturilor pentru obiectele de adnotare. 

Structura implicită este:

• Adnotări cu Stiloul, incluzând Evidențiatorul, pe stratul
superior.
• Textele și formele pe stratul de mijloc.
• Conectorii sunt pe stratul inferior.

Cand salvați un flipchart desktop, obiectele sunt salvate pe un 
fundal invizibil. Desktop-ul nu face parte din flipchart, si nu va fi 
salvat.

Opțiuni
Puteți salva un flipchart desktop ca parte a unui flipchart în 
următoarele moduri:
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• Ca fundal pentru flipchart.

• Folosind Suprapunerea Desktop (Desktop Overlay) și

Captura Desktop (Desktop Snapshot).

Din Meniul de Fișiere (File Menu), selectați Edit > Page 
Background. Se deschide fereastra de dialog Set Background.
Selectați opțiunea Desktop Snapshot. 

Pentru a vedea desktopul înainte de a realiza captura, apăsați 
pe pictograma Show Desktop.

Când sunteți gata să realizați captura, apăsași pe pictograma 
Take Snapshot.

După ce captura a fost realizată, apăsați pe Done.

Dacă doriți ca pagina curentă să nu aibă fundal:
Selectați opțiunea Desktop Overlay, apoi apăsați pe Done.
Desktopul nu va fi parte din flipchart și nu va fi salvat.
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 Acasă  > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Desktop

Utilizare Instrumente Desktop
Instrumentele Desktop sunt o colecție cu cele mai utilizate instrumente ActivInspire pe care le puteți găsi folositoare când lucrați în alte aplicații, 
în ocaziile în care este posibil să nu aveți neapărat nevoie de funcțiile complete oferite de Desktop Annotate.  .

Când apăsați pe pictograma Desktop Tools, ActivInspire este 
minimizat, dar setul de Instrumente Desktop este afișat:

Setul de instrumente poate fi mutat oriunde pe desktop prin 
glisare, unde va rămâne și se va afișa deasupra altor aplicații.

Puteți apăsa pe pictogramă pentru a afișa toate instrumentele.
Setul conține următoarele instrumente (în sensul acelor de 
ceasornic, de sus):

Restabilire Inspire

Sondaj Rapid

Înregistrare Ecran

Mai multe Instrumente

Cameră

Tastatură pe Ecran

Promethean Planet

Închide setul de Instrumente Desktop și vă întoarce la aplicația 
ActivInspire.

Afișează sau ascunde Roata Minunilor pentru vot.

Pornește instrumentul ActivInspire Înregistrare Ecran.

Vedeți mai jos.

Vedeți mai jos.

Încarcă programul de tastatură pe ecran ales.

Deschide site-ul web Promethean Planet în browserul de Internet.

Mai Multe Instrumente

Când treceți cu cursorul peste pictograma Mai Multe Instrumente se deschide un 
alt nivel cu Instrumente Desktop.

Puteți selecta următoarele instrumente:
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Panglică cu Mesaje Pornește funcția ActivInspire Panglică cu Mesaje (Tickertape).

Ceas
Afișează Ceasul ActivInspire.

Înregistrare Sunet Pornește instrumentul ActivInspire Înregistrare Sunet.

Calculator Deschide programul de calculator ales.

Aruncătorul de Zaruri Afișează funcția de aruncare zaruri.

Cameră
Când treceți cu cursorul peste pictograma Cameră  
se deschide un alt nivel cu Instrumente Desktop.

Puteți selecta următoarele tipuri de capturi:

 Captură ecran complet 
(Fullscreen Snapshot)  

Captură de fereastră 
(Window Snapshot)

Captură fără formă 
(Freehand Snapshot)
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Captură între două puncte (Point to Point Snapshot)

 Captură Zonală (Area Snapshot)

Pentru detalii despre toate instrumentele disponibile în setul de Instrumente Desktop, vedeți secțiunile 
relevante din acest document de ajutor.
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Cameră

Utilizare Cameră

Utilizați instrumentul Cameră pentru a captura o 
imagine e desktopului, flipchartului și video-urilor 
puse pe pauza sau animații. Puteți realiza o 
fotografie a întregului ecran sau puteți defini o 
anumită zonă de pe ecran..

Fotografia va cuprinde toate tipurile de obiecte 
afișate pe ecran, inclusiv fundalul, adnotările, 
grilele, liniile, formele, textul și alte imagini.

1. Din Meniul Principal, selectați Camera.
Alegeți tipul de captură din meniul drop-down:

Captură Zonală (Area Snapshot) - O 
casetă evidențiată este afișată. Apăsați în 
interiorul casetei și glisați ca să o mutați – 
schimbați dimensiunile glisând marginile. 
Pentru ajustarea fină, utilizați comenzile de 
poziție din Caseta Instantaneu Cameră.

Captură între două puncte (Point to Point 
Snapshot) - Apăsați și trageți, trasând linii 
drepte pentru a contura o zonă cu marginile 
evidențiate pe ecranul gri. Zona de captură 
nu poate fi mutată sau modificată – dacă 
greșiți, doar închideți “Caseta Captură 
Cameră” și încercați din nou. Camera este 
activată când conturul este complet

Captură fără formă (Freehand Snapshot) - 
Apăsați și trageți, desenând cu mâna liberă, 
pentru a contura o zonă cu marginile 
evidențiate pe ecranul gri. Zona de captură 
nu poate fi mutată sau modificată – dacă 
greșiți, doar închideți “Caseta Captură 
Cameră” și încercați din nou

Captură de fereastră (Window Snapshot) - 
Capturați ferestre de dialog sau fereastra 
ActivInspire.

Captură ecran complet (Fullscreen 
Snapshot) - Capturați întregul ecran.

2. Alegeți destinația pentru captură din caseta Camera Snapshot:

Pagina Curentă (Current 
Page) – Capturați imaginea pe 
pagina curentă a flipchartului.
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Pagină Nouă (New Page) – 
Capturați imaginea pe o pagină 
nouă la sfârșitul flipchartului.

Clipboard – Capturați imaginea în 
clipboard..

Resusele Mele (My Resources) – 
Capturați imaginea în fișierul My 
Resources. 

Resurse Partajate (Shared 
Resources) – Capturați imaginea 
în fișierul Shared Resources..

Imaginea rezultată a tuturor acestor obiecte, poate fi adăugată pe pagina flipchart, Biblioteca de Resurse, bara de Comenzi 
Rapide sau clipboard ca obiect pe care îl puteți utiliza. Fotografia este pur și simplu o imagine a ecranului, deci niciun obiect din 
fotografie nu va fi editabil. Puteți redimensiona sau roti fotografia ca orice alt obiect de imagine. 

Asigurați-vă că ecranul afișează imaginea pe care doriți să o capturați. Alegeți unul dintre următoarele tipuri de capturi, care sunt 
discutate în ordine așa cum apar în meniul instrumentului Cameră:

Zonă (Area)
Va apărea o linie punctată în formă de 
dreptunghi pe ecran. Dreptunghiul poate fi 
poziționat oriunde pe ecran printr-un clic în 
interiorul formei dreptunghiulare și tragerea lui în 
altă parte a ecranului. Poate fi și redimensionat 
utilizând punctele de dimensionare care 
înconjoară marginea. Deplasați-le până la forma 
care conține imaginea pe care doriți să o 
capturați, apoi alegeți una dintre opțiunile de 
lipire disponibile în caseta Fotografie 
(Photograph).

Între două puncte (Point to 
Point)
Vă permite să capturați o formă neregulată 
realizată din linii drepte. Primul clic pornește 
forma. De fiecare dată când faceți clic adăugați 
alt nod la formă, astfel încât să puteți muta linia 
într-o altă direcție. Pentru a termina, faceți clic în 
apropiere de primul punct și ActivInspire va 
închide automat forma.
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Fără formă (Freehand)
Vă permite să capturați o formă neregulată 
folosind linii trasate cu mâna liberă. Faceți clic și 
trageți cursorul pentru a începe captura. Pe 
măsură ce deplasați cursorul, o linie punctată îl 
urmează pentru a defini zona de captură. Pentru 
a termina forma, eliberați clicul și ActivInspire va 
închide forma prin plasarea unei linii drepte între 
primul și ultimul punct. O previzualizare a 
fotografiei va apărea pe ecran, înconjurată de 
un fundal roz. Alegeți una dintre opțiunile de 
lipire disponibile în caseta Fotografie 
(Photograph).
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Utilizare Ceas
Folosiți ceasul pentru a afișa timpul pe tablă. Îl 
puteți utiliza și pentru numărătoare inversă 
sau acțiuni automatizate pe flipchart.

Din Meniul de Instrumente selectați More 
Tools > Clock.

Ceasul se afișează într-o casetă.

• Apăsați pe pictogramele din casetă
pentru a comuta între tipurile de afișare
ceas – analog, digital și ambele.
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• Apăsați pe butonul cu simbolul pentru pauză
pentru a opri ceasul.

• Apăsați pe săgeata în jos pentru a număra
înapoi dintr-un anumit interval..

• Apăsați pe săgeata în sus pentru a număra
înainte dintr-un anumit interval.

• Apăsați pe X pentru a ieși din ceas.

Apăsând pe oricare dintre săgeți veți 
deschide fereastra de dialog Clock 
Counter.

Setați timpul în formatul 00:00:00 (ore: minute: secunde)

Bifați căsuța Repeat pentru a repeta numărătoarea până este închis ceasul. 

Meniurile drop-down vă permit să:

• Alegeți un sunet care să înceapă la expirarea numărătorii.

• Apăsați și trageți de marginile sau
colțurile casetei pentru a modifica
dimensiunea casetei și a ceasului.
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• Se schimbe automat pagina sau să se reseteze pagina la expirarea numărătorii.

Dacă alegeți Turn to Next Page și ați bifat căsuța Repeat, pagini goale vor fi adăugate la flipchart până va fi închis ceasul.

Apăsați Reset pentru a restabili setările implicite pentru numărătoare.
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Utilizare Recunoaștere scris de mână
Instrumentul pentru Recunoașterea Scrisului de Mână este în Meniul de Instrumente (Tools Menu).

Folosiți acest instrument pentru a converti adnotările făcute cu mâna liberă în text, dacă preferați aspectul textului formatat în flipchart. 
ActivInspire poate face acest lucru în timp ce dumneavoastră scrieți la tablă. Pe lângă recunoașterea scrisului de mână și a formelor din 
ActivInspire, Instrumentul pentru Recunoașterea Scrisului de Mână poate recunoaște scrisul și din alte aplicații, cum ar fi Microsoft Word®.

1. Selectați Handwriting Recognition.
2. Scrieți un cuvânt pe tablă. Așteptați să fi convertit în text.
3. Dacă cuvântul nu a fost convertit corect, apăsați pe pictograma Alternatives pentru mai
multe opțiuni. Apăsați pe varianta corectă.
4. Scrieți alt cuvânt sau apăsați pe un instrument diferit.

Noul obiect de text preia cele mai recente setări de text.

Când adnotarea devine un obiect de text, se deplasează pe stratul de mijloc și nu veți putea utiliza instrumentul Radieră.

Selectați adnotarea (convertită), apoi faceți clic pe Instrumentul Text pentru a afișa Instrumentele de Formatare.

Evidențiați textul și formatați-l.

Puteți termina o secțiune de scriere și o puteți converti în text mai târziu:

• Din Meniul Editare Obiect, selectați Convert to text.
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Opțiuni și setări

Opțiunile și setările pentru Instrumentele de Recunoaștere sunt în fila 
Settings din caseta de text Edit Profiles:

• Interval de timp de recunoaștere (Recognition Timeout) –
Glisorul ajustează intervalul de timp între 1 și 5 secunde.

• Umplere forme recunoscute (Fill recognized shapes) – Bifați
căsuța ca să umpleți formele închise produse prin conversie.
Culorile de umplere devin disponibile – puteți umple forma cu
culoarea conturului sau selectați altă culoare din caseta Another
color.
• Limba de recunoaștere a scrisului (Handwriting recognition
language) – Pentru detalii despre limbile disponibile, vedeți
Reference > Settings > Language.
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Utilizare Recunoaștere Formă
Adnotările de tip desen, făcute cu mâna liberă, pot fi convertite în obiecte de formă în timp ce desenați la tablă cu ActivPen.

Instrumentul pentru Recunoașterea Formă este în Meniul de Instrumente (Tools Menu).

În timp ce adnotarea devine obiect de formă, se mută pe stratul de mijloc.

Când selectați o formă nouă, o puteți transforma utilizând:

• Punctele și marcajele pentru redimensionare.

• Instrumentele Principale.

• Navigatorul de Proprietăți.

Dacă obiectul este pe stratul de mijloc, nu veți putea folosi Radiera. Dacă mutați obiectul pe stratul superior, 
puteți folosi Cerneala Magică.

Setări și Opțiuni
Select File > Settings > Edit Profiles > Settings > User Input

Dacă preferați să lucrați fără funcția de recunoaștere forme activată, puteți converti oricând o adnotare făcută cu mâna

liberă într-o formă.

Faceți clic dreapta pe adnotare și selectați Convert to Shape.
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Utilizare Cerneală Magică
Aici vă prezentăm Cerneala Magică (Magic Ink) și vă arătăm cum să o utilizați.

Puteți folosi Cerneala Magică pentru a face invizibil orice obiect (sau o parte a unui obiect) din stratul superior. Gândiți-vă la Cerneala 
Magică ca la un stilou care poate desena o adnotare pe stratul superior prin care puteți vedea. Cerneala Magică vă permite să faceți 
orificii prin obiectele de pe stratul superior, astfel încât să puteți vedea obiectele de pe straturile de dedesubt.

Exemplul 1
Adăugați o imagine din Biblioteca de Resurse. 
Imaginea va fi pe stratul de mijloc al paginii. Apoi 
selectați Instrumentul Stilou și setați lățimea la maxim, 
colorați peste imagine până când este complet 
ascunsă. Această adnotare cu stiloul va fi pe stratul 
superior. În cele din urmă utilizați Cerneala Magică 
pentru a elimina adnotarea cu stiloul și a dezvălui 
imaginea de dedesubt.

Exemplul 2
Adăugați două fotografii ale aceleiași scene peisagistice, una făcută iarna și una vara. Așezați fotografia de iarnă pe stratul 
superior astfel încât să fie poziționată exact peste fotografia de vară. Apoi utilizați Cerneala Magică pentru a șterge treptat 
imaginea de iarnă ca să dezvăluiți imaginea de vară de dedesubt.

De ce Cerneala Magică funcționează doar pe anumite elemente?
Adnotările pe care le creați cu Cerneala Magică sunt obiecte în sine. Deci puteți folosi Cerneala Magică ca să ascundeți obiecte pe 
care vreți să le dezvăluiți mai târziu.

Straturile și suprapunerea sunt importante când folosiți Cerneala Magică:
• Cerneala Magică funcționează doar pe stratul superior.
• Pe stratul superior, Cerneala Magică funcționează doar pe obiectele poziționate mai jos în ordinea de
suprapunere.
• Orice element așezat pe stratul superior poate, deci, fi făcut invizibil cu Cerneala Magică.

Pentru mai multe informații, vedeți Folosirea straturilor și a suprapunerii. (Using layers and stacking)
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Schimbați dimensiunea peniței de Cerneală Magică
Din setul de Instrumente Principale:

• Apăsați pe una dintre dimensiunile prestabilite sau

• Folosiți glisorul pentru grosimea Stiloului pentru a alege orice

dimensiune între 1 și 100 pixeli.

Vedeți printr-o adnotare
Pentru a vedea printr-o adnotare:

1. Din Meniul de Instrumente, selectați Magic Ink
2. Apăsați și trageți cursorul peste adnotarea prin care doriți să
vedeți.

Găsiți o adnotare cu Cerneală Magică
Ca să aflați dacă un flipchart conține un element creat cu Cerneala Magică:

1. Deschideți Navigatorul de Obiecte și căutați obiecte cu pictograma
Cerneală Magică, ca cel indicat în exemplul din dreapta.

2. Când apăsați pe element în Navigatorul de Obiecte, este selectat pe
pagina flipchart:

Acum puteți muta, șterge sau modifica adnotarea cu Cerneală Magică.

Before and after...

Alternativ:

Treceți cursorul peste adnotarea cu Cerneală Magică (sunteți în locul 
potrivit când cursorul arată așa        )

Ștergeți Cerneala Magică
Puteți șterge adnotările cu Cerneală Magică ca oricare alt obiect:

• Selectați adnotarea cu Cerneală Magică de pe pagina flipchart sau în Navigatorul de Obiecte și

apăsați Delete sau

• Trageți și plasați adnotarea în Coșul de Gunoi.
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Utilizare Panglică cu mesaje
Din Meniul de Instrumente, selectați More Tools 
> Tickertape. În fereastra de dialog Tickertape
sunt afișate trei elemente:

• Mesajul implicit de derulare pe panglică.
• Previzualizare continuă care răspunde
instant la modificări.
• Consola panglicii.

Puteți:

• Ajusta viteza cu glisorul.

• Pune pauză sau relua redarea

Pentru a introduce mesajul panglicii:

Introduceți un mesaj în caseta de text.

Mesajele lungi combinate cu fonturi de dimensiuni mari necesită multă memorie. În cazuri extreme, este posibil ca mesajul panglicii 
să nu se afișeze.

Umbră (Shadow)

Introduceți un număr în caseta de text drop pentru a adăuga sau modifica dimensiunea umbrei. Un zero indică faptul că nu este 
necesară umbra. Orice modificări aduse umbrei sunt afișate imediat pe mesajul derulant, permițându-vă să revizuiți panglica. 
Apăsați pe Caseta de Culori pentru a vizualiza Paleta de Culori și selecta o culoare diferită pentru umbră.

Fundal (Background)

Bifați căsuța Screen pentru a selecta ecranul curent ca fundal pentru panglică.

Bifați căsuța Color dacă doriți ca panglica să se deruleze pe o bandă de fundal de culoare simplă. Apăsați pe Caseta de Culori 
pentru a vizualiza Paleta de Culori și selecta o culoare diferită pentru fundal.

Font

Vă permite să modificați fontul, dimensiunea, stilul și atributele scriptului pentru banda curentă.

Test

Apăsați pe acest buton pentru a testa panglica.

Buclă (Loop)

Bifați căsuța pentru a vă asigura că panglica se va derula continuu până când este întreruptă printr-un clic dreapta pe mesajul în 

sine.

Poziţie (Position)

Faceți clic pe săgeata drop-down și selectați Top (Sus), Middle (Mijloc) sau Bottom (Jos) din listă pentru a specifica poziția de 

derulare a panglicii.

Setați ca implicit (Make Default)

Apăsați pe acest buton pentru a păstra setările curente ale panglicii pentru următoarea dată când definiți o panglică.
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Utilizare Dezvăluitor
Dezvăluitorul (Revealer) simulează o un rulou sau o jaluzea. Pagina flipchart este acoperită, iar cursorul devine un mâner. Dezvăluiți 
pagina treptat, deplasând cursorul spre interior din orice parte a paginii. Când Dezvăluitorul este activat, acesta va acoperi toate 
paginile flipchart în mod implicit.

Pentru a utiliza Dezvăluitorul, selectați Tools > Revealer.

Pentru a dezactiva Dezvăluitorul:

În Navigatorul de Properietăți, selectați Page Tools > Tools Off din Meniul drop-down.

Pentru a schimba setările Dezvăluitorului:

1. Din Meniul Fișiere (File Meniu), selectați Settings. Se va deschide fereastra de
dialog Edit Profiles.

2. Selectați Effects.
3. Pentru a schimba culoarea, faceți dublu clic pe căsuța de lângă Color. Se va
deschide Paleta de Culori.
4. Selectați o culoare.
5. Pentru a salva modificările, apăsați Done.

Dacă aveți un dispozitiv de prezentare ActivRemote, puteți activa Dezvăluitorul de oriunde din clasă.

Pentru a ajusta viteza animației:

1. Selectați Effects, după indicațiile de mai sus.
2. Mutați glisorul de la 1 (încet) până la 20 (rapid).
3. Pentru a salva modificările, apăsați Done.
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Utilizare Tastatură pentru ecran
Tastatura pentru ecran (On-Screen Keyboard) este în Instrumentele de Formatare (Format Toolbox) și în Meniul 
de Instrumente (Tools Menu) sub Mai multe Instrumente (More Tools).
Folosiți Tastatura pentru ecran pentru a adăuga text în flipchart (sau alte aplicații) în timp ce folosiți tabla.
Cu Instrumentul Text selectat și o casetă de text deschisă:

1.Apăsați pe On-Screen Keyboard

Tastatura se deschide. Conține configurația și tastele standard. Aspectul depinde de sistemul de operare al computerului.

2. Pentru a muta tastatura, apăsați oriunde în bara de titlu a Tastaturii pentru ecran și așezați-o unde doriți, cu drag & drop.
3. Pentru a adăuga text, cu o casetă de text deschisă, apăsați pe oricare dintre taste.
4. Ca să închideți tastatura când ați terminat de adăugat text, apăsați pe tasta X.
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Utilizare Reflector

Reflectorul (Spotlight) este un instrument de 
prezentare. Ascunde o parte a flipchartului, deci 
doar o porțiune este vizibilă. Setările implicite cu 
fundal negru și reflector circular alb simulează 
lumina reflectoarelor și ajută la concentrarea 
atenției.

Din Meniul Instrumente, selectați Spotlight

Puteți defini opțiuni pentru afișarea Instrumentului 
Reflector în caseta de dialog Spotlight Settings:

Lățimea marginii (Border width)

Mutați glisorul pentru a mări sau micșora lățimea 
marginii care înconjoară zona reflectorului. 
Intervalul este între 0 și 20 pixeli.

Culoarea marginii (Border color)

Pentru a schimba culoarea marginii reflectorului, 
apăsați pe Caseta de Culori și selectați o culoare 
din Paleta de Culori.

Culoarea fundalului (Background Color)

Faceți clic aici pentru a selecta culoarea zonei din 
afara reflectorului când utilizați Instrumentul 
Reflector.

Margine translucidă (Translucent border)

Bifați căsuța dacă doriți să vedeți prin marginea 
reflectorului. Debifați dacă preferați să aveți 
marginea reflectorului ca o culoare solidă.

Ecran translucid (Translucent screen)

Bifați căsuța dacă doriți să vedeți prin ecranul 
reflectorului (zona întunecată care acoperă 
fereastra Flipchart sau Desktop). Debifați dacă 
preferați să aveți ecranul reflectorului ca o culoare 
solidă.

Capturați imagine cu clic dreapta (Right-
click captures image)

Cu unul dintre reflectoare activate, faceți clic 
dreapta pe pagină și o imagine a zonei 
reflectorului va fi lipită pe pagina curentă flipchart.

javascript:void(0);


Using the Spotlight

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/using_the_spotlight.htm[1/21/2010 6:08:28 PM]



Using Teacher Lock

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/using_teacher_lock.htm[1/21/2010 6:08:29 PM]

Show 
Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Blocare Acces

Utilizare Blocare Acces

Puteți bloca ActivInpire pentru a împiedica modificările dacă nu 
sunteți la tablă.

Din Meniul Instrumente, selectați More Tools > Teacher Lock.

Se va deschide fereastra de dialog Teacher Lock, câteva dintre 
funcțiile ActivInspire se vor dezactiva.

Pentru a relua lucrul cu ActivInpire, trebuie să introduceți 
parola Teacher Lock de pe tastatura computerului. Parola 
implicită este 1234.

Pentru a schimba parola, selectați Change Password și 
completați câmpurile din fereastra de dialog Change Teacher 
Lock.
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Utilizare Instrumente 
Secțiunea descrie:

Utilizare Aruncătorul de Zaruri

Utilizare Calculator

Utilizare Riglă

Utilizare Raport

Utilizare Compas

Setare XY Origine
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Acasă > Referințe

Referințe
Această secțiune de referințe enumeră și descrie succint scopul instrumentelor, meniurilor, acțiunilor, proprietăților și setărilor 
disponibile în ActivInspire:

Comenzi rapide cu tastatura 

Opțiuni de personalizare

Meniuri și meniuri popup

Seturi și casete de instrumente

Instrumente

Acțiun

Proprietăți

Setări
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Acasă > Referințe >  Instrumente

Instrumente
Această secțiune descrie în detaliu toate instrumentele disponibile în ActivInspire. Pentru fiecare instrument descriem ce face, cum 
se folosește, ce puteți personaliza și unde îl găsiți implicit.
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Inserare multimedia
Puteți avea un sunet sau un video în flipchart, cu condiția ca hardware-ul să le suporte.

Fișiere de sunet
Unele fișiere de sunet sunt incluse în resursele ActivInspire.

Afișați Navigatorul de Resurse și mergeți spre Shared Resources > Sounds > Animals > Bird.wav.

Trageți sunetul în flipchart. Este inserat ca un obiect de imagine cu acțiunea de a reda fișierul asociată.

Când treceți peste imagine, este afișat butonul albastru care indică că este asociată o acțiune.

Când apăsați pe imagine este redat sunetul și este afișată implicit Consola de sunet ActivInspire.

Selectați View > Sound Controller pentru a scunde Consola.

Puteți dezactiva afișarea consolei din profilul dvs.:

Selectați File > Settings > Settings Tab > Multimedia și debifați Show sound controller.

Când faceți dublu-clic pe imagine este selectată, așa cum indică punctele de acțiuni.

Navigatorul de Obiecte (vezi dedesubt) afișează imaginea, iar Navigatorul de Acțiuni afișează acțiunea asociată.

Puteți reda două sunete diferite în același timp. Sunt afișate două console, pentru Track 1 și Track 2.

Track 1 redă discurs sau fișiere audio de sunet cu extensiile .wma .wav .snd .au .aif .aifc .aiff.
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Track 2 redă fișiere audio mai complexe, cu extensiile .mp3 .cda .mid .rmi .midi.

Din Bara de Meniu selectați Insert > Media.

Se va deschide fereastra de dialog Choose 

media to insert.

Selectați Insert > Link.
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Înregistrări

 Despre detalii despre accesarea Setărilor (Settings), vedeți Alegerea setărilor aplicațiilor (Choosing application settings).

Setări Opțiuni

Rata de captură a cadrelor (Capture Frame Rate)

Înregistrare audio (Record audio) Implicit = Înregistrare sunet în timp ce creați video.

Nu înregistrați sunet.

Captură rapidă (Quick capture) Optimizați înregistrarea activităților în care mișcați cursorul 
de multe ori peste zone statice mari.

Implicit = Nu optimizați.

Captură cursor mouse (Capture mouse pointer) Implicit. Înregistrați mișcările cursorului în video.

Nu înregistrați mișcările cursorului.

Captură ferestre stratificate (Capture layered windows)
Ferestrele stratificate sunt folosite de aplicații pentru a crea 

ferestre translucide. De exemplu, imaginea translucidă care 
apare când mutați o pictogramă cu drag & drop pe desktop. 

Înregistrați aplicațiile care folosesc ferestre stratificate. 
Capturarea ferestrelor stratificate poate face cursorul să 
clipească în timpul înregistrării. Acest efect nu va apărea în 
fișierul video.

Implicit = Nu capturați ferestrele stratificate.

Dezactivare creștere viteză hardware în timpul înregistrării 
(Disable hardware acceleration during recording)

Viteza hardware îmbunătățește performanța graficii 3D de pe 
computer, dar poate afecta performanța Înregistrării 
Ecranului.

Implicit = Permite ActivInspire să oprească creșterea 
vitezei hardware la începutul înregistrării și să o restabilească 
când înregistrarea este gata.

Păstrați accelerarea hardware pornită.

Ascundere set de instrumente de înregistrare 
în timpul înregistrării (Hide screenrecorder toolbox 
whilst recording)

Ascundeți setul de instrumente de Înregistrare Ecran la 
începutul fiecărei înregistrări noi. Când setul de instrumente 
este ascuns, opriți înregistrarea apăsând pe pictograma 
Înregistrare Ecran.

Înregistrare Sunet Locația unde înregistrările de sunet vor fi salvate. Selectați 
din meniul drop-down:

Adăugare în flipchart (Add To Flipchart) Implicit = Adaugă o pictogramă de sunet în pagina flipchart 

Rata de captură a cadrelor pe secundă.

Interval = 1 – 10 

Implicit = 5

Implicit = Afișați setul de instrumente
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când se termină înregistrarea. Apăsați pe pictogramă, cu 
opțiunea Enable Actions activată, pentru a reda înregistrarea.

Salvează în computer (Save To Disk) Când apăsați pe pictograma Record, ActivInspire vă solicită 
să specificați un nume pentru fișier și locația în care se va 
salva, înainte de a începe înregistrarea.

Ambele (Both) Vi se va solicita să specificați un nume pentru înregistrare și 
locația în care doriți să o salvați; o pictogramă va fi adăugată în 
flipchart.
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Acasă  > Referințe > Setări > Instrumente

Instrumente

 Despre detalii despre accesarea Setărilor (Settings), vedeți Alegerea setărilor aplicațiilor (Choosing application settings).

Setări Opțiuni

Instrument implicit (Default tool) Instrumentul care este activat când porniți ActivInspire. Alegeți 
din meniul drop-down: Stilou, Evidențiator, Radieră sau 
Selectați Instrument. 
Implicit = Stilou

Afișează indicatorul de grosime (Show pen width indicator) Implicit = Afișează un contur mic colorat în vârful stiloului. 
Conturul va avea culoarea curentă selectată.

Nu arătați culoarea în vârful stiloului.

Camera capturează instrumentele principale 
(Camera captures main toolbox)

Setul de Instrumente Principale ActivInspire va fi 
inclus în captura de ecran realizată cu Camera.

Implicit = Captura de ecran nu include Instrumentele Principale.

Instrumente Matematice

Culoare instrument (Tool color) Implicit = Gri
Apăsați pentru a schimba culoarea riglei, raportorului 
sau compasului.

Culoare text instrument  (Tool text color) Implicit = Negru
Apăsați pentru a schimba culoarea textului de pe riglă, 
raportor sau compas.

Transluciditate (Translucency) Faceți raportorul, rigla sau compasul mai mult sau 
mai puțin translucid.
Interval = 20 – 255
Implicit = 255

Scalare instrument (Tool scale) Folosiți glisorul pentru a crește sau scădea dimensiunea 
instrumentului matematic pentru a se potrivi cu dimensiunea 
ecranului.
Interval = 50 – 200
Implicit = 150

Toleranță umplere imagine 
(Image fill tolerance)

Se aplică fișierelor grafice .jpg și .png. Folosiți glisorul pentru a 
seta cât de apropiată să fie culoarea de umplere cu o culoare 
corespondentă din fișierul selectat. O toleranță scăzută 
înseamnă că numai zonele similare din fișierul grafic vor fi 
umplute, în timp ce o toleranță mai mare are efectul opus.
Interval = 0 – 100
Implicit = 5

Transluciditate Evidențiator (Highlighter Translucency) Folosiți glisorul pentru a crește sau scădea 
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transluciditateaEvidențiatorului.
Interval = 20 – 255
Implicit = 128

Aruncătorul de Zaruri

Viteză zaruri (Dice speed) Folosiți glisorul pentru a schimba viteza la care se vor învârti 
zarurile. 
Interval = 3 – 11
Implicit = 7 secunde

Număr de zaruri (Number of dice) Folosiți glisorul pentru a schimba numărul de zaruri.
Interval = 1 – 5
Implicit = 5

Calculator

Folosiți calculatorul din sistemul de operare 
(Use calculator supplied with operating system)

Implicit = Folosiți calculatorul din ActivInspire
Folosiți calculatorul implicit furnizat de sistemul de 

operare.

Folosiți calculatorul ales de utilizator 
(Use calculator specified by user)

Apăsați și căutați pentru a selecta un alt calculator.
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Acasă > Mai multe despre ActivInspire > Realizarea flipcharturilor interactive  > Lucrul cu acțiuni

Lucrul cu acțiuni
În ActivInspire, puteți asocia o acțiune cu un obiect. Acest obiect devine apoi un obiect de acțiune. Când apăsați pe obiectul de acțiune, 
acțiunea asociată se întâmplă. De exemplu, se redă un fișier de sunet sau o animație sau se deschide o altă pagină flipchart. Puteți testa 
acțiunile imediat și sunt activate când părăsiți Modul Design. 

Există câteva sute de acțiuni disponibile în Navigatorul de Acțiuni, unde sunt prezentate în cinci categorii diferite. Puteți fie să accesați 
acțiunile pe categorii, să selectați dintr-o listă cu toate acțiunile sau să alegeți una dintre cele mai populare acțiuni din fila Drag and Drop. 

Pentru detalii despre toate acțiunile disponibile, inclusiv diferențele dintre acțiunile ActivInspire și cele create cu 
generațiile anterioare de software Promethean, vedeți Referințe > Acțiuni. (Reference > Actions)

Aici vă prezentăm categoriile de acțiuni, descriem cum să adăugați acțiuni, vă arătăm cum să asociați o acțiune Drag and Drop unui 
obiect, oferim un exemplu pentru fiecare categorie de acțiuni, apoi vă arătăm cum să eliminați acțiunile:

Categorii de acțiuni

Adăugarea unei acțiuni

Eliminarea unei acțiuni

Exemple

Asocierea unei acțiuni Drag and Drop

Adăugare acțiune de comandă

Adăugare acțiune de pagină

Adăugare acțiune de obiect

Adăugare acțiune de document/media

Adăugare acțiune de votare

Categorii de acțiuni

Categorie

Acțiuni de comandă

Acțiuni de pagină

Acțiuni de obiecte

Acțiuni de 
documente/
media

Acțiuni de votare

Descriere

Acțiuni care execută o comandă sau 
pornesc un instrument.

Acțiuni care funcționează cu paginile 
flipchart.

Cea mai mare gamă de acțiuni: afișați și 
ascundeți elemente, rotiți elemente, 
manipulați imagini și text, modificați 
alinierea sau poziția unui element.

Acțiuni care inserează media sau legături 
sau deschid un document, fișier sau 
sunet.

Acțiuni care pornesc diferite activități sau 
instrumente LRS.
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Înapoi sus 

Adăugarea unei acțiuni
Pentru a adăuga o acțiune:

1. Selectați obiectul din pagină căruia doriți să-i aplicați o acțiune.
2. Deschideți Navigatorul de Acțiuni.
3. Derulați prin lista de acțiuni pentru a selecta acțiunea dorită.
4. În partea de jos a Navigatorului de Acțiuni, apăsați pe Aplicare modificări (Apply Changes). Acesta asociază acțiunea aleasă
cu obiectul selectat.

Unele acțiuni necesită adăugarea de „Proprietăți acțiune” și sunt afișate, acolo unde este necesar, în partea de jos a Navigatorului de Acțiuni. 
De exemplu, acțiunea „Size Top Incrementally” vă permite să furnizați un „obiect țintă” căruia i se va aplica acțiunea de dimensionare și, de 
asemenea, să furnizați o proprietate „Y” care vă permite să specificați intervalul de dimensionarea pentru obiectul țintă (în pixeli).

Dacă selectați mai multe obiecte, puteți utiliza Navigatorul de Acțiuni pentru a aplica aceeași acțiune tuturor 
obiectelor selectate.

Pentru a adăuga o acțiune drag & drop:

1. Selectați obiectul.
2. Deschideți Navigatorul de Acțiuni.
3. Apăsați pe fila „Drag and Drop”.
4. Derulați prin lista de acțiuni pentru a selecta acțiunea dorită.
5. Trageți și fixați acțiunea pe obiect.

Eliminarea unei acțiuni

Pentru a elimina o acțiune Drag and Drop, apăsați pe 
pictograma acțiunii (în exemplul nostru, pictograma Riglă din 
triunghiul roșu) și trageți-o în Coșul Flipchart, cu drag & drop.

Pentru a elimina alte acțiuni:

1. Cu Instrumentul de Selectare, trageți în jurul obiectului de acțiune pentru a-l selecta.
2. În Navigatorul de Acțiuni, apăsați pe Remove Existing.

Dacă nu sunteți sigur ce pagini flipchart conțin obiecte de acțiune:

Treceți la Modul Design. 
Acțiunile sunt dezactivate și toate obiectele 
de acțiune sunt identificate printr-un pătrat roșu.

Înapoi sus 
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Asocierea unei acțiuni Drag and Drop

Aceasta este cea mai rapidă metodă să adăugați 
elemente interactive într-un flipchart:

1. Selectați obiectul.
2. În Navigatorul de Acțiuni, deschideți fila Drag and

Drop.
3. Din listă, selectați Rigla (Ruler).

4. Aplicați Rigla cu drag & drop pe obiectul de acțiune,
în cazul nostru un triunghi roșu. Pictograma Riglă de
pe triunghi și cursorul de acțiune arată că acțiunea
a fost adăugată cu succes.

5. Testați acțiunea. Când apăsați pe triunghiul roșu,
apare Rigla. Folosiți rigla în mod normal,
apoi plasați-o în Coșul de Gunoi cu drag & drop.

Puteți repeta acțiunea de câte ori doriți. Va rămâne 
asociată cu obiectul până când ștergeți fie obiectul, fie 
acțiunea.

Pentru detalii despre toate acțiunile din această categorie, vedeți Referințe > Acțiuni > Acțiuni Drag and 

Adăugare acțiune de comandă
Cu obiectul selectat și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Command Actions.
2. Apăsați pe Circular Spotlight.
3. Apăsați pe Apply Changes.
4. Testați acțiunea. Când apăsați pe obiect, ecranul se

schimbă și apare Reflectorul Circular. Folosiți Reflectorul în 
mod normal, apoi selectați Close din meniul popup.

Pentru detalii despre toate acțiunile din această categorie, 
vedeți Referințe > Acțiuni > Acțiuni de comandă. 
(Reference > Actions > Command Actions)

Inapoi
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Adăugare acțiune de pagină
Cu obiectul selectat și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Page Actions.
2. Apăsați pe Set Background.
3. Apăsați pe Apply Changes.
4. Testați acțiunea. Când apăsați pe obiect, se deschide

caseta de dialog “Set Background”. Alegeți fundalul și 
aspectul, apoi apăsați pe OK pentru a închide caseta.

Pentru detalii despre toate acțiunile din această categorie, 
vedeți Referințe > Acțiuni > Acțiuni de pagină 
(Reference > Actions > Page Actions.)

Adăugare acțiune de obiect
Unele acțiuni de obiect vă oferă variante: puteți face ca obiectul de acțiune să fie ținta acțiunii sau să faceți ca acțiunea să se întâmple 
unui cu totul alt obiect. Aici vă arătăm un exemplu al ambelor.

Obiectul de acțiune este obiectul țintă

Cu obiectul selectat și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Object Actions.
2. Derulați în jos și apăsați pe Reflect.
3. În “Action Properties”, apăsați pe butonul  Selectare (Selector). Se deschide caseta 
de dialog “Select Object”.
4. Selectați obiectul, în exemplul nostru o bulă de dialog.
5. Apăsați pe Apply Changes.
6. Testați acțiunea. Când apăsați pe bula de dialog, acesta se reflectă. Acum arată spre
cealaltă față.

Obiectul de acțiune nu este obiectul țintă

Cu obiectul de acțiune selectat, în cazul nostru triunghiul roșu, și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Object Actions.
2. Derulați în jos și apăsați pe Original Size.
3. În “Action Properties”, apăsați pe butonul Selectare (Selector). Se deschide caseta de dialog
“Select Object”.
4.Selectați obiectul țintă, în exemplul nostru triunghiul albastru.
5. Apăsați pe Apply Changes.
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6. Testați acțiunea. Faceți triunghiul albastru mai mic sau mai mare. Când apăsați pe
triunghiul roșu, triunghiul albastru revine la dimensiunea originală.

Pentru detalii despre toate acțiunile din această categorie, vedeți Referințe > Acțiuni > Acțiuni de obiect. 
(Reference > Actions > Object Action)

Adăugare acțiune de document/media
Cu obiectul selectat și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Document/Media Actions.
2. Apăsați pe Open Website.
3. În “Action Properties”, introduceți URL-ul website-ului pe care doriți să îl asociați cu obiectul, de exemplu

www.prometheanplanet.com.
4. Selectați obiectul țintă, în exemplul nostru triunghiul albastru.
5. Apăsați pe Apply Changes.
6. Testați acțiunea. Când apăsați pe obiect, în exemplul nostru o imagine a unei flăcări, se deschide 

website-ul Promethean

Pentru detalii despre toate acțiunile din această categorie, vedeți Referințe > Acțiuni > Acțiuni 
de document/media. (Reference > Actions > Document/Media Actions)

Adăugare acțiune de votare
Cu obiectul selectat și cu Navigatorul de Acțiuni deschis:

1. În fila “Current Selection”, selectați Voting Actions.
2. Apăsați pe Start/Stop Flipchart Vote.
3. Apăsați pe Apply Changes.
4. Testați acțiunea. Când apăsați pe obiect, votul începe. În exemplul nostru, obiectul este o
imagine a pictogramei Start/Stop Flipchart Vote pentru ActivInspire Primary.

Pentru detalii despre toate acțiunile din această categorie, vedeți Referințe > Acțiuni > Acțiuni de votare.
(Reference > Actions > Voting Actions).
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Acasă > Referințe > Actiuni > Acțiuni de comandă

Acțiuni de comandă

Utilizați acțiuni de comandă pentru a activa un instrument, de exemplu, Ceasul sau pentru a lansa o comandă, de 
exemplu, Închidere Flipchart, când apăsați pe un obiect de acțiune.

Următorul tabel enumeră acțiunile și descrie ce se întâmplă când apăsați pe obiectul de acțiune:

Acțiune Efect Mai multe informații

1024 x 768 Flipchart

Creează un nou flipchart “Untitled” la 
dimensiunea specificată. Crearea primului flipchart1152 x 864 Flipchart

1280 x 1280 Flipchart

Despre (About) Deschide fereastra de dialog “About ActivInspire”.

Navigatorul de Acțiuni 
(Action Browser)

Deschide Navigatorul de Acțiuni. Turul Active Inspire > Navigatorul de 
acțiuni (Studio)

Turul Active Inspire  > Navigatorul de 
acțiuni (Primary)

Lucrul cu acțiuni

Captură Zonală
(Area Snapshot)

Începe o captură zonală. Referințe > Instrumente > Camera 

Utilizare cameră

Calculator Activează Calculatorul. Referințe > Instrumente > Calculator 

Utilizare Calculator

Reflector Circular
(Circular Spotlight)

Plasează un reflector circular pe pagina curentă. Referințe > Instrumente > Reflector 

Utilizare Reflector

Ceas (Clock) Activează Ceasul. Referințe > Instrumente > Ceas 

Utilizare ceas

Închidere flipchart (Close Flipchart) Închide flipchartul curent.

Compas (Compass) Activează Compasul. Utilizare compas > Referințe > 

Instrumente > Compas

Conector (Connector) Activează instrumentul de conectare. Referințe > Instrumente > Conector

Flipchart cu dimensiune personalizată 
(Custom Size Flipchart)

Creează un flipchart nou, personalizat la 
dimensiunea pe care o doriți.

Panoul de Control (Dashboard) Deschide Panoul de Control. Panoul de control
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Modul Design (Design Mode) Activează modul design.

Aruncătorul de zaruri 
(Dice Roller)

Deschide caseta „Dice Roller”. Utilizare aruncător de zaruri > 

Instrumente > Aruncătorul de zaruri

Utilizator Dual (Dual User) Pornește modul Utilizator Dual și activează 
Setul de Instrumente Duale.

Referințe > Instrumente > Utilizator Dual 

Lucrul în modul dual

Editează profilurile (Edit Profiles) Deschide fereastra 'Edit Profiles' Referințe > Setări

Lucrul cu profiluri

Radieră (Eraser) Activează Radiera. Referințe > Instrumente > Radieră 

Ștergerea chestiilor

Ieșire (Exit) Iese din ActivInspire și vă solicită să salvați 
modificările, dacă este cazul.

Umplere (Fill) Activează instrumentul de umplere. Referințe > Instrumente > Umplere

Adăugarea și manipularea formelor > 
Umplerea unei forme

Captură fără formă
(Freehand Snapshot)

Pornește o captură cu mâna liberă. Referințe > Instrumente > Camera 

Folosirea camerei

Captură ecran complet
(Fullscreen Snapshot)

Pornește o captură a întregului ecran. Referințe > Instrumente > Camera 

Folosirea camerei

Designer grile (Grid Designer) Deschide designerul de grile. Crearea și editarea grilelor

Recunoaștere Scris de Mână Activează recunoașterea scrisului de mână. Referințe > Instrumente > 
Recunoașterea scrisului de mână

Folosirea Recunoaștere scris de mână

Ajutor (Help) Deschide acest fișier de ajutor.

Asundere grilă (Hide Grid) Ascunde grila.

Evidențiator (Highlighter) Activează evidențiatorul. Referință > Instrumente > Evidențiator 

Scrierea pe flipchart > Evidențierea

Cerneala Magică (Magic Ink) Activează cerneala magică.
Referințe > Instrumente > Cerneală 
Magică 
Folosiți Cerneală Magică

Flipchart Nou (New Flipchart) Creează un fliphart nou “Untitled”.

Navigatorul de Notițe 
(Notes Browser)

Deschide Navigatorul de Notițe. Turul Active Inspire  > Navigatorul de 
notițe (Studio)

Turul Active Inspire  > Navigatorul de 
notițe (Primary)

Crearea notițelor pe pagină
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Navigatorul de Obiecte 
(Object Browser)

Deschide Navigatorul de Obiecte. Turul Active Inspire  > Navigatorul de 
obiecte (Studio)

Turul Active Inspire  > Navigatorul de 
obiecte (Primary)

Tastatură pentru ecran 
(On-screen Keyboard)

Afișează tastatura pe ecran. Referințe > Instrumente > 
Tastatura pe ecran

Deschide din flipcharturile mele
(Open From My Flipcharts)

Deschide fereastra de dialog „Select Flipchart”, ca 
să puteți naviga și selecta un flipchart.

Primii pași în Active Inspire > 
Deschidrea unui flipchart

Navigatorul de Pagini
(Page Browser)

Deschide Navigatorul de Pagini. Turul Active Inspire  > Navigatorul 
de pagini (Studio)

Turul Active Inspire  > Navigatorul 
de pagini (Primary)

Mărire și micșorare pagină 
(Page Zoom)

Enables Page Zoom. Referințe > Instrumente > Zoom pagină

Vizualizare flipchart > Mărire și 
micșorare pagină (Studio)

Vizualizare flipchart > Mărire și 
micșorare pagină (Primary)

Stilou (Pen) Activează stiloul. Referințe > Instrumente > Stilou 

Scrierea pe flipchart

Captură între două puncte 
(Point to Point Snapshot)

Pornește o captură între două puncte. Referințe > Instrumente > Camera 

Folosirea camerei

Printați (Print) Deschide fereastra de dialog “Flipchart Print”. Primii pași în Activ Inspire > Printarea 
unui flipchart

Navigatorul de Proprietăți 
(Property Browser)

Deschide Navigatorul de Proprietăți. Turul Activ Inspire > Navigatorul de 
proprietăți(Studio)

Turul Active Inspire  > Navigatorul de 
proprietăți(Primary)

Modificarea proprietăților unui obiect

Referințe > Proprietăți

Raportor (Protractor) Activează raportorul. Referințe > Instrumente > Raportor 

Folosirea raportorului

Refaceți (Redo) Restabilește comanda anterioară. Referințe > Instrumente > Anulați și 
refaceți

Navigatorul de Resurse 
(Resource Browser)

Deschide Navigatorul de Resurse. Turul Active Inspire  > Navigatorul de 
resurse (Studio)

Turul Active Inspire  > Navigatorul de 
resurse (Primary)

Utilizarea resurselor

Dezvăluitorul (Revealer) Activează Dezvăluitorul Referințe > Instrumente > Dezvăluitorul
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Utilizati Dezvăluitorul

Riglă (Ruler) Activează Rigla. Referințe > Instrumente > Riglă 

Utilizați rigla

Salvează în flipcharturile mele 
(Save to My Flipcharts)

Deschide fereastra de dialog ”Save the flipchart 
as…”, ca sa puteți salva flipchartul în locația 
aleasă.

Salvați un flipchart

Înregistrare Ecran 
(Screen Recorder)

Activează înregistrarea ecranului. Referințe > Instrumente > 
Snregistrarea ecranului
Utilizați Înregistrare ecran

Flipchart de dimensiunea ecranului Creează un nou flipchart “Untitled” de dimensiunea ecranului. Crearea primului flipchart

Căutați resurse în 
Prmethean Planet 

Deschide website-ul Promethean Planet în 
browserul de Internet.

Selectați (Select) Activează instrumentul de selectare. Referințe > Instrumente > Selectare

Formă (Shape) Activează instrumentul de forme. Referințe > Instrumente > Forme 

Adăugarea și manipularea formelor

Recunoaștere formă
(Shape Recognition)

Activează recunoașterea formelor. Referințe > Instrumente > 
Recunoaștere formă

Referințe > Setări > Recunoaștere 
formă

Utilizare Recunoaștere formă

Fixare în grilă (Snap to Grid) Face ca obiectele mutate să se fixeze în grilă, chiar 
dacă aceasta nu este vizibilă. 

Instrumente de referință > Fixare în grillă

Reflector Circular Compact Activează tipul de reflector pe care îl doriți. Referințe > Instrumente > Reflector 

Folosirea ReflectoruluiReflector Pătrat Compact 

Consola de sunet Deschide consola de sunet.

Înregistrare sunet Deschide caseta popup “Sound Recorder”. Referințe > Instrumente > Înregistrare 

sunet > Utilizare Înregistrare sunet

Corector ortografic flipchart
(Spellcheck Flipchart)

Activează corectorul ortografic pe flipchart. Referințe > Instrumente > Corector 
ortografic flipchart

Adăugarea și formatarea textului > 
Corector ortografic

Reflector pătrat 
(Square Spotlight)

Activează reflectorul pătrat. Referințe > Instrumente > Reflector

Utilizarea Reflectorului

Blocare acces
(Teacher Lock)

Deschide fereastra de dialog “Enter Teacher Lock 
password”.

Referințe > Instrumente > Blocare acces

Utilizare Blocare acces

Text Referințe > Instrumente > Text

Activează tipul de reflector pe care îl doriți.
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Activează instrumentul de text. Adăugarea și formatarea textului

Panglică cu mesaje (Tickertape) Deschide fereastra de dialog “Tickertape”. Referințe > Instrumente > Panglică cu 
mesaje

Marcă temporală (Timestamp) Aplică o marcă temporală pe pagina flipchart curentă.

Rulare set de instrumente Înfășoară setul de instrumente principale.

Anulați (Undo) Anulează comanda sau acțiunea anterioară. Referințe > Instrumente > Anulați și 
refaceți 

Navigatorul de Votare 
(Voting Browser)

Deschide Navigatorul de Votare. Turul Active Inspire  > Navigatorul de 
votare (Studio)

Folosirea sistemelor de Răspuns 

pentru elevi

Web Browser Deschide browserul de Internet.

Captură fereastră 
(Window Snapshot)

Pune Camera în modul “Window snapshot”, pentru 
a vă permite să capturați una dintre ferestrele 
vizibile.

Referințe > Instrumente > Camera 

Folosirea camerei

Originea XY (XY Origin) Pornește instrumentul XY Origin, în jurul căruia 
toate obiectele vor fi rotite.

Referințe > Instrumente > XY Origin
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Acasă > Primii pași cu ActivInspire  > Scrierea pe flipchart

Scrierea pe flipchart
Când lucrați la tablă și nu doriți să folosiți tastatura computerului, puteți scrie pe flipchart cu Stiloul.

Aici vă arătăm cum să:

Scrieți cu stiloul

Adăugați evidențieri

Modificarea grosimii Stiloului și Evidențiatorului

Schimbați culoarea

Toate instrumentele descrise în această secțiune sunt în Instrumentele Principale (Main Toolbox).

Scrierea cu Stiloul
Când rulați ActivInspire, Stiloul este activat în mod implicit, astfel încât să puteți începe să scrieți imediat. Alteori, este posibil să 
trebuiască să faceți clic sau să apăsați pe el ca să îl selectați.

Cu Stiloul activat:

1. Poziționați cursorul unde doriți să începeți.

2. Atingeți și trageți pentru a desena o linie sau o formă sau pentru a scrie un cuvânt.
Orice ați desena sau scrie apare în culoarea curentă selectată pentru Stilou.

De fiecare dată când scrieți pe flipchart, creați o adnotare.

Stiloul rămâne activat până când selectați un alt instrument.

Evidențierea

Pentru a evidenția o parte sau tot textul:

1. Faceți click pe Evidențiator Cursorul
se schimbă într-un mic evidențiator cu cerc.

2. Deplasați cursorul unde doriți să începeți.

3. Faceți clic sau atingeți și trageți pentru a evidenția o
zonă a flipcharului.

La fel ca un evidențiator real, îl puteți utiliza pe orice zonă a flipchartului, nu doar pe text.

Înapoi sus 

Modificarea grosimii Stiloului și Evidențiatorului
ActivInspire Studio

În ActivInspire Studio, grosimea Stiloului este setată la 4 pixeli, iar Evidențiatorul la 20 de pixeli, în mod implicit.
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Pentru a modifica grosimea:

1. Faceți clic pe Stilou sau Evidențiator

2. Setați grosimea liniei:

Faceți clic pe una dintre presetări: 2, 4, 6 sau 8 pentru 
Stilou și 10, 20, 35 sau 50 pentru Evidențiator sau

Faceți clic și trageți glisorul de grosime pentru a alege 
orice dimensiune între 0 și 100 pixeli.

ActivInspire Primary

În ActivInspire Primary, selectați pur și simplu un Stilou sau un Evidențiator mai gros sau mai subțire din Caseta Stilou.

Modificarea culorii
Culoarea Stiloului este setată la negru, iar Evidențiatorul la galben translucid, în mod implicit. 

Cel mai rapid mod (ActivInspire Studio) 

1. Faceți clic pe Stilou sau Evidențiator.
2. Faceți clic pe o altă culoare din Paleta de culori

Cel mai rapid mod (ActivInspire Primary) 

1. Faceți clic pe Stilou sau Evidențiator.
2. Faceți clic pe o altă culoare din Paleta de culori.

Mai multe opțiuni (ActivInspire Studio) 

1. Faceți clic pe Stilou sau Evidențiator.
2. Faceți clic dreapta pe Paleta de culori. Se va

deschide Paleta de culori extinsă. 
3. Aveți trei opțiuni:

Faceți clic pe una dintre culorile din paletă. 

Folosiți Selectorul de culori pentru a alege o culoare 
de oriunde din fereastra ActivInspire. 

Utilizați Schema de culori pentru a amesteca 
propria culoare.

Pentru a alege o culoare din fereastra ActivInspire: 

1. Cu paleta de culori extinsă deschisă, faceți clic pe Selectorul de culori.
Se deschide caseta Color Picker.
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2. Mutați Selectorul de culoare în zona ferestrei cu culoarea pe care o
doriți. Caseta Color Picker afișează culoare la și lângă Selectorul de
culori.

3. Când pătratul din centrul casetei arată culoarea dorită, faceți clic
pentru a o adăuga la Paleta de culori.

Pentru a amesteca propria culoare: 

Cu Paleta de culori extinsă deschisă, faceți clic pe pictograma Schema de culori. O casetă de dialog 
specifică sistemului de operare se deschide. 

Exemplu 

Imaginea din dreapta arată caseta de dialog pentru 
sistemul de operare Windows. 

1. O puteți folosi ca să:

a. Alegeți din 48 de culori de bază.
b. Faceți clic oriunde în Spectrul de culori.
c. Faceți clic oriunde în Spectrul de culori, apoi

folosiți glisorul din dreapta pentru a face culoarea mai 
deschisă sau mai întunecată. 

d. Faceți clic pe pictogramele corespunzătoare Sus
și Jos pentru a regla echilibrul de roșu, verde, 
albastru, precum și nuanța și saturația. 

2. Faceți clic pe Add to custom color.

3. Creați câte culori personalizate doriți.

4. Faceți clic pe OK pentru a salva culoarea sau pe
Cancel pentru a anula.

Windows

1 Culori de bază

2 Spectru de culori

3 Glisor

4 Butoane sus și jos

5 Butonul Add to custom color

6 Butoanele OK și Cancel

ActivInspire salvează setările de culoare și grosime ale Stiloului și Evidențiatorului. Data următoare când 
folosiți aceste instrumente, acestea vor fi setate să utilizeze orice culoare și grosime au fost setate anterior.

Înapoi sus 

Mai multe opțiuni (ActivInspire Primary) 

1. Faceți clic pe Stilou sau Evidențiator.

2. Faceți clic dreapta pe unul dintre cele trei sloturi de culoare goale din Caseta Stilou.
Se deschide Paleta de culori extinsă.
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3. Aveți trei opțiuni:

a. Faceți clic pe una dintre culorile din paletă.

b. Utilizați Selectorul de culori pentru a alege
o culoare de oriunde din fereastra ActivInspire.

c. Utilizați Schema de culori pentru a amesteca
propria culoare.

ActivInspire salvează setările de culoare și grosime ale Stiloului și 
Evidențiatorului. Data următoare când folosiți aceste instrumente, acestea vor fi 
setate să utilizeze orice culoare și grosime au fost setate anterior.

Înapoi sus 
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de 
Pagini

Navigatorul de Pagini
Acest navigator vă ajută să puneți rapid baza unui flipchart. Afișează miniaturi ale paginilor într-o rolă de film de-a lungul marginii de 
jos a ecranului.

Folosiți Navigatorul de Pagini pentru:

Vizualizarea întregului flipchart ca miniaturi de pagină
Navigarea printre paginile flipchartului
Setarea fundalului și grilelor pentru pagini
Organizarea paginilor din flipchart folosind drag & drop (trageți și plasați) sau comenzile Decupează (Cut), Copiază (Copy), 
Șterge (Delete) și Duplică (Duplicate)

Exemple

Imaginea din dreapta prezintă un flipchart cu 
mai multe pagini în Navigatorul de Pagini. Puteți 
vedea miniaturi ale primelor cinci pagini din 
flipchart. 

Picrograma Meniu Popup din miniatură indică 
că aceasta este pagina curentă. Asta înseamnă 
că puteți selecta un element sau zonă din 
pagină și să lucrați.

Pentru a afișa o altă pagină, apăsați pe 
miniatură.

Pentru a vizualiza miniaturi ale altor pagini din 
flipchart, apăsați pe triunghiul negru de pe rola 
de film.
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Show 

Home > A tour of ActivInspire > Exploring ActivInspire Primary > ActivInspire's Browsers > Resource Browser

Navigatorul de Resurse
Acest navigator vă ajută să vizualizați, navigați și utilizați facil resursele furnizate de ActivInspire pentru a vă crea flipcharturile. 
Biblioteca de Resurse conține o gamă largă de jocuri și activități, adnotări, evaluări, fundaluri, hărți conceptuale, imagini, forme, sunete 
și alte elemente prea numeroase pentru a fi enumerate. Puteți îmbogăți cu ușurință biblioteca cu resursele proprii și ale altor persoane 
și puteți adăuga pachete de resurse de pe website-ul Promethean Planet www.prometheanplanet.com sau de la partenerii noștri.

Navigatorul de Resurse fișează miniaturi ale resurselor într-o rolă de film de-a lungul marginii de jos a ecranului.

Utilizați Navigatorul de Resurse pentru: 

• Navigare rapidă și vizualizare a tuturor resurselor dintr-un anumit folder, de exemplu Resursele Mele, Resurse Partajate sau
altele locații din memorie sau în rețea.
• Afișarea miniaturilor și numelor de fișiere ale resurselor selectate.
• Inserarea resurselor, cum ar fi șabloane de pagini, pagini de activitate și pagini de întrebări din navigator în flipchart, prin drag
& drop.
• Inserarea propriilor creații dintr-o pagină flipchart într-un folder din Biblioteca de Resurse, prin drag & drop.
• Schimbarea transparenței unei resurse în flipchart.
• Crearea rapidă a mai multor copii ale unei resurse într-un flipchart, cu ajutorul Rubberstamp.

Exemple
Implicit, Navigatorul de Resurse deschide 
fișierul Shared Resources. Toate resursele 
ActivInspire sunt organizate pe categorii și 
stocate în fișiere denumite clar.

Imaginea din dreapta prezintă câteva dintre 
resursele din fișierul Shared Resources.

Apăsați pe pictogramele de sus pentru a 
căuta resurse în următoarele locuri

• Resursele Mele (My Resources)
• Resurse Partajate (Shared
Resources)
• Alt fișier cu resurse
• Alt fișier din computer
• Promethean Planet

Caseta popup “Resource Locations” arată 
fișierele. Meniul Popup vă permite să 
importați și exportați Pachete de Resurse.

           Funcția de import este disponibilă doar 
din Meniul Popup a folderului principal.

De acolo puteți:

• Insera resurse din Biblioteca de Resurse
în flipchart.
• Șterge resurse din Biblioteca de Resurse.

Rola de film din partea de jos a ferestrei 
ActivInspire arată miniaturile resurselor din 
acel fișier și denumirile lor.
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Imaginea din dreapta prezintă câteva 
butoane și pictograme din Navigatorul de 
Resurse. Săgeata de lângă navigator 
deschide Biblioteca de Resurse. Conține, de 
asemenea, două instrumente folositoare 
pentru copierea și modificarea resurselor:

Modificați transparența (Toggle 
Transparency) vă permite să faceți 
transparent fundalul unei imagini atunci când 
o trageți în pagină.

Multiplică (Rubberstamp) vă permite să
inserați rapid mai multe copii ale unei 
resurse în flipchart.

Înapoi sus 



Object Browser

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/object_browser_primary.htm[1/21/2010 6:08:51 PM]

 
Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de Obiecte

Navigatorul de Obiecte
O introducere despre obiecte și Navigatorul de Obiecte:

Despre proiecte

Despre straturi și suprapunere

Vizualizare obiecte

Work with objects 

Exemple

Despre obiecte

În ActivInspire, tot ce adăugați într-un flipchart este un obiect de un fel sau altul. De exemplu, dacă scrieți ceva cu Stiloul (Pen), 
desenați o formă, adăugați o imagine sau o legătură spre un fișier audio, oricare dintre aceste elemente sunt obiecte. Puteți adăuga 
multe tipuri diferite de obiecte într-un flipchart. Navigatorul de Obiecte vă ajută să urmăriți numărul și tipul de obiecte din flipchart și să 
luați cu ușurință obiecte dintr-un flipchart creat de altcineva.

Despre suprapunerea obiectelor
Navigatorul de Obiecte arată detalii despre obiectele de pe pagina curentă. Deși o pagină este un plan drept, o pagină flipchart are de 
fapt 4 straturi! Acestea sunt ca niște foi transparente care conțin anumite tipuri de obiecte, asta dacă nu mutați obiecte de pe un strat 
pe celălalt. Într-un layer puteți suprapune obiecte.

Implicit:

Conține

Adnotări: tot ce desenezi cu Stiloul, Evidențiatorul sau Cerneala Magică, un 
instrument secret despre care vom vorbi mai târziu

Imagini, forme și obiecte text.

Acest strat

Superior

De mijloc

Inferior

Fundal

Tot ceea ce desenezi cu Conectorul, dar puteți plasa și alte obiecte pe acest 
strat, cu drag & drop..

Fundaluri, grile și culoarea paginii.

Selectați obiectele listate în Navigatorul de Obiecte pentru a le putea insera în primele trei straturi din navigator, dar nu în stratul de 
fundal. Acest lucru influențează direct stratificarea lor pe pagina flipchart. Straturile sunt complet separate unul de celălalt. Cu alte 
cuvinte, puteți înlocui fundalul fără a vă afecta imaginile sau adnotările. Sau puteți adnota peste fotografii și fundal fără a afecta alte 
straturi

Pentru mai multe detalii, vedeți Folosirea straturilor și suprapunerii (Using layers and stacking)

Vizualizare obiecte
Utilizați Navigatorul de Obiecte pentru a vizualiza rapid:

• Ordinea de afișare a obiectelor și ce obiecte se află în straturile superior, de mijloc și inferior ale unei
pagini.
• Care obiecte sunt grupate împreună. Acest lucru vă permite să lucrați la toate în același timp.
• Dacă o pagină conține obiecte ascunse.
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• Dacă o pagină conține obiecte care sunt blocate astfel încât să nu poată fi mutate.

Lucrul cu obiecte
Utilizați Navigatorul de Obiecte ca să:

• Mutați obiecte dintr-un strat în altul, cu drag& drop
• Grupați, suprapuneți și reordonați obiecte.
• Afișați sau ascundeți obiecte.
• Blocați sau deblocați obiectele selectate, de exemplu, dacă planificați o activitate cu
elevii în care doar anumite obiecte pot fi mutate, iar altele trebuie să rămână fixe.

Exemplu

Prima imagine din dreapta arată obiectele de pe pagina 
flipchart curentă.

A doua imagine prezintă cum arată detaliile acestor obiecte 
în Navigatorul de Obiecte.

Puteți vedea în fila de stratificare din Navigator că toate 
obiectele sunt identificate prin:

• Pictograma instrumentului prin are au fost create

• Numele lor.

Navigatorul arată clar ce obiecte sunt pe fiecare strat: 
Există nouă obiecte în stratul superior. 
Acestea sunt adnotările scrise cu stiloul 
Există cinci obiecte în stratul de mijloc: 

Textul creat cu Instrumentul de Text și câteva forme

Triunghiul și pătratele create cu instrumentul de Forme 
sunt implicit în stratul de mijloc.

Lacătul de lângă obiectul Text din Navigator indică faptul că obiectul a fost fixat. 
Lacătul este un comutator care permite blocarea și deblocarea rapidă a obiectelor.

Ochiul tăiat de lângă triunghiul Navigator indică faptul că obiectul este ascuns. După 
cum puteți vedea pe pagina flipchart, triunghiul nu este vizibil. Pictograma ochi este un 
comutator care permite afișarea și ascunderea rapidă a obiectelor.

Înapoi sus 
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de Notițe

Navigatorul de Notițe
Acest Navigator vă ajută să faceți flipchartul și mai ușor de utilizat, permițându-vă să creați, vizualizați și editați notițe despre 
flipcharturi. Puteți folosi aceste notițe în ce fel doriți. Veți învăța din experiență că notițele pot face diferența între o lecție neinspirată 
și una care decurge minunat. Vă încurajăm să folosiți Navigatorul de Notițe la potențial maxim pentru a îmbunătăți experiența de 
predare cu ActivInspire.

Folosiți Navigatorul de Notițe ca să:

• Adăugați propriile notițe și comentarii la un flipchart, făcându-l mai ușor de partajat și refolosit.

• Dacă folosiți un flipchart creat de altcineva:

Vizualizați notițele și comentariile altor profesori despre flipchart și adăugați propriile notițe unde este adecvat.

Vizualizați notițe de la autori despre cum să le folosiți mai bine flipcharturile și adăugați propriile notițe unde este adecvat.

Exemplu

Imaginea din dreapta prezintă Navigatorul de Notițe. Puteți 
introduce notițele ca text simplu sau puteți deschide 
Instrumentele de Formatare (Format Toolbar) și formata textul.

ActivInspire afișează pictograma Notițele Paginii (Page Notes) 
în Bara de Meniu dacă pagina curentă conține notițe.

Puteți adăuga notițe la fiecare pagină a unui flipchart și le 
puteți printa, fie odată cu paginile flipchartului, fie separat.

javascript:void(0);


Property Browser

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/property_browser_primary.htm[1/21/2010 6:08:54 PM]

 

Acasă  > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de 
Proprietăți

Navigatorul de Proprietăți
Acest Navigator vă ajută să vizualizați rapid proprietățile unui obiect. Este un instrument puternic pentru a adăuga 
facil interactivitate lecțiilor.

Folosiți acest Navigator pentru a:

• Afișa toate proprietățile unui obiect. Glisați bara verticală a Navigatorului în sus și în jos pentru a vizualiza întreaga gamă
de proprietăți disponibile.
• Vizualiza și modifica poziția și modul de afișare a unui obiect schimbându-i setările din Navigatorul de Proprietăți. Desigur,
puteți controla în continuare poziția unui obiect cu drag & drop și îl puteți edita pentru a-i schimba culoarea.
• Adaugă caracteristici interactive la flipchart și controlați cum pot fi utilizate.
• Adăuga etichete vizibile permanent la obiecte sau etichete care apar doar când treceți cu cursorul mouse-ului peste obiect
• Controla comportamentul unui obiect prin definirea unor reguli numite restricții, care influențează mutarea acestuia.
Această opțiune este folositoare, de exemplu, dacă doriți să creați propriul joc pe ecran.
• Toate proprietățile sunt clasificate clar ca sa puteți selecta proprietățile în funcție de tip

Exemplu

Prima imagine din dreapta prezintă toate obiectele de pe 
pagină, cu pătratul roșu selectat.

Pe pagina flipchart, puteți vedea de asemenea Punctele pentru 
Redimensionare care înconjoară obiectul. Acestea indică că 
puteți muta obiectul sau îl puteți redimensiona. Rândul de 
pictograme pătrate care apar de-a lungul obiectului reprezintă 
Meniul de Editare al Obiectului pentru a putea lucra cu obiectul. 
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A doua imagine prezintă cum arată câteva dintre 
proprietățile pătratului roșu în Navigatorul de Proprietăți. 

Puteți vedea numele obiectului și câteva detalii despre 
poziția pe pagină. Puteți vedea de asemenea că pătratul 
este în stratul de mijloc. 
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Acasă > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de 
Acțiuni

Navigatorul de Acțiuni
Acest Navigator vă ajută să asociați rapid un obiect cu o acțiune. Acest lucru înseamnă că atunci când obiectul este selectat, acțiunea 
asociată cu acesta va avea loc. De exemplu, o panglică va apărea afișând un mesaj sau se va auzi un fișier audio sau va începe un 
vot pe flipchart. Toate acțiunile sunt clar clasificate, ca să puteți selecta acțiunile după tip. Puteți seta oricâte acțiuni în flipchart pentru 
a face lecția cât de variată și interactivă doriți. 

Folosiți Navigatorul de Acțiuni ca să:

• Aplicați o comandă de acțiune unui obiect, de exemplu, Aruncarea Zarurilor (Dice Roller), pentru ca până la 5 zaruri
să fie aruncate atunci când cineva selectează un anumit obiect pe tablă
• Aplicați unui obiect o acțiune pentru pagină, de exemplu, pentru a trece la pagina următoare.
• Aplicați unui obiect o acțiune pentru obiect, de exemplu, pentru a modifica dimensiunea, poziția sau transparența unui obiect.
• Aplicați unui obiect o acțiune media sau document, de exemplu, pentru a insera o legătură către un fișier sau un website.
• Aplicați unui obiect o acțiune de votare, de exemplu pentru a porni sau opri un Vot pe Flipchart.
• Eliminați o acțiune care nu mai este necesară.
• Previzualizați o acțiune pentru a verifica dacă se comportă cum vă doriți.

Exemplu

Imaginea din dreapta prezintă 
Navigatorul de Acțiuni. Am asociat 
Aruncătorul de Zaruri cu pătratul 
albastru.

Știm că o acțiune este asociată cu 
acest obiect pentru că atunci când 
trecem cursorul peste obiect apare 
o pictogramă de Previzualizare.

Când apăsați pe pătrat, fereastra 
popup a Aruncătorului de Zaruri 
se deschide și zarurile se învârt.

Puteți:

• Alege numărul de zaruri.
• Crește sau scădea viteza.
• Arunca zarurile de câte ori doriți.
• Trimite numărul de aruncări pe
flipchartul curent.

Aruncați zarurile!
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Aveți nevoie de ActivInspire Professional pentru a folosi Navigatorul de Acțiuni.
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Acasă  > Turul ActivInspire > Explorați ActivInspire Primary > Navigatoarele ActivInspire > Navigatorul de 
Votare

Navigatorul de Votare
Acest navigator vă ajută să administrați toate aspectele înregistrării dispozitivelor ActivSlate, ActiVote și ActivExpression, să 
porniți sesiuni de vot, dar și să le înregistrați, stocați și căutați rezultatele unei astfel de sesiuni. 

Folosiți Navigatorul de Votare ca să:

• Înregistrați dispozitivele ActivSlate, ActiVote și ActivExpression.

• Repartizați elevii pe dispozitive.

• Comutați între votul anonim sau cu nume.

• Selectați între dispozitivele ActiVote sau ActivExpression pentru o sesiune de vot.

• Setați, suspendați sau schimbați timpul permis pentru răspunsuri.

• Porniți și opriți votul.

• Afișați sau ascundeți mesajul Votați Acum (Vote Now).

• Căutați rezultate ale sesiunilor de vot și să le exportați într-o foaie de calcul Microsoft Excel.

Pentru detalii despre înregistrarea dispozitivelor și folosirea lor în sesiunile de vot, vedeți Folosirea Sistemelor de Răspuns pentru 
Elevi. (Using Learner Response Systems)
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Acasă  > Mai multe despre ActivInspire > Lucrul cu resurse

Lucrul cu resurse
Această secțiune conține mai multe informații despre lucrul cu resurse:

Despre resurse

Adăugarea resurselor în flipchart 

Importul și exportul pachetelor de resurse 

Lucrul cu propriile materiale

Publicarea flipcharturilor
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Acasă  > Mai multe despre ActivInspire > Lucrul cu obiecte

Lucrul cu obiecte
Această secțiune conține mai multe informații despre lucrul cu obiecte:

Utlizarea straturi și suprapunere

Adăugarea de imaginidding images

Adăugarea și eliminarea legăturilor

Adăugarea multimedia

Transformarea obiectelor

Crearea și editarea grilelor

Modificarea proprietăților obiectelor
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Acasă  > Mai multe despre ActivInspire > Realizarea flipcharturilor interactive

Realizarea flipcharturilor interactive
Această secțiune conține mai multe informații despre adăugarea elementelor interactive în flipcharturi:

Crearea containerelor

Crearea restricțiilor

Lucrul cu acțiuni
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Show 
Home > More about ActivInspire > Importing and exporting files

Importul și exportul fișierelor 
Aici vă prezentăm cum să importați fișiere din alte aplicații și să exportați o pagină flipchart ca un document grafic:

Importul fișierelor

Exportul fișierelor
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Acasă  > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea profilurilor > Crearea unui 
profil

Crearea unui profil
Profilul dvs. implicit evoluează ori de câte ori selectați sau modificați ceva în ActivInspire. Instrumente noi apar în Bara de comenzi 
rapide pentru instrumente și poate ați deschis sau închis Navigatorul, ați fixat sau mutat setul de Instrumente Principale sau ați 
schimbat afișajul astfel încât să puteți folosi zona World. Toate aceste preferințe sunt înregistrate în profilul dvs. implicit. 

În exemplul din dreapta, puteți vedea că: 

• Setul de Instrumente Principale este fixat
de-a lungul marginii de jos.
• Coșul pentru flipchart este deasupra
acestuia, în stânga.
• Navigatorul este închis și
• Dimensiunea paginii a fost redusă pentru a
da acces la zona World.

Pentru a crea un profil: 

1. Din meniul de Editare (Edit), selectați
Profiles. Fila „Layout” se deschide în
caseta de dialog „Edit Profiles”.

2. Faceți clic pe opțiuni pentru a le selecta
sau modifica.

3. Faceți clic pe fila „Commands” și adăugați
sau eliminați instrumente.

4. Faceți clic pe fila „User defined tools” și
definiți propriile butoane.

5. Faceți clic pe fila „Settings”, selectați o
zonă din panoul din stânga și schimbați
setările.

6. Când sunteți mulțumit de profilul dvs., faceți clic pe Save Profile As. Se deschide caseta
de dialog „Save Profile As”.
7. Tastați numele noului dvs. profil, de exemplu, „Profilul favorit” și faceți clic pe Save.
8. Noul profil „Profilul favorit” este acum profilul curent.

9. Faceți clic pe Done.

Pentru informații detaliate despre cum să personalizați fiecare zonă (Pașii de la 2. la 5.), consultați:

Alegerea aspectului

Alegerea instrumentelo

Definirea butoanelor

Alegerea setărilor aplicațiilor
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  Acasă  > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea profilurilor > Alegerea 
aspectului

Alegerea aspectului
Aici introducem componentele ferestrei ActivInspire a cărei aspect poate fi personalizat și vă arătăm cum să faceți asta:

Ce puteți personaliza?

Desciderea filei Layout

Salvarea modificărilor

Ce puteți personaliza?
Puteți controla poziția, vizibilitatea și comportamentul implicite pentru seturile și barele de instrumente, 
navigatoare și alte zone din ActivInspire. Descriem succint opțiunile de aspect

Opțiune

Dimensiunea
pictogramelor

Setul de Instrumente 
Principale

 Descriere
Setați dimensiunea pictogramelor astfel încât să fie adecvată pentru lucrul pe computer sau la tablă și vârsta 
elevilor.Intervalul este de la 16 la 32 de pixeli. Cu cât alegeți un număr mai mare, cu atât vor fi mai mari 
pictogramele în fereastra ActivInspire.

Poziționați setul de instrumente și controlați-i comportamentul:

Ancorat sau liber

Afișează 8, 16 sau 24 culori

Fixat, parțial sau ascuns

Ancorați (dock) setul de instrumente de marginea interioară a ferestrei 
ActivInspire în poziția dorită (top, bottom, left, right) sau lăsați-l liber (floating) 
ca să îl puteți muta cu drag & drop în funcție de necesități.

Setați numărul de culori care să fie afișate în Paleta de Culori.

Pin - setul de instrumente rămâne fixat când mutați cursorul în altă zonă din 
fereastra ActivInspire. Lăsați-l liber ca să se ruleze spre margine când nu este 
folosit. 

Roll up – doar primul rând de pictograme din setul de instrumente este vizibil.

Roll in – bara de comenzi rapide pentru instrumente este ascunsă.

Setul de 
Instrumente Duale

Poziționați setul de instrumente și controlați-i comportamentul:

Ancorat sau liber

Afișează 8, 16 sau 24 culori 

Fixat

Ancorați (dock) setul de instrumente de marginea interioară a ferestrei 
ActivInspire în poziția dorită (top, bottom, left, right) sau lăsați-l liber (floating) 
ca să îl puteți muta cu drag & drop în funcție de necesități.

Setați numărul de culori care să fie afișate în Paleta de Culori.

Pin - setul de instrumente rămâne fixat când mutați cursorul în altă zonă din 
fereastra ActivInspire. Lăsați-l liber ca să se ruleze spre margine când nu este 
folosit. 

Navigatoarele Poziționați navigatoarele și controlați-le comportamentul:

Ancorat sau liber

Bara de meniu

Pinned

Visible

Poziționați bara de meniu și controlați-i comportamentul:

Ancorat

Ancorați (dock) navigatoarele de marginea interioară a ferestrei ActivInspire 
în poziția dorită (top, bottom, left, right) sau lăsați-le libere (floating) ca să le 
puteți muta cu drag & drop în funcție de necesități.

Pin – navigatoarele rămân fixate când mutați cursorul în altă zonă din 
fereastra ActivInspire. Lăsați-le libere ca să se ruleze spre margine când nu 
sunt folosite. 

Afișați sau ascundeți Navigatoarele.

Ancorați Bara de meniu în marginea interioară de sus sau de jos a ferestrei 
ActivInspire
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Vizibilitate Afișați sau ascundeți Bara de meniu.

Filele document Poziționați filele document și controlați-le comportamentul:

Setările pentru filele document nu sunt disponibile pentru Mac®.

Ancorat

Vizibilitate

Ancorați filele document în marginea interioară de sus sau de jos a 
ferestrei ActivInspire.

Afișați sau ascundeți filele document.

Afișați Coșul de gunoi

Afișați întreg ecranul

Afișați sau ascundeți Coșul de gunoi.

Afișați flipcharturile pe ecran complet sau la dimensiunea la care au fost create.

Înapoi sus

Deschiderea filei Layout

1. Din Edit Menu, selectați Profiles. Se deschide fila Layout.
2. Selectați profilul ale cărui setări doriți să le personalizați sau acceptați-le pe cele implicite.
3. Selectați componentele ale căror aspect doriți să-l personalizați

ActivInspire Studio ActivInspire Primary

Salvarea modificărilor
Puteți salva modificările în profilul curent sau într-un profil nou.

 Salvarea modificărilor în profilul curent

Apăsați pe Done.

Salvarea modificărilor într-un profil nou

1. Apăsați pe Save As. Se deschide caseta de dialog “Save profile as”.
2. Tastați numele noului dvs. profil, de exemplu, „Profilul favorit” și faceți clic pe
Save.
3. Noul profil „Profilul favorit” este acum profilul curent.
4. Faceți clic pe Done.
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  Acasă  > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea profilurilor > Alegerea 
instrumentelor

Alegerea instrumentelor
ActivInspire vă permite să adăugați și să eliminați instrumente în și din caseta Setul de Instrumente Principale și să personalizați punctele de acțiuni care 
apar atunci când selectați un obiect.

1. Din File Menu, selectați Settings. Se deschide caseta de dialog „Edit Pofiles”. Profilul curent este afișat în partea stângă sus.
2. Din meniul drop-down, selectați profilul pe care doriți să îl editați sau acceptați-l pe cel implicit.
3. Faceți clic pe fila Commands.
4. Din meniul drop-down, selectați instrumente pe care să le adăugați sau să le eliminați din Setul de Instrumente Principale sau din punctele de acțiuni.

Pentru a adăuga un instrument:

1. Selectați instrumentul din panoul din stânga și faceți clic pe Add. Instrumentul apare în panoul
din dreapta.

2. Pentru a-i schimba poziția în setul de instrumente, faceți clic pe Move Up sau Move Down.

Pentru a elimina un instrument:
Selectați instrumentul din panoul din dreapta și faceți clic pe Remove.

Pentru a salva profilul și a ieși, faceți clic pe Done.

Pentru a salva ca profil nou, faceți clic pe pictograma Save as.
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Acasă  > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea profilurilor > Definirea butoanelor

Definirea butoanelor
Din File Menu, selectați 
Settings. Se deschide 
caseta de dialog „Edit 
Pofiles”.

• Selectați fila „User
defined buttons” și
apăsați pe Add....

Este afișată pictograma pentru 
definirea butoanelor de către 
utilizator.

1. Selectați Program/File din meniu.
2. Sub Program/File introduceți calea pentru fișierul pe care

doriți să îl deschideți.

3. Sub Command line parameters introduceți comanda
pentru a porni aplicația care va deschide fișierul de mai
sus. Puteți adăuga și un indiciu (Tooltip).
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Show 

Home > More about ActivInspire > Making profiles work for you > Creating and switching profiles > Choosing application settings

Alegerea setărilor aplicațiilor
Aici introducem zonele din ActivInspire pe care le puteți personaliza schimbându-le setările și vă arătăm cum să faceți asta.

Ce puteți personaliza?

Deschidrea filei

Modificarea setărilor

Salvarea setărilor

Ce puteți personaliza?
Următorul tabel descrie succint fiecare dintre zonele pe care le puteți personaliza. Pentru detalii despre setările disponibile pentru fiecare zonă, apăsați pe link-urile din tabel.

Folosiți aceste setări ca să...

Instrumentul ceas

Modul design

Personalizați aspectul ceasului.

Controlați comportamentul obiectelor când este selectat Modul Design. Aceste setări anulează proprietățile individuale 
ale obiectelor setate din Navigatoarele de Acțiune și Proprietăți.

Efects

Flipchart

Obiecte flipchart 

Limbă

LSistem de răspuns din partea elevilor

Multimedia

Setări online

Profiluri și resurse

Înregistrări

Recunoaște forma  

Corector ortografic 

Instrumente

Inputul utilizatorului

Specificați cum doriți să funcționeze                   Reflectorul și                     Dezvăluitorul.

Specificați setări implicite pentru flipcharturi.

Definiți opțiuni pentru a îmbunătăți calitatea obiectelor și a afișării acestora.

Schimbați limba folosită de ActivInspire.

Personalizați modul de lucru cu dispozitivele ActivExpression și ActiVote și cum sunt afișate răspunsurile.

Personalizați modul de lucru cu fișierele audio, video sau Flash.

Introduceți detaliile necesare pentru a accesa resurse online folosind ActivInspire.

Specificați unde doriți să stocați profilurile, folderele My Resource Library și Shared Resource Library, dar și fișierele cu 
pagini șablon și de întrebări.

Modificați diverse setări video și audio. Schimbând aceste setări puteți îmbunătăți performanța instrumentului de 
Înregistrare Sunet.

Umpleți automat formele care au fost create cu instrumentul de Recunoaștere formă.

Definiți reguli pentru corectorul ortografic.

Schimbați aspectul riglei, raportorului sau compasului. Există și opțiuni pentru modificarea locației pentru Resource Library, 
modificarea vitezei Aruncătorului de Zaruri și mărire și micșorare pagină. 

Modificați modul de lucru pentru Tastatura Flotantă sau Recunoaștere Scris de Mână.

Înapoi sus 

Deschiderea filei Settings
1. Din File Menu, selectați Settings. Se deschide caseta de dialog „Settings”.
2. Selectați profilul ale cărui setări doriți să le personalizați sau acceptați-le pe cele implicite.
3. Din panoul din stânga al filei „Settings”, selectați zona pe care doriți să o personalizați, de exemplu Learner Response System

(Sistem de Răspuns din partea Elevilor).

ActivInspire Studio ActivInspire Primary
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Modificarea setărilor
Unele setări au o casetă de selectare simplă care acționează ca un comutator, în timp ce alte setări au comenzi diferite:

Pentru a alege o setare, bifați sau debifați caseta.

Pentru a modifica setarea, selectați valoarea implicită și tastați deasupra acesteia.

Pentru a schimba culoarea, faceți clic pe culoare și selectați alta din Paleta de culori standard pentru sistemul dvs. de operare.

Pentru a schimba setarea, mutați glisorul.

Pentru a modifica setarea, selectați una diferită din meniul drop-down.

Pentru a modifica setarea, faceți clic pe pictogramă și navigați la un alt folder.

Salvarea modificărilor
După ce ați făcut modificările, faceți clic pe Done pentru a le salva.

Înapoi sus 

sau
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Acasă > Mai multe despre ActivInspire > Personalizarea profilurilor > Crearea și comutarea profilurilor > Comutarea 
profilurilor

Comutarea profilurilor
Comutarea profilurilor este utilă atunci când trebuie să comutați rapid între aspectele și setările salvate anterior. De exemplu, este 
posibil să aveți un profil care să conțină toate preferințele și setările pentru pregătirea flipcharturilor și altul pentru stilul de 
prezentare ales sau poate doriți să treceți la un profil care conține toate instrumentele de matematică. 

Două moduri de a schimba profilurile: 

1. În Instrumentele Principale, faceți clic pe Switch Profile. Se deschide o casetă popup care listează profilurile disponibile.
2. Faceți clic pe profilul dorit, de exemplu, Multimedia. Caseta se închide și profilul devine activ imediat.

Sau

1. Din Edit Menu, selectați Profiles... Se deschide caseta de dialog „Edit profiles”.
2. Din lista drop-down, selectați profilul dorit. Profilul devine activ imediat.
3. Faceți clic pe Done.
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Acasă  > Referințe  > Proprietăți  > Proprietăți diverse

Proprietăți diverse
Pentru detalii despre schimbarea proprietăților, vedeți Schimbarea proprietăților obiectelor (Changing object properties)

Proprietate Opțiune Descriere

End Cap A None Implicit

Radius Adăugați o terminație în marginea din stânga a unei forme, linii sau conector.

Arrow

End Cap B None Implicit

Radius Adăugați o terminație în marginea din dreapta a unei forme, linii sau conector.

Arrow

Pick Trough True Implicit

Dacă proprietatea de transparență a unui obiect este setată pe True, puteți să 
apăsați pe zona transparentă a unui obiect pentru a selecta un alt obiect de 
dedesubt.

False

Transpartent Color Blue Implicit

Funcționează doar dacă proprietatea de transparență a unui obiect este setată pe 
True.
Apăsați pe caseta de culori pentru a activa Selectorul de culori și alegeți orice 
culoare de pe display, apoi aplicați-o obiectului.

Transparent True Implicit

False Selectați pentru a face obiectul opac.

Tiled

Fill Mode None Implicit

Drag a Copy False Implicit

True Setați pe True pentru a putea face copii ale unui obiect apăsând pe el și glisând.
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Prezentare generală
Ce este acesta?
ActivClassroom Learner Response System (LRS) (Sistemelul de Răspuns pentru Elevi) cuprinde:

• ActivBoard

• Computer cu ActivInspire instalat

• ActivHub model AH1 sau AH2

• Dispozitive de vot

Pentru detalii despre dispozitivele compatibile, vedeți Înregistrarea dispozitivelor (Registering devices)

Cum funcționează?
1. Conectați ActivHub la un slot USB de pe computer.

2. Împărțiți dispozitivele de vot elevilor.
3. Porniți ActivInspire și înregistrați dispozitivele.
4. Când ați lansat întrebarea, faceți clic pe Start Vote.
5. Când toți elevii au votat sau când expiră timpul, rezultatele sunt afișate pe tablă.

De asemenea, aveți opțiunea de a aloca elevii pe dispozitive. Acest lucru poate fi util când 
aceiași elevii vor folosi aceleași dispozitive pentru o perioadă lungă de timp.

Pot folosi dispozitivele ActiVote și ActivExpression în aceeași sesiune de vot?
Puteți utiliza atât dispozitivele ActiVote, cât și ActivExpression în lecție, dar nu în același timp. Puteți realiza două sesiuni de vot - 
nu trebuie să închideți flipchartul sau rezultatele afișate înainte de a rula o altă sesiune de votare.

Care este diferența dintre votul anonim și votul numit?

În votarea anonimă (Anonymous voting), sunt afișate numerele dispozitivelor - nu vedeți cine a trimis răspunsul.
În votarea numită (Named voting), sunt afișate numele dispozitivelor, astfel încât să puteți vedea mai ușor ce dispozitive au 
trimis voturi.
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Înregistrarea dispozitivelor
Aici vă arătăm cum să configurați sistemul de răspuns Activclassroom LRS

(About Device Registration)

(Register ActivExpression devices) 

(Rename ActivExpression devices) 

(Register ActiVote devices - model AV3) 

(Register ActiVote devices - model AV2)

Despre înregistrarea dispozitivelor
Înregistrarea dispozitivelor este procesul prin care informați ActivHub câte 
dispozitive și grupuri de dispozitive există în clasă. Trebuie să înregistrați 
dispozitivele înainte de a începe o sesiune de vot. 

Începeți înregistrarea dispozitivelor din Navigatorul de Votare. Imaginile din 
dreapta afișează informațiile pe care le veți vedea în caseta de dialog 
„Device Registration”:

• Câte ActivHub sunt conectate la computer.

• Grupuri de dispozitive.

• Câte dispozitive sunt înregistrate la fiecare ActivHub.

Vestea bună este că, odată ce le-ați înregistrat, puteți lua 
dispozitivele și ActivHub în altă locație, conectați ActivHub 
la un alt computer cu ActivInspire instalat și începeți să 
votați imediat.

Există două tipuri de ActivHub:

Acest ActivHub...

AH2

AH1

Este compatibil cu...

ActiVote AV3, ActivExpression 

ActiVote AV2

Înregistrarea dispozitivele ActivExpression 
Înainte de a începe înregistrarea:

1. Porniți ActivInspire.
2. Conectați un ActivHub model AH2 la computer.
3. Distribuiți dispozitivele ActivExpression și asigurați-vă că sunt pornite.

Pentru înregistrare:

1. Deschideți Navigatorul de Vot (Voting Browser) și faceți clic pe Device Registration.
Se deschide caseta de dialog „Device Registration”.
2. Selectați ActivExpressions și faceți clic pe Register.
3. Introduceți numărul de dispozitive pe care doriți să le înregistrați (sau utilizați săgețile) și

faceți clic pe Next.

 Următoarea fereastră arată un cod PIN care 

• Despre înregistrarea dispozitivelor

• Înregistrarea dispozitivele ActivExpression 

• Redenumirea dispozitivele ActivExpression 

• Înregistrarea dispozitivele ActiVote - model AV3

• Înregistrarea dispozitivele ActiVote - model AV2 
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trebuie introdus pe fiecare dispozitiv ActivExpression care urmează să fie înregistrat. 
Fereastra are instrucțiuni clare, cu fotografii, astfel încât elevii să poată finaliza 
înregistrarea (ar trebui să exersați procedura înainte!).

Pentru ca elevii să termine înregistrarea, trebuie să:

a. Apese butonul MENU / SYM de pe dispozitivele ActivExpression.
b. Apese pe tasta de opțiune Register, indicată pe ecranul ActivExpression.
c. Introducă codul PIN, apăsând tastele de opțiune ActivExpression corespunzătoare
codului PIN, așa cum este indicat pe ecran.

Codul PIN nu se introduce cu tastele text.

După introducerea a trei litere, așa cum este afișat în caseta codului PIN de pe ecranul ActivExpression, literele sunt transmise către ActivHub. ActivHub 
trimite codul către ActivInspire.

Codul PIN poate fi editat înainte de transmitere, dar numai dacă au fost introduse una sau două litere. Tastele de opțiune pentru Ștergere (Clear) și 
Anulare (Abort) pot fi utilizate pentru editare, dar și tasta Ștergere (Delete) de pe tastatură.

ActivInspire înregistrează dispozitivele pe ActivHub unul câte unul. Puteți vedea numărul actualizat în fereastră, chiar sub codul PIN.

Când acest număr este egal cu numărul introdus la pasul 3 de mai sus, fereastra se închide automat, deoarece toate dispozitivele au fost înregistrate.

Dacă înregistrarea eșuează pentru unul dintre dispozitive, fereastra trebuie închisă manual.

Dacă un cod PIN este introdus incorect, pașii de la a. la c. trebuie repetați pentru o înregistrare reușită.

Această procedură poate fi repetată de câte ori doriți, dar nu ar trebui să fie necesară - sistemul este extrem de fiabil. După câteva eșecuri pentru un 
dispozitiv puteți să:

• Faceți clic pe Finish pentru a închide fereastra și continuați sau

• Îl înlocuiți cu un alt dispozitiv ActivExpression, înregistrându-l dacă este necesar.

Înapoi sus

Redenumirea dispozitivele ActivExpression 

Există două locuri de unde puteți redenumi dispozitivele:

• Redenumiți dispozitivele individual în fereastra „Device Registration”

• Redenumiți dispozitivele individual sau deodată din caseta „ActivExpression Devices Group”

Redenumirea dispozitivelor individual

Pentru a redenumi dispozitivele individual în fereastra „Device Registration”:

1. Selectați orice dispozitiv individual și faceți clic pe Rename. Numele
existent al dispozitivului este afișat într-o casetă pe care o puteți edita.

2. Introduceți noul nume și faceți clic pe OK. Noul nume este afișat în
caseta de dialog „Device Registration”. Aceasta înseamnă că este stocat pe
ActivHub. Dispozitivul ActivExpression poate fi oprit, dar data următoare
când este pornit, comunică cu ActivHub și primește noul său nume.

Pentru a redenumi dispozitivele individual în caseta „ActivExpression Devices Group”:

1. Faceți clic pe Rename. Se deschide caseta „Device Naming”.
2. Faceți dublu clic pe nume și editați-l.
3. Faceți clic în coloana „Committed”. Dispozitivul este redenumit ca mai sus.

Redenumirea tuturor dispozitivelor

Puteți redenumi toate dispozitivele cu numere consecutive și un prefix comun.

1. În caseta ActivExpression Devices Group, faceți clic pe Rename pentru a afișa caseta „Device Naming”.
2. Faceți clic în caseta „Rename all of the devices using the prefix” și introduceți un prefix.
3. Faceți clic pe Apply prefix. Toate dispozitivele ActivExpression din grup sunt redenumite pe ActivHub, așa

cum este descris mai sus, cu prefixul și numerele, începând cu 1
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Numerele pot fi editate separat.

Înregistrarea dispozitivele ActiVote - model AV3
Înainte de a începe înregistrarea:

1. Distribuiți dispozitivele ActiVote și asigurați-vă că sunt pornite.
2. Conectați un ActivHub model AH2 la computer.
3. Porniți ActivInpire.

Pentru înregistrare:

1.Deschideți Navigatorul de Vot (Voting Browser) și faceți clic pe Device
Registration. Se deschide caseta de dialog „Device Registration”.
Este afișat:

• O imagine a unui ActivHub AH2.

• Dispozitivele ActiVote și ActivSlate sub Device Groups.

2.Selectați ActiVotes și apăsați pe Register.
3.Introduceți numărul de dispozitive pe care doriți să le
înregistrați (sau folosiți săgețile) și apăsați pe Next.

Următoarea fereastră afișează instrucțiuni clare, cu fotografii, astfel încât 
elevii să poată finaliza înregistrarea (ar trebui să exersați procedura 
înainte!).

Este afișat un cod PIN de trei litere, care trebuie introdus pe fiecare 
dispozitiv care urmează a fi înregistrat.

Ca să finalizeze înregistrarea, elevii trebuie să:

a. Ține apăsat butonul central Registration de pe dispozitivele
ActiVote, până când ambele lumini superioare sunt aprinse.

b. Introducă codul PIN, apăsând tastele dispozitivului ActiVote.

ActivInspire înregistrează dispozitivele pe ActivHub unul câte unul. Puteți vedea numărul actualizat în fereastră, chiar sub codul PIN.

Când acest număr este egal cu numărul introdus la pasul 3. de mai sus, fereastra se închide automat, deoarece toate dispozitivele au fost înregistrate. 
Dacă înregistrarea eșuează pentru oricare dintre dispozitive, fereastra trebuie închisă manual.

Dacă un cod PIN este introdus incorect, ambii pași a. și b. trebuie repetați, adică butonul central trebuie apăsat și menținut până când ambele lumini sunt 
aprinse și trebuie introdus codul PIN corect pentru o înregistrare reușită.

Această procedură poate fi repetată de nenumărate ori, dar nu ar trebui să fie necesară – sistemul este extrem de fiabil. După câteva eșecuri pentru un 
dispozitiv puteți să:

• Faceți clic pe Finish pentru a închide fereastra și să continuați sau

• Să îl înlocuiți cu un alt dispozitiv ActiVote, înregistrându-l dacă este necesar.

Înapoi sus 

Înregistrarea dispozitivele ActiVote - model AV2
Înainte de a începe înregistrarea:
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1. Porniți ActivInspire.
2. Conectați un ActivHub model AH1 la computer.
3. Distribuiți dispozitivele ActiVote și asigurați-vă că sunt pornite.

Pentru înregistrare:

1. Deschideți Navigatorul de Vot (Voting Browser) și faceți clic pe Device
Registration. Se deschide caseta de dialog „Device Registration”.

Este afișat:

• O imagine a unui ActivHub AH1.

• Dispozitivele ActiVote și ActivSlate sub Device Groups.

2. Selectați ActiVotes și apăsați pe Register.
3. Introduceți numărul de dispozitive pe care doriți să le
înregistrați (sau folosiți săgețile) și apăsați pe Next.

Următoarea fereastră afișează instrucțiuni clare, cu fotografii, astfel încât 
elevii să poată finaliza înregistrarea (ar trebui să exersați procedura 
înainte!).

Ca să finalizeze înregistrarea, elevii trebuie să:

a.Țină apăsat butonul central Registration de pe dispozitivele
ActiVote. Lumina roșie din partea de sus clipește, urmată de lumina
verde.
b. Elibereze butonul Registration.

    




Înapoi sus
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Acasă  > Folosirea Sistemelor de Răspuns pentru Elevi > Alocarea elevilor pe dispozitive

Alocarea elevilor pe dispozitive
Aici descriem avantajele atribuirii studenților pe dispozitive și vă arătăm cum să faceți acest lucru:

De ce să repartizați elevii pe dispozitive?

Alocarea elevilor pe dispozitive

De ce să repartizați elevii pe dispozitive?
Nu este obligatoriu să alocați elevii pe dispozitive, dar făcând acest lucru puteți reduce timpul necesar pentru a strânge și a procesa 
rezultatele și vă oferă o perspectivă imediată asupra progresului fiecărui elev.

Puteți atribui numele studenților dintr-un fișier bază de date. Puteți utiliza baze de date existente sau puteți genera și exporta o bază 
de date folosind ActivInspire.

Când atașați un ActivHub la computer, dispozitivele înregistrate sunt afișate în caseta de dialog „Device Registration”. În funcție de 
selecțiile din Navigatorul de Votare, caseta afișează una dintre următoarele:

• Număr dispozitiv (Device Number) - Vot anonim.
• Nume dispozitiv (Device Name) - Votare numită (studenți nealocați dispozitivelor).
• Nume student (Student Name) - Votare numită (studenți alocați dispozitivelor).

Alocarea elevilor pe dispozitive

În Navigatorul de vot:

1.Faceți clic pe Assign students to devices.

Caseta de dialog „Assign students to devices”se 
deschide.

Numele și id-ul studenților trebuie să fie 
plasate în această casetă de dialog dintr-un 
fișier bază de date. Numele pot fi importate 
dintr-o bază de date cu extensia de fișier .edb 
or.csv sau puteți genera și exporta o bază de 
date a clasei din ActivInspire.

2. Faceți clic pe Edit Student Database. Se deschide caseta de dialog „Edit Student Database”.
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3. Adăugați o clasă în caseta  a:

a. Faceți clic pe Add Class. Se deschide
caseta de dialog „Add Class”.

b. Introduceți numele clasei și al
profesorulului. Notițele sunt opționale.

c. Faceți clic pe Submit.

4. Adăugați elevii în caseta b:

• Faceți clic pe Add Student. Se deschide
caseta de dialog „Student”.
• Introduceți numele, prenumele și ID-ul.
• Faceți clic pe Submit.
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Înapoi în caseta de dialog „Edit Student Database”:

5. Evidențiați clasa.
6. Evidențiați numele elevilor pe care doriți să îi atribuiți dispozitivelor de vot.

7. Faceți clic pe săgeți pentru a adăuga sau elimina studenți în sau din caseta c.
8. Faceți clic pe OK. Se închide caseta de dialog „Edit Student Database”, iar ActivInspire revine la caseta de dialog
„Assign students to devices”.

Elevii afișați în această casetă pot fi repartizați. Dacă numărul elevilor este mai mare decât numărul de dispozitive 
înregistrate, este afișat un avertisment.

Dacă doriți să înregistrați mai multe dispozitive înainte de a aloca elevii pe dispozitive, selectați Top-up Registration. 
Se deschide caseta de dialog „Device Registration”. Pentru detalii, vedeți Înregistrarea dispozitivelor. (Registering 
devices)

În caseta de dialog „Assign students to devices”:

9. Selectați Assign Devices - numerele PIN ale dispozitivelor apar în caseta de dialog. Pe dispozitivele ActivExpression este, de
asemenea, afișată o solicitare.
10. Fiecare elev trebuie să introducă numerele PIN corecte:
• Dispozitive ActiVote - apăsați butoanele de vot
• Dispozitive ActivExpression - apăsați butoanele de opțiune

Caseta de dialog „Assign students to devices” afișează dispozitivele atribuite, evidențiate în verde. Acum, când 
selectați Named Voting, Navigatorul de Vot afișează numele studenților.

înapoi sus
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Acasă  > Folosirea Sistemelor de Răspuns pentru Elevi > Întrebări pregătite – Folosirea Expertului în Întrebări

Întrebări pregătite – Folosirea Expertului în Întrebări
Cum funcționează

Expertul în Întrebări (Question Wizard) afișează o 
serie de casete de dialog, fiecare cu instrucțiuni 
detaliate ca să vă fie de ajutor.

Trebuie să: 

1. Alegeți tipul de întrebare.
2. Alegeți un aspect.
3. Introduceți text pentru întrebare și

răspunsuri, acolo unde este cazul.
4. Faceți clic pe Finish pentru a închide

Expertul în Întrebări.

Expertul în Întrebări plasează obiecte text pe pagina 
flipchart, transformându-l într-o pagină de întrebări. 
Dacă alegeți unul dintre șabloanele de aspect 
oferite, există și obiecte grafice. 

Folosiți Navigatoarele pentru a identifica obiecte. 
Puteți edita oricare dintre texte sau obiecte. 

Whenever you navigate to that page, the Start

Ori de câte ori navigați la pagina respectivă, butonul 
Start Vote              este evidențiat în verde și puteți 
face clic pe buton pentru a începe o sesiune de vot. 

Alte opțiuni importante 

Puteți nominaliza răspunsurile corecte pentru toate tipurile de întrebări. Când aceste răspunsuri sunt returnate prin 
vot, sunt evidențiate în verde în toate afișajele opționale ale rezultatelor, în afară de diagrama radială, unde sunt 
evidențiate în roșu.
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Pentru informații importante despre proprietăți și 
etichete, consultați Referințe > Proprietăți> 
Proprietăți de identificare.  (Reference > Properties 
> Identification properties).

Răspunsurile text nominalizate ca „corect” sunt un 
caz sensibil. Răspunsurile numerice care sunt 
nominalizat ca „corect” permit un nivel de eroare 
care poate să fie setat în Expertul în Întrebări.

Toate tipurile de întrebări sunt încheiate cu o 
solicitare pentru o întrebare de continuitate. Aceasta 
este pentru a încuraja discuțiile și feedback-ul.

Înapoi sus 
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Acasă  > Folosirea Sistemelor de Răspuns pentru Elevi > Întrebări și sondaje rapide

Întrebări și sondaje rapide

În orice moment al lecției, le puteți adresa elevilor o întrebare și dați clic pe ExpressPoll. Acesta afișează Roata 
Minunilor (Wonderwheel) pentru votare.

Folosiți-l de câteva ori și veți înțelege de ce este denumit așa. Designul Roții Minunilor vă ajută să comunicați întrebarea în mod 
clar, astfel încât elevii să înțeleagă rapid cum ar trebui să răspundă.

Cum funcționează 

1. Treceți cu stiloul peste Roata Minunilor și evidențiați un stil de întrebare.
2. Mutați stiloul radial și în exterior pentru a afișa opțiunile pentru stilul pe care

tocmai l-ați ales
3. Faceți clic pentru a selecta una dintre opțiuni.

Imaginea din dreapta arată Roata Minunilor pentru dispozitivele ActiVote. Stilul 
de întrebare evidențiat este „Adevărat / Fals” (True/False). Acest stil de întrebare 
are trei opțiuni de răspuns. Opțiunea selectată permite răspunsurile, „Adevărat”, 
„Fals” și „Nu știu”.

Aceste răspunsuri posibile sunt afișate în caseta „Voting Summary” afișată.

Puteți seta un timp de expirare acum, lângă butonul roșu Stop Vote, introducând un număr sau folosind săgețile. Dacă profilul are 
deja are un timp de expirare setat pentru ExpressPoll, numărătoarea inversă începe imediat ce este afișată caseta cu rezumatul 
votului. Când utilizați un timp de expirare, aveți și un buton Pause Vote pentru un control suplimentar.

Pentru detalii despre cum să creați și să personalizați profiluri, vedeți mai multe despre ActivInspire> Personalizarea profilurilor 
(More about ActivInspire > Making profiles work for you).

Înapoi sus 
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Acasă > Mai multe despre ActivInspire > Realizarea flipcharturilor interactive > Crearea containerelor

Crearea containerelor
După cum sugerează și numele, containerele sunt obiecte care pot conține alte obiecte. Acest lucru este util pentru crearea de 
activități care se bazează recunoașterea obiectelor și fie acceptarea, fie respingerea de către un alt obiect. Orice obiect care nu se 
potrivește cu toate proprietățile alese este respins ori de câte ori cineva încearcă să îl introducă în container.

Puteți selecta proprietățile containerului și, prin urmare, defini comportamentul containerului, în secțiunea „Container” a Navigatorului 
de Proprietăți.

Pentru detalii despre proprietățile disponibile pentru containere, vedeți  Referințe > Proprietăți > Container properties. 

Pentru detalii despre cum puteți modifica proprietățile, vedeți Modificarea proprietăților obiectelor.

Aici vă explicăm regulile containerului, cum să creați un container și să adăugați un sunet de recompensă:

Reguli pentru containere

Crearea unui container

Adăugare sunet de recompensă

Reguli pentru containere
• Orice tip de obiect, cu excepția adnotărilor, poate fi un container.
• Obiectul care trebuie adăugat trebuie să fie în fața containerului. Prin urmare, trebuie să fie:

o Pe un strat superior decât containerul sau
o Deasupra în stivă pe același strat cu containerul.

Containerele pot conține alte containere, permițându-vă să creați containere imbricate. Adnotările care sunt 
făcute direct într-un obiect container sunt adăugate automat.

.

Crearea unui container
Aici vă vom arăta cum să transformați un obiect de formă într-un container care poate conține un anumit obiect, 
dar care să respingă altele. 

1.Selectați Shape și creați trei forme, una mai mare decât
celelalte. În imaginea din dreapta, noi am creat un pătrat
galben, containerul și două triunghiuri, unul roșu, unul albastru.

Pentru acest exemplu, am schimbat proprietatea „Name” a 
obiectului care urmează să fie adăugat în „Triunghiul roșu (Red 
Triangle)” din secțiunea „Identification” a Navigatorului de proprietăți. 

2. Selectați cea mai mare formă, în cazul nostru pătratul galben.

3. Deschideți Navigatorul de proprietăți și derulați până la secțiunea Container.

4.În secțiunea „Container”, setați proprietățile. În poza din dreapta am setat:

a. Can Contain la Specific Object. Asta înseamnă că poate fi introdus doar
un anumit obiect în containerul pătrat galben.
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b. Contain Object la Red Triangle. Pătratul galben 
poate conține doar triunghiul roșu.

c. Contain Rule la Completely Contained. 
Triunghiul roșu trebuie plasat în interiorul 
containerului.

d. Return if not Contained la True. Dacă triunghiul 
roșu nu este complet conținut sau încercați să puneți 
un alt obiect în pătratul galben, obiectul va reveni la 
poziția inițială.

5.Testați containerul. Numai triunghiul roșu,
dar nu și cel albastru, poate fi pus în container.

Când un articol a fost conținut, îl puteți muta din container dintr-o singură mișcare. Orice alte mișcări ulterioară, 
atunci când obiectul nu este conținut, îl vor readuce în poziția inițială. 

Adăugare sunet de recompensă 
Un sunet de recompensă este un fișier de sunet care se redă atunci când un obiect este corect conținut. 

Aici vă arătăm cum să adăugați un sunet de recompensă la un container: 

1.Creați containerul așa cum se arată mai sus.
2. În secțiunea „Container” din Navigatorul de proprietăți,
setați proprietățile sunetului:

a.Setați Reward Sound la True.
b.Setați Reward Sound Location la locația fișierului

de sunet pe care doriți să îl redați când un obiectul este 
corect conținut. 
În imaginea din dreapta, acesta este fișierul a.wav. 

3.Testați containerul. Când obiectul corect este introdus în
container, Controlerul de Sunet se deschide și se redă
sunetul de recompensă ales.
Controlerul de sunet rămâne pe ecran până când îl
închideți

Setați proprietatea „Reward Sound” pe container, nu pe conținut.
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Acasă > Mai multe despre ActivInspire > Realizarea flipcharturilor interactive > Crearea restricțiilor

Crearea restricțiilor
Utilizați restricții pentru a controla modul în care elementele se pot deplasa pe pagină.

Pentru detalii despre proprietățile disponibile pentru restricții, vedeți Referințe > Proprietăți > Proprietăți restricțiilor.

Pentru detalii despre modul de modificare a proprietăților, vedeți  Modificarea proprietăților obiectelor

Puteți utiliza restricții în multe moduri diferite.

Aici vă arătăm cum să creați o restricție care conține un cerc, astfel încât să se poată deplasa doar de-a lungul unei anumite căi.

1. Selectați Design Mode

2. Cu Stiloul, trageți o linie pe pagină.

3. Selectați Forme și creați un cerc.

4. Selectați cercul.

5. Deschideți Navigatorul de Proprietăți și derulați în jos
până la secțiunea „Restrictors”.

6. În secțiunea „Restrictors”, selectați proprietățile așa cum se arată în
partea dreaptă:

a. Pentru Can Move, selectați Along path din lista drop-down.
b. Pentru Move Path, faceți clic pe butonul de selectare.

Se deschide caseta de dialog “Select Object”.
c. Selectați obiectul linie, aici Pen 4.

7. Faceți clic pe OK.

8. Părăsiți Design Mode.

9. Testați restricția. Când faceți clic pe cercul roșu, acesta sare la linia
albastră. Acum cercul se poate deplasa doar de-a lungul liniei.
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Acasă > Primii pași cu ActivInspire > Adăugarea și formatarea textului

Adăugarea și formatarea textului
Aici vă arătăm:

Adăugați text

Formatați text 

Corectați text

În cele din urmă, vă oferim, de asemenea, câteva informații despre două instrumente excepționale pentru lucrul cu text pe tablă

Adăugare text
ActivInspire are mai multe instrumente utile pentru adăugarea de text, fie la tablă, fie pe computer.

De asemenea, adăuga text din documente existente cu copy & paste sau drag & drop, de exemplu dintr-un fișier Word, 
în flipchart.

Instrumentul Text

Instrumentul Text din setul de Instrumente Principale este o modalitate rapidă de a adăuga text de pe computer:

1. Faceți clic pe pictograma Text. Se deschid Instrumentele de Formatare și cursorul se schimbă 
într-o mică bară cu câteva litere.

2. Deplasați cursorul în locul în care doriți să creați text și faceți clic.
Două lucruri se întâmpla:

• Se deschide o casetă text cu două opțiuni. Acestea vă permit să deplasați liber 
                    sau să extindeți caseta de text.

•Instrumentele de Formatare se deschid, fie în partea de sus, fie în partea de
jos a ferestrei ActivInspire, în funcție de preferințele dvs. la pornire. Le puteți
folosi pentru a formata textul. Vă vom arăta cum în secțiunea următoare.

3. Cu tastatura computerului, introduceți textul. Textul apare în caseta de text cu
fontul, culoarea și dimensiunea implicite.
Vă arătăm cum să le schimbați în Formatare text.

Pentru a corecta o greșeală:

1. Cu Instrumentul de text selectat, poziționați cursorul unde doriți să începeți
în text și faceți clic.

2. Țineți apăsat butonul mouse-ului și trageți cursorul peste literele pe care doriți
să le schimbați.
3. Când sunt evidențiate, începeți să tastați pentru a înlocui textul selectat sau
apăsați tasta Backspace pentru a șterge.

Inapoi sus 
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Formatare text
Instrumentele de Formatare (Format Toolbar) se deschid când selectați Instrumentul de Text. Conține instrumente standard pentru 
formatarea textului și pictograma Tastatură pentru ecran. Utilizați Instrumentele de Formatare pentru a modifica proprietățile și 
alinierea textului. De exemplu, pentru a schimba culoarea, dimensiunea, fontul, conturul casetei de text și caracteristicile de umplere 
ale textului selectat.

ActivInspire Studio

Aici vom descrie pe scurt instrumentele.

1 Schimbă fontul și dimensiunea fontului textului selectat 7 Mărește sau micșorează spațiul dintre linii

2 Mărește sau micșorează dimensiunea fontului 8 Mărește sau micșorează indentarea

3 9 Formatează ca listă cu marcatori

4 10 Deschide Tastatura pentru ecran

5 11 Selectează tot textul din caseta de text

6

Pune textul cu caractere aldine, cursive sau subliniate

Adaugă un indice sau un exponent

Modifică culoarea textului (implicit negru) și de 
asemenea culoarea de fundal a textului (implicit 
transparentă)

Aliniază la stânga, centrat sau la dreapta 12 Introduce un simbol

ActivInspire Primary

În ActivInspire Primary, structura și aspectul Instrumentelor de Formatare este ușor diferite, dar instrumentele sunt aceleași.

Schimbați tot textul dintr-o casetă de text

1. Cu Instrumentul de Text selectat și o casetă de text deschisă, faceți clic în caseta de text.
2. În Instrumentele de Formatare, faceți clic pe Select All

• Pentru a modifica fontul sau dimensiunea fontului, faceți clic pe meniurile drop-down.
• Pentru a schimba culoarea, alinierea textului și alte caracteristici, faceți clic pe butoanele corespunzătoare.

3.Pentru a finaliza editarea, faceți clic pe un alt instrument.

Schimbați o parte a textului

1. Cu Instrumentul de Text selectat și o casetă de text deschisă, faceți clic în caseta de text.
2. Țineți apăsat butonul mouse-ului și trageți cursorul peste cuvintele pe care doriți să le modificați. Când sunt evidențiate, faceți
clic pe butoanele sau meniurile drop-down corespunzătoare.
3. Pentru a finaliza editarea, faceți clic pe un alt instrument.
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Înapoi sus

Corector ortografic

Puteți verifica și corecta rapid ortografia în tot sau în parte a flipchartului, cu Flipchart Spellchecker (Corector ortografic).
Acest instrument începe întotdeauna să verifice ortografia de la începutul flipchartului, chiar dacă îl porniți pe pagina finală.
Veți găsi Corectorul ortografic în:
Meniu Instrumente > Mai multe instrumente
Pentru a utiliza verificatorul Corectorul ortografic:

1. Cu Instrumentul de Text selectat și o casetă de text deschisă, faceți clic în caseta de text.
2. Din Tools > More Tools, selectați Flipchart Spellchecker. Se deschide caseta de dialog „Flipchart Spellchecker”. Posibilele erori
de ortografie apar în roșu. Puteți deselecta această opțiune din                     Edit Profiles, în caseta de dialog „Edit Profiles”.

3. Puteți accepta sau respinge sugestii de ortografie, le puteți aplica curentului sau tuturor instanțelor cuvântului sau puteți selecta
text în caseta de dialog și introduce propriile modificări.
4. Faceți alegeri până când caseta de dialog de confirmare indică faptul că verificarea ortografică este completă sau faceți clic pe
Done pentru a opri verificarea.

Inapoi sus

Instrumente excepționale
ActivInspire oferă, de asemenea, două instrumente excepționale pentru lucrul cu textul.

Utilizați acest instrument...

On-Screen Keyboard
 (Tastatura pentru ecran)

Handwriting Recognition 
(Recunoaștere scris de mână)

To...

A adăuga text la tablă, atunci când nu doriți să utilizați Stiloul. Pur și simplu 
atingeți literele și simbolurile de pe tastatura de pe ecran pentru a forma cuvinte 
și propoziții..

Pentru detalii, vedeți Utilizare Tastatură pentru ecran ( Using the On-Screen 
Keyboard.)

A scrie pe tablă și lăsați ActivInspire să vă transforme scrierea în text tastat.

Pentru detalii, vedeți Utilizare Recunoaștere Scris de Mână
 (Using Handwriting Recognition.)

Inapoi sus
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Acasă > Mai multe despre ActivInspire > Lucrul cu obiecte  > Modificarea proprietăților obiectelor

Modificarea proprietăților obiectelor
Proprietățile obiectelor definesc un obiect. Puteți vizualiza și modifica aceste proprietăți în Navigatorul de Proprietăți.

1. Selectați pagina sau obiectul ale cărui proprietăți doriți să le vizualizați sau să le
modificați.

2. Deschideți Navigatorul de Proprietăți.
3. În Navigator, selectați categoria de proprietăți, de exemplu, proprietăți
„Identification” (de identificare).
4. Schimbați proprietățile obiectului. Orice modificare efectuată se aplică imediat

De fiecare dată când schimbați o proprietate, aceasta este adăugată la Istoricul de Anulare (Undo History), permițându-
vă să anulați fiecare modificare pe care o faceți.

Tipuri de proprietăți
Unele proprietăți au valori numerice, în timp ce alte proprietăți pot fi modificate cu diferite comenzi:

 or 

• Pentru a modifica proprietatea, selectați valoarea implicită și tastați deasupra ei.

• Pentru a schimba culoarea, faceți clic pe culoare și selectați alta din Paleta de

culori standard pentru sistemul dvs. de operare.

• Pentru a schimba proprietatea, mutați glisorul.

• Pentru a modifica proprietatea, selectați una diferită din meniul drop-down.

• Pentru a schimba proprietatea, faceți clic pe pictogramă.

Folosiți aceste proprietăți ca să…

Identificați în mod unic un obiect sau o pagină. Acest lucru este util dacă doriți să refolosiți obiectul sau 
flipchartul sau dacă doriți să îl adăugați la Biblioteca de Resurse sau să îl distribuiți altora.
Controlați aspectul unui obiect pe flipchart.

Controlați caracteristicile conturului care înconjoară un obiect.

Adăugați textură unui obiect cu umbrire gradată de la o culoare la alta.

Controlați caracteristicile fundalului unui obiect.

Controlați poziția și mărimea unui obiect pe pagina flipchart. Există trei modalități să modificați aceste 
proprietăți:

• Trageți de Punctele de Redimensionare ale obiectului.

• Folosiți Meniul Editare Obiect (Object Edit Menu).

• Editați proprietățile în Navigatorul de Proprietăți.

Identification

Appearance 

Outline

Fill 

Background 

Position

Label Adăugați o etichetă la un obiect și definiți modul în care eticheta arată și se comportă. 
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Container

Rotate

Restrictors

Miscellaneous

Multimedia

Page

Tools

Revealer

Spotlight

Grid

Creați activități în care obiectele sunt recunoscute de alte obiecte.

Controlați modul în care un obiect poate fi rotit pe pagină.

Definiți reguli pentru a restricționa mutarea unui obiect.

Definiți câteva caracteristici diverse pentru obiect.

Definiți proprietățile pentru fișierele de sunet, video și Flash.

Controlați aspectul unei pagini flipchart.

Setați Reflectorul sau Dezvăluitorul să păstreze proprietatea selectată curent sau reveniți la 
cea implicită, definită în profilul selectat curent.

Controlați comportamentul Dezvăluitorului.

Definiți tipul și dimensiunea Reflectorului, dar și poziția când este selectat.

Afișați sau ascundeți grila și să-i modificați proprietățile.

Inapoi sus 
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  Acasă  > Mai multe despre ActivInspire > Lucrul cu obiecte > Adăugare și eliminare legături

Adăugare și eliminare legături
Utilizați legături către fișiere sau site-uri web în flipcharturi pentru a îmbogăți experiența de învățare, pentru a schimba ritmul unei 
lecții sau pentru a reorienta atenția elevilor. 
Pentru a deschide fișierul sau a accesa site-ul web, trebuie doar să faceți clic pe link în momentul adecvat al lecției. 
Aici vă arătăm:

Crearea unei legături către un fișier

CCrearea unei legături către un site web

Eliminarea sau editarea unei legături

Crearea unei legături către un fișier 
Când creați o legătură către un fișier, aveți următoarele opțiuni pentru a controla modul în care legătura apare pe pagină și unde 
este fișierul stocat:

Ca să..Alegeți această opțiune...

Add link as...(Adăugați legătura ca)

Text Adăugați legătura ca un fragment de text.

Image Icon

Action Object

Existing object

Placeholder

Store as

Store file externally

Store file in flipchart

Store file in flipchart + Directory

Multimedia

Autoplay

Loop

Controller

Placeholder

Adăugați legătura ca o pictogramă de imagine pe pagină.

Adăugați legătura ca un obiect de acțiune.

Asociați legătura cu un obiect existent de pe pagină.

Inserați un substitut (pentru fișiere multimedia). Puteți modifica imaginea 

substitutului dacă doriți.

Stocați fișierul separat de flipchart.

Includeți fișierul în flipchart. În funcție de dimensiunea și natura fișierului, 

acesta va crește considerabil dimensiunea fișierului .flipchart.

Includeți fișierul în flipchart, dar și într-un folder.

Se aplică doar fișierelor multimedia:

Redați fișierul automat când este deschis flipchartul.

Redați fișierul în buclă.

Afișați Consola Multimedia ca să puteți să opriți și să porniți redarea.

Adăugați legătura ca o imagine substitut. Puteți accepta imaginea implicită 
sau căuta și selecta altă imagine.
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Aici vă arătăm cum să legați un obiect existent la un fișier, astfel încât fișierul să se deschidă când faceți clic pe obiect.

1. Din Insert Menu, selectați Link > File.
Se deschide caseta de dialog „Select
File”.

2. Navigați la folderul care conține fișierul
către care doriți să faceți legătura.
3. Faceți dublu clic pe fișier sau selectați-l și
faceți clic pe Open. Se deschide caseta de
dialog „Insert File”.
4. Selectați Existing object, așa cum se
arată în partea dreaptă.

5. Faceți clic pe butonul Selector. Se deschide caseta de dialog „Select Object”.
6. Selectați obiectul cu care doriți să asociați legătura. În imaginea din dreapta, acesta este triunghiul negru.
7. Faceți clic pe OK. Se deschide din nou caseta de dialog „Select File”.
8. Selectați unde doriți să stocați fișierul, de exemplu, Store externally.
9. Faceți clic pe OK.
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Crearea unei legături către un site web 
Crearea unei legături către un site web este aproape la fel cu crearea unei legături către un fișier. Puteți adăuga legătura ca:

• Text

• Pictogramă imagine (Image Icon)

• Obiect de acțiune (Action Object)

• Obiect existent (existing object)
Pentru descrieri ale opțiunilor, consultați Crearea unei legături către un fișier de mai sus. (Create a link to a file )

Aici vă arătăm cum să adăugați o legătură ca pictogramă imagine, astfel încât browserul de Internet din sistemul de operare să 
deschidă URL-ul selectat când faceți clic pe pictogramă

1. Din Insert Menu, selectați Link>

Website. Se deschide caseta de dialog

„Insert Website”.

2. Tastați adresa URL a site-ului web către

care doriți să creați legătura.

3. Selectați Image Icon.

4. Faceți clic pe OK.

Eliminarea sau editarea unei legături
Site-urile web se schimbă, la fel și flipcharturile. Uneori poate fi necesar să eliminați sau să editați o legătură și aici vă vom arăta cum. 

Eliminarea unei legături

Două modalități rapide de a elimina o legătură, faceți clic dreapta pe pictogramă, imagine, obiect sau text, apoi:

1. Mutați-l în Coșul de gunoi cu drag & drop.
2. Selectați Delete din meniul popup.
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Alternativ:

1. Faceți clic dreapta pe legătură.

2. Din meniul popup, selectați Action Browser.

3. Faceți clic pe Remove existing.

Editarea unei legături

1. Faceți clic dreapta pe legătură.

2. Din meniul popup, selectați Action Browser.

3. În „Action Properties”, selectați adresa URL și modificați-o.

4. Faceți clic pe Apply Changes.
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Acasă  > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Matematice > Utilizare Aruncătorul de Zaruri

Utilizare Aruncătorul de Zaruri

Aruncarea zarurilor

1.Faceți clic pe Dice Roller.
2.În caseta „Dice Roller”, faceți clic pe butonul
Roll.

Schimbarea numărului de zaruri

1.În caseta „Dice Roller”, faceți clic pe
săgeată drop-down.
2.Selectați numărul de zaruri dorit.

Schimbarea vitezei zarurilor
În caseta „Dice Roller”, utilizați glisorul Speed pentru a mări sau micșora viteza zarurilor.

Afișarea totalului zarurilor pe pagină
În caseta „Dice Roller”, faceți clic pe butonul Output to Flipchart.
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Matematice > Utilizare Calculator

Utilizare Calculator
Pentru a utiliza calculatorul furnizat cu ActivInspire:

• Din Tools Menu selectați Math Tools > Calculator.

Pentru a utiliza calculatorul din sistemul de operare sau altul la alegere:

1. Din File Menu, selectați Settings.

2. Selectați Tools.
3. Derulați în jos la setările Calculator

• Verificați Use calculator supplied with operating system sau
• Lângă Use calculator specified by user, navigați la calculatorul dorit.

4. Faceți clic pe Done.
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Acasă  > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Matematice > Utilizare Raportor

Utilizare Raportor

Folosiți Raportorul pentru a măsura unghiuri și a 
desena arcuri de cerc.

Din Tools Menu selectați Math Tools > Protractor. 
Puteți avea mai multe raportoare.

Culorile implicite sunt gri / negru. Pentru a schimba 
culoarea riglelor și a raportoarelor, selectați File > 
Settings > Tools. 

Modificările de culoare sunt afișate la următoarea 
riglă sau raportor pe care îl selectați.

Meniul popup care apare când faceți clic dreapta 
oferă opțiuni pentru raportor și desenarea arcului de 
cerc.

Când sunteți gata să desenați, treceți cu stiloul 
peste marginea raportorului.

Cursorul sare sau se fixează la raportor.

Faceți clic și trageți de-a lungul marginii raportorului 
și va fi desenat un arc de cerc perfect. Cele trei 
stilurile diferite de arc de cerc sunt afișate în 
dreapta.

Unghiul este vizualizat la scara de pe 
raportor (măriți pentru o precizie mai mare).
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Matematice > Utilizare Compas

Utilizare Compas

Compasul desenează un arc simplu cu caracteristicile de contur și umplere ale Stiloului.

Din Tools Menu selectați Math Tools > Compass. Puteți avea mai multe compasuri.

Pentru a configura compasul, faceți clic pe diferitele părți ale acestuia:

• Faceți clic pe brațul stâng pentru a deplasa compasul pe
pagină.
• Așezați vârful unde doriți centrul de rotație.
• Faceți clic pe brațul drept pentru a roti compasul fără a
desena.
• Faceți clic pe suportul pentru creion pentru a lărgi
deschiderea compasului.
• Faceți clic pe balama pentru a ascunde compasul

Când sunteți gata să desenați, treceți cu stiloul peste vârful creionului.

Cursorul sare sau se fixează la vârful creionului.

Faceți clic și trageți pentru a desena arcul de cerc.
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Acasă > Mai multe despre ActivInspire > Lucrul la tablă > Utilizare Instrumente Matematice > Setare XY Origin

Setare XY Origin
Puteți roti orice obiect doar selectându-l și folosind opțiunea de Rotate Object pentru a roti obiectul în jurul punctului său central. 
Totuși, este posibil să nu doriți să rotiți un obiect în jurul punctului său central. În schimb, utilizați instrumentul XY Origin pentru a 
adăuga un punct de origine oriunde pe o pagină. Obiectul se va roti în jurul punctului de origine de pe pagină atunci când faceți clic și 
rotiți cu opțiunea Rotate Object.

Asigurați-vă că obiectul pe care doriți să îl rotiți se află pe pagină, apoi faceți clic pe instrumentul XY Origin pentru a afișa punctul de 
origine. Mișcați punctul de origine către o nouă poziție, aceasta va fi poziția care doriți să fie centrul de rotație. Selectați obiectul cu 
instrumentul de Selectare, observați că butonul instrumentului XY Origin rămâne selectat. Apoi, utilizați opțiunea Rotate Object 
pentru a roti obiectul în jurul noului punct de origine. După ce ați terminat, faceți clic pe instrumentul XY Origin încă o dată pentru a 
elimina punctul de rotație.

Punctul de origine își va aminti ultima poziție pe o pagină. Când îl porniți din nou, acesta va apărea automat în aceași poziție unde a 
fost afișată ultima dată.

Un grup de obiecte se va roti în jurul punctului central al grupului selectat, cu excepția cazului în care instrumentul XY Origin este 
pornit. În acest caz grupul se va roti în jurul punctului de origine XY.
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Acasă  > Referințe   > Comenzi rapide cu tastatura

Comenzi rapide cu tastatura

Funcție WindowsTM LinuxTM
Mac®

Ajutor F1 F1 F1

Comutare pe Modul Design F2 F2 F2

Sondaj Rapid F3 F3 F3

Utilizator Dual F4 F4 F4

Comutare pe Ecran Complet F5 F5 F5

Instrumente Desktop F6 F6 F6

Corector ortografic F7 F7 F7

Navigatorul de Pagini F8 F8 F8

Navigatorul de Proprietăți F9 F9 F9

Navigatorul de Acțiuni F10 F10 F10

Panou de Control F11 F11 F11

Promethean Planet F12 F12 F12

Selectare totală CTRL+A CTRL+A Cmd+A

Comutați Navigatoarele CTRL+B CTRL+B Cmd+B

Copiază CTRL+C CTRL+C Cmd+C

Duplică CTRL+D CTRL+D Cmd+D

Radieră CTRL+E CTRL+E Cmd+E

Umplere CTRL+F CTRL+F Cmd+F

Comutați pe Grupat CTRL+G CTRL+G Cmd+G

Evidențiator CTRL+H CTRL+H Cmd+H

Inserează pagină goală după curentă CTRL+I CTRL+I Cmd+I

Editare Profiluri CTRL+J CTRL+J Cmd+J
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Tastatură pentru ecran CTRL+K CTRL+K Cmd+K

Inserează legătură spre document CTRL+L CTRL+L Cmd+L

Inserează media CTRL+M CTRL+M Cmd+M

Deschidere flipchart nou CTRL+N CTRL+N Cmd+N

Deschidere flipchart existent CTRL+O CTRL+O Cmd+O

Stilou CTRL+P CTRL+P Cmd+P

Inserare întrebare CTRL+Q CTRL+Q Cmd+Q

Dezvăluitorul CTRL+R CTRL+R Cmd+R

Salvare flipchart CTRL+S CTRL+S Cmd+S

Text CTRL+T CTRL+T Cmd+T

Vizualizare Personalizare CTRL+U CTRL+U Cmd+U

Lipire CTRL+V CTRL+V Cmd+V

Închidere CTRL+W CTRL+W Cmd+W

Decupare CTRL+X CTRL+X Cmd+X

Refacere ultima acțiune CTRL+Y CTRL+Y Cmd+Y

Anulare ultima acțiune CTRL+Z CTRL+Z Cmd+Z

Creștere dimensiune obiect CTRL+ + CTRL+ + Cmd+ +

Scădere dimensiune obiect CTRL+ - CTRL+ - Cmd+ -

Adnotări desktop CTRL+Shift+A CTRL+Shift+A Cmd+Shift+A

Trimitere în spate CTRL+Shift+B CTRL+Shift+B Cmd+Shift+B

Conectori CTRL+Shift+C CTRL+Shift+C Cmd+Shift+C

Captură de ecran CTRL+Shift+D CTRL+Shift+D Cmd+Shift+D

Export pagină CTRL+Shift+E CTRL+Shift+E Cmd+Shift+E

Aduceți în față CTRL+Shift+F CTRL+Shift+F Cmd+Shift+F

Designer grile CTRL+Shift+G CTRL+Shift+G Cmd+Shift+G
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Recunoaștere scris de mână CTRL+Shift+H CTRL+Shift+H Cmd+Shift+H

Comutare pe Ascuns CTRL+Shift+I CTRL+Shift+I Cmd+Shift+I

Comutare Copie cu drag CTRL+Shift+J CTRL+Shift+J Cmd+Shift+J

Cameră – Zonă CTRL+Shift+K CTRL+Shift+K Cmd+Shift+K

Comutare pe Blocat CTRL+Shift+L CTRL+Shift+L Cmd+Shift+L

Cerneală Magică CTRL+Shift+M CTRL+Shift+M Cmd+Shift+M

Navigatorul de Notițe CTRL+Shift+N CTRL+Shift+N Cmd+Shift+N

Reflector Circular CTRL+Shift+O CTRL+Shift+O Cmd+Shift+O

Imprimă CTRL+Shift+P CTRL+Shift+P Cmd+Shift+P

Editare Întrebare pe Pagină CTRL+Shift+Q CTRL+Shift+Q Cmd+Shift+Q

Înregistrare Sunet CTRL+Shift+R CTRL+Shift+R Cmd+Shift+R

Forme CTRL+Shift+S CTRL+Shift+S Cmd+Shift+S

Panglică cu mesaje CTRL+Shift+T CTRL+Shift+T Cmd+Shift+T

Ceas CTRL+Shift+U CTRL+Shift+U Cmd+Shift+U

Aduceți în față CTRL+Shift+V CTRL+Shift+V Cmd+Shift+V

Trimitere în spate CTRL+Shift+W CTRL+Shift+W Cmd+Shift+W

Rotire X CTRL+Shift+X CTRL+Shift+X Cmd+Shift+X

Rotire Y CTRL+Shift+Y CTRL+Shift+Y Cmd+Shift+Y

Page Zoom CTRL+Shift+Z CTRL+Shift+Z Cmd+Shift+Z

Selectare Esc Esc Esc

Mergeți la pagina următoare PgDown PgDown Down

Mergeți la pagina anterioară PgUp PgUp Up

Ștergere Del Del Del
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Acasă  > Referințe   > Opțiuni de personalizare

Opțiuni de personalizare
Puteți personaliza comportamentul și poziția tuturor seturilor de instrumente, navigatoarelor și barelor de meniu din ActivInspire.

Toate pot fi fixate și mutate cu drag & drop. Unele pot fi flotante, pot fi rulate sau derulate sau ancorate.

Opțiune Studio Primary Descriere

Toolbox
Options

Dock left Poziționați setul de instrumente la stânga/la dreapta/în partea de 
sus/în partea de jos a ferestrei ActivInspire.

Dock
right

Dock top

Dock
bottom

Floating Vă permite să apăsați oricând pe bara cu denumirea setului și îl 
mutați oriunde în fereastra ActivInspire cu drag & drop.

Roll Up Comutator.
Când setul de instrumente este în starea normală (derulată), faceți 
clic pe acesta pentru a rula setul de instrumente, afișând doar 
pictogramele pentru Meniul Principal și Navigarea pe Pagină.

Când setul de instrumente este rulat, faceți clic pe acesta pentru a 
reveni la starea derulată, unde sunt afișate toate instrumentele.

Roll In Comutator.
Afișează sau ascunde bara de scurtătură pentru Setul de 
Instrumente Principale.

Rulează Vezi “Roll Up” de mai sus.

Fixează
setul de 
instrumente

Comutator.

Fixează setul de instrumente pentru a împiedica ieșirea acestuia 
din câmpul vizual când este ancorat.
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Acasă  > Referințe   > Meniuri și meniuri popup  > Bara de meniu

Bara de meniu
Această pagină listează funcțiile implicite din fiecare meniu al barei de meniu ActivInspire:

File (Fișier)

Edit (Editare)

View (Vizualiare)

Insert (Inserare)

Tools (Instrumente)

Help (Ajutor)
Pentru mai multe detalii despre instrumentele din ActivInspire, vedeți Instrumente (Tools)

Fișier

Meniul Fișier include:

Funcții menu Opțiuni Descriere

New Flipchart Deschide un nou flipchart “Untitled”.

New

Deschide un nou flipchart de o anumită dimensiune.

Screen Size
Flipchart

1024 x 768
Flipchart

1152 x 864
Flipchart

1280 x 1280
Flipchart

Custom Size
Flipchart

Open... Deschide folderul „My Flipcharts”

Open Recent Deschide o listă drop-down cu flipcharturile recente.

Clear List Resetează lista cu flipcharturile recente.

Close flipchart Închide flipchartul curent. Dacă acesta conține modificări nesalvate, se 
deschide o casetă de dialog care vă solicită să salvați modificările sau să 
anulați.

Dacă apăsați pe Yes pentru a salva înainte de a închide, se deschide 
folderul 'My flipcharts' din caseta de dialog 'Save the flipchart as...'.
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Save Salvează flipchartul curent. Dacă este nedenumit (Untitled) se 
deschide caseta de dialog 'Save the flipchart as...'.

Save As... Deschide folderul 'My flipcharts' din caseta de dialog 'Save the 
flipchart as...'. Puteți redenumi flipchartul, salva flipchartul în acest 
folder sau să navigați la altă locație din computer sau rețea.

Apăsați:

• Save pentru a salva flipchartul

• Cancel pentru a ieși fără să salvați

Summary... Deschide caseta de dialog 'Flipchart Summary'.

Aici puteți introduce informații despre flipchart.

Apăsați: 

• OK pentru a salva rezumatul flipchartului

• Cancel pentru a ieși fără să salvați

Title Introduceți titlul flipchartului.

Description Introduceți o scurtă descriere a conținutului.

Grade Menționați nivelul de clasă pentru care a fost realizat flipchartul.

Keywords Adăugați cuvinte cheie pentru a clasifica flipchartul.

Publish... Deschide caseta de dialog 'Publish Flipchart'.
Aceasta vă permite să restricționați ce pot face alții cu flipchartul 
odată ce a fost publicat.
Apăsați: 

• Cancel pentru a ieși fără să salvați
• Save Details pentru a salva fără să publicați
• Publish... pentru a salva modificările și a publica flipchartul

Publisher
Information

Introduceți informații în caseta de text. Aceste informații nu sunt 
vizibile altor utilizatori. Caseta arată automat orice informație 
introdusă anterior.

Prevent copying
pages and
objects

Nu permite paginilor flipchart și obiectelor să fie copiate sau tăiate. 
Utilizatorii pot duplica sau reflecta obiectele și descompune textul.

Prevent Flipchart
saving and
exporting

Nu permite utilizatorilor să salveze sau să exporte flipchartul. 
Această restricție nu permite nici exportul rezultatelor de la Sistemul 
de Răspuns pentru Elevi. 
Dacă salvarea este permisă, flipchartul nou salvat este salvat ca un 
flipchart normal, fără nicio restricție. 

Prevent Flipchart
printing

Nu permite utilizatorilor să printeze flipchartul.

Prevent Camera Nu permite utilizatorilor să folosească Camera în sesiunea curentă.



Menubar

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/menubar1.htm[1/21/2010 6:09:49 PM]

Tool Se va aplica și altor flipcharturi deschise în același timp. 

Submit Flipcharts
to Promethean
Planet

Deschide website-ul Promethean Planet în browserul de Internet.

Import Pentru fiecare operațiune de import, puteți căuta locația 
fișierului și să îl selectați.
Apăsați: 

• Open pentru a începe operațiunea de import

• Cancel pentru a ieși fără să salvați

PowerPoint® As
Images

Deschide o fereastră de dialog care vă permite să căutați și să 
selectați fișierul pe care doriți să îl importați.

Nu este disponibil în ActivInspire Personal.

PowerPoint® As
Objects

ExamView® XML
file

IMS QTI XML file

SMART Notebook
File v8, v9, v9.5,
v10

SMART Gallery
Item File

Resource Pack
To My
Resources... Deschide casuța de dialog 'Open Resource Pack' pentru a-ți da 

voie să copiezi resursele.
Resource Pack
To Shared
Resources...

Print... Trimite flipchart-ul catre printer-ul selectat in mod normal.

Settings... Deschide fila 'Settings' din caseta de dialog 'Edit Profiles'. Aici puteți 
personaliza funcții ca Sistemul de Răspuns pentru Elevi, 
Instrumente și Multimedia.
Despre detalii despre toate setările disponibile, vedeți Referințe > 
Setări.

Exit Închidere ActivInspire. Vă solicită să salvați modificările înainte de 
a ieși.

Apăsați: 
• Yes pentru a salva modificările

• No pentru a ieși fără să salvați

• Cancel pentru a continua să lucrați
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Editare
Meniul de Editare include:

Funcții menu Opțiune Descriere

Design Mode Comutator care activează/ dezactivează Modul Design. Pentru 
detalii despre setările Modului Design, vedeți Modul Design.

Undo
Anulează/ Reface comanda sau acțiunea anterioară.

Redo

Select
Activează instrumentul de Selectare..

Select All Selectează toate obiectele de pe pagina curentă.

Page
Background...

Deschide caseta popup 'Set Background' ca să puteți 
selecta un fundal pentru pagina curentă.

Alegeți dintre:

• Fill ï selectați una sau două culori pentru o umplere cu
umbrire gradată.
• Image ï căutați o imagine și alegeți poziționarea și
potrivirea
• Desktop Snapshot
• Desktop Overlay

Grid... Deschide Designerul de Grile pentru a vă permite să creați grile 
multicolore, pe mai multe niveluri.

Clear Toate acțiunile de ștergere se aplică paginii curente.

Clear Annotations Șterge orice este creat cu Stiloul, Evidențiatorul sau Cerneala Magică.

Clear Objects Șterge orice obiect care conține text creat cu Instrumentul de Text.

Clear Grid Șterge toate nivelurile grilelor.

Clear Background Șterge fundalul.

Clear Page Șterge totul de pe pagină.

Reset Page Resetează pagina curentă la starea în care era la ultima 
salvare.

Cut

Taie, copiază, lipește, duplică sau șterge obiectele selectate de 
pe pagină/pagini.

Copy

Paste
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Duplicate

Delete

Transform

Increase Object
Size

Crește sau scade dimensiunea obiectului cu 10% din 
dimensiunea curentă.

Decrease Object
Size

Original Size Resetează dimensiunea obiectului la cea originală.

Best Fit to Width Setează obiectul(e) selectat să se încadreze în lățimea sau înălțimea 
paginii, în timp ce păstrează raportul de aspect al obiectului(lor).

Se aplică doar obiectelor a căror dimensiune inițială este 
mai mare decât pagina flipchart, de exemplu, imagini scanate.

Best Fit to Height

Best Fit to Page Setează obiectul(e) selectat să se încadreze în lățimea sau înălțimea 
paginii, în timp ce păstrează raportul de aspect al obiectului(lor).

Se aplică doar obiectelor a căror dimensiune inițială este 
mai mare decât pagina flipchart, de exemplu, imagini scanate.

Mirror in X Axis Creează o imagine reflectată a obiectului de pe axa X, spre 
partea de sus a paginii. 

Mirror in Y Axis Creează o imagine reflectată a obiectului de pe axa Y, spre 
partea stângă a paginii.

Flip in X Axis Răsucește obiectul de pe axa X, spre partea de sus a paginii.

Flip in Y Axis Răsucește obiectul de pe axa Y, spre partea stângă a paginii.

Align Aliniază grupuri de obiecte.

Align Left Aliniază toate obiectele selectate astfel încât marginea lor din stânga 
să se alinieze cu obiectul din selecție aflat cel mai la stânga.

Align Center
X

Aliniază toate obiectele selectate astfel încât centrul lor să se 
alinieze orizontal, cu punctele lor centrale plasate în centrele inițiale 
ale dreptunghiului de delimitare.

Align Right Aliniază toate obiectele selectate astfel încât marginea lor din 
dreapta să se alinieze cu obiectul din selecție aflat cel mai la dreapta.

Align Top Aliniază toate obiectele selectate astfel încât marginea lor 
superioară să se alinieze cu obiectul din selecție aflat cel mai sus.

Align Center
Y

Aliniază toate obiectele selectate astfel încât centrul lor să se 
alinieze vertical, cu punctele lor centrale plasate în centrele 
inițiale ale dreptunghiului de delimitare.
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Align Bottom Aliniază toate obiectele selectate astfel încât marginea lor inferioară 
să se alinieze cu obiectul din selecție aflat cel mai jos.

Align Width Lărgește toate obiectele selectate la aceeași lățime ca primul 
obiect creat dintre cele selectate.

Align Height Aliniază obiectele la înălțimea primului obiect creat din grup. 

Align Angle Aliniază obiectele la unghiul primului obiect creat.

Align
Complete

Aliniază toate obiectele selectate pentru a se potrivi cu proprietățile 
(stânga, dreapta, sus, jos, lățime, înălțime, unghi) primului obiect 
creat dintre cele selectate.

Reorder Mută obiectele selectate în alt loc în stivă sau pe alt strat.

Bring to Front Trimite obiectul în partea de sus a stivei.

Bring Forwards Trimite obiectul în sus cu câte o poziție în stivă.

Send to Back Trimite obiectul la fundul stivei.

Send Backwards Trimite obiectul în jos cu câte o poziție în stivă.

To Top Layer

Trimite obiectul în stratul superior, inferior sau de mijloc.To Middle Layer

To Bottom Layer

Question on
Current Page...

Deschide Expertul 'Insert Question' care vă permite să alegeți 
un tip de întrebare și aspectul.

Pentru detalii, vedeți Folosirea Sistemelor de Răspuns pentru 
Elevi > Întrebări pregătite – Folosirea Expertului în Întrebări

Student
Database...

Deschide caseta de dialog 'Edit Student Database'.
Pentru detalii, vedeți Folosirea Sistemelor de Răspuns pentru 
Elevi > Alocarea elevilor pe dispozitive.

Profiles... Deschide fila 'Layout' din caseta de dialog 'Edit Profiles'.

Nu este disponibil în ActivInspire Personal.

Design Mode
Settings...

Deschide fila 'Settings' din caseta de dialog 'Edit Profiles'.

Inapoi sus 

Vizualizare
Meniul Vizualizare include:

Descriere
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Articole meniu

Switch Profile Afișează un meniu drop-down cu profilurile existente.

Nu este disponibil în ActivInspire Personal.

Fullscreen Schimbă pe modul ecran complet.

Apăsați pe pictograma Fullscreen pentru a ieși 
sau a schimba din/pe modul ecran complet.

Flipcharts Afișează un meniu drop-down cu paginile flipchart curente deschise.

Next Page Merge la pagina următoare sau anterioară.

Previous Page

Page Zoom Începe mărirea/ micșorarea paginii. Faceți clic stânga sau dreapta pentru mărire sau 
micșorare. Faceți clic și trageți pentru a vă deplasa pe pagina flipchart.

Browsers Comutatoare care afișează sau ascund Navigatoarele, Bara de Meniu, Filele de Documente 
și Coșul de Gunoi.

Menubar

Document tabs

Flipchart bin

Dashboard Afișează Panoul de Control ActivInspire.

Sound Controller Afișează Consola de Sunet când apăsați pe un sunet pentru a-l reda. Consola de Sunet 
rămâne afișată până o închideți sau mergeți la altă pagină flipchart.

Customise... Deschide fila 'Commands' din caseta de dialog 'Edit Profiles'.

Inapoi sus

Inserare
Meniul Inserare include:

Articole Meniu Opțiuni Descriere

Page Blank Page
Before Current

Inserează o pagină goală înainte sau după pagina curentă.

Blank Page After
Current

Desktop
Snapshot

Afișează desktopul și activează Captura Desktop. Când apăsați 
pe Take Snapshot, inserează o captură a desktopului după 
pagina curentă.

Alte opțiuni pot fi disponibile aici. Aceasta depinde de resursele pe care le-ați instalat.
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More Page
Templates

Deschide folderul 'Shared Resources' din Navigatorul de Resurse.

Question... Deschide Expertul 'Insert Questions'.

Media... Opens the 'Choose media to insert' Dialog Box.

Link

File... Deschide caseta de dialog 'Select File'.

Website... Deschide caseta de dialog 'Insert Website'.

Text
Activează Instrumentul de Text.

Shapes Deschide Meniul Forme. Vă permite să alegeți o formă și să o desenați. 

Nu este disponibil în ediția ActivInspire Personal.

Connectors
Activează Instrumentul Conector.

Timestamp Adaugă o marcă temporală pe pagina curentă.

Inapoi sus 

Instrumente
Meniul Instrumente include:

Articole Meniu Opțiune Descriere

Desktop Annotate Vă permite să:

• Scrieți adnotări pe dektopul live al computerului cu Stiloul
sau Evidențiatorul.

• Interacționați cu alte aplicații de pe desktop cu Selectare.

Desktop Tools Minimizează ActivInspire și afișează Instrumentele Desktop.

Dual User Activează lucrul colaborativ cu două ActivPens pe o tablă 
ActivBoard versiunea 3 sau ActivBoard versiunea 2 actualizată.

ExpressPoll Lansează Roata Minunilor pentru votare cu care puteți selecta un 
stil și opțiuni pentru întrebări.

Pen Vă permite să scrieți și să desenați adnotări pe tablă.
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Highlighter Vă permite să evidențiați secțiuni din flipchart într-o culoare translucidă.

Eraser Vă permite să ștergeți permanent sau să despărțiți adnotări 
realizate cu Stiloul, Evidențiatorul sau Cerneala Magică.

Fill Vă permite să umpleți:
• Forme cu o singură culoare sau umrbire gradată (puteți seta 
culorile pentru gradare din Navigatorul de Proprietăți)
• Forme parțial intersectate cu forme umplute cu diferite culori
• Pagini

Magic Ink Vă permite să faceți anumite zone ale flipchartului invizibile și să 
le dezvăluiți când elevii sunt pregătiți.

Handwriting
Recognition

Vă permite să scrieți pe tablă și transformă textul în scris tastat.

Shape
Recognition

Vă permite să desenați pe tablă și transformă desenele în 
forme.

Revealer Vă permite să descoperiți selectiv părți din pagina flipchart.

Spotlight Circular Spotlight

Vă permite să mutați lumini de diverse forme sau reflectoare opace 
pentru a arăta sau ascunde zone de pe flipchart.

Square Spotlight

Solid Circular
 Spotlight

Solid Square
Spotlight

Camera Area Snapshot

Vă permite să realizați o captură de pe ecran – aceasta poate fi o 
imagine de pe un website sau flipchart, de exemplu.

Point to Point
Snapshot

Freehand
Snapshot

Window Snapshot

Fullscreen
Snapshot

Math Tools Ruler Vă permite să desenați și măsurați linii pe flipchart.

Protractor Vă permite să desenați arcuri de cerc, segmente și cercuri 
și să măsurați unghiuri.

Compass Vă permite să desenați cercuri și arcuri de cerc de orice dimensiune, 
să colorați sau să îngroșați conturul cu Stiloul, Evidențiatorul sau 
Radiera.

Dice Roller Vă permite să aruncați până la 5 zaruri, setați viteza de aruncare și 
să afișați rezultatele pe flipchart.
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Calculator Vă permite să faceți calcule matematice la tablă.

More Tools...

Sound Recorder Vă permite să înregistrați sunete și să le încorporați în flipcharturi.

Screen Recorder Vă permite să înregistrați acțiuni de pe un flipchart, desktop 
flipchart, desktop sau alte aplicații, apoi să le redați ca 
animații.

On-screen
Keyboard

Vă permite să adăugați text tastat pe flipchart 
în timp ce sunteți la tablă.

Clock Afișează un ceas pe care îl puteți folosi în activități și 
competiții temporizate.

Tickertape... Rulează o bandă cu text la alegere de-a lungul tablei până o 
opriți.

Web Browser Deschide browserul de Internet.

Spellcheck
Flipchart

Vă permite să verificați ortografia de pe flipchart.

Teacher Lock... Restricționează accesul la activitatea curentă.

Device
Registration...

Începe procesul prin care ActivHub primește informații despre 
numărul de dispozitive și grupuri de dispozitive din clasă. Trebuie 
să înregistrați dispozitivele înainte de a începe o sesiune de votare.

Edit User Defined
Buttons...

Vă permite să vă definiți propriile butoane care vor apărea în 
Bara de Scurtături din Instrumentele Principale.

Inapoi sus

Ajutor
Meniul Ajutor include:

Articole Meniu Descriere

Contents Deschide acest fișier de ajutor.

Promethean
Website

Deschide website-ul Promethean sau Promethean Planet în browserul de Internet.
Promethean
Planet

Check for
updates...

Verifică dacă este disponibilă o actualizare pentru ActivInspire. Fie confirmă că aveți cea mai nouă 
versiune instalată, fie deschide caseta de dialog 'ActivInspire Update'. Urmați instrucțiunile de pe ecran 
pentru a descărca și instala actualizările software.

About Deschide caseta de dialog ' About ActivInspire'. Aceasta conține detalii despre versiunea de lansare a 
software-ului și acordul de licențiere.
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Inapoi sus
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  Acasă > Referințe > Seturi și casete de instrumente  > Seturi și casete de instrumente

Seturi și casete de instrumente
Această secțiune vă oferă o privire de ansamblu asupra instrumentelor și funcțiilor din seturile și casetele de instrumente ActivInspire:

Main Toolbox (Instrumente Principale)

Pen Tray (ActivInspire Primary) (Caseta stilou)

Dual Pen Tray (ActivInspire Primary) (Caseta stilou duală)

Fill Tray (ActivInspire Primary) (Casetă Umplere)

Dual Fill Tray (ActivInspire Primary) (Casetă Umplere Duală)

Desktop Tools (Instrumente Desktop) 

Format Toolbar (Format Toolbar) 

Voting Wonderwheel (Roata minunilor pentru votare)

Dual Toolbox (Instrumente Duale)

Pentru detalii complete despre instrumentele și funcțiile din ActivInspire, vedeți Referințe > Instrumente.

Pentru un rezumat al instrumentelor și funcțiilor disponibile în fiecare meniu și meniu popup din ActivInspire, 
consultați  Referințe > Meniuri și meniuri pop-up.

Puteți personaliza setul de Instrumente principale și Bara de instrumente de editare a obiectelor (Object Edit 
Toolbar) pentru a conține orice combinație de instrumente care să se potrivească nevoilor de învățare. Pentru 
detalii, consultați Alegerea instrumentelor.

Instrumente Principale
Setul de Instrumente Principale conține implicit următoarele instrumente și articole:

Instrument/ 
Articol din 
Meniu

Studio Primary Descriere
Mai multe 
informații

Meniu 
Principal

Deschide Meniul Principal. Acesta 
vă oferă acces la aceleași meniuri 
ca Bara de Meniu.

Referințe > Meniuri > 
Fișier, Editare, 
Vizualizare, Inserare, 
Instrumente, ajutor

Comutare
 Profil

Deschide o casetă popup care 
afișează profilurile disponibile 
pentru a comuta rapid de la un 
profil la altul.

Mai multe despre 
ActivInspire > 
Personalizarea 
profilurilor

Adnotări 
Desktop

Face desktopul live al computerului 
fundalul flipchartului. Vă permite să 
adnotați desktopul și să 
interacționați cu alte aplicații.

Referințe  > 
Instrumente > 
Adnotări Desktop

Instrumente 
Dektop

Minimizează ActivInspire și 
deschide Instrumentele 
Desktop.

Instrumente Desktop

Pagina
Anterioară

Afișează pagina flipchart 
anterioară.

javascript:void(0);
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Pagina 
Următoare

Afișează următoarea pagină 
flipchart.
Adaugă o nouă pagină flipchart 
dacă apăsați pe acest instrument 
pe ultima pagină flipchart.

Pornire/Oprire 
Vot Flipchart

Deschide caseta Voting Summary'.
Deschide caseta Voting Summary'.
Se activează doar dacă pagina 
conține o întrebare de vot 
pregătită.

Folosirea Sistemelor 
de Răspuns pentru 
Elevi > Întrebări 
pregătite – Folosirea 
Expertului în Întrebări

Sondaj Rapid Vă permite să le adresați elevilor o 
întrebare rapidă și să afișați 
instantaneu rezultatele votului.

Folosirea Sistemelor 
de Răspuns pentru 
Elevi >  Întrebări și 
sondaje rapide
Referințe  > 
Instrumente > Sondaj 
Rapid

Paleta 
de Culori

see Pen
Tray

În ActivInspire Studio, vă permite 
selectați culoarea textului, 
evidențierii, liniilor și formelor, 
umplerea obiectelor etc. 
Pentru a selecta o culoare care nu 
este inclusă în Paleta de Culori, 
faceți clic dreapta pe culoarea pe 
care vreți să o schimbi și selectați o 
culoare sau creați-vă propria 
culoare personalizată.

Primii pași cu 
ActivInspire > 
Scrierea pe 
flipchart

Selector
grosime

see Pen
Tray

În ActivInspire Studio, vă permite 
să selectați o dimensiune diferită 
pentru Radieră, Evidențiator sau 
Stilou. Pentru a schimba 
dimensiunea, asigurați-vă că 
instrumentul este selectat, apoi 
efectuați una dintre opțiunile:

•Faceți clic pe una dintre
bulinele de grosime din
Selectorul de grosime.
Pentru Radieră și Evidențiator
puteți alege 20 sau 50 pixeli.
Pentru Stilou puteți alege 2, 4, 6
sau 8 pixeli.

• Faceți clic și glisați glisorul ca
să modificați grosime de la 0 la
100 pixeli, în trepte de 1.
Setarea grosimii la 0 va rezulta
într-o grosime fixă de 1 pixel.
Asta înseamnă că grosimea va
fi întotdeauna 1 pixel, chiar dacă
utilizați Page Zoom pentru
augmentare.

Puteți modifica grosimea conturului a

Primii pași cu 
ActivInspire > 
Scrierea pe 
flipchart
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dnotărilor, liniilor și formelor doar prin 
selectarea obiectului și făcând clic pe 
o opțiune de grosime.

Selectare Vă permite să selectați obiectele și 
să interacționați cu ele pe pagina 
flipchart.

Referințe  
> Instrumente
> Selectare

Instrumente Deschide Meniul Instrumente. Referințe  > Meniuri > 
Meniuri și meniuri 
popup > Instrumente

Stilou Scrie sau desenează pe flipchart.
În ActivInspire Primary, deschide 
Caseta Stilou în partea de jos a 
ferestrei ActivInspire.

Referințe  > I
Instrumente > Stilou
Primii pași cu 
ActivInspire > 
Scrierea pe 
flipchart

Evidențiator see Caseta 
Stilou

Evidențiază zone de pe flipchart cu 
o culoare translucidă.

Referințe  
> Instrumente
> Evidențiator

Primii pași cu 
ActivInspire > 
Scrierea pe 
flipchart

Radieră see Caseta 
Stilou

Șterge permanent adnotările făcute 
cu Stiloul, Evidențiatorul și 
Cerneala Magică de pe flipchart.

Referințe  
> Instrumente
> Radieră
Primii pași cu 
ActivInspire > Ștergerea 
elementelor

Umplere Umple cu culoare un obiect sau o 
pagină selectate.

În ActivInspire Primary, deschide 
Caseta Umplere în partea de jos a 
ferestrei ActivInspire.

Referințe > 
Instrumente > Umplere

Primii pași cu 
ActivInspire > 
Adăugarea și 
manipularea 
formelor

Formă Deschide Meniul Forme ca să puteți 
selecta o formă și apoi să o 
desenați.

Referințe > 
Instrumente > Formă

Conector Conectează obiecte sau forme cu o 
linie.

Referințe >
Instrumente > Conector

Inserează 
Media din 
fișier

Deschide o casetă de dialog de 
unde puteți căuta, selecta și insera 
elemente grafice, video-uri și alte 
fișiere în pagina flipchart.

Text Adaugă textul pe care îl 
tastați pe tastatura 
computerului.

Referințe > Instrumente 
> Text

Primii pași cu 
ActivInspire > 
Adăugarea și 
formatarea textului
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Navigatorul 
de Resurse

Nu se aplică Deschide Navigatorul de Resurse. Turul ActivInspire > 
Explorați ActivInspire 
Primary > Navigatorul 
de Resurse

Navigatorul 
de Pagini

Nu se aplică Deschide Navigatorul de Pagini. Turul ActivInspire > 
Explorați 
ActivInspire Primary 
> Navigatorul de
Pagini

Ștergere Șterge elemente de pe pagina 
curentă:

Primii pași cu 
ActivInspire > 
Ștergerea 
elementelorAdnotări Șterge orice 

desenat cu 
Stiloul, 
Evidențiatorul 
sau Cerneala 
Magică.

Obiecte Șterge toate 
imaginile, 
formele și 
textul.

Grilă Șterge orice 
grilă.

Fundal Șterge orice 
fundal.

Pagină Șterge toate 
obiectele de 
pe pagina 
curentă.

Resetare 
pagină

Resetează pagina curentă la starea 
în care era la ultima salvare.

Pentru pagini noi, nesalvate, șterge 
pagina curentă.

Primii pași cu 
ActivInspire > 
Ștergerea 
elementelor

Anulează
Anulează sau reface ultima acțiune, 
de exemplu, Umplere. Apăsați în 
mod repetat pentru a anula și reface 
câte acțiuni este necesar.

Referințe  > 
Instrumente > 
Anulare și refacere

Reface

Editare butoane
 definite 
de utilizator

Vizibil când Setul de Instrumente 
Principale nu este rulat. 
Deschide fila 'User defined buttons' 

More about
ActivInspire >
Making profiles
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din caseta de dialog 'Edit Profiles'. 
Puteți aloca proprietăți unui buton, 
de exemplu să deschidă un fișier 
sau să pornească un program. Puteți 
adăuga și un indiciu pentru a 
identifica butonul.

Mai multe despre 
ActivInspire > 
Personalizarea 
profilurilor > Crearea și 
comutarea profilurilor  
> Definirea butoanelor

Înapoi

Caseta Stilou (ActivInspire Primary)
IÎn ActivInspire Primary, unele instrumente care sunt disponibile în Setul de Instrumente Principale  în ActivInspire Studio, sunt 
furnizate aici în Caseta Stilou, pentru acces facil de către elevii mai mici. 

Caseta Stilou se deschide când faceți clic pe Stilou . Caseta Stilou conține următoarele instrumente:

Instrument Descriere Mai multe 
informații

Evidențiatoare Trei evidențiatoare de grosimi 
diferite.

Turul ActivInspire > 
Explorați ActivInspire 
Primary > Caseta Stilou

Stilouri Șase stilouri de grosimi 
diferite.

Radiere Trei radiere de dimensiuni 
diferite.

Culori De-a lungul părții de jos a 
casetei:

O gamă de culori din 
care puteți alege 
culoarea pentru Stilou și 
Evidențiator. 

Câteva fante libere pe 
care puteți face clic 
dreapta pentru a alege 
sau mixa propriile culori.

Caseta Umplere (ActivInspire Primary) 
Caseta Umplere se deschide când faceți clic pe Instrumentul de Umplere. Conține:

O gamă de culori din care puteți selecta culoarea pentru Instrumentul de Umplere.

Câteva fante de culoare goale pe care puteți face clic dreapta pentru a alege sau amesteca propria culoare.

Caseta Umplere Duală (ActivInspire Primary)
Caseta Umplere Duală este identică cu Caseta Umplere, cu excepția culorii casetei.

Înapoi
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Caseta Stilou Duală (ActivInspire Primary)
Caseta Stilou Duală conține aceleași instrumente ca Caseta Stilou, cu excepția Radierelor.

Instrumente Desktop
Instrumentele Desktop sunt disponibile sub forma unei Roți Minunate atunci când minimizați ActivInspire. Conține instrumente care 
pot fi utilizate peste desktop. Instrumentele Desktop se închid automat când restaurați fereastra ActivInspire. 

Pentru a muta Instrumentele Desktop, faceți clic în centrul Roții Minunate și trageți instrumentele în noua lor locație. 

Instrument Studio Primary Descriere Mai multe informații

Restaurează 
ActivInspire

Maximizează ActivInspire și închide 
Instrumentele Desktop.

Sondaj Rapid Vă permite să le adresați elevilor o 
întrebare rapidă și să afișați 
instantaneu rezultatele votului.

Referințe  > Instrumente > Sondaj Rapid

Planeta 
Promethean

Deschide website-ul Promethean 
Planet în browserul de Internet.

Tastatura 
pentru Ecran

Vă permite să adăugați text tastat în 
flipchart când sunteți la tablă.

Referințe  > Instrumente > Tastatura 
pentru Ecran

Mai multe despre ActivInspire > 
Lucrul la tablă >  Utilizare Tastatură 
pentru ecran

Camera Vă permite să realizați o captură a 
ecranului, de exemplu o imagine de 
pe un website sau flipchart.

Referințe  > Instrumente > Cameră

Mai multe despre ActivInspire > Lucrul 
la tablă >  Utilizare Cameră

Panglică cu 
mesaje

Vă permite să creați un mesaj care se 
derulează permanent de-a lungul 
ecranului.

Referințe  > Instrumente > Panglică cu 
mesaje
Mai multe despre ActivInspire > Lucrul la 
tablă >  Utilizare Panglică cu mesaje

Ceas Vă permite să alegeți un ceas digital 
sau analog. Puteți seta ecranul, alege 
tipul de numărătoare.

Referințe  > Instrumente > Ceas

Mai multe despre ActivInspire > Lucrul 
la tablă >  Utilizare Ceas 

Înapoi
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Înregistrare 
ecran

Vă permite să înregistrați acțiuni de pe 
un flipchart, desktop flipchart, desktop 
sau alte aplicații, apoi să le redați ca 
animații.

Referințe  > Instrumente > Înregistrare 
ecran

Înregistrare 
sunet

Vă permite să înregistrați sunet, dacă 
aveți echipamentul hardware necesar.

Referințe  > Instrumente > Înregistrare 
sunet

Calculator Vă permite să faceți calcule 
matematice la tablă.

Referințe  > Instrumente > Calculator

Mai multe despre ActivInspire > Lucrul 
la tablă > Utilizare Instrumente 
Matematice > Utilizare Calculator

Aruncătorul 
de Zaruri

Vă permite să aruncați până la 5 zaruri. Referințe  > Instrumente > Aruncătorul 
de Zaruri

Mai multe despre ActivInspire > Lucrul la 
tablă > Utilizare Instrumente Matematice 
> Utilizare Aruncătorul de Zaruri

Înapoi 

Instrumente de Formatare
Bara de Instrumente de Formatare se deschide în mod implicit, de fiecare dată când lucrați cu instrumentul Text. De asemenea, 
puteți deschide Bara de Instrumente de Formatare din Navigatorul de Notițe.

Pentru detalii, vedeți Primii pași cu ActivInspire> Adăugarea și formatarea textului.

Puteți accesa următoarele funcții din Bara de Instrumente de Formatare: 

Funcție Studio Primary Descriere

Fonturi Vă permite să selectați fontul din 
meniul drop-down.

Dimensiune font Vă permite să selectați o dimensiune 
pentru font din meniul drop-down.

Creștere 
dimensiune font

Creșteți sau scădeți dimensiunea 
fontului cu două unități deodată.

Scădere 
dimensiune font

Aldin 
Vă permite să adăugați text cu 
caractere aldine sau cursive sau să 
modificați textul deja existent selectat.Cursiv 

Subliniat Vă permite să adăugați text subliniat sau 
să subliniați textul selectat existent.

Exponent Vă permite să adăugați text de tip 
exponent sau indice sau să modificați 
textul selectat existent.

Indice
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Culoare text Vă permite să selectați o culoare 
pentru text sau fundal din Paleta de 
Culori sau să mixați propria culoare.Culoare 

fundal

Aliniere stânga

Aliniază textul la stânga, central sau la 
dreapta.

Centru

Aliniere dreapta

Creștere 
spațiu dintre 
rânduri Creșteți sau scădeți spațiul dintre 

rândurile de text selectate.Scădere spațiu 
dintre rânduri

Creștere alineat
Creșteți sau scădeți indentarea.

Scădere alineat

Listă Vă permite să transformați textul într-o 
listă cu puncte.

Tastatură 
pentru Ecran

Afișează Tastatura pentru Ecran care vă 
permite să introduceți text tastat la tablă.

Selectare totală Selectează tot textul din obiectul de 
text curent selectat.

Simboluri Vă permite să alegeți simboluri dintr-
o listă drop-down.

Înapoi 

Roata Minunilor pentru Votare

Instrument Studio Primary Descriere

Întrebări cu răspuns 
scala Likert

Afișează opțiunile de răspuns 'Likert Scale' în caseta 'Voting 
Summary' și le trimite către dispozitivele ActivExpression.

Întrebări cu răspuns 
numeric

Afișează opțiunile de răspuns 'Number entry' în caseta 'Voting 
Summary' și le trimite către dispozitivele ActivExpression.

Întrebări cu răspuns
text

Afișează opțiunile de răspuns 'Text entry' în caseta 'Voting 
Summary' și le trimite către dispozitivele ActivExpression.
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Întrebări cu răspuns 
multiplu

Afișează opțiunile de răspuns 'Multiple choice' în caseta 'Voting 
Summary' și le trimite către dispozitivele ActivExpression.

Întrebări cu răspuns 
de ordonare

Afișează opțiunile de răspuns 'Sort in Order' în caseta 'Voting 
Summary' și le trimite către dispozitivele ActivExpression.

Întrebări cu răspuns 
da/nu – adevărat/fals

Afișează opțiunile de răspuns ' Yes/No or True/False' în 
caseta 'Voting Summary' și le trimite către dispozitivele 
ActivExpression.

Acțiuni

Înregistrare 
dispozitive

Deschide caseta de dialog 'Device Registration' pentru a 
putea înregistra dispozitivele ActiVote sau ActivExpression.

Alocare elevi pe 
dispozitive

Deschide caseta de dialog 'Assign students to devices' ca să 
puteți importa numele elevilor dintr-o bază de date.

Închidere Închide Roata Minunilor pentru Votare.

Dispozitive 
ActivExpression

Setează tipul de dispozitive de pe care vor fi acceptate voturi 
în sesiunea curentă de votare.

Dispozitive 
ActiVote

Înapoi

Instrumente Duale
Setul de Instrumente Duale apare în partea din stânga jos a ferestrei ActivInspire în mod implicit. Puteți fixa sau muta instrumentele 
cu drag & drop. Nu puteți adăuga sau elimina instrumente din acest set. 

Setul de Instrumente Duale conține următoarele instrumente:

Instrument/ 
Articol din 
Meniu

Studio Primary Descriere

Paletă de 
Culori

vedeti Caseta 
Stilou

Apăsați pe o culoare pentru a selecta culoarea pentru Stilou, Evidențiator sau Formă.

Faceți clic dreapta pentru a accesa Paleta de Culori Extinsă sau să creați o culoare 

personalizată.

Selectare 
grosime

vedeti Caseta 
Stilou Folosiți opțiunile prestabilite sau glisorul pentru a seta grosimea 

instrumentului de scris.

Selectare Vă permite să selectați și să interacționați cu obiectele de pe pagina flipchart.

Umplere Umple cu culoare un obiect sau o pagină selectate.
În ActivInspire Primary deschide  Caseta Umplere Duală  în partea de jos a 
ferestrei ActivInspire.
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Stilou Scrie sau desenează pe flipchart.
În ActivInspire Primary deschide Caseta Stilou Duală în partea de jos a 
ferestrei ActivInspire.

Evidențiator vedeti Caseta
Stilou

Evidențiază zone de pe flipchart cu o culoare translucidă.

În ActivInspire Primary deschide Caseta Stilou Duală în partea de jos a 
ferestrei ActivInspire.

Formă
Deschide Meniul Forme. Vă permite să alegeți o formă și să o desenați.

Conector Conectează obiecte sau forme cu o linie Conector.

Recunoaștere 
scris de mână Transformă adnotările în text.

Recunoaștere 
forme

Transformă desenele trasate cu mâna liberă în forme.

Înapoi
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  Acasă > Referințe > Acțiuni

Acțiuni 
Puteți asocia o acțiune cu orice obiect din flipchart în Navigatorul de Acțiuni. 

Dacă sunteți obișnuit să lucrați cu acțiuni în ActivStudio sau ActivPrimary, vedeți Rezumatul diferențelor pentru 
informații importante despre utilizarea acțiunilor în flipcharturile existente în ActivInspire.

Pentru fiecare acțiune, există un instrument sau o comandă de potrivire.

Pentru informații despre tipurile de acțiuni disponibile în ActivInspire, vedeți:

Acțiuni Drag and Drop 

Acțiuni de comandă

Acțiuni de pagină

Acțiuni de obiect 

Acțiuni de document/media

Acțiuni de votare
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  Acasă > Referințe > Proprietăți

Proprietăți
Utilizați Navigatorul de Proprietăți pentru a vizualiza, modifica și aplica o serie de proprietăți puternice pentru pagina flipchart sau 
obiecte. Opțiunile sunt afișate în Navigator și depind de faptul dacă ați selectat o pagină, un singur obiect sau mai multe obiecte. 
Diferite tipuri de obiecte au diferite tipuri de proprietăți.

Pentru detalii despre modul de modificare a proprietăților, vedeți Modificarea proprietăților obiectelor.

Această secțiune descrie pe scurt proprietățile disponibile pe categorii:

Proprietăți de identificare

Proprietăți de aspect 

Proprietăți contur

Proprietăți umplere 

Proprietăți fundal

Proprietăți poziționare 

Proprietăți etichetare 

Proprietăți container 

Proprietăți rotire 

Proprietăți restricții 

Diverse proprietăți 

Proprietăți multimedia 

Proprietăți pagină

Proprietăți instrumente 

Proprietăți Dezvăluitor 

Proprietăți Reflector 

Proprietăți grile
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  Acasă > Referințe > Setări

Setări
Puteți personaliza ActivInspire în mai multe moduri diferite pentru a se potrivi nevoilor dumneavoastră. Pentru a vă asigura că 
instrumentele și caracteristicile selectate se comportă întotdeauna într-un mod predefinit, puteți configura și salva preferințele într-unul 
sau mai multe profiluri.

Această secțiune descrie setările disponibile și opțiunile acestora:
Sistemul de Răspuns pentru Elevi

Instrumentul Ceas

Efecte

Obiecte flipchart 

Limbă

Setări online

Corector ortografic

Instrumente

Input utilizator

Înregistrări

Profiluri și Resurse 

Flipchart

Multimedia

Modul Design

 Pentru detalii despre cum accesați și modificați Setările, vedeți Alegerea setărilor aplicațiilor.
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Show  Acasă > Referințe> Acțiuni> Acțiuni Drag and Drop

.

Acțiuni Drag and Drop 

Cel mai rapid mod de a asocia o acțiune cu un obiect este din fila Drag and Drop din Navigatorul de Acțiuni.

Următorul tabel listează acțiunile și descrie pe scurt ce se întâmplă când faceți clic pe obiectul de acțiune:

Acțiune Efect  Mai multe informații

Select
Activează Selectarea

Instrumente > Selectare

Pen
Activează Stiloul

Instrumente > Stilou

Highlighter
Activează Evidențiatorul

Instrumente > Evidențiator

Eraser
Activează Radiera

Instrumente > Radieră

Text
Activează Instrumentul Text

Instrumente > Text

Shape
Activează Instrumentul de Forme

Instrumente > Formă

Fill Activează Instrumentul de Umplere Instrumente > Umplere

Notes Browser
Deschide Navigatorul de Notițe

Navigatoarele ActivInspire > Navigatorul de 
Notițe (Studio) 

Navigatoarele ActivInspire > Navigatorul de 
Notițe (Primary)

Next Page
Merge la pagina flipchart următoare/ anterioară.

Previous Page

First Page
Merge la prima/ ultima pagină flipchart.

Last Page

Revealer
Activează Dezvăluitorul

Instrumente > Dezvăluitorul

Reset Page Resetează pagina curentă la starea în 
care era la ultima salvare.
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Ruler
Activează Rigla

Instrumente > Riglă

Protractor
Activează Raportorul

Instrumente > Raportor

Compass
Activează Compasul

Instrumente > Compas

ExpressPoll Lansează Roata Minunilor pentru Votare.
Folosiți-o ca pe o scurtătură în locul 
butonului ExpressPoll, de exemplu, atunci 
când Instrumentele Principale nu sunt 
disponibile. 

Instrumente > Sondaj Rapid

Folosirea Sistemelor de Răspuns pentru 
Elevi >  Întrebări și sondaje rapide

Start Flipchart Vote Pornește o sesiune de votare, dar doar dacă 
există o întrebare pe pagina curentă.

Întrebări pregătite – Folosirea Expertului 
în Întrebări

Snap to Grid Face ca obiectul să se fixeze de grilă, 
chiar și atunci când grila este invizibilă.

Instrumente > Fixare în grilă
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Show  Acasă  > Referințe  > Acțiuni > Acțiuni de pagină

Acțiuni de pagină
Utilizați acțiunile de pagină pentru a naviga rapid în jurul flipchartului, a insera sau a șterge o pagină sau a schimba fundalul.

Următorul tabel listează acțiunile și descrie ce se întâmplă când faceți clic pe obiectul de acțiune:

Acțiune Efect

Another Page Merge la numărul de pagină specificat în Proprietățile de acțiune 
(Action properties) în Navigatorul de Acțiune.

Clear Page Șterge pagina și șterge obiectul de acțiune în sine.

Copy Page Copiază pagina curentă, inclusiv obiectul de acțiune, astfel încât 
să îl puteți lipi pe o pagină nouă.

Cut Page Taie pagina curentă din flipchart.

Duplicate Page After Current Page
Taie pagina curentă din flipchart.

Duplicate Page Before Current Page

Duplicate Page at End of Flipchart Inserează un duplicat al paginii curente la sfârșitul flipchartului.

First Page Merge la prima pagină din flipchart.

Last Page Merge la ultima pagină din flipchart.

New Page After Current Page
Inserează o pagină goală înainte sau după pagina curentă.

New Page Before Current Page

Next Page Merge la pagina următoare.

Page History Back De fiecare dată când afișați o pagină din flipchart, acest număr de 
pagină este adăugat la o listă internă a istoricului de pagini. 
Folosiți acțiunea „Page History Back” pentru a naviga prin istoricul 
paginilor. Daca ați vizitat o serie de pagini și fiecare pagină 
conține un obiect de acțiune „Page History Back”, făcând clic pe 
aceste obiecte vă va duce înapoi prin istoricul paginilor.

Page History Forward Această acțiune vă va duce înainte prin paginile din istoricul de 
pagini. Această acțiune funcționează numai dacă ați inclus cel 
puțin o acțiune „Page History Back” pe una sau mai multe pagini.

Previous Page Merge la pagina anterioară.

Reset Page Resetează pagina la starea în care se afla când a fost salvată ultima dată.

Set Background Deschide caseta de dialog „Set Background”, care vă permite 
să setați o culoare sau imagine de fundal.
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Acasă > Referințe > Acțiuni > Acțiuni de obiect

Acțiuni de obiect
Utilizați acțiunile de obiect pentru a schimba, de exemplu, dimensiunea, alinierea sau poziția unui obiect, astfel încât atunci când 
faceți clic pe un obiect de acțiune, fie obiectul țintă, fie obiectul de acțiune în sine este schimbat.

Următorul tabel listează acțiunile și descrie ce se întâmplă când faceți clic pe obiectul de acțiune:

Acțiune Efect Mai multe informații

Align Angle Aliniază toate obiectele selectate astfel încât 
unghiurile lor să se potrivească cu primul 
obiect creat dintre obiectele selectate.

 Pentru fiecare dintre aceste acțiuni, 
criteriile de aliniere pentru întreg grupul 
sunt întotdeauna bazate pe primul obiect 
creat din grup.Align Bottom Aliniază toate obiectele selectate astfel 

încât marginea lor inferioară să se alinieze 
cu obiectul din selecție aflat cel mai jos.

Align Center X Aliniază toate obiectele selectate astfel încât 
centrele lor să se alinieze orizontal (pentru X) 
sau vertical (pentru Y), cu punctele lor centrale 
plasate în centrele inițiale ale dreptunghiului de 
delimitare.

Align Center Y

Align Complete Aliniază toate obiectele selectate pentru a se 
potrivi cu proprietățile (stânga, dreapta, sus, 
jos, lățime, înălțime, unghi) primului obiect 
creat dintre cele selectate.

Align Height
Aliniază toate obiectele selectate la aceeași 
înălțime ca primul obiect creat dintre cele 
selectate.

Align Left
Aliniază toate obiectele selectate astfel încât 
marginea lor stângă, dreaptă sau superioară 
să se alinieze cu obiectul din selecție aflat 
cel sus, la stânga sau la dreapta.

Align Right

Align Top

Align Width Lărgește un grup de obiecte la aceeași lățime 
ca primul obiect creat din grup.

Angle Rotește obiectele la unghiul specificat în 
Proprietățile de acțiune.

Angle Incrementally Rotește în mod incremental obiectele după 
unghiul  specificat în Proprietățile de acțiune. De 
exemplu, dacă specificați 10 grade, unghiul 
obiectul țintă se modifică cu 10 grade în sensul 
acelor de ceasornic de fiecare dată când faceți 
clic pe obiectul de acțiune. Puteți specifica o 
valoare cu minus pentru unghi pentru a roti 
obiectele în sens invers acelor de ceasornic.

Append Text Adaugă textul pe care l-ați introdus în 
Proprietățile de acțiune pentru obiectul text Sfat Inserați un spațiu la începutul textului.
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țintă când faceți clic pe obiectul de acțiune.

Best Fit To Height

Aplică cea mai bună potrivire în pagină 
pentru obiectele țintă.Best Fit to Page

Best Fit to Width

Bring Forwards Trimite obiectul înainte cu o poziție în stiva 
de pe stratul său curent.

Utilizare straturi și suprapunere
Bring to Front Trimite obiectul în partea din față a stivei pe 

stratul său actual.

Change Text Value Mărește sau scade valoarea obiectul text țintă 
după valoarea textului specificată în 
Proprietățile de acțiune. De exemplu, dacă 
obiectul text țintă conține „5” și textul proprietății 
de acțiune este „-2”, obiectul țintă se va reduce 
la „3” când se aplică acțiunea.

Clear Annotations Șterge toate adnotările de pe pagină.

Clear Background Șterge fundalul.

Clear Grid Șterge grilele.

Clear Objects Șterge toate obiectele de pe pagină.

Copy
Copiază / Taie / Șterge / Duplică oricare 
dintre următoarele obiecte: text, imagine, 
adnotare, obiecte, formă, acțiune și grupuri 
mixte de obiecte.

Cut

Delete

Duplicate

Edit Text Selectează obiectul text țintă și activează 
Instrument de Text.

Extract Text Creează un obiect text nou din fiecare cuvânt 
pe care faceți clic din obiectul text țintă.

Flip in X Axis Răsucește obiectul țintă pe axa X, spre 
partea de sus a paginii.

Flip in Y Axis Răsucește obiectul țintă pe axa Y, către 
stânga paginii.

Toggle Grouped Vă permite să grupați sau să degrupați 
selecția curentă de obiecte.

Toggle Hidden Vă permite să afișați sau să ascundeți selecția
 curentă de obiecte.
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Invert Întoarce obiectul cu susul în jos.

Less Translucent Face ca obiectul țintă să fie mai puțin 
translucid, cu cât faceți mai des clic pe 
obiectul de acțiune.

Toggle Locked Vă permite să blocați sau deblocați selecția 
curentă de obiecte.  Poate fi mutat cu instrumentul de 

mutare liberă a obiectelor.  

Mirror in X Axis Creează o imagine în oglindă a obiectului din 
axa X spre partea de sus a paginii.

Mirror in Y Axis Creează o imagine în oglindă a obiectului din 
axa Y spre partea stângă a paginii.

More Translucent Face ca obiectul țintă să fie mai translucid, 
cu cât faceți mai des clic pe obiectul de 
acțiune.

New Text Object Inserează un nou obiect de text care conține 
textul introdus în Proprietățile de acțiune.

Folositor când vreți să folosiți pictograme de 
text cu care să afișați un text la momentul 
oportun.

Original Size Resetează dimensiunea obiectului la cea 
originală. Pentru forme, aceasta este 
dimensiunea originală a formei la care a fost 
adăugată pe pagină.

Paste Lipește conținut care a fost copiat sau tăiat anterior.

Position Bottom Mută partea de jos a obiectului țintă la poziția Y, 
așa cum se specifică în Proprietățile de acțiune.

Position Bottom Left Mută partea din stânga jos a obiectului țintă 
la poziția X, Y, așa cum se specifică în 
Proprietățile de acțiune.

Position Bottom Right Mută partea din dreapta jos a obiectului țintă 
la poziția X, Y, așa cum se specifică în 
Proprietățile de acțiune.

Position Central Mută obiectul țintă la poziția X, Y, așa cum 
se specifică în Proprietățile de acțiune.

Position Incrementally Mută obiectul țintă în mod incremental din 
poziția inițială după numărul de pixeli specificat 
în Proprietățile de acțiune.

Position Left Mută marginea din stânga a obiectului țintă la 
poziția X,  așa cum se specifică în Proprietățile 
de acțiune.

Position Right Mută marginea din dreapta a obiectului țintă la 
poziția X,  așa cum se specifică în Proprietățile 
de acțiune.

Position Top Mută marginea superioară a obiectului țintă la poziția 
Y,  așa cum se specifică în Proprietățile de acțiune.
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Position Top Left Mută marginea din stânga sus a obiectului țintă 
la poziția X, Y,  așa cum se specifică în 
Proprietățile de acțiune.

Position Top Right Mută marginea din dreapta sus a obiectului 
țintă la poziția X, Y,  așa cum se specifică în 
Proprietățile de acțiune.

Reflect Întoarce obiectul în jurul propriei axe centrale 
Y.

Select All Selectează totul de pe pagină. Referințe> Selectare

Send Backwards Trimite obiectul înapoi cu o poziție în stiva 
de pe stratul său curent.

Utilizare straturi și suprapunere
Send to Back Trimite obiectul în partea din spate a stivei 

pe stratul său actual.

Size Bottom Acțiunile de dimensionare stabilesc 
dimensiunea generală a obiectului țintă la 
valoarea specificată în Proprietățile de acțiune. 
Poziția finală a obiectului este dictată de 
acțiunea de dimensionare aleasă. De exemplu 
dacă alegeți „Size Bottom 100”, obiectul va fi 
dimensionat astfel încât să aibă 100 de pixeli 
în lățime și înălțime, menținând în același timp 
poziția marginii superioare a obiectului.

Acțiunile de dimensionare incrementale se 
comportă ca acțiunile de dimensionare cu 
excepția că obiectul ținta este mărit sau 
micșorat de numărul de pixeli specificat în 
Proprietățile de acțiune, menținând în același 
timp poziția originală, de exemplu în dreapta 
jos.

 Acțiunile de dimensionare mențin 
raportul de aspect a obiectului țintă.Size Bottom Incrementally

Size Bottom Left

Size Bottom Left
Incrementally

Size Bottom Right

Size Bottom Right
Incrementally

Size Central

Size Central Incrementally

Size Left

Size Left Incrementally

Size Right

Size Right Incrementally

Size Top

Size Top Incrementally

Size Top Left

Size Top Left Incrementally

Size Top Right
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Size Top Right
Incrementally

Stretch Bottom Acțiunile de întindere stabilesc lățimea și 
înălțimea generale a obiectului țintă la valoarea 
specificată în Proprietățile de acțiune. Poziția 
finală a obiectului este dictată de acțiunea de 
întindere aleasă. De exemplu dacă alegeți 
„Stretch Bottom 100”, obiectul va fi dimensionat 
astfel încât să aibă 100 de pixeli în înălțime, 
menținând în același timp poziția marginii 
superioare a obiectului.

Acțiunile de întindere incrementale se 
comportă ca acțiunile de dimensionare cu 
excepția că obiectul ținta este mărit sau 
micșorat de numărul de pixeli specificat în 
Proprietățile de acțiune, menținând în același 
timp poziția originală, de exemplu în dreapta 
jos.

 Acțiunile de întindere deformează 
raportul de aspect al obiectului țintă.Stretch Bottom

Incrementally

Stretch Bottom Left

Stretch Bottom Left
Incrementally

Stretch Bottom Right

Stretch Bottom Right
Incrementally

Stretch Central

Stretch Central
Incrementally

Stretch Left

Stretch Left Incrementally

Stretch Right

Stretch Right Incrementally

Stretch Top

Stretch Top Incrementally

Stretch Top Left

Stretch Top Left
Incrementally

Stretch Top Right

Stretch Top Right
Incrementally

To Bottom Layer
Trimite obiectul pe stratul inferior, de mijloc 
sau superior. Utilizare straturi și suprapunereTo Middle Layer

To Top Layer

Translucency Schimbă transluciditatea obiectului țintă la o 
valoare fixă, unde
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0 = opac

255 = transparent
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Acasă > Referințe > Acțiuni > Acțiuni de document/media

Acțiuni de document/media
Următorul tabel listează acțiunile și descrie ce se întâmplă când faceți clic pe obiectul de acțiune:

Acțiune Efect Mai multe informații

Open Document, File or
Sound

Deschide documentul sau fișierul sau redă 
sunetul pe care l-ați atribuit obiectului în 
Proprietățile de acțiune.

Mai multe despre ActivInspire > 
Realizarea flipcharturilor interactive > 
Lucrul cu acțiuni

Mai multe despre ActivInspire > Lucrul 
cu obiecte > Adăugare multimedia

Open Website Deschide URL-ul pe care l-ați atribuit obiectului în 
Proprietățile de acțiune.
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Acasă > Referințe > Acțiuni > Acțiuni de votare

Acțiuni de votare
Următorul tabel listează acțiunile și descrie ce se întâmplă când faceți click pe obiectul de acțiune:

Acțiune Efect Mai multe informații

Assign students to devices Deschide caseta de dialog 'Assign students to devices'.Folosirea Sistemelor de Răspuns
pentru Elevi > Alocarea elevilor pe 
dispozitive

Device Registration
Pornește Înregistrarea dispozitivelor.

Folosirea Sistemelor de Răspuns 
pentru Elevi > Înregistrarea 
dispozitivelor

Export Results To Excel® Deschide caseta de dialog 'Export Results To 
Excel®' dacă există rezultate de vot pe pagina 
curentă.
Alegeți un folder și introduceți un nume pentru fișier 
– rezultatele votului sunt salvate ca un fișier .xls și
deschise automat în Excel, dacă îl aveți instalat în
computer.
Puteți alege să exportați rezultatele curente sau
anterioare afișate în Navigatorul de Rezultate.

Folosirea Sistemelor de Răspuns 
pentru Elevi

ExpressPoll Lansează Roata Minunilor pentru votare.
Folosiți ca o scurtătură în loc de butonul 
EpressPoll, de exemplu când Instrumentele 
Principale nu sunt disponibile.

Folosirea Sistemelor de Răspuns 
pentru Elevi >  Întrebări și sondaje 
rapide

Insert Question Lansează Expertul în Întrebări. Când completați 
câmpurile, întrebarea este afișată pe pagina 
curentă (sau una nouă).

Ori de câte ori navigați la o pagină de 
întrebări, butonul  Start/Stop 
Flipchart Vote este evidențiat cu 
verde, gata de a începe un vot.

Pause Vote Comutator. Oprește votul dacă a fost setat un timp 
limită. Apăsați din nou pentru a reîncepe.

Start/Stop Flipchart Vote Folosiți ca o scurtătură în loc de butonul Start 
Flipchart Vote, de exemplu când Instrumentele 
Principale nu sunt disponibile.

Pornește sau oprește o sesiune de vot, dar doar 
dacă există o întrebare pe pagina curentă.

Student Database Deschide caseta de text 'Edit Student Database'. 
Folosiți ca o scurtătură dacă alocați adesea 
dispozitive elevilor sau clasa se schimbă frecvent.
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Acasă > Primii pași cu ActivInspire > Crearea primului flipchart

Crearea primului flipchart
Felicitări! Când deschideți ActivInspire, ați creat deja primul flipchart! 

Spațiul gol din spatele Panoului de Control din fereastra ActivInspire este de fapt prima pagină a unui flipchart nou. Puteți începe 
să lucrați imediat și să îl salvați mai târziu. 

Aici vă arătăm alte două modalități de a crea un flipchart. 

Crearea unui flipchart din Panoul de Control
În Panoul de Control, faceți clic pe  Create a new Flipchart 

ActivInspire creează un nou flipchart „Untitled”. 

Crearea unui flipchart

1. Faceți clic pe pictograma Meniu Principal.

2. Din meniu, selectați:

New Flipchart
sau

New și apoi selectați una dintre următoarele opțiuni:

Opțiune Descriere

Screen Size Flipchart Creează un flipchart care are aceeași dimensiune ca 
rezoluția ecranului. Aceasta este setarea implicită și este 
utilă dacă nu cunoașteți dimensiunea ecranului.

1024 x 768 Flipchart

Creează un flipchart nou cu înălțimea și lățimea specificate, 
în pixeli.1152 x 864 Flipchart

1280 x 1024 Flipchart

Custom Size Flipchart Creați o dimensiune proprie de flipchart folosind caseta 
'Custom Page Size'. Aceasta este folositoare când vreți să 
creați un flipchart pentru o tablă sau un ecran extra-lat, de 
exemplu.

ActivInspire creează un nou flipchart „Untitled”.
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Acasă > Referințe > Instrumente > Calculator

Calculator 

Ce? Efectuează calcule matematice la tablă.

Unde? Tools > Math Tools > Calculator 

Instrumente Desktop

Cum? Faceți clic sau apăsați pe tastele calculatorului pentru a face calcule.

Ce puteți personaliza? Alegerea calculatorului

Calculatorul din ActivInspire (implicit)

Calculatorul din sistemul de operare

Alt calculator instalat pe computer

Unde puteți personaliza? Edit Profiles > Settings > Tools

Mai multe informații
Utilizare Calculator

Alegerea setărilor aplicațiilor

Referințe > Setări > Instrumente

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Spotlight

Reflector

Ce? Oferă un strat “mască” peste flipchart (sau desktop) care conține o zonă mobilă, 
dimensionabilă, cunoscută sub numele de Spotlight (Reflector), prin care puteți vedea 
obiectele de dedesubt.
Reflectorul ales poate fi:

Mutat prin glisarea oricărei părți a zonei mascate

Mărit prin tragerea oricărei părți din perimetrul reflectorului

În timp ce Spotlight este afișat, puteți continua să interacționați cu orice zone vizibile ale 
flipchartului.

Unde? Main Menu > Tools > Spotlight

Comandă rapidă? Reflector Circular (vedeți descrierea mai jos):

CTRL+Shift+O (WindowsTM & LinuxTM)

Cmd+Shift+O (Mac®)

Cum? Alegeți tipul de reflector din meniul drop-down:

Circular Spotlight Oferă o zonă luminată 
mobilă, dimensionabilă 
circulară/ovală sau 
pătrată/dreptunghiulară, 
printr-un strat de 
mascare completă a 
paginii.

Square Spotlight

Solid Circular Spotlight Oferă o zonă 
mascată mobilă, 
dimensionabilă 
circulară/ovală sau 
pătrată/
dreptunghiulară.

Solid Square Spotlight

Ce puteți personaliza? Border width Creșteți sau scădeți 
lățimea marginii din 
jurul zonei 
reflectorului. Intervalul 
este de la 0 la 20 
pixeli.

Border color Culoarea marginii 
din jurul reflectorului.

Background color Culoarea zonei din 
afara reflectorului.
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Translucent border Face marginea 
reflectorului translucidă
 sau opacă.

Translucent screen  Faceți ca ecranul 
reflectorului (zona 
întunecată care 
acoperă fereastra 
Flipchart sau 
Desktop) să fie 
translucid sau opac.

Unde puteți 
personaliza?

Settings > Effects

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Reflector 

Bara de Meniu > Instrumente

Referințe > Setări > Efecte
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Acasă > Referințe > Instrumente > Compas

Compas 

Ce? Folosit pentru desenarea cercurilor și arcurilor de cerc de orice mărime, 
culoare sau grosime a liniilor cu  Stiloul                Evidențiatorul         
sau Radiera 

Unde? Tools > Math Tools > Compass

Cum? Trageți compasul în zona paginii în care doriți să desenați un cerc sau arc, 
extindeți-l la raza dorită, selectați instrumentul Stilou sau Evidențiator, 
reglați grosimea liniei și culoarea, dacă este necesar, trageți brațul stiloului 
până când ați creat forma dorită. Apoi faceți clic pe crucea dintre cele două 
brațe pentru a elimina instrumentul sau trageți-l în Coșul de gunoi.

Mai multe informații
Utilizare Compas

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Conector

Conector 

Ce? Desenați conexiuni între obiecte, de exemplu, în timp ce creați hărți 
conceptuale. Linia de conectare se adaptează automat când unul dintre 
obiectele conectate este mutat.

Unde? Tools > Connector

Main Toolbox

Dual Toolbox

Comandă rapidă? CTRL+Shift+C (WindowsTM & LinuxTM)

Cmd+Shift+C (Mac®)

Cum? Faceți click și trageți să creați legături între obiecte.

Mai multe informații
Lucrul în modul Dual User

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Aruncătorul de Zaruri

Aruncătorul de Zaruri 

Ce? Aruncați până la 5 zaruri.

Unde? Tools > Math Tools > Dice Roller

Desktop Tools

Cum? Selectați numărul de zaruri, viteza de rulare și dacă să se afișeze sau nu rezultatele 
pe flipchart.

Ce puteți personaliza? Number of dice 1 - 5

Speed 3 - 11 secunde

Roll Apăsați pentru a arunca zarurile.

Output to
Flipchart

Apăsați pentru a pune rezultatele pe flipchart.

Unde puteți personaliza? Caseta 'Dice Roller'

Edit Profiles > Settings > Tools

 Mai multe informații
Utilizare Aruncătorul de Zaruri

Setări > Instrumente

Lucrul cu acțiuni 

Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Radieră

Radieră

Ce? Șterge permanent sau desparte adnotări făcute cu Stiloul, Evidențiatorul sau 
Cerneala Magică.

Ce? Tools > Eraser

Main Toolbox

Dual Toolbox

Comandă rapidă? CTRL+E (WindowsTM & LinuxTM)

Cmd+E (Mac®)

Cum? Selectați grosimea, apoi frecați ușor peste adnotare.

Ce puteți personaliza? Width Creșteți sau scădeți grosimea Radierei cu glisorul.

Unde puteți personaliza? Main Toolbox

Mai multe informații
Ștergerea elementelor

Lucrul cu acțiuni

Acțiuni > Acțiuni de comandă
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Acasă > Primii pași cu ActivInspire > Ștergerea elementelor

Ștergerea elementelor
Aici vă prezentăm câteva modalități facile de a șterge diferite elemente de pe pagină:

Ștergerea cu Radiera

Ștergere totală pagină

Resetare pagină

Anulați și refaceți

Utilizare Coș de gunoi

De asemenea, puteți selecta obiecte și le puteți șterge cu tasta Delete de pe tastatură.

Majoritatea instrumentelor pe care le descriem în această secțiune se află în setul de
Instrumente Principale, cu excepția Coșului de gunoi.

Ștergerea cu Radiera 

Radiera  funcționează pe orice adnotări, atâta timp cât sunt pe stratul superior.

Puteți utiliza Radiera în două moduri:

Să ștergeți complet o adnotare.

Pentru a despărți o adnotare în obiecte separate. Aceasta 
are avantajul că puteți selecta apoi și manipula părțile 
rămase ale adnotării ca obiecte separate.

Pentru a șterge ceva cu Radiera:

1. Faceți clic pe Radieră. Cursorul se schimbă într-o mică radieră cu
un cerc.

2. Poziționați cursorul unde doriți să începeți.

3. Faceți clic și trageți pentru a șterge total sau parțial adnotarea.

Puteți modifica grosimea Radierei în același mod în care modificați 

grosimea Stiloului sau a Evidențiatorului.

Ștergere totală pagină

Pentru a șterge totul de pe pagina curentă, dați clic pe Clear           și selectați Clear Page.

pentru mai multe scopuri diferite, de exemplu, pentru a șterge toate adnotările sau pentru a șterge toate 
obiectele și a lăsa orice altceva la locul lui. 

Puteți utiliza Clear

Clear este disponibil și din Meniul Editare.

Resetare pagină 
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Aceasta este o modalitate rapidă de a anula toate modificările făcute pe pagina curentă de la ultima salvare a flipchartului.

 Reset Page        este disponibilă și din Meniul Editare.

Anulați și refaceți

Undo și Redo sunt instrumente puternice care vă pot scoate rapid din tot felul de probleme!

De exemplu, dacă ați folosit prea liber oricare dintre instrumentele de mai sus și trebuie să refaceți o parte sau tot ceea ce ați șters.

Utilizare Coș de gunoi
Dacă Coșul de gunoi este vizibil, puteți șterge obiecte în următoarele moduri:

Trageți un obiect sau obiecte în Coșul de gunoi și plasați-le când este o săgeată roșie 
apare în Coșul de gunoi.
Selectați un obiect sau obiecte, apoi faceți clic pe Coșul de gunoi pentru a le șterge.

 Vă puteți recupera oricând obiectele cu Undo .

Înapoi 
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Acasă > Referințe > Instrumente > Umplere

Umplere 

Ce? Umpleți:

Forme cu culori uni sau gradate (puteți seta culorile pentru gradare în 
Navigatorul de Proprietăți)

Forme de diferite culori care se intersectează

Pagini

Modificați culoarea conturului obiectelor.

Unde? Main Toolbox

Tools > Fill

Dual Toolbox

Comandă rapidă? CTRL+F (WindowsTM & LinuxTM)

Cmd+F (Mac®)

Cum? Selectați instrumentul de Umplere, modificați culoarea dacă doriți și faceți clic pe 
obiect, pagină sau contur.

Unde puteți personaliza? In Property Browser > Fill properties

Mai multe informații
Adăugare și manipulare forme  > Umplere forme

Lucrul cu acțiuni

Referințe  > Proprietăți  > Proprietăți umplere

Referințe > Acțiuni > Acțiuni de comandă
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  Acasă > Primii pași cu ActivInspire > Adăugare și manipulare forme

Adăugare și manipulare forme
Puteți adăuga mai multe tipuri diferite de obiecte în flipchart. Acestea variază de la forme simple pe care le creați cu 

Instrumentul Forme și adnotări pe care le creați cu Stiloul  sau Evidențiatorul  la obiecte precum: 

Fișiere din Biblioteca de resurse

Imagini importate
Videoclipuri și fișiere audio

Puteți manipula majoritatea acestor tipuri de obiecte în același mod.

Aici vă arătăm cum să creați și să manipulați forme simple cu Instrumentul Shape:

Crearea unei forme

Selectare formă

Umplere formă

Mutare sau rotire formă

Redimensionare formă

Schimbare formă

Grupare și degrupare forme

În cele din urmă, vă oferim, de asemenea, informații despre un  instrument extraordinar pentru crearea de forme la tablă..

Crearea unei forme
Pentru a adăuga o formă în flipchart:

1. Faceți clic pe Shape   Se deschide Shapes Menu. În funcție de preferințe, acesta este aliniat de-a lungul părții laterale 
sau inferioare din fereastra ActivInspire.

2. Selectați forma pe care doriți să o desenați, de exemplu Triunghi. Cursorul se transformă într-o săgeată și o versiune mică a
formei pe care ați ales-o.

3. Deplasați cursorul în locul din pagină unde doriți să vă desenați forma, apoi faceți clic sau apăsați.

4. Continuați să apăsați și să desenați ușor până când forma are dimensiunea dorită.

Selectare formă
Pentru a aduce modificări formei pe care tocmai ați creat-o:

1. Faceți clic pe  Select

2. Deplasați cursorul peste formă. Cursorul se schimbă într-un
mic cap de săgeată cu o cruce. Faceți clic sau atingeți forma.
În exemplul din dreapta, am selectat triunghiul negru. În jurul
obiectului apare o casetă.

Notă:

Șirul de pictograme de deasupra obiectului formă, acestea 
sunt Punctele de acțiuni. Fiecare dintre aceste puncte vă 
permite schimbați obiectul într-un mod diferit.
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Conturul pătrat din jurul obiectului. Are cercuri gri sau 
galbene (ActivInspire Primary) la colțuri și în centrele 
fiecăreia dintre cele patru laturi. Acestea sunt Punctele 
de redimensionare. Puteți să faceți clic și să le trageți ca 
să extindeți și distorsionați obiectul. Există, de 
asemenea, un punct special pentru redimensionarea 
obiectului proporțional, fără distorsiuni.

Pentru detalii despre toate punctele, vedeți Referințe > 
Meniuri și meniuri popup > Puncte de acțiuni și 
redimensionare.

ActivInspire Primary

Aici descriem pe scurt Punctele de acțiuni pe care le vom folosi în această secțiune:

1

2

3

4

5

Punctul pentru mutarea liberă a obiectului vă permite să mutați obiectul oriunde pe pagina flipchart. Acest instrument 
anulează toate restricțiile și blocajele obiectelor.

Rotire obiect

Un comutator care vă permite să grupați și să degrupați obiecte, astfel încât să le puteți schimba sau muta ca unul.

Mărire dimensiune obiect

Reducere dimensiune obiect

Vă permite să schimbați forma unui obiect prin mișcarea și glisarea colțurilor acestuia.

Înapoi 

Umplere formă
Pentru a umple o formă cu culoare:

1. În setul de Instrumente Principale, faceți clic pe Umplere (Fill)



Adding and manipulating shapes

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/adding_and_manipulating_shapes.htm[1/21/2010 6:10:29 PM]

2. Din Paleta de culori, selectați o culoare de umplere.

3. Faceți clic pe formă.

Mutare sau rotire formă
Mutare formă

Iată două moduri de a muta o formă.

1. Selectați forma

2. Țineți apăsat butonul mouse-ului sau ActivPen și mutați forma unde doriți pe pagina curentă, cu drag & drop.

SAU
1. Selectați forma.

2. Faceți clic pe Mutare obiect

3. Țineți apăsat butonul mouse-ului sau ActivPen pe pictogramă și mutați forma unde doriți pe pagina curentă, cu drag & drop.

Rotire formă

1. Selectați forma.

2. Faceți clic pe Rotire obiect

3. Țineți apăsat butonul mouse-ului sau ActivPen și trageți cursorul în sus sau jos pentru a modifica unghiul de rotație al formei.

Înapoi 

Redimensionare formă
Iată două moduri de a crește și de a micșora dimensiunea unei forme sau a unui alt obiect, fără a o distorsiona. 

O modificare minoră

 sau Reducere dimensiune obiect 

1. Selectați forma.

2. Faceți clic pe  Creștere dimensiune obiect
pentru a modifica dimensiunea puțin câte puțin.

3. Repetați până când forma are dimensiunea corectă.
O modificare majoră

1. Selectați forma.

2. Faceți clic pe punctul de dimensionare care menține raportul de aspect

3. Țineți apăsat butonul mouse-ului sau ActivPen și trageți de punct până când forma are dimensiunea dorită.

Înapoi 

Schimbare formă
Iată două moduri de a schimba forma unui obiect.

 Alungire sau scurtare obiect

1. Selectați forma.

2. Faceți clic pe unul dintre punctele de redimensionare.

3. Țineți apăsat butonul mouse-ului sau ActivPen și trageți punctul până când obiectul are lungimea sau înălțimea dorită.
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Punctele de editare a formei

Pentru a face modificări mai complexe sau mai subtile unei forme, utilizați 

Punctele de editare a formei

1. Selectați forma.

2. Faceți clic pe Punctele de editare a formei        Marginea obiectului se transformă 
într-o serie de pătrățele. Fiecare dintre acestea este un punct de formă. Exemplul
din dreapta arată cele opt puncte de formă ale unui pătrat.

3. Faceți clic și trageți oricare dintre punctele de formă pentru a modifica forma
pătratului.

Înapoi 

Grupare și degrupare forme

Pentru a muta mai multe obiecte în același timp, puteți selecta toate obiectele și le puteți grupa împreună cu punctul de acțiune 
pentru Comutare Grupat.

1. Faceți clic pe Selectare.

2. Faceți clic și trageți cursorul în diagonală peste toate obiectele pentru a le
selecta.

3. Faceți clic pe  Comutare Grupat.                 Punctul de acțiune pentru 
Comutare Grupat își schimbă culoarea pentru a indica faptul că obiectele au
fost grupate împreună.

4. Faceți clic pe obiectele grupate și trageți-le în noua lor poziție.

Pentru a degrupa obiecte, astfel încât să le puteți manipula individual:

1. Faceți clic pe orice parte a grupului pentru a o selecta.
2. Faceți clic pe punctul de acțiune pentru Comutare Grupat.

Pentru detalii despre toate punctele, vedeți  Referințe > Meniuri și meniuri 
popup > Puncte de acțiuni și redimensionare.

Înapoi 

Instrument extraordinar
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ActivInspire oferă, de asemenea, Instrumentul de Recunoaștere formă  

pentru crearea de forme pe tablă. Desenați o formă cu mâna și lăsați 

ActivInspire să-l transforme într-un obiect de formă. 

Pentru detalii, consultați Utilizare Recunoaștere Formă.
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Acasă > Mai multe despre ActivInspire > Lucrul cu obiecte > Crearea și editarea grilelor

Crearea și editarea grilelor
Grila este un fundal cu model. Puteți avea fundaluri cu culori și imagini diferite.

Pentru a selecta un fundal:

Din Meniul Principal selectați  File > Edit > Page Background.

Pentru a crea o grilă:

Faceți clic dreapta pe o zonă goală a unei pagini flipchart și din meniul popup selectați  Grid Designer.

Despre Designerul 

de grile  

Grid Designer are trei secțiuni: 

Grid Setări de ajustare și scalare a 
grilei.

Grid (Level) Adăugați / ștergeți 
nivele și resetați grila. 

Current Level Setați opțiuni, 
inclusiv modelul și culoarea pentru 
câte un nivel. 

Puteți modifica setările grilei și 
previzualiza rezultatele instantaneu. 

Selectați Close pentru a continua 
flipchartul.

Bifați căsuța de selectare Visible. Este afișată grila implicită.

Grila implicită are un nivel, un model de casetă cu linii gorase, orizontale și 
verticale (X-Y Direction).

Bifați căsuța Allow snap pentru a activa fixarea obiectelor în punctele grilei. 
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Bifați căsuța  On top pentru a afișa 
grila deasupra tuturor obiectelor 
flipchartului. Acest lucru nu 
interferează cu utilizarea flipchartului. 

Pentru casete mai mari sau mai mici 
în modelul grilei, faceți clic pe  + saiu 
-.

Pentru un model de plasă, modificați 
Grid style la 45 Degrees.

Pentru un model de rețea cu romburi, 
schimbați  Grid style la Angle și 
introduceți un număr pentru unghiul 
liniilor. Puteți introduce o valoare 
zecimală cu șase cifre. 

Dacă aveți Navigatorul de Pagini 
deschis, iar grila nu poate fi văzută în 
mod clar, schimbați Thumbnail 
scale. Acest lucru se aplică și 
grilelor din Biblioteca de resurse. 

Dacă doriți linii într-o singură direcție, 
selectați  X only sau Y only din 
meniul drop-down  Direction.

Pentru stilul liniilor, în loc de Solid 
Lines (linii continue), puteți alege 
Dashed Lines (linii întrerupte) sau 
Dotted Lines (linii punctate), 
Crosses (cruci) sau Dots (puncte) 
din meniul drop-down Line style. 

Puteți avea o grilă cu mai multe stiluri 
de model și culori diferite. Faceți clic 
pe Add Level pentru a crea un nivel 
suplimentar. Numărul de nivele este 
afișat în titlul Grid (x Level) unde x 
este totalul numărul de nivele. 

Fiecare nivel nou are proprietățile 
implicite pentru grile. Puteți schimba 
Color pentru a identifica nivele noi. 

Faceți clic pe caseta Color pentru a 
deschide Paleta de culori. Când ați 
selectat o culoare, faceți clic pe OK.
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Grile inversate 

O grilă inversată are o culoare 
deschisă a modelului pe un fundal 
întunecat. Utilizați alb / negru 
pentru a reprezenta o tablă clasică.
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  Acasă > Referințe > Instrumente > Recunoaștere Scris de Mână

Recunoaștere Scris de Mână

Ce? Scrieți pe tablă și lăsați ActivInspire să transforme adnotările cu mâna liberă în text. Pe 
lângă recunoașterea scrierii de mână și a formelor în ActivInspire, Instrumentul de 
Recunoaștere Scris de Mână poate recunoaște și scrierea de mână în alte aplicații, de 
exemplu Microsoft Word®.

Unde? Tools > Handwriting Recognition

Dual Toolbox

Comandă rapidă? CTRL+Shift+H (WindowsTM & LinuxTM)

Cmd+Shift+H (Mac®)

Cum? Utilizați Recunoaștere Scris de Mână în timp ce scrieți:

Nu vă grăbiți, scrieți încet și clar. Dacă ActivInspire vă interpretează scrierea 
corect, continuați să scrieți, altfel selectați ortografia corectă din lista drop-down.

Folosiți-l mai târziu:

Cu Instrumentul de Selectare, selectați adnotările care urmează să fie 
transformate în text, apoi selectați Convert to Text din meniul de editare obiect.

Ce puteți personaliza? În setul de Instrumente Principale:

Pen width Implicit = Linie subțire

Modificați grosimea Stiloului cu glisorul sau selectați o grosime 
implicită pentru a crea linii mai groase. 

Color Implicit = Negru

Schimbați culoarea alegând alta din Paleta de Culori.

În secțiunea User Input din Settings:

Recognition
Timeout

Implicit = 5

Intervalul de timp în secunde înainte ca ActivInspire să înceapă 
să transforme scrisul în text.

Mutați glisorul pentru a modifica timpul, de la 0 la 5 secunde.

Handwriting
recognition
language

Implicit = Limba folosită de sistemul de operare al computerului

Limba în care scrieți adnotările. Selectați din următoarele limbi:

Daneză, Germană, Greacă, Engleză (Canada), Engleză (SUA), 
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Spaniolă, Spaniolă (Mexic), Finlandeză, Franceză, Franceză 
(Canada), Italiană, Japoneză, Coreeană, Olandeză, 
Norvegiană, Portugheză, Portugheză (Brazilia), Rusă, 
Suedeză, Chineză (RPC), Chineză (Taiwan).

Unde puteți 
personaliza?

Main Toolbox

Settings > User Input

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Recunoaștere Scris de Mână

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/magic_ink.htm[1/21/2010 6:10:35 PM]

 

Acasă > Referințe > Instrumente > Cerneala Magică

Cerneala Magică

Ce? Face orice obiect de pe stratul superior (sau parte dintr-un obiect) invizibil, ca să 
puteți vedea obiectele de pe straturile de dedesubt.

Unde? Tools > Magic Ink

Comandă rapidă? CTRL+Shift+M (WindowsTM & LinuxTM)

Cmd+Shift+M (Mac®)

Cum? Cerneala Magică acționează ca un stilou cu care desenați pe stratul superior o 
adnotare prin care puteți vedea, permițându-vă să realizați zone transparente prin 
obiectele de pe stratul superior.

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Cerneală Magică 

Realizarea flipcharturilor interactive > Lucrul cu acțiuni 
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Acasă > Primii pași cu ActivInspire > Crearea notițelor de pagină

Crearea notițelor de pagină

Puteți crea, vizualiza și edita notițele de pagină despre flipchart cu ajutorul Navigatorului de Notițe. .

1. Faceți clic pe Notes Browser        Se deschide navigatorul.

2. Cu tastatura computerului, tastați notițele. Acestea pot fi la fel de detaliate sau scurte pe cât doriți. În mod implicit, notițele
apar ca text simplu.

3. Pentru a vă formata textul, utilizați Instrumentele de Formatare.

4. După ce ați finalizat notițele, faceți clic pe un alt instrument pentru a închide Navigatorul și instrumentele.

Înapoi 
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Acasă > Referințe > Instrumente > Tastatura pentru Ecran

Tastatura pentru Ecran

Ce? Adăugați text tastat pe flipchart când lucrați la tablă.

Unde? Tools > More Tools > On-Screen Keyboard

Desktop Tools

Comandă rapidă? CTRL+K (WindowsTM & LinuxTM)

Cmd+K (Mac®)

Cum? Apăsați pe tastele de pe ecran pentru a crea text.

Ce puteți personaliza? Schimbați formatarea, culoarea textului și fontul din Instrumentele de Formatare.

Unde puteți personaliza? Pe tastatură există opțiuni pentru a afișa o tastatură standard sau extinsă și 
pentru a alege numărul de taste.

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Tastatură pentru ecran 

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Primii pași cu ActivInspire > Deschiderea unui flipchart

Deschiderea unui flipchart
Aici vă arătăm mai multe moduri de a deschide un flipchart.

Deschidere din Panoul de Control
Când rulați ActivInspire, Panoul de Control se deschide, cu excepția cazului în care ați debifat caseta „Show the dashboard window 

on startup”. Două modalități de a deschide un flipchart existent din Panoul de Control.

Răsfoire

1. Faceți clic pe Open a flipchart. Se deschide o casetă de dialog care afișează toate flipcharturile în folderul My Flipcharts.

2. Selectați un flipchart din lista din folder sau navigați la un alt folder care conține flipcharts și faceți clic pe Open. Flipchartul
selectat se deschide în fereastra ActivInspire.

Lista Panoului de Control

Pentru a economisi timp, ActivInspire listează cele mai recente flipcharturi în Panoul de Control. Faceți clic pe unul dintre flipcharturi.

Alte două modalități de a deschide un flipchart

1. Din File Menu, selectați Open, sau tasați CTRL+O (WindowsTM  and LinuxTM ) sau Cmd+O (Mac®). Se deschide o casetă
de dialog, afișând toate flipcharturile în folderul My Flipcharts.

2. Selectați un flipchart din lista din folder sau navigați la un alt folder care conține flipcharturi și faceți clic pe Open. Flipchartul
selectat se deschide în fereastra ActivInspire.
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Acasă > Primii pași cu ActivInspire > Printarea unui flipchart

Printarea unui flipchart
Puteți să imprimați flipchartul și să îl utilizați integral sau parțial ca fișă pentru elevi sau să imprimați orice notiță de pagină pe care ați adăugat-o cu 
Navigatorul de Notițe.

1. Din File Menu, selectați Print sau apăsați CTRL + Shift + P (Windows ™ și Linux ™) sau Cmd + Shift + P (Mac®). Se deschide caseta de dialog
'Flipchart Print' (prezentată mai jos). Puteți selecta dintr-o serie de opțiuni de imprimare, inclusiv Exportul în PDF.

2. Faceți alegerile, apoi faceți clic pe Print.

ActivInspire Studio ActivInspire Primary
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Acasă > Referințe > Instrumente > Raportor

Raportor 

Ce? Desenați arcuri de cerc, segmente și cercuri și măsurați unghiuri.

Unde? Tools > Maths Tools > Protractor

Cum? Poziționați raportorul, trageți-l la dimensiunea dorită, selectați tipul de raportor pe 
care doriți să îl utilizați și selectați tipul de arc. Apoi Selectați stiloul și schimbați 
culoarea sau grosimea după cum este necesar, aliniați cursorul pe marginea 
raportorului și începeți să desenați.

Închideți Raportorul din meniul popup sau trageți-l în Coșul de gunoi.

Ce puteți personaliza? Full
Protractor

Afișează un raportor circular de 360 grade.

Half
Protractor

Afișează un raportor de 180 grade.

Arc Vă permite să desenați un arc deschis.

Closed Arc Vă permite să desenați un arc închis.

Filled Arc Vă permite să desenați un arc umplut.

Unde puteți personaliza? Meniul contextual al Raportorului.

Mai multe informații
Utilizare Raportor

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Anulare și refacere

Anulare și refacere

Ce? Anularea sau refacerea ultimei acțiuni, de exemplu Umplere.

Unde? Edit > Undo

Edit > Redo

Main Toolbox

Comandă rapidă? Anulare:

CTRL+Z (WindowsTM & LinuxTM)

Cmd+Z (Mac®)

Refacere:

CTRL+Y (WindowsTM & LinuxTM)

Cmd+Y (Mac®)

Cum? Apăsați repetat pentru a anula sau reface câte acțiuni este necesar.

Mai multe informații
Primii pași cu ActivInspire > Ștergerea elementelor
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Acasă > Referințe > Instrumente > Riglă

Riglă

Ce? Desenarea și măsurarea liniilor la tablă.

Unde? Tools > Maths Tools > Ruler

Cum? Trageți rigla pentru a o prelungi sau scurta, poziționați-o pe pagina unde doriți să 
desenați sau măsurați, selectați unitățile de măsură ale riglei.
Utilizați Stiloul sau Evidențiatorul pentru a desena linii.

Ce puteți personaliza? Lungimea riglei.

Selectați unitățile de măsură pentru marginea inferioară și superioară.

Unde puteți personaliza? În meniul popup al riglei.

Mai multe informații
Utilizare Riglă

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Primii pași cu ActivInspire > Salvarea unui flipchart

Salvarea unui flipchart
După ce ați terminat flipchartul, trebuie să îl salvați.

Aici vă arătăm două modalități de a face acest lucru.

Salvarea unui flipchart cu numele său curent

Apăsați CTRL+S (WindowsTM și LinuxTM), sau Cmd+S (Mac®).

Dacă salvați un flipchart deja denumit, asta este tot ce trebuie să faceți

Dacă salvați un flipchart nou, se deschide o casetă de dialog de salvare standard, care vă permite să denumiți și să salvați 
flipchartul. Când a fost salvat, fila Document a flipchartului arată noul nume al flipchartului.

Salvarea unui flipchart cu un nume nou
Poate doriți să utilizați un flipchart ca punct de plecare, apoi să faceți modificări și să salvați diferite versiuni ale acestuia pentru 
scopuri diferite.

1. Din File Menu, selectați  Save As...

2. Tastați numele flipchartului.

3. Faceți clic pe  Save. Fila Document arată acum noul nume.
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Acasă  > Referințe > Instrumente > Selectare

Selectare 

Ce? Selectarea și manipularea unuia sau mai multor obiecte de pe flipchart.

Unde? Tools > Select

Main Toolbox

Cum? Selectați instrumentul, apoi faceți clic pe articol sau trageți cursorul peste unul sau 
mai multe articole pentru a le selecta ca un grup.

Mai multe informații
Primii pași cu ActivInspire > Adăugare și manipulare forme  > Selectare formă 

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Formă

Formă 

Ce? Instrumentul Formă deschide accesul la instrumentele de forme, care conțin o 
gamă predefinită de forme și linii care pot fi adăugate pe pagina flipchart.

Unde? Main Toolbox

Main Menu > Insert > Shapes

Comandă rapidă? CTRL+Shift+S (WindowsTM & LinuxTM)

Cmd+Shift+S (Mac®)

Cum? Faceți clic pe instrumentul Formă pentru a afișa setul cu instrumentele de forme. În 
setul de instrumente, faceți clic pe forma (sau linia) specifică pe care doriți să o 
adăugați în pagină. Mutați cursorul pe pagina în locul în care doriți să desenați forma. 
Apoi faceți clic și trageți cursorul peste flipchart pentru a adăuga noul obiect de formă 
la dimensiunea necesară pe pagină.

Ce puteți personaliza? Outline Selectați culoarea conturului din Paleta de Culori sau 
schimbați culoarea conturului și alte proprietăți din 
secțiunea Outline a Navigatorului de Obiecte.

Fill Selectați culoarea de umplere din Paleta de Culori sau 
schimbați culoarea de umplere și alte proprietăți din 
secțiunea Fill a Navigatorului de Obiecte.

Unde puteți personaliza? Main Toolbox

Property Browser > Fill section

Mai multe informații
Primii pași cu ActivInspire > Adăugare și manipulare forme 

Modificarea proprietăților obiectelor

Referințe > Proprietăți > Proprietăți contur

Referințe > Proprietăți > Proprietăți umplere
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Acasă > Referințe > Instrumente > Recunoaștere Formă

Recunoaștere Formă

Ce? Desenați pe tablă și lăsați ActivInpire să transforme desenele în forme.

Unde? Tools > Shape Recognition

Dual Toolbox

Cum? Nu vă grăbiți, desenați încet și clar. Funcționează pentru toate tipurile de forme, dar 
este cel mai folositor pentru triunghiuri, pătrate și cercuri.

Ce puteți personaliza? În setul de Instrumente Principale:

Pen width Implicit = Linie subțire

Modificați grosimea Stiloului cu glisorul sau selectați o 
grosime implicită pentru a crea linii mai groase.

Color Implicit = Negru

Schimbați culoarea alegând alta din Paleta de Culori.

În secțiunea User Input din Settings:

Recognition
Timeout

Implicit = 5
Intervalul de timp în secunde înainte ca ActivInspire să 
înceapă să transforme scrisul în text.
Mutați glisorul pentru a modifica timpul, de la 0 la 5 
secunde.

Fill recognized
shapes

 Implicit. Formele recunoscute sunt automat umplute cu o 
altă culoare sau cu aceeași culoare cu a conturului (vedeți Fill 
mode mai jos).

 Formele recunoscute sunt afișate cu culoarea conturului, 
dar nu sunt umplute.

Fill mode Se activează doar dacă Fill recognized shapes este selectat.

Another
color

Implicit. Umple formele cu altă culoare decât conturul.

Same as the
outline

Umple formele cu aceeași culoare ca a conturului.

Another color Apăsați pentru a selecta o culoare de umplere din 
Paleta de culori.

Unde puteți personaliza? Main Toolbox

Settings > User Input

javascript:void(0);


Shape Recognition

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/shape_recognition.htm[1/21/2010 6:10:52 PM]

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >   Utilizare Recunoaștere Formă 

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă  > Referințe > Instrumente  > Fixare în grilă

Fixare în grilă

Ce? Aceasta este o opțiune de comutare care, atunci când este activată, forțează 
obiectele care sunt mutate pe pagină să se alinieze automat la cea mai apropiată 
parte a grilei.

Unde? Flipchart Page > Popup Menu > Snap To Grid

Cum? Această funcție se aplică numai dacă pagina are o grilă care a fost concepută 
pentru a permite fixarea să se producă. Când este setată, obiectele se vor alinia 
după grilă după ce le mutați. În majoritatea cazurilor, colțul din stânga jos al 
obiectul se va alinia la cea mai apropiată intersecție de pe grilă. La obiectele text, 
baza textului se va fixa în grilă.

Mai multe informații
Mai multe despre ActivInspire > Lucrul cu obiecte > Crearea și editarea grilelor 

Referințe  > Instrumente > Designer grile
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Acasă > Referințe > Instrumente > Corector ortografic

Corector ortografic

Ce? Verifică ortografia.

Unde? Tools > More Tools

Cum? La fel ca verificatorul ortografic din software-ul de procesare a textului de pe computer, 
vă permite să selectați o limbă și sugerează modificări pe care le puteți accepta, 
respinge, ignora, aplica individual sau în întregul flipchart. După ce ați terminat, faceți 
clic pe  Done.

Ce puteți personaliza?

Caseta de dialog 'Spell Checker' 

File > Settings > Spell checker
Unde puteți personaliza?

Puteți alege ce tip de cuvinte să fie ignorate, ce limbă să fie folosită și dacă 
să evidențieze sau nu cuvintele scrise greșit.

 Mai multe informații
Primii pași cu ActivInspire >  Adăugarea și formatarea textului > Corector ortografic

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Referințe > Instrumente > Blocare acces

Blocare acces (Teacher Lock) 

Ce?  


Unde? Main Menu > Tools > More Tools… > Teacher Lock

Cum? Faceți clic pe Instrumentul Blocare acces și introduceți parola (implicit 1234). 
Blocare acces devine activ.

Faceți clic din nou pe Instrumentul Blocare acces și introduceți parola pentru a 
dezactiva funcția.

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Blocare Acces
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Acasă > Referințe > Instrumente > Text

Text 

Ce? Vă permite să adăugați sau să editați obiecte text pe paginile flipchart.

Unde? Main Menu > Tools > Text

Main Toolbox

Comandă rapidă? CTRL+T (WindowsTM & LinuxTM)

Cmd+T (Mac®)

Cum? Selectați Instrumentul Text, apoi faceți clic pe pagina flipchart pentru a începe un nou 
obiect text sau faceți clic pe un obiect text existent pentru a reedita acel obiect.

În modul de editare text, instrumentele de formatare se deschid în partea de sus a 
ecranului, oferind o serie de funcții de editare a textului, inclusiv selectarea fontului, 
dimensiunea, atributele și simbolurile. Pentru a trimite textul din caseta de editare a 
textului pe pagină, faceți clic în afara casetei sau selectați un alt instrument.

Mai multe informații
Primii pași cu ActivInspire > Adăugarea și formatarea textului
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Acasă > Referințe > Instrumente > XY Origin

XY Origin 

Ce? Definiți un punct de rotație al paginii, astfel încât să puteți roti obiecte în jurul 
punctului de origine.

Unde? Tools > Maths Tools

Cum? Selectați XY Origin, folosiți Selectare pentru a muta punctul în poziția dorită și faceți 
clic sau apăsați. Rotiți obiecte în jurul punctului cu Punctul de rotire al obiectului.

Mai multe informații
Mai multe despre ActivInspire > Lucrul la tablă >  Utilizare Instrumente Matematice > 
Setare XY Origin
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Acasă > Primii pași cu ActivInspire

Primii pași cu ActivInspire 
Această secțiune conține informațiile de care aveți nevoie pentru a începe rapid lucrul cu ActivInspire:

Crearea primului flipchart

Scrierea pe flipchart

Adăugarea și formatarea textului

Adăugarea și manipularea formelor 

Copierea, lipirea și duplicarea obiectelor 

Ștergerea elementelor

Inserarea paginilor

Inserarea resurselor

Utilizarea grilelor

Crearea obiectelor

Crearea notițelor pe pagină

Salvarea unui flipchart

Printarea unui flipchart

Deschiderea unui flipchart

Trucuri pentru profesori
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Acasă > Mai multe despre ActivInspire > Lucrul cu resurse > Despre resurse

Despre resurse
ActivInspire include un set de resurse utile, în cadrul Bibliotecii 
de resurse.

Biblioteca de resurse conține multe tipuri de resurse, de 
exemplu activități, forme, obiecte, fundaluri, grile, fișiere 
grafice, fișiere video, sunete și șabloane.

Există două secțiuni principale în Biblioteca de resurse:

Utilizați Resursele mele (My Resources) 
pentru a stoca orice resurse proprii.

Utilizați Resursele partajate (Shared Resources)   
pentru a accesa resursele care au fost instalate în ActivInspire.  

Utilizați Navigatorul de Resurse       pentru a organiza 
folderele Bibliotecii de resurse și conținutul resurselor din foldere.

Puteți personaliza Biblioteca de resurse, adăugând propriile foldere și 
resurse și eliminându-le pe cele de care nu aveți nevoie.

Puteți, de asemenea, să stocați resursele în alte foldere de pe 
computer.

Puteți prelua resurse de oriunde de pe computer, iar dacă aveți acces 
la Internet, puteți descărca resurse de pe Promethean Planet.

Trebuie să vă înregistrați ca membru și să vă 
conectați, pentru a descărca resurse de la  
Promethean Planet.

Explorați!
Dacă nu ați explorat încă Biblioteca de resurse, faceți acest lucru acum.

1. Deschideți Navigatorul de Resurse.

În ActivInspire Primary, faceți clic pe butonul  Resource Locations de pe rola de film.

2. Răsfoiți folderele Resurse partajate. Faceți clic pe simbolurile + și - pentru a extinde sau a restrânge folderele afișate.

3. Căutați categorii care vă interesează în mod special și explorați-le.
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Acasă > Mai multe despre ActivInspire > Lucrul cu resurse > Adăugarea resurselor în flipchart

Adăugarea resurselor în flipchart
Procesul de adăugare a resurselor din Biblioteca de resurse într-un flipchart este întotdeauna același, indiferent de tipul de resursă.

Aici ne concentrăm pe șabloane, un tip de resursă care poate fi utilizat în mai multe moduri diferite:

Despre șabloane

Inserarea unui șablon

Despre șabloane
Unele șabloane sunt concepute pentru a fi utilizate așa cum sunt, în timp altele pot fi utilizate ca punct de plecare pentru propria 
lucrare. Șabloane sunt de ajutor atunci când trebuie să creați rapid o lecție.

Unele șabloane conțin Notițe de pagină cu sugestii despre modul de utilizare a șablonului. Modul în care utilizați șabloanele depinde 
în totalitate de dvs. 

Puteți vizita oricând Promethean Planet pentru mai multe șabloane

Inserarea unui șablon
Aici vă arătăm câteva modalități rapide de a insera un șablon în flipchart.

Drag & drop

1. În Navigatorul de Pagini, faceți clic pe miniatura 
paginii după care doriți să inserați un șablon de 
pagină.

2. Deschideți Navigatorul de Resurse și navigați în 
folderul Templates (Șabloane).

3. Selectați o categorie și vizualizați conținutul acesteia 
în Navigator. De exemplu, Templates > Dual 
mode. Această categorie conține șabloane pentru 
colaborarea cu două ActivPens.

4. Faceți clic pe șablonul ales și inserați-l pe pagina cu 
flipchart cu drag & drop.

Exemplul din dreapta arată un șablon pentru 
lucrul cu numere în modul Utilizator Dual.

Pentru idei despre cum să utilizați acest șablon, faceți clic pe pictograma Notițe.

După ce adăugați o pagină de activitate șablon, salvați flipchartul.

Apoi, după efectuarea activității, puteți utiliza pictograma Resetare pagină           pentru a restabili pagina activității la starea 
originală salvată.

Din Insert Meniu

1. În Navigatorul de Pagini, faceți clic pe miniatura paginii după care doriți să inserați un șablon de pagină.
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2. Din Insert Menu, selectați Page > și una dintre categoriile disponibile, de exemplu, Templates > Dual mode.
Sau 

3. Din Insert Menu, selectați Page > More Page Templates. Folderul Resurse partajate se deschide în Navigatorul de 
Resurse.

4. Faceți clic pe folderul Shared Page Templates și vedeți miniaturile șabloanelor disponibile.
5. Trageți șablonul ales pe pagina flipchart sau faceți dublu clic pe miniatură pentru a-l adăuga în pagină.
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Acasă > Mai multe despre ActivInspire > Lucrul cu resurse > Importul și exportul pachetelor de resurse

Importul și exportul pachetelor de resurse
Aici vă vom arăta cum să importați și să exportați pachete de resurse.

Importul pachetelor de resurse
Puteți importa pachete de resurse în Resursele mele sau Resurse partajate.

1. Din File Menu, selectați Import > Resource Pack To My Resources sau Resource Pack To Shared 
Resources. Se deschide o casetă de dialog.

2. Căutați unde se află pachetul de resurse.

3. Selectați pachetul de resurse și faceți clic pe  Open.

Exportul pachetelor de resurse
Orice folder de resurse poate deveni un pachet de resurse.

1. În Navigatorul de Resurse, selectați folderul de resurse pe care doriți să îl exportați.
2. Faceți clic dreapta și selectați Export to Resource Pack 

sau
Din meniul popup, selectați Export to Resource Pack. Se deschide o casetă de dialog.

3. Răsfoiți unde doriți să exportați folderul.
4. Tastați un nume pentru pachetul de resurse.
5. Faceți clic pe Save. Dacă există deja un pachet de resurse cu același nume în locația aleasă, ActivInspire vă solicită să:

Overwrite - suprascrieți pachetul de resurse existent

Extend - extindeți pachetul de resurse

Abort - renunțați la acțiune.
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Acasă > Mai multe despre ActivInspire > Lucrul cu resurse > Lucrul cu propriile materiale

Lucrul cu propriile materiale
Recunoaștem că materialele didactice vin în mai multe formate diferite. Fiecare are propriile sale moduri de a crea și de a 
prezenta informațiile și ActivInspire acceptă multe formate comune.

Puteți:

Insera imagini și text în flipcharturi din alte aplicații care rulează pe același computer, cu drag & drop.
Importa fișiere din alte aplicații, de exemplu SMART Notebook și Microsoft PowerPoint. Pentru detalii, vedeți Importul și exportul 
fișierelor.

Naviga la resursele dvs. existente cu Navigatorul de Resurse.

Deschide flipcharturi (.flp) create cu versiunile anterioare ale software-ului Promethean (Activstudio sau Activprimary versiunile 2 și 3.

Promethean, acesta salvează flipcharturile într-un format (.flipchart) care este incompatibil cu versiunile anterioare 
ale software-ului. Odată ce salvați aceste flipcharturi în ActivInspire, nu le puteți deschide în Activprimary sau 
Activstudio.
Dacă flipcharturile conțin acțiuni, verificați dacă acestea funcționează conform așteptărilor.
Dacă nu, vedeți Referințe > Acțiuni > Rezumatul diferențelor, unde descriem diferențele dintre acțiunile create în 
ActivInspire și versiunile anterioare ale software-ului Promethean.
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Acasă > Mai multe despre ActivInspire > Lucrul cu resurse > Publicarea flipcharturilor

Publicarea flipcharturilor
Utilizați Flipchart Publisher pentru a crea o versiune protejată a flipchartului dvs., interzicând anumite funcții de editare. Puteți 
apoi distribui flipchartul protejat care împiedică utilizatorul să copieze, să imprime sau să utilizeze Camera.    .

Salvați o copie a flipchartului într-un loc cunoscut înainte de a-l publica. Când este publicat, orice restricții ați setat 
pentru utilizatori, se vor aplica și dvs. 

Oferiți informații despre editor și limitați ceea ce pot face utilizatorii cu flipchartul. 

Două modalități de a deschide Flipchart Publisher 
Din setul de Instrumente Principale

1. Faceți clic pe pictograma Main Menu

2. Selectați Publish...

Din File Menu

1. Din File Menu selectați Publish... Se deschide caseta de dialog „Flipchart Publisher”.

2. Introduceți informațiile editorului, după caz. Aceste informații sunt pentru propria dvs. utilizare și nu vor fi vizibile 
pentru utilizatori.

3. Selectați sau deselectați restricțiile după caz, apoi efectuați una dintre următoarele acțiuni:

Faceți clic pe Cancel pentru a închide caseta de dialog fără a salva. 

Faceți clic pe Save Details pentru a salva alegerile fără publicare. 

Faceți clic pe Publish... pentru a vă implementa opțiunile și pentru a publica flipchartul în altă locație. 

Pentru mai multe informații, consultați Opțiunile Flipchart Publisher
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  Acasă > Mai multe despre ActivInspire > Lucrul cu obiecte > Adăugare imagini

Adăugare imagini
Aici enumerăm tipurile de imagini pe care le puteți utiliza și vă vom arăta cum să le adăugați:

Ce fișiere grafice puteți utiliza?

Adăugare imagine din Biblioteca de resurse

Adăugare imagine din altă parte

Ce fișiere grafice puteți utiliza?
Puteți adăuga imagini cu aceste extensii de fișier în flipcharturi, .jpg, .gif, .bmp, .tif, .png și .wmf (numai pentru computerele Windows).

Orice alte formate nu sunt acceptate.

Adăugare imagine din Biblioteca de resurse

1. Deschideți Navigatorul de Resurse

2. În panoul superior al Navigatorului, răsfoiți prin Resursele partajate până când găsiți categoria dorită.

3. Deschideți folderul și răsfoiți conținutul acestuia în panoul de jos al Navigatorului de Resurse.

4. Faceți dublu clic pe imagine sau inserați-o pe pagina cu flipchart, cu drag & drop.

Adăugare imagine din altă parte

1. Din Insert Menu, selectați Media. Se deschide caseta de dialog „Choose media to insert”.

2. Navigați la folderul care conține fișierul. Acesta poate fi pe computerul sau în rețea.

3. Faceți dublu clic pe fișier sau faceți clic pe fișier, apoi faceți clic pe Open.

De asemenea, puteți crea propriile capturi la tablă cu Camera.

Pentru mai multe informații, vedeți Utilizare Cameră.
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Acasă > Mai multe despre ActivInspire > Lucrul cu obiecte > Transformarea obiectelor

Transformarea obiectelor
Selectarea obiectelor

Faceți clic pentru a selecta obiecte când cursorul Object  arată că obiectul se află în raza de acțiune.

Faceți clic și trageți în diagonală - un dreptunghi gri indică zona de selecție. Orice obiect atins de zona de selecție este selectat. 
Faceți clic în Navigatorul de Proprietăți.

Mutarea obiectelor

Faceți clic și trageți obiectul sau trageți-l cu Punctul pentru mutarea liberă a obiectului pentru a nu sta direct în fața tablei

Redimensionarea obiectelor 

Faceți clic și trageți Punctele de redimensionare pentru a redimensiona obiectele.

Utilizați punctul din dreapta jos pentru a transforma obiecte cu o scalare uniformă. Asta înseamnă păstrarea proporțiilor originale. 
Redimensionarea cu alte puncte va schimba proporțiile și va produce un obiect distorsionat.

Dacă distorsionați un obiect din greșeală, faceți clic dreapta pe obiect și afișați Navigatorul de Proprietăți. Scala Factor X și Y arată 
scalarea precisă. Setați-le la fel pentru scalarea proporțională. Setați ambele la 1 pentru a reveni la dimensiunile originale.

Meniul popup Editare obiect are instrumente de transformare convenabile (de mai jos) care pot fi adăugate ca parte a unui profil.
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Increase / Decrease Object Size: dimensiunea obiectului este mărită sau scăzută cu 10%. 

Original Size: obiectul este restabilit la dimensiunea originală.

Best Fit to Width: dacă lățimea unui obiect este distorsionată, înălțimea crește proporțional. 

Best Fit to Height: dacă înălțimea unui obiect este distorsionată, lățimea crește proporțional. 

Best Fit to Page: dimensiunea obiectului este mărită proporțional la maximul pentru pagină. 

Mirror in X / Y Axis: obiectul este reflectat de-a lungul axei X sau Y.

Flip in X / Y Axis: obiectul este reflectat și duplicat de-a lungul axei X sau Y.

Opțiunile de aliniere (Align) sunt afișate grafic în meniu.
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Acasă > Mai multe despre ActivInspire > Importul și exportul fișierelor > Importul fișierelor

Importul fișierelor
În această secțiune, vă vom arăta cum să importați fișiere care au fost create cu alte programe.

Puteți importa următoarele tipuri de fișiere:

Fișiere PowerPoint® ca obiecte sau ca imagini

Fișiere XML ExamView®

Fișiere IMS® QTI XML

Fișiere SMART® Notebook

Articole din galeria SMART®

Pentru detalii despre cum să importați pachete de resurse, consultați  Importul și exportul pachetelor de resurse..

Importul fișierelor din PowerPoint®
Puteți alege să importați fișierele PowerPoint:

Ca obiecte, ceea ce înseamnă că elementele din prezentarea PowerPoint devin obiecte individuale pe fiecare pagină a 
flipchartului, astfel încât să le puteți edita, de exemplu, cu Instrumentul de Text.

Ca imagini, ceea ce înseamnă că fiecare diapozitiv al prezentării PowerPoint este importat ca o singură imagine care umple o 
pagină flipchart întreagă.

Importul fișierelor PowerPoint ca obiecte

1. În Panoul de Control, faceți clic pe
Import from Powerpoint... sau din File
Menu, selectați Import > Powerpoint®
as objects. Se deschide caseta de dialog
„Select a Powerpoint® File”

2. Navigați la folderul care conține fișierul pe
care doriți să îl importați și selectați-l.

3. Faceți clic pe Open. O bară de progres
indică modul în care importul progresează
și se închide la finalizare.

ActivInspire importă fișierul selectat într-un 
flipchart nou „Untitled”.

După finalizarea importului, puteți selecta și 
manipula obiectele importate ca orice alte 
obiecte.

Importul fișierelor PowerPoint ca imagini

Din File Menu, selectați Import > Powerpoint® as images.

Procesul de import este exact același ca și pentru obiecte, de mai sus, doar rezultatul este diferit. Fiecare diapozitiv PowerPoint 
este importat ca o singură imagine pe fiecare pagină flipchart.
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Importul altor tipuri de fișiere

1.Din File Menu, selectați una dintre următoarele:

Import > ExamView® XML 
file sau

Import > IMS® QTI XML file 
sau

Import > SMART® Notebook 
File v8, v9, v9.5, v10 sau

Import > SMART® Gallery 
File.

2. O casetă de dialog pentru operațiunea de 
import aleasă se deschide.

3. Navigați la folderul care conține fișierul pe 
care doriți să îl importați și selectați-l.

4. Faceți clic pe Open. O bară de progres 
indică modul în care importul progresează 
și se închide la finalizare.

ActivInspire importă fișierul selectat într-un 
fișier flipchart cu același nume ca fișierul 
original. De exemplu, „Question Types Test”, 
așa cum este prezentat în partea dreaptă.

După finalizarea importului, puteți selecta și 
manipula obiectele importate cum orice alte 
obiecte.
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Acasă > Mai multe despre ActivInspire > Importul și exportul fișierelor > Exportul fișierelor

Exportul fișierelor
Din ActivInspire puteți exporta: 

Flipcharturile în format PDF. Pentru detalii, vedeți Printarea unui flipchart. 

O pagină flipchart ca fișier grafic.

Rezultatele votului în Microsoft Excel®. 

Exportul unei pagini ca fișier grafic 
1. Faceți clic dreapta pe o parte goală a paginii pe care doriți să o exportați.
2. Din meniu selectați Export Page. Se deschide caseta de dialog „Export Page”.
3. Navigați la folderul în care doriți să salvați fișierul.
4. Selectați un tip de fișier (Bitmap, JPEG, PNG sau TIF).
5. Tastați un nume de fișier.
6. Faceți clic pe Save.
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Acasă > Referințe > Setări > Ceas

Ceas

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Analog

Clock numbers  Implicit = Afișează numerele pe ecranul ceasului.

Afișează blocuri colorate pe ecranul ceasului.

Second hand Implicit = Afișează a doua limbă a ceasului.

Afișează doar limbile pentru oră și minute.

Digital

24 Hour Afișează ceas cu afișaj 24 de ore.

Implicit = Afișează ceas cu afișaj 12 ore.

Seconds  Implicit = Afișează numărătoarea secundelor.

Afișează doar ora și minutele.

Show AM/PM Afișează ceas cu afișaj 12 ore cu AM sau PM expuse.

Implicit = Nu afișa AM/PM.

Show date Implicit = Afișează data curentă sub timp.

Afișează doar timpul.
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Acasă > Referințe > Setări > Modul Design

Modul Design

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Allow locked objects to be edited  Implicit = Elimină toate proprietățile de blocare pentru a 
permite mutarea liberă și editarea obiectelor.

Nu permite.

Show hidden objects Implicit = Face toate obiectele vizibile.

Nu arată obiectele ascunse.

Highlight actions Implicit = Evidențiază acțiunile cu un pătrat roșu în Modul 
Design.

Nu evidențiază acțiunile.

Disable Actions and Drag a Copy   Implicit = Oprește orice acțiune și dezactivează opțiunea de 
duplicare a unui obiect prin apăsare și glisare în Modul Design.

 Menține acțiunile și opțiunea de duplicare activată.

Disable object restrictions   Implicit = Oprește orice restricție de obiect în Modul 
Design ca să puteți muta liber obiectele.

Păstrează active restricțiile de obiecte.

Disable blocker objects  Implicit = Oprește setările restricției de blocare a obiectelor

Nu dezactivează blocarea obiectelor.

Disable grid snapping   Implicit = Elimină proprietățile de fixare în grilă setate pentru 
obiecte pentru a permite mișcarea liberă a obiectelor.

Păstrează proprietățile de fixare în grilă.

Disable desktop interaction Implicit = Dezactivează adnotarea pe desktop și instrumentele 
desktop.

Nu dezactivează interacțiunea desktop.

Show Design Mode Tooltip Hints Implicit = Arată indiciile.

Nu arată indiciile.
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 Acasă > Referințe > Setări > Efecte

Efecte

 Pentru detalii despre accesarea Setărilor, vedeți Choosing application settings.

Setări Opțiuni

Reflector

Border width Crește sau scade lățimea marginii din jurul zonei 
reflectorului. Intervalul este de la 0 la 20 pixeli.

Implicit = 15

Border color Culoarea marginii din jurul reflectorului.

Implicit = albastru

Background color Culoarea zonei din afara reflectorului.

Implicit = negru

Translucent border  Implicit = Face marginea reflectorului translucidă.

Conferă marginii reflectorului o culoare solidă.

Translucent screen   Face ecranul reflectorului (zona întunecată care acoperă 
flipchartul sau fereastra desktop) translucidă.

Implicit = Face ecranul reflectorului opac.

Right click captures image   Implicit = Lipește o imagine a zonei reflectorului pe pagina 
flipchart curentă când faceți clic dreapta în timp ce reflectorul 
este activat.

Clic dreapta nu capturează zona reflectorului.

Dezvăluitor

Color Culoarea jaluzelei Dezvăluitorului.

Implicit = negru

Animation Speed Viteza cu care obiectele ascunse vor fi dezvăluite când folosiți 
dispozitivul ActionRemote. Intervalul este de la 1 la 20 secunde.

Implicit = 15
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Acasă > Referințe > Setări > Flipchart

Flipchart

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Create desktop flipchart on launch Creează un flipchart desktop când porniți ActivInspire

Implicit = Nu creează un flipchart dektop la pornire.

World color Culoarea fundalului flipchartului desktop, în spatele paginii 
flipchart.

Implicit = albastru

Default page scale Scalarea implicită a paginii când creați un flipchart nou sau 
deschideți un flipchart existent:

Implicit = Best Fit 

Width Fit (potrivire în lățime)

Height Fit (potrivire în înălțime)

25%

50%

100%

150%

200%

400%

800%

Original Scale (scalare originală)

Trebuie să reporniți ActivInspire pentru a activa setarea 
după modificări.

Default page size Dimensiunea implicită a paginii când creați un flipchart nou sau 
deschideți un flipchart existent:

Screen Size (dimensiunea ecranului)

Implicit = 1024 * 768 

1152 * 864

1280 * 1024 

Custom (=personalizată)

Default Page color Activă doar dacă setați fundalul implicit să fie o culoare.

Implicit = alb

Show flipchart summary when saving   Deschide o fereastră pentru a introduce informații 
despre flipchart când salvați.
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Implicit = Închide fără a arăta rezumatul flipchartului.
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Acasă > Referințe > Setări > Obiecte Flipchart

Obiecte Flipchart

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

High-quality rendering   Implicit = Îmbunătățește rezoluția obiectelor. Poate face 
computerele mai vechi să funcționeze mai greu.

  Desenează obiecte cu rezoluție mai scăzută. Poate face 
marginile să arate inegale.

High-quality rendering when annotating   Îmbunătățește aspectul marginilor liniilor și obiectelor, 
inclusiv adnotările cu mâna liberă. Poate face computerele 
mai vechi să funcționeze mai greu.

 Implicit = Desenează adnotări cu rezoluție mai scăzută.

Container center tolerance Dacă folosiți containere cu opțiunea de potrivire a centrelor, 
puteți specifica cât de precisă trebuie să fie alinierea centrelor 
obiectelor pentru a fi conținute. Cu cât este mai mic numărul de 
pixeli, cu atât este mai mare acuratețea necesară în alinierea 
centrelor obiectelor.

Implicit = 10

Show pickup handles when dragging objects from Library   Implicit = Activează Instrumentul de Selectare și afișează 
Punctele de mutare ale elementelor trase din Biblioteca de resurse.

Nu activează Instrumentul de Selectare. 

Show pickup rectangle  Implicit = Afișează un dreptunghi în jurul obiectelor selectate.

Nu afișează un dreptunghi.

Add Timestamp to all new pages created Marchează data și timpul pe toate paginile noi flipchart.

Implicit = Nu adaugă o marcă temporală.

Automatic annotation grouping Grupează automat adnotările ca un singur obiect.

Tratează adnotările ca obiecte individuale.

Biblioteca de resurse

Default resource library Locația bibliotecii de resurse care este afișată în 
Navigatorul de Resurse.

Implicit = Shared Resources

My Resources

Alta

Resource items retain transparency      Implicit = Obiectele transparente își mențin transparența 
originală când sunt trase pe o pagină flipchart din biblioteca.

javascript:void(0);


Flipchart Objects

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/settings_flipchart_objects.htm[1/21/2010 6:11:24 PM]

de resurse.

 Obiectele transparente nu își mențin transparența originală.

View Mode Structura conținutului din biblioteca de resurse.

Implicit = listă

Grid (grilă)

Thumbnail Size Dimensiunea miniaturilor afișate în Biblioteca de resurse.
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Acasă > Referințe > Setări > Limbă

Limbă

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Application language Afișează ActivInspire în limba implicită a computerului. Puteți 
alege o altă limbă din meniul drop-down, dacă computerul 
suportă mai multe setări regionale.
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 Acasă > Referințe > Setări > Sistem de Răspuns din partea elevilor

Sistem de Răspuns din partea Elevilor

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Sondaj Rapid (ExpressPoll)

Question timeout Timpul alocat pentru a răspunde la o întrebare. Setarea unui timp 
implicit restricționează timpul disponibil pentru vot.

Dacă nu setați un timp implicit, votul va continua până când toți 
utilizatorii vor răspunde sau până apăsați pe Stop Vote.

Implicit = 0

Apply timeout to prepared questions Aplică intervalul de timp de mai sus pentru întrebările pregătite.

Implicit =  Nu aplică intervalul de timp

Append question to current flipchart   Adaugă întrebarea la sfârșitul flipchartului curent, pe o pagină 
nouă.

Implicit = Nu adaugă întrebarea.

ActiVote

Allow users to modify their response   Permite utilizatorilor să își modifice întrebările în intervalul de timp 
setat. La expirarea timpului, răspunsurile ulterioare sunt ignorate.

Implicit = Nu permite utilizatorilor să își modifice răspunsul.

Răspunsuri

Show results after vote  Implicit = Afișează rezultatele pe tablă la încheierea votului.

 Nu afișează rezultatele.

Automatic page advance  Trece automat la pagina următoare după înregistrarea voturilor.

 Implicit = Nu trece automat la pagina următoare.

Anonymous mode  Afișează anonim rezultatele votului.

 Implicit = Afișează rezultatele pe dispozitiv sau pe nume.

javascript:void(0);


Learner Response System

file:///C|/Program%20Files/Activ%20Software/Inspire/help/en_US/settings_learner_response.htm[1/21/2010 6:11:27 PM]



Multimedia
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Acasă > Referințe > Setări > Multimedia

Multimedia

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Show sound controller   Implicit = Arată Consola de sunet când este redat un 
fișier de sunet; anulează alte setări dinamice.

Ascunde Consola de sunet în timpul redării.

Show controls for flash   Implicit = Arată comenzile când sunt redate fișiere 
Flash®. Anulează setările dinamice.

Nu arată comenzile pentru fișiere Flash®.

Show frame capture button   Implicit = Arată butonul de captură a cadrelor pentru 
imagini statice din video-uri și fișiere Flash.

Nu arată butonul de captură a cadrelor.

Force overlay mode for flash  Vă permite să adnotați peste fișierele Flash.

 Implicit = Nu vă permite să adnotați peste fișierele Flash.
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Acasă > Referințe > Setări > Setări online

Setări online

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Web Links

Home URL Website-ul care este afișat când deschideți browserul de 
Internet din ActivInspire.

Web update

URL Website-ul cu care comunică ActivInspire când faceți clic pe 
Check for Updates din Panoul de Control.

Proxy settings

Proxy server name Numele și numărul portului HTTP a serverului proxy.
Numărul implicit pentru portul HTTP = 0
Administratorul de sistem sau furnizorul de servicii vă va da 
aceste informații.

HTTP port number

Username Utilizatorul și parola necesare pentru a accesa serverul, nu 
pentru a accesa Biblioteca de resurse online.

Administratorul de sistem sau furnizorul de servicii vă va da 
aceste informații.

Password
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Acasă > Referințe > Setări > Profiluri și resurse

Profiluri și resurse

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

ActivInspire stochează profiluri, șabloane și alte fișiere în folderele implicite afișate în tabelul următor. Puteți copia sau muta fișierele 
în alte foldere dacă doriți, și modifica setarea corespunzătoare, astfel încât ActivInspire să poată accesa fișierele în noua lor locație.

Când schimbați locațiile implicite din „Profile and Resources”, pur și simplu îi indicați lui ActivInspire să caute 
fișiere într-o locație nouă. Fișierele în sine nu se mișcă. Copiați fișierele în noua locație înainte să schimbați 
locația în ActivInspire. Pentru informații despre copierea sau mutarea fișierelor, consultați documentația 
sistemului de operare.

Setări Opțiuni

Use default profile path  Implicit = Accesează profilurile în locația arătată mai jos.

 Accesează profilurile în altă locație.

Profile stored in

Windows My Resources\My Profiles

Mac
My Resources/My Profiles

Linux

Use default 'My Resources'
path

 Implicit = Accesează My Resources în locația arătată mai jos.

 Accesează My Resources în altă locație.

My resources files in

Windows XP Documents and Settings\username\My Documents\Activ Software\ActivInspire\My
Resources

Windows Vista Users\username\Document\ Activ Software\ActivInspire\My Resources

Mac /Users/username/Documents/Activ Software/ActivInspire

Linux /home/username/Documents/Activ Software/ActivInspire

Use default 'Shared Resources'
path

 Implicit = Accesează Shared Resources în locația arătată mai jos.

 Accesează Shared Resources în altă locație.

Shared resources files in

Windows XP Documents and Settings\All Users\Documents\Activ Software\ActivInspire

Windows Vista \Users\Public\Documents\ Activ Software\ActivInspire
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Mac /Users/shared/Promethean/Activ Software/ActivInspire

Linux  /var/Promethean/Inspire/Shared Resources

Use default page template path  Implicit = Accesează șabloanele de pagină în locația arătată mai jos.

 Accesează șabloanele de pagină în altă locație.

Page template files in

Windows Shared Resources\Activities and templates

Mac
Shared Resources/ Activities and templates

Linux

Use default question page path  Implicit = Accesează paginile de întrebări în locația arătată mai jos.  

 Accesează paginile de întrebări în altă locație.

Question page files in

Windows Shared Resources\FlipchartPages\Activities and templates\Templates (learner
response)\

Mac
Shared Resources/FlipchartPages/Templates (learner response)/

Linux
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Acasă > Referințe > Setări > Corector ortografic

Corector ortografic

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Highlight misspelled words   Evidențiază cuvintele scrise greșit imediat ce au fost 
adăugate pe flipchart.

 Implicit = Nu evidențiază

Ignore capitalized words   Ignoră cuvintele cu inițială majusculă în timpul verificării 
ortografice.

Implicit = Nu ignoră.

Ignore words in UPPERCASE Ignoră cuvintele scrise cu majuscule în timpul verificării 
ortografice. 
Implicit = Nu ignoră.

Ignore words that contain numbers Ignoră cuvintele care conțin numere în timpul verificării 
ortografice.
Implicit = Nu ignoră.

Ignore words in mixed case   Ignoră cuvintele care conțin și majuscule și minuscule în 
timpul verificării ortografice..

Implicit = Nu ignoră.

Ignore internet addresses Ignoră adresele de Internet în timpul verificării ortografice.

Implicit = Nu ignoră.

Report repeated words   Implicit = Anunță cuvintele care se repetă în timpul verificării 
ortografice.

Nu raportează cuvintele care se repetă.

Edit user dictionary Deschide dicționarul utilizatorului pentru limba selectată 
curent (vedeți mai jos) într-un editor de text.

Dictionary language Limba folosită pentru verificare ortografică, selectată din 
meniul drop-down.

Implicit = Limba din sistemul de operare al computerului.
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 Acasă > Referințe > Setări > Input utilizator

Input utilizator

 Pentru detalii despre accesarea Setărilor, vedeți Alegerea setărilor aplicațiilor.

Setări Opțiuni

Tastatură

Use keyboard supplied with operating system Folosește tastatura furnizată de sistemul de operare.

Implicit = Folosește tastatura flotantă furnizată de 
ActivInspire.

Use keyboard specified by user Vă permite să selectați o altă tastatură.

Automatically show keyboard with text objects Afișează tastatura flotantă când editați obiecte de text.

Implicit = Nu afișează tastatura.

Automatically show keyboard when saving files   Afișează tastatura când salvați un flipchart. Aceasta este 
folositoare când lucrați la tablă și vreți să tastați rapid un nume 
de fișier fără să vă întoarceți la computer. 

Implicit = Nu afișează tastatura.

Instrumente de recunoaștere

Recognition Timeout (seconds) Interval de timp pentru recunoașterea scrisului de mână și a 
formelor.
Interval = 1- 5 secunde
Implicit = 5

Fill recognized shapes   Umple formele cu culoare când sunt 
recunoscute.

Implicit = Nu umple formele recunoscute.

Fill mode Activ doar dacă „Fill recognized shape” este selectat. 
Selectați din meniul drop-down:

Same as outline (aceași culoare cu conturul)

Another color (altă culoare) (vedeți mai jos)

Another color Activ doar dacă „Another color” este selectat. Faceți clic pe 
casetă pentru a alege o culoare.

Handwriting Recognition Language Limba folosită pentru recunoașterea scrisului de mână, 
selectată din meniul drop-down.

Implicit = Limba sistemului de operare al computerului.
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Acasă > Referințe > Proprietăți > Proprietăți de identificare

Proprietăți de identificare
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Name ActivInspire alocă nume implicite pentru obiectele flipchart, de exemplu, Shape 1, Shape 2.

Puteți selecta și schimba numele implicit.

Keywords Unul sau mai multe cuvinte care identifică obiectul.

Două modalități de a introduce cuvinte cheie:

Faceți clic pe caseta Keywords și începeți să tastați. Separați cuvintele cheie 
individuale cu un spațiu.

Faceți clic pe pictograma Editor de cuvinte cheie [...], faceți clic pe Add și începeți 
să tastați. Folosiți Editor de cuvinte cheie pentru a adăuga, muta și elimina 
cuvinte cheie.

Utilizați cuvinte cheie cu containere. Dacă setați un container astfel încât să poată 
conține un obiect cu un anumit cuvânt cheie, de exemplu, „animal”, orice obiect cu cuvântul 
cheie „animal” poate să fie conținut de acel container.

Description Se aplică numai paginilor.

Vă permite să includeți instrucțiuni sau comentarii despre o anumită pagină în zona de 
descriere. Aceasta poate fi utilizată pentru a descrie modul în care a fost configurată pagina, 
de exemplu, dacă partajați pagini cu colegi profesori și ați creat câteva proprietăți complexe 
ale obiectelor sau acțiunilor.

Question
Tag

O întrebare cu mai multe răspunsuri produsă cu Expertul în întrebări sau ExpressPoll are 
trei tipuri de obiecte text:

Cu Question

Option

Etichete Label
Numerele etichetelor vă permit să vedeți perechile de răspunsuri / opțiuni - acest lucru vă 
poate fi util atunci când editați și reformatați textul sau mutați răspunsurile.

Dacă ați nominalizat un răspuns corect cu Expertul în întrebări, aceste informații sunt 
conținute în cadrul etichetei „Label”. Când răspunsul corespunzător este returnat de 
utilizatori, este evidențiat verde în afișarea rezultatelor. Nominalizați un nou răspuns corect 
plasându-l lângă obiectul cu numărul de „Label” corespunzător.

  Nu puteți genera o întrebare și începe un vot aplicând etichete textului introdus în 
afara Expertului pentru întrebări sau ExpressPoll.

None Implicit

Question Alocat la textul întrebării.

Option 1 Asociat cu text etichetat Label 1 (afișat ca răspuns A sau 1)

Option 2 Asociat cu text etichetat Label 2 (afișat ca răspuns A sau 2)
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Option 3 Asociat cu text etichetat Label 3 (afișat ca răspuns A sau 3)

Option 4 Asociat cu text etichetat Label 4 (afișat ca răspuns A sau 4)

Option 5 Asociat cu text etichetat Label 5 (afișat ca răspuns A sau 5)

Option 6 Asociat cu text etichetat Label 6 (afișat ca răspuns A sau 6)

Label 1 Numerele opțiunilor și ale etichetelor trebuie să se potrivească, pentru ca răspunsurile să fie 
corect interpretate.

Dacă mutați o opțiune sau o etichetă, veți observa schimbările.

Label 2

Label 3

Label 4

Label 5

Label 6
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Acasă > Referințe  > Proprietăți > Proprietăți container

Proprietăți container
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Can Contain Nothing Implicit

Nu este aplicată nicio setare de container

Anything Orice obiect plasat deasupra este recunoscut.

Specific Object Alegeți un obiect specific pentru a fi recunoscut 
de container.

Keywords Containerul recunoaște orice resursă care are 
cuvintele cheie pe care le specificați.

Contain
Object

Activ doar dacă “Can Contain” este setat la 
“Specific Object” (vedeți mai sus).

Selectați obiectul din caseta de dialog “Select 
Object”.

Contain
Words

Activ doar dacă “Can Contain” este setat la 
“Keywords” (vedeți mai sus).
Tastați cuvintele cheie pe care le poate recunoaște 
containerul.

Contain Rule

Centers Must Match Centrul conținutului trebuie să fie plasat pe centrul 
containerului pentru a recunoaște conținutul. Folositor 
când conținutul este mai mare decât containerul.

Completely Contained Conținutul trebuie să se potrivească în interiorul 
containerului.

Reward
Sound

False Implicit.

Setați pe “True” să se redea un sunet când un 
obiect este conținut corect.

Reward
Sound
Location

Activ doar dacă “Reward Sound” este setat la 
“True” (vedeți mai sus).

Se deschide caseta de dialog “Select a sound” 
pentru a putea căuta și selecta un sunet.

Return if not
Contained

False Implicit

Restabilește obiectul la poziția sa inițială pe 
pagina flipchart dacă este setat la “True”.
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Acasă > Referințe > Proprietăți > Proprietăți restricții

Proprietăți restricții
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Can Block False Implicit

True Obiectul se poate bloca.

Can Snap False Implicit

True Obiectul se poate fixa.

Snap Point x Punct pe axa X la care obiectul se poate fixa.

Snap Point y Punct pe axa Y la care obiectul se poate fixa.

Snap To Center Implicit. Obiectul se fixează de mijloc.

Other Place Obiectul se fixează de alt loc pe care îl puteți defini.

Other Object Obiectul se poate fixa de alt obiect.

First Text Line Obiectul se poate fixa de prima linie de text.

Specific Point Obiectul se poate fixa de un punct specific.

Top Left Obiectul se poate fixa de partea din stânga sus.

Top Obiectul se poate fixa de partea de sus.

Top Right Obiectul se poate fixa de partea din dreapta sus.

Left Obiectul se poate fixa de partea din stânga.

Right Obiectul se poate fixa de partea din dreapta.

Bottom Left Obiectul se poate fixa de partea din stânga jos.

Bottom Obiectul se poate fixa de partea de jos

Bottom Right Obiectul se poate fixa de partea de dreapta jos.

Can Move Freely Implicit. Obiectul poate fi mutat oriunde pe pagina flipchart.

Vertically Obiectul se poate mișca doar vertical.

Horizontally Obiectul se poate mișca doar orizontal.
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Along path Obiectul se poate mișca doar de-a lungul traseului stabilit.

No Obiectul nu se poate mișca.

Move Path Activ doar dacă “Can Move” este setat la “Along path” (vedeți mai sus).

Selectați traseul din caseta de dialog “Select Object”

Can Size Freely Implicit

None Obiectul nu poate fi redimensionat.
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Acasă > Referințe > Meniuri și meniuri popup

Meniuri și meniuri popup
Această secțiune enumeră și descrie succint instrumentele și funcțiile disponibile în fiecare Meniu și Meniu Popup din 
ActivInspire:

Bara de meniu

Meniuri popup

Puncte de acțiuni și redimensionare
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Acasă > Referințe > Instrumente > Sondaj Rapid

Sondaj Rapid (ExpressPoll)

Ce? Puneți elevilor o întrebare rapidă și afișați rezultatele instantaneu.

Unde? Tools > ExpressPoll

Main Toolbox

Desktop Tools

Comandă rapidă? F3

Cum? Selectați un tip de întrebare și opțiuni din Roata Minunilor de votare.

Ce puteți personaliza? Question timeout Specifică timpul disponibil pentru răspuns.

Apply timeout to prepared
questions

Comutator

Append question to current
flipchart

Comutator

Unde puteți personaliza? Settings > Learner Response System

Mai multe informații
Folosirea Sistemelor de Răspuns pentru Elevi

Setări > Sistem de Răspuns

Lucrul cu acțiuni

Acțiuni > Acțiuni de votare
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  Acasă > Referințe > Acțiuni > Rezumatul diferențelor

Informații importante pentru utilizatorii Activstudio și 
Activprimary
Rezumatul diferențelor
ActivInspire a fost optimizat pentru a funcționa pe computerele Windows ™, Mac® și Linux ™. Flipcharturile produse cu Activstudio și 
Activprimary 3.n ar trebui să se deschidă în ActivInspire, pe oricare dintre aceste platforme. În plus, ActivInspire este integrat pentru a 
suporta dispozitivele care anterior aveau nevoie de software separat.
Cu toate acestea, ca urmare a optimizării, unele obiecte flipchart cu acțiuni asociate anterior își pot pierde acțiunea atunci când 
deschideți flipchartul în ActivInspire.
Dacă se întâmplă acest lucru, puteți atribui o altă acțiune adecvată sau șterge obiectul.

Următoarele secțiuni listează diferențele dintre acțiunile din Activstudio și Activprimary 3.n și ActivInspire:

Incompatibile 

Înlocuite

Compatibile cu diferențe

Incompatibile
Aceste acțiuni nu funcționează în ActivInspire:

Export Page Fraction Creator Powerpoint Convertor Link Library

Power Tools Export to ppt Export to ppt obj Export to doc

Export to pdf Export to html Export to swf Export Results to Text

Export Wizard Activity Wizard Activcataloger Annotation Upgrader

Open My Notes and Pointers Open Shared Notes and
Pointers

Open Other Notes and
Pointers

Export to QuickTime (Mac)

Export to picture slides
(Mac)

Export to Applescript (Mac) Activmarker Clipboard Tickertape

Open My Tickertapes Open Shared Tickertapes Open Other Tickertapes Resource Library Small
Thumbnails

Resource Library Large
Thumbnails

Page Select Small Page Select Medium Page Select Large

Înlocuite
Aceste acțiuni nu funcționează în ActivInspire pentru că au fost înlocuite cu alte acțiuni. Vă recomandăm să citiți notițele și să salvați 
flipchartul în noul format .flipchart cu File > Save As.... Apoi încercați să adăugați alte acțiuni și să le încercați înainte de a folosi 
flipchartul în clasă. Vedeți coloana Notițe pentru sugestii.

Acțiune Notiță
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Recognition Toolbox Alegeți dintre Recunoaștere scris de mână (Handwriting Recognition)
și Recunoaștere formă (Shape Recognition). 

Flipchart Recorder
Folosiți Înregistrare ecran (Screen Recorder) 

Update Thumbnails Miniaturile sunt actualizate automat în Navigator.

Embed File Actions Alegeți dintre Inserare legătură fișier (Insert Link to File) și Inserare media din fișier 
(Insert Media from File)

Resource Manager În ActivInspire, administrați resursele cu Navigatorul de Resurse.

Keyword Editor În ActivInspire, accesați Editorul de cuvinte cheie (Keyword Editor) din Navigatorul de 
Proprietăți.

Flipchart Builder În ActivInspire, construiți flipcharturi cu Navigatorul de Pagini și Navigatorul de Resurse.

Launch/Quit Application (Mac) Folosiți Inserare legătură fișier (Insert Link to File). Puteți lansa o aplicație, dar nu 
puteți ieși.

Compatibile cu diferențe
Aceste acțiuni funcționează, dar se pot comporta diferit în ActivInspire. Vă recomandăm să citiți notițele și să salvați flipchartul în 
noul format .flipchart cu File > Save As...,apoi să încercați să testați acțiunile înainte de a folosi flipchartul în clasă. Vedeți coloana 
de Notițe pentru o descriere succintă a diferențelor.

Acțiune Activstudio 
& Activprimary

Acțiune ActivInspire Notițe

Deconstruct Text Extract Text Nume nou, aceeași funcționalitate.

Start/Stop ActiVote
Start Flipchart Vote Activează Start Flipchart Vote    dacă există o 

întrebare pe pagina flipchart curentă.

ActiVote Results Voting Browser Afișează rezultatele votului în Navigatorul de Votare.

ActiVote Session Voting Browser Deschide Navigatorul de Votare (Voting Browser)

și afișează informații despre sesiunea curentă.

Various Show Clock actions Clock Afișează Ceasul 
în funcție de setările din fila „Edit Profile Settings”.

ActiVote Question Settings Question on Current Page Lansează Expertul în întrebări (Insert Question 
Wizard). După ce completați informațiile, întrebarea 
este afișată pe pagina curentă.

Recorder Menu Screen Recorder Afișează Înregistrare ecran
Nu există posibilitatea înregistrării unei singure zone 
din ecran în ActivInspire.Area Screen Recorder

Straight Line

Horizontal Line

Vertical Line

Shape
Activează Instrumentul Formă (Shape).
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Square Tool

Circle Tool

Semi Arc

Rectangle

Ellipse

Corner Arc

Callout

Arrow

Point to Point

Slate Control

Device Register

ActiVote Users

Device Registration
Începe Înregistrarea dispozitivelor 

Individual Resource Folder
Actions

Resource Library Deschide Resursele partajate 

Question Master Question Wizard Lansează Expertul în întrebări (Insert Question 
Wizard). După ce completați informațiile, întrebarea 
este afișată pe pagina curentă..

Cut Page Cut Page
Taie, copiază sau lipește obiectul desemnat țintă.
Dacă nu există un obiect desemnat țintă, aplică 
acțiunea obiectului selectat curent. Dacă nu este 
selectat niciun obiect, aplică acțiunea obiectului de 
acțiune.

Copy Annotation Copy

Paste Annotation Paste

Show Page Selector Page Browser
Deschide Navigatorul de Pagini 

Edit Text Text
Pornește Instrumentul Text.

Set Grid (Mac) Grid Designer
Deschide Designerul de grile

Set Page rColor (Mac) Set Background Deschide caseta de dialog „Set Background”, unde 
puteți seta o culoare sau o imagine de fundal.

Slate XR (Mac)

Slate IR (Mac)

Device Registration
Începe Înregistrarea dispozitivelor 

Print to pdf (Mac) Print Dialogue Box Deschide caseta de dialog „Print”, unde puteți 
selecta opțiuni de printare PDF.

Înapoi 

În ActivInspire, următoarele activități deschid caseta de dialog „Edit Profiles”. Vedeți coloana Notițe pentru detalii despre ce să faceți 
în continuare.

Acțiune Activstudio 
& Activprimary

Notițe
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Vote Settings Faceți clic pe fila „Settings” și selectați Learner Response Systems.

Toolstore Faceți clic pe fila „Command” și adăugați sau eliminați instrumente în/din 
Instrumentele Principale sau Punctele de acțiuni.

Open Toolbox Layout Faceți clic pe fila „Layout”.

Small Toolbox

Medium Toolbox

Large Toolbox

Vertical Orientation

Right Orientation

Left Orientation

8, 16, 24 Toolbox Colors

Faceți clic pe fila „Layout” și selectați aspectul dorit.

Dock Resource Library Left

Dock Resource Library Right

Dock Resource Library Bottom
Left

Dock Resource Library Bottom
Right

În ActivInspire Studio, Biblioteca de Resurse se deschide din Navigatorul de Resurse. 
Faceți clic pe fila „Layout” și selectați comportamentul dorit pentru Navigator.

Save Toolbox Layout Faceți clic pe fila „Layout”. Salvați aspectul la profilul implicit sau la un alt profil.

Clock Settings Faceți clic pe fila „Settings”, apoi pe Clock Settings.

Înapoi 
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 Acasă > Referințe > Proprietăți > Proprietăți de aspect

Proprietăți de aspect
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Layer Top

Middle

Bottom

Background

Implicit

Specificați pe ce strat este plasat obiectul.

Depth not applicable Indicator de informare. Arată poziția obiectului în ordinea de stivuire.

Grilele și obiectele, dacă sunt așezate în față, au un număr mai mare în 
ordinea de stivuire.

Translucency Această valoare poate varia de la translucid total (vizibil) la fără transluciditate 

(solid). Utilizați glisorul pentru a modifica transluciditatea.

Visible True

False

Implicit

Setați pe „False” pentru a face obiectul invizibil.

Ink Type Pen

Highlighter

Magic Ink

Implicit

Adnotările pot fi una din cele trei tipuri:
Adnotările cu Stiloul sunt solide.
Adnotările cu Evidențiatorul sun parțial translucide.
Adnotările cu Cerneala Magică vă permite să vedeți prin obiectele de pe 
stratul superior.
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Acasă > Referințe > Proprietăți > Proprietăți contur

Proprietăți contur
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Style
Solid

None

Dashed

Dot

Dash-Dot

Dash-Dot-Dot

Stilul de contur

Implicit

Color

Black

Culoarea conturului

Implicit

Width

4

Grosimea conturului în pixeli. Interval = 1 – 100

Implicit

Cap Style

Round

Flat

Square

Aplică majuscule de tipul selectat la începutul și la sfârșitul adnotărilor sau 
liniilor, când „Style” este setat la una dintre opțiunile punctate.

Implicit

Join Style

Round

Mitre

Bevel

Se aplică la colțurile exterioare ale obiectelor formă.

Implicit
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 Acasă > Referințe > Proprietăți > Proprietăți umplere

Proprietăți umplere
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Style None Implicit

Setați altă opțiune pentru a aplica un stil la alegere.

Solid Aplică un efect de umplere solid.

Dense1

Dense2

Dense3

Dense4

Dense5

Dense6

Dense7

Selectați din modelele matriciale de diferite densități.

Horizontal

Vertical

Cross

Backward Diagonal

Forward Diagonal

Cross Diagonal

Selectați dintr-o gamă de modele hașurate.

Gradient Selectați pentru a activa o umplere gradată în două 
culori.

Gradient None

Vertical

Horizontal

Diagonal1

Diagonal2

Radial

Implicit
Setați altă opțiune pentru a aplica colorarea gradată la 
alegere.

Color Black Implicit
Setați altă culoare pentru a aplica umbrirea la 
alegere.

 Activ doar dacă stilul de umplere este 
setat pe Gradient (vedeți mai sus).

Color 2 Black
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Acasă > Referințe > Proprietăți > Proprietăți fundal

Proprietăți fundal
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

rColor Black Implicit

Setați la altă culoare pentru a modifica fundalul.

Mode Transparent

Opaque

Implicit

Setați pe Opaque pentru a face culoarea fundalului solidă.
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Acasă > Referințe > Proprietăți > Proprietăți poziționare

Proprietăți poziționare
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Left Distanța obiectului de marginea din stânga în pixeli. Acuratețe până la 3 zecimale.

Top Distanța obiectului de marginea de sus în pixeli. Acuratețe până la 3 zecimale.

Width Lățimea obiectului în pixeli. Acuratețe până la 3 zecimale.

Height Înălțimea obiectului în pixeli. Acuratețe până la 3 zecimale.

Scale Factor x 1 Implicit
Modificați numărul pentru a scala obiectul după noul factor pe axa X. De 
exemplu, setați factorul de scalare la 2 pentru a dubla dimensiunea.

Scale Factor y 1 Implicit

Modificați numărul pentru a scala obiectul după noul factor pe axa Y.

Inverted False Implicit

Schimbați pe True pentru a roti obiectul la 180 de grade pe verticală.

Angle 0 Implicit
Modificați la orice valoare între 1 și 360 pentru a pivota obiectul după numărul de 
grade specificat în jurul Punctului de rotire din dreapta sus.

Reflected False Implicit

Schimbați pe True pentru a roti obiectul la 180 de grade pe orizontală.

Locked False Implicit
Modificați pe True pentru a fixa obiectul astfel încât să nu poată fi selectat și mutat, 
decât cu Punctul pentru mutare liberă.
Pentru a-l debloca, setați înapoi pe False sau faceți dublu-clic pe pictograma lacăt 
din Navigatorul de Obiecte.
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Acasă > Referințe > Proprietăți > Proprietăți etichetare

Proprietăți etichetare
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Caption Vă permite să adăugați unui obiect un titlu pe o singură linie.

Font Name Arial Implicit

Faceți clic pe caseta drop-down pentru a modifica fontul.

Font Size 12 Implicit
Apăsați pe săgețile în sus sau în jos pentru a crește sau scădea dimensiunea 
fontului sau selectați dimensiunea în cifre și tastați noua dimensiune.

Font Color Black Implicit

Faceți clic pe caseta de culori și selectați altă culoare pentru font.

Outline Style None

Implicit

Apăsați pe săgeata drop-down pentru a selecta un tip de contur pentru etichetă.
Solid

Dashed

Dot

Dash-Dot

Dash-Dot-Dot

Background
Mode

Opaque Implicit

Transparent Selectați pentru a face fundalul etichetei transparent.

Background
Color

Apăsați pe casetă pentru a selecta o culoare de fundal.

Behavior Always On Implicit

Tooltip Selectați pentru a face eticheta vizibilă doar când cursorul se mișcă peste ea.
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Acasă > Referințe > Proprietăți > Proprietăți rotire

Proprietăți rotire
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Can Rotate Freely Implicit

Obiectul poate fi rotit fără nicio restricție.

Clockwise Obiectul poate fi rotit doar în direcția acelor de ceasornic.

Anticlockwise Obiectul poate fi rotit doar invers acelor de ceasornic.

No Obiectul nu poate fi rotit.

Rotate Step Obiectul se rotește cu un pas.

Rotate About Center Implicit

Obiectul poate fi rotit doar în jurul centrului său.

Other Place Obiectul poate fi rotit în jurul altui loc pe care îl definiți.

Other Object Obiectul poate fi rotit în jurul altui obiect.

First Text Line Obiectul poate fi rotit în jurul primei linii de text.

Specific Point Obiectul poate fi rotit în jurul unui punct specific.

Top Left Obiectul poate fi rotit în jurul părții din stânga sus.

Top Obiectul poate fi rotit în jurul în jurul părții superioare.

Top Right Obiectul poate fi rotit în jurul părții din dreapta sus.

Left Obiectul poate fi rotit în jurul părții din stânga.

Right Obiectul poate fi rotit în jurul părții din dreapta.

Bottom Left Obiectul poate fi rotit în jurul părții din stânga jos.

Rotate Object Activ doar dacă Rotate About este setat pe Other Object (vedeți 
mai sus).
Selectați obiectul din caseta de dialog “Select Object”.

Rotate Point x Obiectul poate fi rotit în jurul coordonatei X.

Rotate Point y Obiectul poate fi rotit în jurul coordonatei Y.
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Acasă > Referințe > Proprietăți > Proprietăți multimedia

Proprietăți multimedia
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietățile multimedia depind de tipul de fișier, sistem de operare și player multimedia.

Proprietate Opțiune Descriere

Force Overlay

(doar obiecte swf și 
flv)

False Obiectele multimedia nu sunt forțate să apară deasupra adnotărilor.

True Obiectele multimedia sunt forțate să apară deasupra adnotărilor.

Autoplay False Redarea începe automat când este afișată pagina.

True Redarea nu începe automat când este afișată pagina.

Loop False Redare unică sau redare controlată a fișierului multimedia.

True Redarea este repetată până este oprită.

Hide Controls False Consola este afișată.

True Consola este ascunsă.

Force Aspect False Redimensionarea păstrează raportul de aspect.

True Distorsiunile de redimensionare sunt posibile.

Transparent
Background

(swf objects only)

False Când obiectele încorporate nu sunt setate la suprapunere forțată, acestea vor fi 
transparente.

True Când obiectele încorporate nu sunt setate la Force Overlay, acestea vor fi transparente.
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Acasă > Referințe > Proprietăți > Proprietăți pagină

Proprietăți pagină
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Width Lățimea paginii în pixeli.

Height Înălțimea paginii în pixeli.

Frames Across Implicit = 0
Vă permite să împărțiți pagina în cadre și să specificați numărul de 
cadre orizontale.

Frames Down Implicit = 0
Vă permite să împărțiți pagina în cadre și să specificați numărul de 
cadre verticale.

Background Fill Implicit = alb

Image Vă permite să folosiți o imagine, o captură de desktop sau o 
suprapunere desktop ca fundal pentru pagina flipchart.

Desktop Snapshot

Desktop Overlay
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Acasă > Referințe  > Proprietăți  > Proprietăți instrumente

Proprietăți instrumente
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Page Tools As before Implicit pentru toate paginile.
Păstrează starea actuală a Reflectorului sau Dezvăluitorului atunci când 
mergeți la pagina selectată. De exemplu, dacă Dezvăluitorul este pornit 
pentru pagina 1 a flipchartului, acesta va fi pornit automat atunci când 
treceți la pagina 2, dacă pagina 2 conține starea instrumentului „As 
before”. Cu toate acestea, dacă Dezvăluitorul este oprit pe pagina 1, va fi 
oprit și pe pagina 2.

Revealer Tool
Pornește Reflectorul sau Dezvăluitorul când mergeți la această pagină.

Spotlight Tool

Tools off Oprește Reflectorul sau Dezvăluitorul când mergeți la această pagină

Revealer Mode Full Vă permite să descoperiți pagina mișcând cursorul spre interior din 
orice parte a paginii.

Top

Vă permite să descoperiți pagina mișcând cursorul spre interior din 
partea de sus, jos, stângă sau dreaptă a paginii.

Bottom

Left

Right

Spotlight Mode Circular Spotlight Oferă un reflector mobil redimensionabil circular/oval sau pătrat/
dreptunghiular printr-un strat de mascare completă a paginii.

Square Spotlight

Solid Circular Spotlight
Oferă un strat de mascare circular/oval sau pătrat/dreptunghiular.

Solid Square Spotlight
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Acasă > Referințe > Proprietăți > Proprietăți Dezvăluitor

Proprietăți Dezvăluitor
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Mode Off Implicit.

Oprește Dezvăluitorul.

Top

Pornește Dezvăluitorul și vă permite să descoperiți pagina de sus, jos, stânga 
sau dreapta; sau setează Dezvăluitorul pe Full, ca să puteți descoperi pagina 
din orice parte.

Bottom

Left

Right

Full

Distance 0 Implicit
Activ doar dacă Mode este setat pe orice altceva în afară de Off. Setează 
distanța de pornire în pixeli a Dezvăluitorului din marginea de sus, jos, 
stânga sau dreapta a flipchartului.
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Acasă > Referințe > Proprietăți > Proprietăți Reflector

Proprietăți Reflector
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Mode Off Oprește Reflectorul.

Circular Spotlight Ascunde ecranul, în afară de o zonă rotundă sau pătrată.

Square Spotlight

Solid Circular Spotlight Tot ecranul este vizibil, în afară de o zonă rotundă sau pătrată.

Solid Square Spotlight

Left Aliniază Reflectorul la o anumită distanță în pixeli de partea de sus sau de jos a 
ecranului.

Top

Width Setează lățimea sau înălțimea Reflectorului.

Height
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Acasă > Referințe > Proprietăți > Proprietăți grile

Proprietăți grile
Pentru detalii despre schimbarea proprietăților, vedeți Modificarea proprietăților obiectelor.

Proprietate Opțiune Descriere

Visible False Implicit: False

Ascunde grila.

True Afișează grila.

Thumbnail
Scale

Definește scara la care miniatura reprezentare a 
grilei va fi trasată în Biblioteca de resurse când 
navigați după resurse.

Default Scale Definește un factor de scară care se aplică valorilor 
definite de început și de treaptă ale grilei. De 
exemplu, dacă grila are un Step X de 50 pixeli și o 
Default Scale de 2.0, grila va fi desenată la fiecare 
100 de pixeli pe ecran.

Scale Step Definește valoarea cu care se va modifica scara 
implicită a grilei de fiecare dată când faceți clic pe 
butoanele + sau - pentru a mări sau a reduce grila de 
pe pagină. Valoarea este adăugată sau scăzută din 
Default Scale în funcție de butonul apăsat.

Allow Snap False Implicit: False

Activează sau dezactivează fixarea în grilă.
True

On Top False Implicit: False

Plasează grila în fața sau în spatele obiectelor.
True

Grid Designer Deschide Designerul de grile.
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Acasă > Referințe > Meniuri și meniuri popup  > Puncte de acțiuni și redimensionare

Puncte de acțiuni și redimensionare 
Implicit, următoarele puncte sunt disponibile când un obiect este selectat:

Punct de 
acțiune

Studio Primary Descriere
Mai multe 
informații

Freely Move
Object

Vă permite să mutați obiectul 
oriunde pe pagină sau în Coșul de 
gunoi, chiar dacă obiectul este 
blocat.

Primii pași cu ActivInspire > 
Adăugarea și manipularea 
formelor

Rotate Object Vă permite să rotiți obiectul.

Object Edit Menu Deschide Meniul Editare Obiect. Referințe  > Meniuri > 
Meniuri și meniuri popup 
> Meniuri popup

Translucency
Slider

Vă permite să creșteți sau scădeți 
transluciditatea obiectului.

Toggle Grouped Comutator. Grupează obiectele 
selectate ca să puteți lucra cu 
ele ca un singur obiect.

Turul ActivInspire > Explorați 
ActivInspire Studio > 
Navigatoarele ActivInspire > 
Navigatorul de Obiecte

Turul ActivInspire > Explorați 
ActivInspire Primary > 
Navigatoarele ActivInspire > 
Navigatorul de Obiecte

Bring Forward
Aduce obiectul în față sau îl trimite 
în spate cu o poziție în ordinea de 
stivuire.

Mai multe despre 
ActivInspire > Lucrul cu 
obiecte > Folosirea 
straturilor și a suprapunerii

Send Backward

Duplicate Duplică obiectul selectat 
curent.

Primii pași cu ActivInspire > 
Copierea, lipirea și duplicarea 
obiectelor

Increase Object
Size

Crește sau scade dimensiunea 
obiectului în trepte, conform cu 
factorul de scalare setat în 
Navigatorul de Obiecte. Factorul 
implicit este 1.

Decrease Object
Size

Edit Shape Points Activează punctele de formă ale 
unui obiect pe care le puteți trage 
pentru a schimba forma obiectului.

Primii pași cu ActivInspire > 
Adăugarea și manipularea 
formelor
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Punct de 
redimensionare
Size Object Faceți clic și trageți pentru a 

extinde și distorsiona obiectul. Primii pași cu ActivInspire > 
Adăugarea și manipularea 
formelorSize Object

(Maintain Aspect)
Faceți clic și trageți pentru a 
extinde obiectul proporțional.

Pentru detalii despre adăugarea și eliminarea Punctelor de acțiune, vedeți Alegerea instrumentelor.
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Acasă > Referințe >  Instrumente  > Designer grile

Designer grile

Ce? Vă creați propriile grile personalizate sau adaptați grilele din Biblioteca de resurse.

Unde? Page Browser Popup Menu

Comandă rapidă? CTRL+Shift+G (WindowsTM & LinuxTM)

Cmd+Shift+G (Mac®)

Cum? Grid Designer vă oferă multe opțiuni. Printre altele, vă permite să selectați culori și 
stiluri de linie pentru grile, introduceți mai multe niveluri de grilă unul peste altul, 
afișați sau ascundeți grila, permiteți sau interziceți fixarea, astfel încât obiectele să se 
alinieze automat cu grila, afișați deasupra sau în spatele obiectelor, setați originile X 
și Y și direcția, precum și dimensiunea treptelor X și Y.

Unde puteți personaliza? Caseta de dialog „Grid Designer”.

Mai multe informații
Mai multe despre ActivInspire > Lucrul cu obiecte > Crearea și editarea grilelor

Lucrul cu acțiuni

Referințe > Acțiuni > Acțiuni de comandă
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Acasă > Primii pași cu ActivInspire > Copierea, lipirea și duplicarea obiectelor

Copierea, lipirea și duplicarea obiectelor 
Puteți economisi mult timp reutilizând obiecte.

Aici vă arătăm:

Copierea și duplicarea obiectelor 

Tăierea și lipirea obiectelor

Copierea și duplicarea obiectelor
Copierea și duplicarea unui obiect sună similar, dar nu este la fel.

Copierea și lipirea unui obiect

Când copiați un obiect, ActivInspire îl stochează într-o memorie de lipire, până când decideți unde doriți să-l puneți.

Iată două moduri de a copia un obiect.

Cu obiectul selectat:

Din Edit Menu, selectați Copy.

           Faceți clic pe Object Edit menu și selectați Copy.

Iată trei moduri de a lipi un obiect.

Navigați la locul în care doriți să puneți copia obiectului. Acesta poate fi pe aceeași pagină, pe altă pagină sau chiar pe alt 
flipchart deschis. 

Faceți clic unde doriți să inserați obiectul și din Edit Menu selectați Paste.

Faceți clic dreapta unde doriți să inserați obiectul și din meniul popup selectați Paste.

Pentru a suprapune un obiect peste altul:

1. Selectați celălalt obiect.
2. Faceți clic pe Object Edit Menu și selectați Paste. Obiectul copiat este suprapus deasupra obiectului selectat. Ambele

obiecte sunt pe același strat.

Duplicarea unui obiect

Când duplicați un obiect, ActivInspire plasează duplicatul astfel încât să se suprapună parțial cu obiectul original.

Iată trei moduri de a duplica un obiect.

Cu obiectul selectat:

Faceți clic pe Punctul de duplicare obiect.

Din Edit Menu, selectați Duplicate.

În exemplul din dreapta, rețineți că al doilea obiect se suprapune pe primul.

Alternativ...
Puteți duplica întreaga pagină, apoi puteți șterge orice obiect nedorit din copie:
Faceți clic dreapta oriunde pe pagină și din meniul popup, selectați Duplicate. 
ActivInspire introduce un duplicat al paginii curente după pagina curentă.
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Înapoi 

Tăierea și lipirea obiectelor
Tăierea și lipirea unui obiect înseamnă eliminarea și inserarea acestuia în altă parte.

Iată două moduri de a tăia și lipi un obiect.

Cu obiectul selectat:

• Din Object Edit Menu, selectați Cut.

• Din File Menu, selectați Cut.

Pentru a lipi obiectul:

• Din Object Edit Menu, selectați Paste.

• Din File Menu, selectați Paste.
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 Acasă > Primii pași cu ActivInspire > Inserarea paginilor

Inserarea paginilor
Aici vă arătăm cum să inserați diferite tipuri de pagini în flipchart:

Inserare pagină goală

Inserare captură desktop

Inserare pagină goală
1. În Navigatorul de Pagini, faceți clic pe miniatura paginii înainte sau după care doriți să inserați o pagină goală.

2. Din Insert Menu, selectați  Page > Blank Page After Current sau Blank Page Before Current.
sau
Din meniul popup al Navigatorului de Pagini, selectați Insert Page > Blank Page After Current sau Blank Page 
Before Current.
O pagină goală este inserată.

Inserare captură desktop
1. În Navigatorul de Pagini, faceți clic pe miniatura paginii după care doriți să inserați o captură.

2. Din Insert Menu, selectați Page > Desktop Snapshot. Se deschide caseta popup „Insert Page”.

3. Faceți clic pe Camera Un instantaneu al desktopului computerului apare într-o pagină nouă după cea curentă.
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Acasă > Primii pași cu ActivInspire > Inserarea resurselor

Inserarea resurselor
Puteți adăuga propriile resurse, puteți utiliza cele furnizate cu ActivInspire sau puteți utiliza pachete de resurse care au fost 
importate în Biblioteca de resurse. Folosiți resursele ca elemente de bază pentru lecții.

Aici vă arătăm cum să găsiți o resursă și să o adăugați la flipchart. Apoi vă arătăm cum să adăugați o resursă la Biblioteca de 
resurse. În cele din urmă, vă vom arăta, de asemenea, cum să adăugați propriile resurse în Biblioteca de resurse.

Mai întâi găsiți resursa (ActivInspire Studio)
1. Faceți clic pe Resource Browser         Folderul Resurse Partajate   se deschide în Navigator. Acest folder conține

resurse pe care le împărtășiți cu colegii. Navigatorul conține, de asemenea, butoane pentru a deschide alte foldere: 

Resursele mele deschide dosarul de resurse personale. 

Alt folder de resurse afișează unele dintre folderele utilizate frecvent. 

deschide o casetă de dialog pentru a vă permite să căutați fișiere  Răsfoire pentru a găsi un alt folder 
în altă parte în computerul sau pentru a crea un alt folder.

deschide pagina Resurse a Promethean Planet Căutare resurse în Promethean Planet 
în browserul de Internet. 

2. În Navigator, explorați categoriile din Resurse partajate până când o găsiți pe cea pe care o căutați și faceți clic pe ea. Jumătatea 
superioară a Navigatorului arată acum subfolderele din acea categorie.

3. Răsfoiți și faceți clic pe folderul care conține tipul de resursă pe care doriți să o inserați, de exemplu, Maths > Tangrams în 
folderul de Adnotări partajate (Shared Annotations). Jumătatea de jos a Navigatorului arată miniaturile resurselor din acest folder.

4. Utilizați glisorul pentru a vedea toate resursele din acest subfolder.

Înapoi 

Mai întâi găsiți resursa (ActivInspire Primary)

1. În setul de Instrumente 
Principale, faceți clic pe 
Navigatorul de Resurse.  
Se deschide Navigatorul de 
Resurse ca o bandă de film 
de-a lungul marginii de jos 
a ferestrei ActivInspire. În 
exemplu în dreapta, puteți 
vedea patru resurse. Cel cu 
pictograma notă muzicală 
include o acțiune sunet.

2. Faceți clic pe Locațiile 
Resurselor. Folderul 
Resurse partajate se 
deschide într-o fereastră 
popup. Acest folder conține 
resurse pe care le 
împărtășiți cu colegii. 

Aici descriem succint părțile Navigatorului de Resurse din imaginea de mai 
sus.

1 Resurse
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Fereastra conține, de 
asemenea butoane pentru a 
deschide altele foldere:

Resursele mele 
deschide folderul 
personal cu resurse.

Folderul alte 
resurse

2    Butoanele Înainte și Înapoi vă permit să navigați printre resurse.

3    Grupul de instrumente conține următoarele instrumente:

Locațiile Resurselor 

Multiplicare activată/dezactivată Toggle 

Comutator transparență

afișează unele dintre folderele utilizate 
frecvent.

Răsfoire pentru a găsi un alt folder deschide o casetă de dialog pentru a vă 

permite să căutați fișiere în altă parte în computerul sau pentru a crea un alt folder.

deschide pagina Resurse a Promethean Planet în Căutare resurse în Promethean Planet 
browserul de Internet. 

3. În fereastra popup, explorați categoriile din Resurse partajate, până când o găsiți pe cea pe care o căutați și 
faceți clic pe ea. Fereastra popup arată acum subfolderele din acea categorie.

4. Răsfoiți și faceți clic pe folderul care conține tipul de resursă pe care doriți să îl inserați, de exemplu, Maths > 
Tangrams în folderul Adnotări partajate. Banda de film arată miniaturile resurselor din acest dosar.

5. Utilizați butoanele Înapoi și Înainte de pe rolă pentru a vedea toate resursele din acest subfolder.

Înapoi  

Inserare resursă în flipchart 
Iată câteva modalități rapide de a insera o resursă: 

Faceți clic pe miniatura resursei din Navigator și inserați-o pe pagina flipchart, cu drag&drop.

Faceți clic dreapta pe miniatură și selectați Insert Resource into Flipchart din meniul popup.  

Faceți clic pe meniul popup și selectați Insert Resource into Flipchart.

După ce ați introdus o resursă, o puteți manipula ca și alte obiecte pentru a se potrivi nevoilor de predare.

Înapoi 

Inserare resursă în Biblioteca de resurse 
De asemenea, puteți adăuga propriile resurse în Biblioteca de resurse dintr-o pagină flipchart. De exemplu, dacă doriți să 
înregistrați și să refolosiți unele imagini, obiecte de acțiune sau containere.

Pentru a adăuga o resursă într-un folder existent în Biblioteca de resurse:

1. Deschideți folderul din Navigatorul de Resurse.

2. Faceți clic și trageți obiectul în folderul în care doriți să îl inserați, apoi eliberați-l. Resursa nou adăugată acum apare în 
secțiunea de articole din Navigator. Are numele implicit „ResourceN” unde „Resource” identifică tipul de resursă, de exemplu, 
Image și „N” este un număr. 
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Pentru a redenumi resursa: 

1. Selectați resursa din Navigatorul de Resurse. 

2. Selectați Rename Resource File din meniul popup. Se deschide caseta de dialog „Rename Resource File”. 

3. Introduceți un nume și faceți clic pe OK.

Pentru a crea un folder nou în care să adăugați resursa: 

1. În Navigatorul de Resurse, navigați și selectați folderul în care doriți să creați un folder nou.

2. Faceți clic pe Resource Browser Folders Menu și selectați  Create New Folder. Se deschide caseta de dialog „Create New 
Folder”. 

3. Introduceți un nume de folder și faceți clic pe OK.

4. În Navigatorul de Resurse, navigați la noul folder, apoi încărcați resursa așa cum este descris mai sus, cu drag&drop.
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Acasă > Primii pași cu ActivInspire > Utilizarea grilelor

Utilizarea grilelor
Aici introducem grilele și vă arătăm cum să le folosiți:

Despre grile

Când se folosesc grilele

Inserare grilă din Biblioteca de resurse 

Fixarea în grilă

Afișare sau ascundere grile

Despre grile
O grilă este una dintre componentele care pot alcătui stratul de fundal al unui flipchart. Când aplicați o grilă unei pagini, puteți 
schimbați în continuare culoarea fundalului și aplica o imagine de fundal paginii. Orice obiecte, cum ar fi adnotări și imagini, sunt 
plasate deasupra grilei deoarece sunt pe un strat diferit. Cu toate acestea, puteți muta grila astfel încât să se afișeze deasupra tuturor 
celorlalte obiecte.

Când se folosesc grilele 
Puteți utiliza grilele într-o gamă largă de activități, iată câteva idei: 

Creați-vă propria hârtie 
milimetrică, pe care o puteți 
folosi pentru a reprezenta 
date numerice într-o formă 
vizuală. 

Creați hârtie specializată 
pentru a reprezenta funcții 
matematice complexe.

Poziționați obiectele cu 
precizie când creați o  
prezentare și sunteți sigur ca 
obiectele sunt aliniate în locul 
corect în timpul activităților 
drag&drop. 

Creați linii de orientare pentru 
a vă ajuta să desenați obiecte 
tridimensionale. 

Adăugați o scală la 
demonstrații, precum 
transformări ale obiectelor. 

Înapoi 

Inserare grilă din Biblioteca de resurse
Biblioteca de resurse conține mai multe eșantioane de grile, care sunt gata de utilizare. 
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Aici vă arătăm cum să inserați una dintre aceste grile într-un flipchart:

1. Navigați la pagina în care doriți să inserați o grilă.

2. Faceți clic pe Navigatorul de Resurse

3. În folderul Shared Resources, faceți clic pe Grids.

4. Selectați categoria la alegere, de exemplu, Graph Paper > Green. Miniaturile din Navigator afișează grilele 
disponibile.

5. Iată trei modalități rapide de a adăuga grila la pagină. Faceți clic pe miniatura grilei alese, apoi: 

Glisați și fixați grila pe pagină. 

Din meniul opup, selectați Insert into Flipchart.

Faceți clic dreapta pe miniatură și selectați Insert into Flipchart.

Fixarea în grilă 
Utilizați Snap to Grid, astfel încât elementele de pe flipchart să se alinieze automat cu o grilă de pe pagină atunci când le mutați.

 Aliniere articole cu o grilă

1. Trageți o grilă pe pagină din Biblioteca de resurse.

2. Faceți clic dreapta pe pagină și selectați Snap to Grid.

3. Mutați sau creați un obiect, observați cum se aliniază cu grila.

Dezactivare fixare în grilă

Snap to Grid rămâne activ până când deselectați Snap to Grid sau până când ștergeți grila.

Când opțiunea de fixare în grilă este activată, este posibil să descoperiți că obiectele continuă să nu se fixeze în grilă. 
Acest lucru se poate datora faptului că grila nu a fost concepută astfel încât să permită să se producă fixarea.

Pentru detalii, consultați Referințe > Instrumente > Designer grile.

 Înapoi 

Afișare sau ascundere grilele
Grilele sunt utile atunci când construiți un flipchart sau când doriți să aliniați sau să măsurați obiecte cu precizie. Poate doriți să 
afișați sau ascundeți o grilă atunci când prezentați la tablă. Puteți utiliza în continuare funcția snap to grid fără a afișa grila în sine.

Presupunem că ați adăugat deja o grilă la pagină.

Aici vă arătăm două moduri de a afișa și ascunde grilele.

Navigatorul de Proprietăți

1. Faceți clic pe pagină pentru a o selecta.

2. Deschideți Navigatorul de Proprietăți

3. Derulați în jos până la Grid. Setați Visible la True pentru a afișa grila sau la False pentru a o ascunde.

Clic dreapta

1. Faceți clic dreapta pe pagină.

2. Selectați Hide Grid. Acesta este un comutator, îl puteți utiliza pentru a afișa sau a ascunde grila.

Înapoi 
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Pentru detalii despre cum să creați propriile grile cu Grid Designer , consultați Crearea și editarea grilelor.
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Acasă > Primii pași cu ActivInspire > Crearea obiectelor

Crearea obiectelor 
Aici vă arătăm:

Crearea unei forme 

Modificarea culorii

Crearea unei forme

1. Click pe Shape Cursorul se modifică pentru a vă oferi o previzualizare a formei implicite
o linie dreaptă. Se deschide Meniul Forme:

In ActivInspire Studio, se deschide vertical în dreapta ferestrei ActivInspire în mod implicit. 

In ActivInspire Primary, se deschide într-o bandă orizontală de film de-a lungul marginii de jos a ferestrei ActivInspire. 
Faceți clic pe butoanele de pe rolă pentru a dezvălui mai multe forme.

2.  Faceți clic pe o altă formă, de exemplu, triunghiul. Observați că cursorul se transformă într-un triunghi.

3.  Poziționați cursorul acolo unde doriți să începeți să desenați triunghiul, apoi faceți clic și trageți până când sunteți mulțumit de 
formă. 

Modificarea culorii
Iată două moduri de a schimba culoarea unei forme:  

Modificare culoare contur 

1. Faceți clic pe Umplere 

2. Selectați o culoare din Paleta de culori. 

In ActivInspire Studio, acesta se află în setul de Instrumente Principale. 

In ActivInspire Primary, acesta se află într-un grup din partea de jos a ferestrei ActivInspire.

3.  Poziționați cursorul peste conturul formei și faceți clic. Culoarea conturului se schimbă cu cea pe care ați ales-o. 

Dacă faceți clic lângă, dar nu pe contur, întreaga pagină va fi umplută cu culoarea selectată. Doar faceți clic pe 

Undo          și încercați din nou. 

Modificare culoare de umplere 

Noile forme sunt umplute în mod implicit. Schimbarea culorii de umplere este chiar mai ușoară decât schimbarea culorii conturului: 

1. Faceți clic pe Umplere

2. Selectați o culoare din Paleta de culori.

3. Poziționați cursorul peste centrul formei și faceți clic. Forma se umple cu culoarea pe care ați ales-o.
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Acasă > Primii pași cu ActivInspire  > Trucuri pentru profesori

Trucuri pentru profesori
ActivInspire vă ajută să includeți imagini, culoare și interactivitate în lecții. Iată câteva idei despre cum să profitați la maximum de 
software: 

1. Folosiți culori și fonturi
Tablele albe interactive vă oferă posibilitatea de a utiliza multe culori la ore. Este ușor să vă obișnuiți să folosiți doar unul sau două 
fonturi. Explorați întreaga gamă de fonturi disponibile, dar nu uitați să alegeți culori puternice care funcționează bine pe tablă, păstrați 
aspectul neaglomerat, astfel încât scopurile și obiectivele lecției să nu se piardă în detalii.  

2. Incursiune în Biblioteca de resurse
În Biblioteca de resurse veți găsi o gamă largă de imagini, fundaluri și alte resurse. 

3. Folosiți multe pagini
Răspândiți exerciții pe mai multe pagini pentru a vă ajuta să controlați ritmul lecțiilor. 

4. Salvați flipcharturile de fiecare dată
Când predați cu flipcharturile, le veți personaliza pentru fiecare clasă. Salvați din nou flipchartul cu un alt nume atunci când ați terminat 
predarea lecției și distribuiți flipcharturile elevilor.

5. Imprimați flipcharturile
Folosiți paginile ca fișe.

6. Explorați instrumentele de prezentare

Profitați de funcțiile de prezentare ale ActivInspire pentru a face lecțiile mai creative și mai atractive. Ce fac  Dezvăluitorul 

Reflectorul         Panglica cu mesaje         și Cerneala Magică       ?

7. Implicați elevii
Încurajați elevii să facă prezentări la tablă; lăsați-i să-și creeze propriile pagini; lăsați-i să preia controlul instrumentelor; lasă-i să 
lucreze împreună în modul Dual User; puneți-le întrebări ad-hoc pentru a stimula discuțiile. 

8. Distribuiți flipcharturile
Și asigurați-vă că ceilalți colegi vă împărtășesc flipcharturile lor! 

9. Încorporați resursele curente în flipchart
Dacă utilizați deja CD-ROM-uri, DVD-uri și dispozitive de stocare USB, utilizați-le cu flipcharturile. Utilizați scanere pentru a copia 
fișele pe care le-ați creat deja - dar nu uitați să profitați de oportunitățile de interactivitate ale ActivInspire. 

10. Păstrați accentul pe învățare
ActivInspire oferă oportunități excelente de predare flexibilă, ceea ce face să pară că sunteți spontan, în timp ce rămâneți strict la 
planul de lecție stabilit în flipchart.

Înapoi 
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Acasă > Referințe > Meniuri și meniuri popup > Meniuri popup

Meniuri popup
Meniurile popup sunt specifice contextului, de exemplu, Meniu Editare Obiect este disponibil numai atunci când lucrați cu obiecte.

Puteți afișa meniurile popup făcând clic pe această pictogramă sau făcând clic dreapta pe o pagină sau obiect flipchart.

Pentru detalii complete despre instrumentele furnizate în ActivInspire, vedeți Referințe > Instrumente..

Aici vă oferim o prezentare generală a instrumentelor și funcțiilor disponibile în meniurile popup din ActivInspire:

Meniu Editare Obiect (Object Edit Menu)

Meniu Pagină (Page Menu)

Meniu Foldere Navigator de Resurse (Resource Browser Folders Menu)

Meniu Elemente Navigator de Resurse (Resource Browser Items Menu)

Meniu Editare Obiect 

După ce ați selectat un obiect, puteți afișa, de asemenea, Meniul Editare Obiect din acest Punct de acțiune.

Puteți accesa următoarele funcții din Meniul Editare Obiect:

Instrument Studio Primary Descriere
Mai multe informații

Property
Browser

Deschide Navigatorul de Proprietăți. Turul ActivInspire > Explorați 
ActivInspire Studio > Navigatoarele 
ActivInspire > Navigatorul de 
Proprietăți

Turul ActivInspire > Explorați 
ActivInspire Primary > Navigatoarele 
ActivInspire > Navigatorul de 
Proprietăți

Action Browser Deschide Navigatorul de Acțiuni. Turul ActivInspire > Explorați 
ActivInspire Studio > Navigatoarele 
ActivInspire > Navigatorul de Acțiuni

Turul ActivInspire > Explorați 
ActivInspire Primary > 
Navigatoarele ActivInspire > 
Navigatorul de Acțiuni

Edit Shape
Points

Activează punctele de formă ale 
unui obiect de care puteți trage 
pentru a modifica forma unui 
obiect.

Primii pași cu ActivInspire > 
Adăugarea și manipularea 
formelor

Insert link to
file...

Deschide fereastra de dialog 
Insert Link to File pentru a 
crea o legătură către un 
document.

Mai multe despre ActivInspire> 
Lucrul cu obiecte > Adăugare și 
eliminare legături

Cut Primii pași cu ActivInspire > 
Copierea, lipirea și duplicarea 
obiectelor

Primii pași cu ActivInspire  > Copy
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Taie, copiază, lipește, duplică sau 
șterge obiectul selectat.

Ștergerea elementelor

Paste

Delete

Transform Afișează instrumente pentru 
modificarea poziției, dimensiunii și 
alinierii obiectului selectat.

Mai multe despre ActivInspire > 
Lucrul cu obiecte > Transformarea 
obiectelor

Referințe  > Meniuri și meniuri 
popup > Bara de meniu > Editare

Reorder Afișează instrumente pentru a 
muta obiectul selectat pe altă 
poziție în ordinea de stivuire sau 
pe alt strat.

Toggle Locked Comutator. Blochează sau 
deblochează obiectul sau obiectele 
selectate pentru a putea sau nu fi 
mutate sau grupate cu alte obiecte.

Turul ActivInspire > Explorați 
ActivInspire Studio > Navigatoarele 
ActivInspire > Navigatorul de 
Obiecte

Turul ActivInspire > Explorați 
ActivInspire Primary > 
Navigatoarele ActivInspire > 
Navigatorul de Obiecte

Toggle Grouped Comutator. Grupează obiectele 
selectate pentru a putea lucra cu 
ele ca un singur obiect.

Toggle Hidden Comutator. Arată sau ascunde 
obiectul selectat.

Toggle Drag a
Copy

Comutator. Activează sau 
dezactivează posibilitatea de a face 
clic pe un obiect și a crea o copie a 
acestui obiect prin tragere din 
obiectul original.

Înapoi 

Meniu Pagină
Acest meniu este disponibil din Navigatorul de Pagini și prin clic-dreapta pe pagina flipchart.

Instrument Descriere
Mai multe informații

Insert Page Referințe > Bara de meniu > Inserare

Primii pași cu ActivInspire > Inserarea 
paginilor

Blank Page Before Current
Inserează o pagină goală după sau 
înainte de pagina curentă.

Blank Page After Current

Desktop Snapshot Minimizează ActivInspire și deschide 
caseta popup “Insert Page” cu 
Camera setată pe “Take Snapshot”

Mai multe despre ActivInspire > Lucrul 
la tablă > Utilizare Cameră

Referințe > Instrumente > Cameră
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More Page Templates Deschide un folder “User Selected”.

Are același efect ca atunci când faceți 
clic pe pictograma Other Resource 
Folder (Alt folder cu resurse) din 
Navigatorul de Resurse.

Mai multe despre ActivInspire > Lucrul 
cu resurse  > Adăugarea resurselor în 
flipchart

Insert Question Lansează Expertul în Întrebări. Folosirea Sistemelor de Răspuns 
pentru Elevi > Întrebări pregătite – 
Folosirea Expertului în Întrebări

Export Page Deschide fereastra de dialog “Export Page”. Mai multe despre ActivInspire > Importul
și exportul fișierelor  

Set Background Deschide fereastra de dialog “Set 
Background”.
Selectați din:

Fill

Image

Desktop Snapshot

Desktop Overlay

Grid Designer Deschide Designerul de grile.

Mai multe despre ActivInspire > Lucrul 
cu obiecte > Crearea și editarea grilelorHide Grid Ascunde grila.

Snap to Grid Face ca obiectele mutate să se fixeze în 
grilă.

Add to Resource Library

Add Page

Add Background

Add Grid

Adaugă articolul selectat în 
folderul My Resources.

Mai multe despre ActivInspire > Lucrul 
cu resurse 

Cut Taie, copiază, lipește, duplică sau 
șterge pagina flipchart curentă.

Copy

Paste

Duplicate

Delete

Înapoi 

Meniu Foldere Navigator de Resurse
Acest meniu este disponibil în secțiunea de foldere a Navigatorului de Resurse.

Instrument Descriere
Mai multe informații

Export to Resource Pack... Deschide fereastra de dialog “Save as”. Mai multe despre ActivInspire > 
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Lucrul cu resurse  > Importul și 
exportul pachetelor de resurse

Import Resource Pack Here... Disponibil doar pentru folderul de nivel 
superior din My Resources și Shared 
Resources.

Rename Folder Disponibil doar pentru folderele de nivele 
inferioare din folderele My Resources, 
Shared Resources și User Selected.

Deschide o casetă de dialog care vă 
permite să redenumiți, ștergeți sau creați 
un folder.

Delete Folder

Create New Folder

Meniu Elemente Navigator de Resurse
Acest meniu este disponibil în secțiunea de resurse a Navigatorului de Resurse.

Instrument Descriere
Mai multe informații

View Mode

View as list

View as grid

Afișează resursele în folder ca listă 
sau grilă.

Turul ActivInspire > Explorați 
ActivInspire Studio > Navigatoarele 
ActivInspire > Navigatorul de 
Resurse

Turul ActivInspire > Explorați 
ActivInspire Primary > 
Navigatoarele ActivInspire > 
Navigatorul de Resurse

Thumbnail Size

Small

Large

Afișează miniaturi mici sau mari ale 
resurselor.

Insert into Flipchart Inserează resursele selectate în 
pagina curentă flipchart.

Primii pași cu ActivInspire > Inserarea 
resurselor

Mai multe despre ActivInspire > Lucrul 
cu resurse  > Adăugarea resurselor în 
flipchart

Rename Resource File Deschide caseta de dialog “Rename 
Resource File”. Vă permite să introduceți 
un nou nume de fișier și să salvați 
resursa.

Delete from Library Șterge resursele selectate din 
Biblioteca de resurse.

Înapoi 
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